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Preface

The typical user of a simulation package is someone who holds a PhD or an MSc,
has several years of experience in modeling and simulation, and underwent
thorough training to use the specific package. He or she typically works as a
scientist in the R&D department of a big organization or as an academic
researcher. Because the theory of simulation is complicated and the typical
simulation package presents many options, it is up to the user to employ his or her
expertise to validate the model and the simulation.

This means that a small group of simulation experts is serving a much larger group
of people working in product development, production, or as students studying
physics effects. Simulation models are oftentimes so complicated that the person
who implemented the model is the only one who can safely provide input data to
get useful output. Hence the use of computer modeling and simulation creates a
bottleneck in product development, production, and education.

In order to make it possible for this small group to service the much larger group,
the Application Builder offers a solution. It makes it possible for simulation experts
to create an intuitive and very specific user interface for his or her otherwise
general simulation model — a ready-to-use application. The general model can
serve as a starting point for several different applications, with each application
presenting the user with input and output options relevant only to the specific task
at hand. The application can include user documentation, checks for “inputs
within bounds”, and predefined reports at the click of a button.

Creating an application often requires a collaborative effort by experts within the
areas of physics, numerical analysis, programming, user-interface design, and
graphic design.

To a reasonable extent, COMSOL’s Technical Support team can recommend
physics and numerical analysis settings for your application. In addition, the
COMSOL documentation and online resources can be of great help. For
programming and design, the Technical Support team can provide very limited
help. These are areas where your own development efforts are critical.

The Application Builder makes it easy for a team to create well-crafted applications
that avoid accidental user input errors while keeping the focus on relevant output
details.

We at COMSOL are convinced that this is the way to spread the successtul use of
simulation in the world and we are fully committed to helping make this possible.



Introduction

A COMSOL® application is an intuitive and efficient way of interacting with a
COMSOL Multiphysics® model through a highly specialized user interface. This
book gives a quick overview of the Application Builder desktop environment with
examples that show you how to use the Form Editor, Main Window Editor, and
the Method Editor. Reference materials are also included in this book, featuring a
list of the built-in methods and functions that are available. For detailed
information on how to use the Model Builder, see the book Introduction to
COMSOL Multiphysics.

If you want to check out an example application before reading this book,
open and explore one of the applications from the Application Libraries in
one of the Applications folders. Keep it open while reading this book to
try things out. Only the Applications folders contain applications with user
interfaces. The other folders in the Application Libraries are tutorial
models with no user interfaces.

The Application Builder is included in the Windows® version of COMSOL

Multiphysics and accessible from the COMSOL Desktop® environment.

COMSOL Multiphysics and its add-on products are used to create an application.

A license for the same add-on products is required to run the application from the

COMSOL Multiphysics or COMSOL Server™ products.

Additional resources, including video tutorials, are available online at

https: / /www.comsol.com/videos.

RUNNING APPLICATIONS WITH COMSOL MULTIPHYSICS

With a COMSOL Multiphysics license, applications can be run from the
COMSOL Desktop in Windows®, macOS, and Linux®.

RUNNING COMPILED APPLICATIONS

By using COMSOL Compiler™ you can compile your application to an
executable file for Windows®, Linux®, and macOS. You can freely distribute the
executable and it can be run without any license file.

RUNNING APPLICATIONS WITH COMSOL SERVER

With a COMSOL Server license, a web implementation of an application can be
run in major web browsers on platforms such as Windows®, macOS, i0S, Linux®,
and Android™. In Windows®, you can also run COMSOL applications by
connecting to a COMSOL Server with an easy-to-install COMSOL Client,
available for download from https: / /www.comsol.com /client-download. COMSOL
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Server does not include the Application Builder, Physics Builder, or Model Builder
tools that come with the COMSOL Desktop environment. Any application
created with the Application Builder will automatically work with a web browser
or any client.

GUIDELINES FOR BUILDING APPLICATIONS

If you are not experienced in building a graphical user interface or programming,
you may want to read “Appendix F — Guidelines for Building Applications” on
page 371.

ADDITIONAL DOCUMENTATION

Additional documentation with information relevant to building applications can
be found in the books: Application Programming Guide, Application Builder
Reference Manual, and Programming Reference Manual.



The Application Builder Desktop Environment

COMSOL DESKTOP ENVIRONMENT —

The COMSOL Desktop environment provides access to the Ap-
plication Builder, including the Form, Main Window, and Method
Editors, as well as the Model Builder and the Model Manager.

MODEL BUILDER, APPLICATION BUILDER, and MODEL
MANAGER—Switch between the Model Builder, the Appli-
cation Builder, and the Model Manager.

DB ER > - BN R ° imph - COMSOL Muiphyzics - o x
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7N ] & settings E G i ] > O) & R =

Model  Model New  New B Ecmorioos) Appliation | B Timer % e o Move T
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Browser with Saved " ) Rest Desktop
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Bulder Manager o Method v Ubraries« | Window  Application

Workspace nputs Events Dedarations Main Window Test

Application Builder | Egprosen |
Bt B 9@ File iome

> = Fa

Reset  Compute  Report Hep

ot | Smustion | Documentation
Input and Description Results
~ nput Temperature

Jimel aa@-

jon  Temperature profiles | Conversion profiles

-@0as @
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K
Ty Jimel

+ Reactor Description

4+ Methanol concents

+ Information

Expected computation

+ When Solved
91 Play sound
3 Email report o

% EmailSetings

253681288

APPLICATION BUILDER WINDOW —
The Application Builder window with the
application tree.

SETTINGS and EDITOR TOOLS WINDOWS — Click any application
tree node or form object to see its associated Settings window.
The Editor Tools window is used to quickly create form objects.

The screenshot above is representative of what you will see when you are working
with the Application Builder. The main components of the Application Builder
desktop environment are:

» Application Builder window and ribbon tab
COMSOL Desktop environment

« Form Editor (sce page 54)

* Main Window Editor (see page 137)
Method Editor (see page 184)
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THE APPLICATION TREE

The application tree consists of the
following nodes:

* Inputs

¢ Themes

¢ Main Window
¢ Forms

¢ Events

¢ Declarations
¢ Methods

¢ Libraries

The Inputs node contains subnodes that are
of the type Application Argument. These can
be used for input arguments to the
application when starting it from the
command line of the operating system.

The Themes node has a Settings window
with choices for the desktop color themes,
as well as font, text color, and other settings
that will affect the general appearance of an
application.

The Main Window node represents the main
window of an application and is also the
top-level node for the user interface. It
contains the window layout, the main
menu specification, and an optional ribbon
specification.

The Forms node contains subnodes that are
forms or folders containing local forms.
Each form may contain a number of form
objects such as input fields, graphics
objects, and buttons.

The Events node contains subnodes that are
global events. These include all events that
are triggered by changes to the various data

Application Builder

v [&] tuning_fork.mph (root)
ﬁ Inputs
% Themes

v D Main Window
v E Menu Bar
v [Z] File {file}
El Save {save}
El Save As {sgveds)
i Toolbar
v [ Forms
D main
D selectllSize
D information
¥ D mainComputer
D toolbarComputer
¥ D mainTablet
D toolbarTablet
D notationsTablet
¥ D mainSmartphone
D toolbarSmartphone
Events
v = Declarations
= Boolean
123 Integer
25 Double
abe String
<Z» Material {materiall ist}

<z» Simulation Type List {simulationTypelist}
,@ Shortcuts

v [ Methods

E initializeApplication
resetToDefault
enableButtons

=| checkFindProenglength
computeAndUpdateResults
runFrequencyStudy

=| playSoundForFrequency

createReport

inputChanged

=] initGraphicsAndButtons
=| setMaterial

v [fifi Libraries
[2] Images
=} Sounds

fE3 Files

entities, such as global parameters or string variables. Global events can also be
associated with the startup and shutdown of the application. Timer events can be
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used to operate an app as a digital twin, enabling automated actions to be
performed at regular intervals.

The Declarations node is used to declare global variables, which are used in
addition to the global parameters and variables defined in the model.

The Methods node contains subnodes that are methods. Methods contain code for
actions not included among the standard run commands of the model tree nodes
in the Model Builder. The methods may, for example, execute loops, process
inputs and outputs, and send messages and alerts to the user of the application.
Methods can modify the model object of a running application or the model
object represented by the Model Builder in the current session. The latter being
utilized when building an add-in.

The Libraries node contains images, sounds, and files to be embedded in an
MPH-file so that you do not have to distribute them along with the application.
In addition, the Libraries node may contain Java® utility class nodes and nodes for
external ]ava® and C libraries.
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THE FORM EDITOR
FORM TAB — The Form tab in the ribbon

gives easy access to the Form Editor.

FORM EDITOR WINDOW — The tabbed Form
Editor window allows you to move objects around
by dragging. Click an object to edit its settings.
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@ Buton [ Dataisplay 1 Sketch i ) ,
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Inputs i~ Input
| Actioneneigy: 75382 ymal
| el conductvy. 0553 k)
| Mestofreation: 24655 Jmot
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'~ Information

| Expected computation time: 5 seconds

>\ Solution not yet vaiable.
I When solved
| Py sound

| Emailreportto:

{3 Emil Setings

00%

ZOOM — Zoom to get
a better view of form

objects. buttons, and more.

I m—— -
g e B > ] ®
Show et Preie Testin Web
e Applicat Form  Browser «
eators et
Settings  Editor Tools
form
Neme:  mein 8
= +
01 Showin Model Buder
- sz
Intiasze: | Automatic
~ Margins
Horzortak 0
Veticat 0
~ Dilog settings
Onrequest
scolsie
+ Grid Layout for Contained Form Objects
»
Coumn | Width sae
' e -
2 Fe - na
3 fe - na
“ Grow - A
” Row Heght sze
' e - A
2 Grow - [na
Horzortal 10
Verica f
~ Appearance
Tt ol Inhert
Tansparent
None +
15468 (2J668

FORM OBJECTS — Each form contains form objects
such as input fields, checkboxes, graphics, images,

SETTINGS and EDITOR TOOLS WINDOWS —
Click any application tree node or form object to see
its associated Settings window. The Editor Tools
window is used to quickly create form objects.

Use the Form Editor for user interface layout by creating forms with form objects
such as input fields, graphics, and buttons.

The main components of the Form Editor are:

e Form ribbon tab

» Application Builder window with the application tree

e Form window
« Editor Tools window

* Settings window
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cess to the Main Window Editor.

Creating a

New Form

To create a new form, right-click the Forms node of the application tree and select
New Form. You can also click New Form in the ribbon. Creating a new form will
automatically open the Form Wizard with a number of layout templates.

If your application already has a form, for example forml, and you would like to
edit it, you can open the Form Editor in either of two ways:

 In the application tree, double-click the forml node.

 In the application tree, right-click the forml node and select Edit.

You can also add forms that are local to other forms. When applicable, this option
is available as a menu option from the New Form button.

THE MAIN WINDOW EDITOR

MAIN WINDOW TAB — The Main MAIN WINDOW EDITOR — The Main Window Editor allows you to
Window tab in the ribbon gives easy ac- design menus, menu items, ribbon tabs, ribbon items, and subwindows.

You can move items around by dragging. Click an object to edit its set-

| tings.
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Fe  Home a
(=) Classic Menu » [E) File Menu \; J J L
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con e E
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W)
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Results
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* Command
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Use the Main Window Editor for menu and ribbon layout by creating menus with
menu items and ribbon tabs with ribbon items. In addition, the Main Window
Editor, available directly from the Main Window node, is used for subwindow

layout.
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The main components of the Main Window Editor are:
¢ Menu editor

 File menu editor

» Ribbon tab editor

e Subwindow editor

THE METHOD EDITOR

METHOD TAB — The Method METHOD WINDOW — The tabbed SETTINGS WINDOW — Click any
tab in the rllbfbon gives eas()jl ;c' Method Window allows you to switch application tree node to see its asso-
cess FO tools for writing and de- between editing different methods. ciated Settings window.
bugging code.
e DB EBR|F -« X B 7 B 0 B ¥ B 5 tuing forkmph- COMSOL Muliphysics _
FR——
@ Uty Class i ?:n:u‘i::ﬂmams Wi g4 @  BiC w = = ) : @t > »)

X Editor Tools Language E Model Expr.

~ Inputs and Output

ace wnen the spplica

Inputs

P Name | Type Defauit Description Unit

jaluations or stop at MAXITERATIONS

Output: | None

5] nitGaphicsandsutons
"

106/ MAXITERATIONS);

> [ Ubrares
(L1+100) 160. Me Wil not get more than 2 decinal accuracy (mesh 1imits the occuracy rather than the secont metnod)
et(Lp, L

itersti cavency aiFF: stostring(Math.abs(f1)));

20868123368

MODEL EXPRESSIONS, LANGUAGE ELEMENTS, and EDITOR TOOLS WINDOWS — These win-
dows display tools for writing code. The Model Expressions window shows all constants, parameters,
variables, and functions available in the model. The Language Elements window is used to insert template
code for built-in methods. The Editor Tools window is used to extract code for editing and running mod-
el tree nodes.

Use the Method Editor to write methods for actions not covered by the standard
use of the model tree nodes. A method is another name for what is known in other
programming languages as a subroutine, function, or procedure.
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The main components of the Method Editor are:

* Method ribbon tab

» Application Builder window with the application tree
* Mecthod window

* Model Expressions, Language Elements, Editor Tools, and Settings
windows (these are stacked together in the figure above)

Creating a New Method

To create a new method, right-click the Methods node in the application tree and
select New Method. You can also click New Method in the ribbon Home tab. In the
New Method dialog you can change the name of the method.

3 Mew Method *

MName: method]

oK Cancel

Creating a new method will automatically open the Method Editor. Methods
created in this way are global methods and accessible from all methods, form
objects, and from the Developer tab in the Model Builder ribbon. By first clicking
a form node you also have the option of creating a Form Method which is local to
a form.

A sequence of commands associated with, for example, a button or menu
item can be automatically converted to a new method by clicking Convert
to Method. Open the new method by clicking Go to Method. You can also
create a method that is local to a form or form object by clicking Convert

18]



to Form Method or Convert to Local Method, respectively. These options are shown
in the figure below.

~ Choose Commands to Run "B ~ Choose Commands to Run &
> [ Forms > [ Forms
> @ GUI Commands > [ GUI Commands
> By Methods v [ Methods
> [l Libraries method1
v £& Model (root) method2

> (] Global Definitions > [l Libraries

> [l Component 1 (comp1) v & Model {root)

~ o Study 1 > () Global Definitions

[= stationary > [l Component 1 (compT)
> [fre Solver Configurations >~ Study 1

v [ Results v [E Results

Edit Node » Run [ Plot 7 SetValue [~ | Show =¢ EditNode P Run [&a) Plot =7 SetValue [ | Show

Show as Dislog T ImportFile &) Enable () Disable Show as Dialeg T ImportFile () Enable () Disable
" Command lcon | Arguments " Command lcon | Arguments
Compute Study 1 method1 5]

Plot Temperature (ht) form1/graphics1

Plot Electric Potential (... from1/graphics]

= g A~
> Dialog Actic 5 Comeriioitetiod > Dialog Actions
$F  Convert to Form Method
> Position anc . > Position and Size
$F Convert to Local Method
> Appearance > Appearance

If a method already exists, say with the name method1, then you can open the
Method Editor in any of these ways:

 In the application tree, double-click the methedl node.
 In the application tree, right-click the methodl node and select Edit.

» Below the command sequence in the Settings window of a form object or an
event, click Go to Method.
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APPLICATION BUILDER PREFERENCES

To access Preferences for the Application Builder, choose Preferences from the File
menu and sclect the Application Builder node.

2 Preferences x

=t

Application Builder

i~ Application Builder | [] Use separate desktop window for Application Builder
v Forms
Grid Mode
Sketch Mode
v Methods
Syntax Highlighting
Chatbot
Client-Server

Maximum number of editors before closing: 15
Show editor preview

Computing
Email

Files

Geometry

Graphics

Help

Libraries

LiveLink Connections
Mesh

Model Builder
Model Manager
Physics Builder
Results

Save

Security

Updates

User Interface

Factory Settings

Factory Settingsfor Al Import. Export. oKk Cancel

You can configure the COMSOL Desktop environment so that the Application
Builder is displayed in a separate desktop window. Select the Use separate desktop
window for Application Builder checkbox.

You can use the keyboard shortcuts Ctrl+Shift+M and Ctrl+Shift+A to switch
between the Model Builder and Application Builder, respectively.

You can set an upper limit to the number of open Form Editor or Method Editor
window tabs. Select the Maximum number of editors before closing checkbox and
edit the number (default 15). Keeping this number low can speed up the loading
of applications that contain a large number of forms.
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The Application Builder and the Model Builder

Use the Application Builder to create an application based on a model built with
the Model Builder. The Application Builder provides three important tools for
creating applications: The Form Editor, the Main Window Editor, and the
Method Editor. The Form Editor includes drag-and-drop capabilities for user
interface components such as input fields, graphics objects, and buttons. The
Main Window Editor lets you design a menu bar or a ribbon. The Method Editor
is a programming environment that allows you to modify the data structures that
represent the different parts of a model. The figures below show the Model
Builder and Application Builder windows.

Model Builder

- ® St Sl - B~

~ 4 helical_static_mixer.mph (root)

(@) Global Definitions

<

P Parameters 1
_I” Step 1 (step1)
> (%) Geometry Parts
£ Default Model Inputs
%) Materials
~ Tl Component 1 comp1)
= Definitions
> [A] Geometry 1

> 2 Materials

~ =X Laminar Flow (spf)
58 Fluid Properties 1
B8 Initial Values 1
S Wall 1
= Inlet 1
= Outlet 1
> 4@ Transport of Diluted Species (tds)
iy Multiphysics
>/ Mesh 1
v ~gb Study 1
[= step 1: Stationary
[= Step 2: Stationary 2
> [fre Solver Configurations
~ [ Results

Datasets

Derived Values

B Tables

i Velocity (spf)

Wi Pressure (spf)

Wi Streamlines (spf)

~¥ Pressure Cut Line

i Dimensionless Concentration (tds)
Wi Scaled Dimensionless Concentration (tds)
~¥ Concentration Cut Lines

i Contact Probability (tds)

il Scaled Contact Probability (tos)
Expart

> [# Reports

Application Builder
= =t Bl B

~ [] helical_static_mixer.mph (root)
F5 Inputs
2 Themes
~ [ Main Window
~ [E] File Menu
[5 save fsave}
[ Save As saveds)
~ [+ Ribbon
~ (7 Home fhome}
> Input {inputSection]
> Geometry {geometrySection]
v Simulatien {simulationSection)
v [Z] Mesh {createMesh}
[ Coarse {coarseButton}
[ Nermal {normaiButton}
[ Fine ffineButton}
[ Compute {compute}
> [] Visualization fvisualizationSection}
> Documentation {documentationSection)
~ B Forms
[ settings
[ graphics
[ operatingConditions
v [ geometry
~ B Forms
[5) mixerProperties
[ bladeProperties
> [ results
~ [ information
~ B Forms
[5 computationTime
[ status
Events
> = Declarations
> B Methods
» [ Libraries

When creating an application, you typically start from an existing model.
However, you can just as well build an application user interface and the
underlying model simultaneously. You can easily, at any time, switch between the
Model Builder and Application Builder. The model part of an application, as
represented by the model tree, is sometimes called an embedded model.
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The tools in the Application Builder can access and manipulate the settings in the
embedded model in several ways; For example:

 If the model makes use of parameters and variables, you link these directly
to input fields in the application by using the Form Wizard or Editor Tools.
In this way, the user of an application can directly edit the values of the
parameters and variables that affect the model. For more information, see
pages 64 and 96.

» By using the Form Wizard or Editor Tools, you can include a button in your
application that runs a study node and thereby starts the solver. In addition,
you can use this wizard to include graphics, numerical outputs, checkboxes,
and combo boxes. For more information, see pages 46 and 64.

* The Data Access tool and the Editor Tools window can be used to directly
access low-level settings in the model for use with form objects or in
methods. For more information, see pages 64, 107, and 190.

* By using the Record Code and Record Method tools, you can record the
commands that are executed when you perform operations within the model
tree and its nodes. These will then be available in a method for further
editing. For more information, see page 194.

Parameters, Variables, and Scope

The model tree may contain both parameters and variables that are used to control
the settings of a model. The figure below shows the model tree of an application
with nodes for both Parameters and Variables.

~ @ helical_static_mixer.mph (root)
v () Global Definitions
Fi Parameters 1
_I” Step 1 (step?)
¥ _l Geometry Parts
4 Default Model Inputs
Materials
~ [l Component 1 {comp1)
~ = Definitions
2= Variables 1
» g Selections
[ Boundary System 1 (sys1)
> [ View1
Parameters are defined under the Global Definitions node in the model tree and are
user-defined constant scalars that are usable throughout the Model Builder. That
is to say, they are “global” in nature. Important uses are:

+ Parameterizing geometric dimensions

22 |



 Specifying mesh element sizes

¢ Defining parametric sweeps

Variables can be defined in either the Global Definitions node or in the Definitions
subnode of any model Component node. A globally defined variable can be used
throughout a model, whereas a model component variable can only be used within
that component. Variables can be used for spatially or time-varying expressions,
including dependent field variables for which you are solving.

In the Model Builder, a parameter or variable is a string with the additional
restriction that its value is a valid model expression. For more information on the
use of parameters and variables in a model, see the book Introduction to
COMSOL Multiphysics.

An application may need additional variables for use in the Form Editor and the
Method Editor. Such variables are declared in the Application Builder under the
Declarations node in the application tree. The figure below shows the application
tree of an application with multiple declarations.

v [&] helical_static_mixer.mph (root)
ﬁ Inputs
% Themes

> [ Main Window

> B Forms
Events

v = Declarations
abe String
25 Double
= Boolean
<> Mumber of Blades List {numberOfBladesChoicelist]
,@ Shortcuts

> [ Methods

» [ Libraries

The declared variables in the Application Builder are typed variables, including
scalars, arrays, Booleans, strings, integers, and doubles. Before using a variable,
you have to declare its type.

The fact that these variables are typed means that they can be used directly in
methods without first being converted using one of the built-in methods. This
makes it easier to write code with typed variables than with parameters and
variables representing model expressions. However, there are several tools
available in the Application Builder for converting between the different kinds of
variables. For more information, see pages 159 and 353. For more information on
typed variables, see the Application Programming Guide.
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Running Applications

With a COMSOL Multiphysics license, applications can be run from the
COMSOL Desktop environment. With a COMSOL Server license, applications
can be run in major web browsers on a variety of operating systems and hardware
platforms. In addition, you can run applications by connecting to COMSOL
Server with a dedicated client for Windows®.

By using COMSOL Compiler™, you can compile your application to an
executable file that can be run in the Windows®, Linux®, and macOS operating
systems.

The following two sections explain how to run applications in these different
settings. The third section, “Publishing COMSOL Applications” on page 44,
describes your rights to publish applications.

Running Applications in COMSOL Multiphysics

In COMSOL Multiphysics, you run an application using any of these ways:
* Click Test Application in the ribbon or in the Quick Access Toolbar.

+ Seclect Run Application in the File menu or in the Quick Access Toolbar.
« Double-click an MPH-file icon on the Windows® Desktop.

» Seclect Test in Web Browser in the ribbon.

TESTING AN APPLICATION

Test Application is used for quick tests. It opens a separate window with the
application user interface while keeping the Application Builder desktop
environment running. The figure below shows the Test section as it appears in the
Form tab of the ribbon.

> B ®

Test Apply Preview  Testin Web

Application  Changes Form Browser ~
Test

While testing an application, you can apply changes to forms, methods, and the
embedded model at run time by clicking the Apply Changes button. Not all

changes can be applied at run time, and in such a case, you are prompted to close
the application and click Test Application again.

To preview the layout of a form without running the application, click Preview
Form in the ribbon.
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When Test Application is used, all methods are automatically compiled with the
built-in Java® compiler. Any syntax errors will generate error messages and the
process of testing the application will be stopped. To check for syntax errors before
testing an application, click the Check Syntax button in the Method tab.

e L El t: A = B+ nd
anguage Elements [\/] Ej . B+C L

A T
El i
e oS ExpIs o Check Gote Record Use Create Local
E‘. Record Method Syntax Mode  Code  Shortcut Variable

Code

Check Syntax finds syntax errors by compiling the methods using the built-in Java®
compiler. Any syntax errors will, in this case, be displayed in the Method Errors and
Warnings window in the Method Editor. For more information, see “The Method
Editor” on page 184.

RUNNING AN APPLICATION

Run Application starts the application in the COMSOL Desktop environment.
Select Run Application to use an application for production purposes. For example,
you can run an application that was created by someone else that is password
protected from editing, but not from running.

e O % = > v
File Home  Form

MNew

Run Application

Open...

NN ar

Open From...

DOUBLE-CLICKING AN MPH-FILE

When you double-click an MPH-file icon on the Windows® Desktop, the
application opens in COMSOL Multiphysics, provided the MPH-file extension is
associated with COMSOL Multiphysics. The application may either be opened for
editing or for running. You control this behavior from the root node of the
application tree. The Settings window for this node has a section titled Application
in which you may select either Edit application or Run application. A change in this
setting will be applied when you save the MPH-file.

~ Application

[[] Ask to save application when closing
When starting with COMSOL Multiphysics:
Edit application -

|Edit application

Run application |
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The option Edit application will open the application in the Application Builder.

The option Run application will open the application in runtime mode for
production purpose use. This option is similar to selecting Run Application in the
File menu with the difference that double-clicking an MPH-file will start a new
COMSOL Multiphysics session.

If you have installed the COMSOL Client for Windows®, the MPH-file extension
may instead be associated with the COMSOL Client, and double-clicking an
MPH-file will prompt you to log in to a COMSOL Server installation.

IGNORING LICENSE ERRORS

In the Settings window for the application tree root node, the Ignore license errors
during launch checkbox is used to control the behavior with respect to licensed
products when running applications.

~ Application

[[] Ask to save application when closing

When starting with COMSOL Multiphysics:
Run application =

Ignore license errors during launch

When selected, an application can be started even if all required licenses are not
available. It is still not possible to use the functionality of products for which the
license is not available. However, you can write methods to create an application
such that the functionality used is dynamically adapted to which types of licenses
are available.

TESTING AN APPLICATION IN A WEB BROWSER

Test in Web Browser is used for testing the application in a web browser. This
functionality makes it easy to test the look and feel of the application when it is
accessed from a web browser connected to a COMSOL Server installation.

= ®
>/
Main Test Apply Test in Web
Window Application  Changes = Browser
Main Window E-' Test in Chrome™ Browser
E-' Test in Firefox ® Browser
C

() Testin Microsoft Edge® Browser

You can choose which of the installed web browsers you would like the application
to launch in. Test in Web Browser opens a separate browser window with the
application user interface while keeping the Application Builder desktop
environment running.

26 |



TEST APPLICATION VS. TEST IN WEB BROWSER

Test Application launches the application with a user interface based on Microsoft®.
NET Framework components, whereas Test in Web Browser launches the
application with a user interface based on HTML5 components. Test Application
will display the user interface as it would appear as a standalone app, compiled
using COMSOL Compiler, or when the application is run with COMSOL
Multiphysics or COMSOL Server, provided the COMSOL Client for Windows®
is used to connect with the COMSOL Server installation. Test in Web Browser will
display the user interface as it would appear when the application is run with
COMSOL Server, provided a web browser is used to connect with the COMSOL
Server installation.

For testing the appearance and function of an application user interface in web
browsers for macOS, iOS, Linux®, and Android™, a COMSOL Server installation
is required.

The table below summarizes the different options for running an application.

SERVER SOFTWARE CLIENT SOFTWARE TOOL OR COMPONENT
COMSOL Multiphysics Test Application

COMSOL Multiphysics Test in Web Browser

COMSOL Multiphysics Run Application

COMSOL Server COMSOL Client for \/\/indovvs®
COMSOL Server Web Browser
N/A Executable file compiled with COMSOL Compiler

The Server column represents the software components that perform the
CPU-heavy computations. The Client column represents the software tool or
component used to present the application user interface. In the case of executable
files, all computations are done locally. For more information on compiled
applications, see “Compiling and Running Standalone Applications” on page 38.

SAVING A RUNNING APPLICATION

When you test an application, it is assigned the name Untitled.mph and is a copy
of the original MPH-file. This is not the case when running an application.

By default, the user of an application will not be prompted to save changes when
exiting the application. You control this behavior from the root node of the
application tree. The Settings window for this node has a section titled Application
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in which you may select the Ask to save application when closing checkbox, as
shown in the figure below.
~ Application

7] Ask to save application when closing

As an alternative, you can add a button or menu item with a command to save the
application. For more information, see page 143.

APPLICATION LIBRARIES

From the File menu, select Application Libraries to run and explore the example
applications that are included in the COMSOL installation. Many of the
screenshots in this book are taken from these examples.

o O = ™ » v v
File

MNew Ctrl+M

Run Application

Open... Ctrl+0

NN aw

Open From... Ctrl+Shift+ 0
Recent >
Application Libraries

Save Ctrl+5

Save As..

Save To.. Ctrl+Shift+5
Revert to Saved Ctrl+Shift+R

Compact History

(o i =

COMSOL Multiphysics Server >
Help >
T Licensed and Used Products...
Preferences...
Exit
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You run an application, or open it for editing, by clicking the corresponding
buttons below the Application Libraries tree.

a [ B ® » ~ . S helical_static_mixer.mph - COMSOL Multiphysics

File Undo Main Window: Application Theme (Ctrl+Z)

Helical Static Mixer

Application Libraries

(3 Refresh [[f] Update COMSOL Application Libraries () Application Gallery
Search
~ [3 COMSOL Multiphysics
« [l Applications
® cluster_setup_validation
O curve_digitizer
© helical_static_mixer
installation_verification
thermnal_actuator_surragate 4
O transmission_line_calculater
O tubular_reactor é}"
O tubular_reactor_surrogate
O tuning fork
> [l Acoustics

This app demonstrates the following:

> [} Chemical Engincering  Geometry parts and parameterized geometries
> fll Cluster and Batch Tutorials + Dark theme
> [l Diffusion + Material appearance visualization with environment reflections

« Report generation for both Microsoft® Word and Microsoft® PowerPoint
- Options for setting different mesh sizes
« Improved graphics visualization by showing/ hiding different geometry objects

> [l Electromagnetics
> [il] Equation Based

> [fll] Fluid Dynamics + Enabling and disabling ribbon items based on the solution state.

> [} Geometry Tutorials

> [fff Geophysics Helical static mixers are often used to mix monomers and initiators which then react during a polymerization

> ] Heat Transfer process. The concentration field is included in the znalysis in order to compute the extent of mixing between two
streams injected into the static mixer through semicircle-shaped inlets,

> [l Meshing Tuterials

> [l Multiphysics The app can be used to estimate the degree of mixing in a system including one to five helical blades whose

> [l Structural Mechanics dimensions can also be varied. The monomers' liquid propesties and inlet velocity can also be varied

> X AC/DC Module
> 1) Acoustics Module

Name helical_static_mixer
> € Battery Design Module
» [ CAD Import Module Used products COMSOL Multiphysics
> = CFD Medule Physics interfaces  Laminar Flow
Transport of Diluted Species
8= &
E Created in COMSOL Multiphysics 6.3 (Build: 236)
Run Applicati Oy
P> Run Application G Computation time 8 minutes
] Open POF Document Author CoMsoL
Last modified Sep 30, 2024, 8:24:04 PM
Help e Close Created Sep 30, 2024, 8:24:04 PM

221GB|2.7GB

Applications that contain a model, but no additional forms or methods, cannot be
run and only opened for editing. Applications that contain forms and methods are
collected in folders named Applications.

The applications in the Application Libraries are continuously improved and
updated. You can update the Application Libraries by clicking Update COMSOL
Application Libraries.

Additional applications that are not part of the Application Libraries may be
available from the COMSOL website in the Application Gallery. To find these
applications, click the Application Gallery button. This will open a browser with
the web page for the Application Gallery.

Each application has an associated thumbnail image that is displayed in the
Application Libraries. In the COMSOL Server web interface, the thumbnail image
is displayed on the Application Library page.
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To set the thumbnail image, click the root node of the application tree. The
Settings window has two options for choosing the image: Set from Graphics
Window and Load from File. You can also Clear the image.

The Load from File option allows you to load images in the PNG or JPG file
formats. Choose an image size from 280-by-210 to 1024-by-768 pixels to ensure
that the image displays properly as a thumbnail in COMSOL Multiphysics and
COMSOL Server.

Settings
helical_static_mixer.mph
~ Protection

Editing not protected Set Password

Running not protected ~ Set Password
~ Used Products

COMSOL Multiphysics
~ Unit System

sl -

~ Presentation

Title: Helical Static Mixer

Description:  This app demenstrates the following:
» Geometry parts and parameterized geometries
= Dark theme

« Material appearance visualization with
environment reflections

Author: COMSOL
Cemputation time
Expected: 8 minutes
Last: Imindds

Thumbnail

Set from Graphics Window Load from File... Clear

The Set from Graphics Window option automatically creates two thumbnail images:

* An image of size 280-by-210 pixels shown in the Settings window of the
application tree root node and in the Application Libraries.

* Animage of size 1024-by-768 used as the default title page image in reports
and in the Application Libraries in COMSOL Server.
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PASSWORD PROTECTION

An application can be password protected to manage permissions. You assign
separate passwords for editing and running in the Settings window, accessible by
clicking the root node of the application tree in the Application Builder window.
You must have permission to edit an application in order to create passwords for
running it.

Settin

elica

gs

~ Protection

Editing not protected Set Password
Running not protected  Set Password

~ Used Products| |3

COMSOL Multiphysit o yprent password

~ Unit System Mew password: sasses

Retype new password: ssssss
sl
MNote: Lost passwords cannot be recovered.

~ Presentation OK Cancel

Title: Helical Static Mixer

When you open a password-protected MPH-file, for editing or running, a dialog
prompts you for the password:

2

Enter password:

OK Cancel

To remove password protection, create an empty password.

The password protection is used to encrypt all model and application settings,
including methods. However, binary data, such as the finalized geometry
including embedded CAD files, mesh data, and solution data, is not encrypted.
Note that for add-ins the password is set in the Add-in Definition window. For more
information, see “Creating Add-ins” on page 225.

SECURITY SETTINGS

When creating an application with the Application Builder, it is important to
consider the security of the computer hosting the application. Both COMSOL
Multiphysics and COMSOL Server provide a very similar set of security settings
for controlling whether or not an application should be allowed to perform
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external function calls, contain links to C libraries, run MATLAB functions, access
external processes, and more.

The security settings in COMSOL Multiphysics can be found in the Security page
in the Preferences window accessed from the File menu. In COMSOL Server, they
are available in the Preferences page in the COMSOL Server web interface if you
are logged in as an administrator. If you are not sure what security settings to use,
contact your systems administrator.

Running Applications with COMSOL Server

COMSOL applications can be run by connecting to COMSOL Server from a web
browser or a COMSOL Client for Windows®. The COMSOL Client for
Windows® allows a user to run applications that require a LiveLink™ product for
CAD, as described in “Running Applications in the COMSOL Client” on page
35.

Running applications in a web browser does not require any installation or web
browser plug-ins. Running an application in a web browser supports interactive
graphics in 1D, 2D, and 3D. In a web browser, graphics rendering in 3D is based
on WebGL™ technology, which is included with all major web browsers.

RUNNING APPLICATIONS IN A WEB BROWSER

Using a web browser, you can point directly to the computer name and port
number of a COMSOL Server web interface — for example,
http://comsol-server-machine-url.com:2036, assuming that port number
2036 is used by your COMSOL Server installation. You need to provide a
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username and password to log in. If you are running COMSOL Server locally, the
address field will typically be localhost:2036.

O LgnwcousLsener x|

€ > C @D nhitpy/comsol-server-machine-urlcom2036 o 2 % 0O & ¢

COMSOL
SERVER

Username

paul

Password
wed

O Remember me (uses cookies)

Log in to COMSOL Server

Powered by COMSOL Muliphysics® About COMSOL Server™

When logged in, the Application Library page displays a list of applications to run.

v - o x
¥ Notify Widget X @ Application Library | COMSOLS: X 4

€ > C  ©® localhost2036/app-lio e % » 02 :
W COMSOL Notifications  Log Out

COMSOL Server / Application Library

paul
aaminisurator Library
_ kearch X Filter: Al SortBy:Name T 40/40 o=
[0R43 [OR43 [OR43 ®

0 upload B-H Curve Checker Beam Section Calculator Beam Section Calculator Bike Frame Analyzer
(Using LiveLink™ for

A Administration < [
i
1
LI
p Licensed and Used i)
Products, H
B )
Msetcfam A
@ Your Settings <
Run in browser - Run in browser - Run in browser - Runin browser <
[OR+4 [0+ ® [O+4
Charge Exchange Cell Cluster Setup Validation Concentric Tube Heat Corrugated Circular Horn
Simulator Exchanger Antenna

== 4
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Click Run in browser to run an application. Applications are run in separate tabs in
the browser.

© Application Library | COMSOLS< X | @ Cormugate

C  ® localhost2036/app/library_RF_Modul

@

Aperture
poiarization I

¢-®- e

@ Geometryview is pdted

Limitations When Running Applications in Web Browsers

When you create applications to run in a web browser, make sure you use the grid
layout mode in the Application Builder; See “Sketch and Grid Layout” on page
113. This will ensure that the user interface layout adapts to the size and aspect
ratio of the browser window. For low-resolution displays, make sure to test the
user interface layout in the target platform to check that all form objects are visible.
Applications that contain resizable graphics forms may not fit in low-resolution
displays. In such cases, use graphics with fixed width and height to make sure all
form objects fit in the target browser window. Depending on the type of web
browser and the graphics card, there may be restrictions on how many graphics
objects can be used in an application. You can get around such limitations by,
instead of using multiple graphics objects, reuse the same graphics object by
switching its source.

When running in a web browser, the LiveLink™ products for CAD software
packages are not supported.

When running COMSOL applications in web browsers for smartphones and
certain tablets, not all functionality is supported. Typical limitations include the
ability to play sounds or open documents. In addition, file upload and download
may not be supported.
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If the application allows the user to make selections, such as clicking on boundaries
to set boundary conditions, running in a web browser is different from running in
COMSOL Multiphysics or the COMSOL Client for Windows®. In a web
browser, boundaries are not automatically highlighted when hovering. Instead, it
is required to click once to highlight a boundary. A second click will make the
selection. A third click will highlight for deselection and a fourth click will deselect.
The process is similar for domains, edges, and points.

Note that file browsing functionality is slightly different depending on the web
browser and depending on the version of the web browser. This may impact the
user experience when running an application that has functionality for saving files
to the client computer. For example, the location of the downloads folder can be
changed in the settings of many web browsers. A web browser may also allow the
user to manually specify the download location for each file. Please refer to the
documentation of your target web browsers for details.

RUNNING APPLICATIONS IN THE COMSOL CLIENT

As an alternative to using a web browser for running applications, the COMSOL
Client for Windows® can be used to connect to COMSOL Server for running
applications natively in the Windows® operating system. This typically gives better
graphics performance and supports more sophisticated graphics rendering in 1D,
2D, and 3D. In addition, the COMSOL Client for Windows® allows running
applications that require a LiveLink™ product for CAD, provided that the
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COMSOL Server you connect to has the required licenses. You can open an
application with the COMSOL Client for Windows® in two different ways:

e The COMSOL Server web interface will allow
you to choose between running an application ® %
in a web browser or with the COMSOL
Client for Windows®.

If you try to run an application with the
COMSOL Client in this way, but it is not yet
installed, you will be prompted to download
and install it.

Biosensor Design

Run in browser hd
Run in browser

Run in COMSOL Client

* Ifyou have the COMSOL
Client fOI' Windows® 3 Connect to COMSOL Multiphysics Server X
already installed, a desktop | ™ veer
shortcut will be available.
You can double-click its
desktop icon and before
you can use the COMSOL ————
Client to run applications,
you will be prompted to log into a COMSOL Server with a valid username
and password. After login, the COMSOL Client displays a COMSOL Server
web interface identical to that seen when logging in from a web browser.

Server: | comsol-server-machine Username: | paul

Port: Default e Password:  sssssssssss

Remember username and password

Using the COMSOL Client, applications run as native Windows® applications in
separate windows. For example, applications run in the COMSOL Client may
have a Windows® ribbon with tabs. When run in a web browser, ribbons are
represented by a toolbar.
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In the figure below, the COMSOL Server web interface is shown (top) with an
application launched in the COMSOL Client for Windows® (bottom).

3 COMSOL Client

1 COMSOL

| paul
| qaminisator

3 uplosd

- Administration

p Licensedand Used
Products

@ Your settings

COMSOL Server / Appiication Library

Library

Search

[0R+¢

B-H Curve Checker

17

et ey

x

[0+

Beam Section Calculator

Filter: All Sort By: Name T 40140

[0+

Beam Section Calculator
(Using LiveLink™ for ...

o
[CR<4 e
Charge Excl

Simulator = S «

Report

o105
o155
05
Hom engt s
Waveguide ngth: '
Matching comugaion fengt 0zs
[E] Result Analysis
Output coss-polazation ati target: s %
Separamete 511 12376 4B
Input waveguide crose-polazaion atis 1762 %

Output aperture cross-polarzation raio:

> Torget crteion: passed.

@ information

defaul parameters excluding postprocessing.ltmay vary
based on the size o the geomelry and the frequency.

@ Lostcomputaton time: 17

@ Geometry view s updated.

0 be sround 9 < with the

Geometry

[0+

Bike Frame Analyzer

Cormugated Crcular Horn Antenna - o x

DFarfield 20 Gein
pattem

Patter (68 Polanzation  Polarzation

=

e tayout Help

Q@@ Lrizkznc- @NeBBO @8

RUNNING COMSOL SERVER ON MULTIPLE COMPUTERS OR A CLUSTER

COMSOL applications can be run on multiple computers or clusters in two main

ways:

* By installing COMSOL Server with primary and secondary instances.

* By configuring one of the study nodes in the Model Builder for a particular

cluster.
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Primary and Secondary Instances

Running COMSOL Server on multiple computers using primary and secondary
instances allows for more concurrent users and applications than a single computer
instance (or installation). The main COMSOL Server instance is called primary
and the other instances are called secondary. The primary server is used for all
incoming connections — for example, to show the web interface or to run
applications in a web browser or with COMSOL Client. The actual computations
are offloaded to the secondary server computers. This type of installation has a
major benefit: Applications do not need to be custom-built for a particular cluster.
Load balancing is managed automatically by the primary server, which distributes
the work load between the secondary servers. A COMSOL Server installation can
consist of multiple primary and secondary server installations without additional
license requirements. You can perform administrative tasks using the COMSOL
Server web interface without checking out license keys for users running
applications. License keys are only checked out when running applications.

Configuring a Study Node for Cluster Sweep or Cluster Computing

If you want to utilize a cluster for applications that require large parametric sweeps
or high-performance computing power, then you can configure the Model
Builder study nodes of an application using the Cluster Sweep and Cluster
Computing options. Note that for building such applications, you will need a
Floating Network License. You can find more information on configuring a study
node for clusters in the Introduction to COMSOL Multiphysics and COMSOL
Multiphysics Reference Manual books. For running such cluster-enabled
applications, you can use either COMSOL Server or a Floating Network License
of COMSOL Multiphysics. Cluster system configurations are available from the
COMSOL Server web interface.

For more information on COMSOL Server, see the COMSOL Server Manual
available with a COMSOL Server installation or from
https: / /www.comsol.com/documentation.

Compiling and Running Standalone Applications

If you have a license for COMSOL Compiler™, there will be a Compiler button in
the ribbon section Main, as shown below.

"5 Data Access
E'.Record Method
[ Compiler

Main
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Clicking this button will add a Compiler node to the application tree, shown in the
figure below.

Application Builder
- Sty Elv P [E

v [&] tuning_fork.mph (root)
[EA Compiler
ﬁ Inputs

% Themes

The corresponding Settings window is shown below.

Settings
Compiler
= Compile Application

~ Qutput

Directory:  CACOMSOL & Browse

Runtime: Download =
Platforms

Windows

[ Linux

[] Linux, ARM

[] macOs, Intel

[] macOs, Apple silicon

~ Appearance

lcon for Windows: Default ~| |4
Splash: Default ~| |4
Preview

COMPILING APPLICATIONS

To compile an application, you need to make a few selections in this window.
Specify an output Directory, where the executable files will be saved after
compilation.

The Runtime option can be left at Download for most situations. COMSOL
Runtime contains all the COMSOL Multiphysics software components needed to
run the application as a standalone program. The Runtime setting specifies how the
COMSOL Runtime environment will be acquired from the compiled application.
If this setting is Download then the first time a user starts the compiled application
the COMSOL Runtime environment files will be downloaded (a service provided
by COMSOL). If the COMSOL Runtime environment already exists on the
computer, with a matching version number, then no download will be performed.
The option Embed will bundle the COMSOL Runtime files in the executable file.
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Note that with this option, the file size may be several hundred megabytes even
for smaller applications.

The Platforms settings determine which target-platform executables should be
generated at compilation. The extensions of the executables for the Windows®
and Linux® operating systems will be .exe and . sh, respectively. For macOS, a
.tar archive is created; unpack this archive on macOS to extract the app.

The Icon for Windows lets you specify the desktop icon. The Splash setting lets you
specify a BMP-image file to be displayed at startup.

After compilation, in the Windows® operating system, the executable file will be
available in the output directory, as shown in the figure below.

CoMsoL x +
A~ ¢ @ > ThisPC > LocalDisk(C) > COMSOL

@ New N Sort O view

£ Home
A Gallery
> @ OneDrive
tuning fork.exe

As a next step, you can, for example, right-click the EXE file and create a shortcut
that you then place on the Windows® desktop. Note that the . exe file extension
might not be shown, depending on the operating system settings.

You can also compile an application from the operating system command line. For
more information, see the COMSOL Multiphysics Reference Manual.

RUNNING COMPILED APPLICATIONS

When running a compiled application, for example, by double-clicking the .exe
file in the Windows® operating system, a splash screen is shown and the
application will start. If the application has the Splash option set to Default, then a
neutral-looking built-in splash screen will be shown.

It is recommended that you replace this with your own splash screen.
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If this is the first time you are running an application on a particular computer,
then, in addition, an Initializing Installer progress window will be displayed. The
initialization progress window is shown below.

Initializing Installer

Starting COMSOL Runtime Installer

Downleading runtime components,

This may take a minute or two.

After a short moment, the COMSOL Runtime Installer window is displayed, as
shown below.

3 COMSOL Runtime 6.3 Installer - x

COMSOL Runtime™ 6.3 Installer wcomMsoL
S M. @0

License Options Instal Finish

COMSOL Runtime License Agreement 6.3
YOU ARE USING COMSOL RUNTIME (THE "RUNTIME") LICENSED BY COMSOL.

If you or your organization obtained the Runtime as part of the COMSOL
Compiler, then the CO) Software License Agreement that was presented upon
installation of the COMSOL Compiler add-on to COMSOL Multiphysics software
(www. comsol.com/sla) shall apply.

ither you nor your organization cbtained the Runtime as part of the
COMSOL Compiler, then the following terms and conditions of this COMSOL
Runtime License Agreement ("CRLA") shall apply.

IF ¥OU DO NOT ACCEPT THE APPLICABLE TERMS AND CONDITIONS, DO NOT USE THE
RUNTIME.

1. Definitions. The following words and phrases shall have the definitions
set forth below throughout this CRLA, regardless of whether or not such
words or phrases are capitalized:

a. The term "Application” shall mean (i) the output that is produced by
using the Application Builder feature of the COMSOL Multiphysics software
(with or without medification using the application programming interface
for such software) or (ii) the output that is produced bv using the

© I accept the terms of the license agreement and understand and acknowledge that with this acceptance all other terms are rejected

() I do not accept the terms of the license agreement

COMSOL Runtime information Cancel

The COMSOL Runtime Installer and its click-through agreement are only shown
once, and the next time you start the same application, it will not be shown. The
click-through agreement and initialization progress window will also not be
shown if you run another application on the same computer that was generated
with the same COMSOL Compiler version (having the same version of the
COMSOL Runtime).
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Click Next to proceed to the Options page, as shown in the figure below.

3 COMSOL Runtime 6.3 Installer - X

COMSOL Runtime™ 6.3 Installer wcoMsOoL
SO 00000

License Options Install Finish

Destination folder:

(C:\Program Files\COMSOL\COMSOLE3\Runtime Browse. ..
File system: c

Space required during installation: 3900 MB

Space required after installation: 3300 MB
Free disk space: 405298 MB

[ Register Livelink™ products
{8 Chedk for updates after installation

[ Ask to update the installed COMSOL Runtime for applications compiled with a newer version

CUDA
CUDA Directory: Browse...

COMSOL Runtime information < Back Install Cancel

On this page, you can set the destination folder for the COMSOL Runtime files,
choose to register LiveLink™ products (if included), and control how updates for
the COMSOL Runtime are handled. Click Install to continue. The installation
takes a few minutes and, when finished, the installer will prompt the user to start
the application.

If you selected the Ask to update the installed COMSOL Runtime for applications
compiled with a newer version checkbox while installing the COMSOL Runtime,
running an application compiled with a newer version of COMSOL Multiphysics
will give you the option to either run anyway or to download an update. An
example of this is shown in the figure below.

Tuning Fork

J

User interface sized for

@ COMSOL Update Available X

The COMSOL Runtime version is older than the version the app was compiled for,
App Version: 6.3.0.251
COMSOL Runtime version: £.3.0.250

[] Do not show this dialog again
Run Anyway Download
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An option for showing the COMSOL About dialog is always available in a
compiled application. The author of the application controls how this information
is available from the Settings of the Main Window; see “About Dialog” on page 139.
The figure below shows the About dialog.

About *

COMSOL Multiphysics .3 (Build: 251)

Products used:  COMSOL Multiphysics

COMSOL )
MULTIPHYSICS®

Acknowledgments v Show Information

»

By using this Application, you agree to be bound by version 6.3 of the COMSOL Application License, see
omsol.com/sla.

omsaol.com/sla. © 1998-2024 COMSOLAB Protected by U.5., European (valid in DE, FR, and UK),
Chinese, Japanese, and Indian patents listed on https msol.comy/ p:tentf Patents pending. Certain technology
components are made available under terms found at https ww.comsol.com/legal/about. Portions of this software are
owned by Siemens Product Lifecycle Management Software Inc. © 1986-2024. All Rights Reserved. Portions of this software
are owned by Spatial Corp. © 1985-2024. All Rights Reserved. COMS0OL, the COMSOL logo, COMSOL Compiler, COMSOL
Runtime, COMSOL Server, COMSOL Multiphysics, COMSOL Desktop, and Livelink are ethe egistered trademarks or
trademarlcs of COMSOL AB. For a list of other trademarks and their owners, see http: v.comsol.com/tm

COMSOL installation folder: Ci\Program Files\COMSOL\COMSOLS3 \Runtime

Preferences oK
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In the About dialog, the user of a compiled application can access the Preferences
by clicking the corresponding button. The Preferences window for a compiled
application is shown below.

Preferences X

Visualization

Rendering: OpenGL -

Optimize for  Quality =

Antialiasing: Medium +

Detail: Mormal =
Meouse

[] 3Dconnexion space mouse
Temporary files

Folder for temporary files (temp:///):  C\Users\username\AppDatatLocal\Ternph W& Browse
Recovery

Folder for recovery files:  Ch\Users\usernamel.comsol\wB3runtime\recow M@ Browse
Multicore

Number of cores: []
GPU acceleration

CUDA directory:
Livelink™ for MATLAB®

MATLAB® installation folder: W& Browse
Preduct updates

[] Ask te update the installed COMSOL Runtime for applications compiled with a newer version

Factory Settings Cancel

Here, the user can change settings for Visualization, Mouse, Temporary files,
Multicore, and LiveLink™ for MATLAB®. Thesc settings represent a subset of the
Preferences available in COMSOL Multiphysics and more information can be
found in the COMSOL Multiphysics Refervence Manual.

If the compiled application detects that OpenGL® graphics hardware
acceleration is not supported, then the application will automatically
switch to software rendering and exit. The next time the application starts,
software rendering will be used.

Publishing COMSOL Applications

The COMSOL Software License Agreement (SLA) gives you permission to
publish your COMSOL applications for others to use, including commercially,
with certain restrictions spelled out in the SLA available at
https://www.comsol.com/sla. This permission enables you to share your
applications with others and to charge them for using your applications through
three different mechanisms.
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First, you can make an application available to others to be run by a COMSOL
Multiphysics installation. For using an application with COMSOL Multiphysics,
the user needs to belong to the same organization that purchased the COMSOL
Multiphysics license.

Second, you can make an application available to others to be run by a COMSOL
Server installation. This approach allows for greater flexibility, as it allows you to
set up a COMSOL Server installation and let users from around the world access
your Application. You just need to provide them with the address, a username, and
password to your COMSOL Server installation. Alternatively, users can purchase
their own COMSOL Server license. If you use COMSOL Server to host and run
applications, the SLA also gives you permission to make time on your COMSOL
Server License (CSL) available to persons outside your organization to host and
run applications that you are publishing to others, subject to certain restrictions.

Third, you can use COMSOL Compiler to compile your application into a
standalone program that contains all of the functionality required to make it run.
This approach gives you the greatest flexibility, as the end user of your application
will not need a license for COMSOL Multiphysics or COMSOL Server to run the
Application. The compiled application can then be run by that user and anyone
else to whom you allow the user to publish the compiled application, around the
world, inside or outside of your organization.

The COMSOL Application License, also available at https: / /www.comsol.com/sla,
further lets you modify applications available in the Application Libraries and
publish those modified applications for others to use, including commercially,
with certain restrictions spelled out in the Application License. This allows you to,
for example, use one of the applications in the Application Libraries as a starting
point for your own applications by adding or removing your own features.

If you wish to apply the Application License to applications that you create, the
Application License contains instructions on how to do so. The Application
License also addresses how you can use terms that you choose for modifications
you make to applications available in the Application Libraries, while the original
portions of those applications remain available under the Application License.

The results from a simulation software such as COMSOL Multiphysics can
shorten design times dramatically by, for example, reducing the number of
experiments or product tests. However, simulation software is not a substitute for
real-world testing. This is especially important if there are risks for physical or
environmental damage.
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Getting Started with the Application Builder

STARTING FROM A COMSOL MULTIPHYSICS MODEL

If you do not have a model already loaded to the COMSOL Desktop
environment, select File > Open to select an MPH-file from your file system or
select a file from the Application Libraries. Note that, in the Application Libraries,
the files in the Applications folders are ready-to-use applications. All other files in
the Application Libraries contain a model and documentation, but not an
application user interface.

Once the model is loaded, click the Application Builder button on the ribbon Home
tab. This will take you to the Application Builder desktop environment.

o DB ER > v

File Home  Definitions Geometry  Materials P

A n >

Application Model Component Add

Builder Manager 1+ Component ~
Waorkspace Maodel
Model Builder
- S St~ Elv Siv v

CREATING A NEW FORM USING TEMPLATES AND THE FORM WIZARD

To start working on the user interface layout, click the New Form button in the
Home tab. This will launch the Form Wizard.

e O % = » v LI
File Home  Main Window
V. z =] " Data Access | Settings
® & [ -
B 4 i
Model Model New New G Record Method Editor Tools
Builder  Manager Form v Method v @3 Compiler
Waorkspace Main

The Form Wizard assists you with adding the most common user interface
components, so-called form objects, to the first draft of your application.
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In the Form Wizard, the first page is the Select Template page.

e D @H » o

File

Select Template

D Blank form
Single form
E Basic

E Subwindows, sections, and graphics

E Subwindows, tabs, and graphics
ﬁ Toolbar, sections, and graphics

ﬁ Buttons, sections, and graphics

ﬁ Compact layout for tablets

ﬁ Advanced compact layout for tablets
ﬁ Compact layout for smartphones

ﬁ Advanced compact layout for smartphones

Content

The different templates listed here will help you quickly create an organized
application with different levels of sophistication and user-interface layouts for
desktop, table, and smartphone use.

For this example, you can load the busbar.mph model from the Application
Libraries at COMSOL Multiphysics > Multiphysics. This is one of the models used in
the Introduction to COMSOL Multiphysics manual.

Select the Basic layout template and click Content. The Select Content page has four
tabs:

¢ Inputs

e Outputs
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¢ Graphics
¢ Ribbon buttons

Select Content

[] Labels on top
Inputs  Qutputs = Graphics = Ribbon buttons
Available: Selected:

~ < Model (root) —+
v () Global Definitions

~ P Parameters 1 Add Selected

25 Length (L)

8.5 Bolt radius (rad_1)

8.5 Thickness (tbb)

8.5 Width (wbhb)

8.5 Maximum element size (mh)
8.5 Heat transfer coefficient (htc)
e5 Applied voltage (Viot)

Double-click a node or click the Add Selected = button to move a node from the
Available area to the Selected area. The selected nodes will become form objects in
the application and a preview of the form will be shown in the Preview area to the
right.

The size as well as other settings for form objects can be edited after exiting the
wizard. You can also choose to exit the wizard at this stage by clicking Done, and
then manually add form objects.

The Inputs and Outputs Tabs

The Inputs and Outputs tab display the model tree nodes that can serve as an input
field, data display object, checkbox, or combo box. Input fields added by the
wizard will be accompanied by a text label and a unit, when applicable. You can
make other parts of the model available for input and output by using Data Access
(see page 107). Checkbox and combo box objects are, for example, only available
in this way. For example, you can make the Predefined combo box for Element Size
under the Mesh node available in the wizard by enabling it with the Data Access
feature.
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In the figure below, three parameters, including Length, Width, and Applied
voltage, have been selected to serve as input fields.

Select Content Preview
[] Lebels ontop cr [
Inputs  Qutputs Graphics = Ribbon buttans
Available:
~ & Model (root) & Inputs.
~ () Global Definitions Model (root)
v Fi Parameters 1 ~ (@ Global Definitions Main
== Bolt radius (rad_1) v Py Parameters 1 —_————
& Thickness (tbb) =5 Length (L} ! Inputs
2= Maximum clement size (mh) = Width (wbb) e .
55 Heat transfer coefficient (htc) o5 Applied voltage (Viot) g St
| Width: 5 cm
| Applied voltage: 20 mv

+ Add Form i Edit Form — Remove Form

eTEmp\a(E
[ 2 B ecan:e\ Moene

In the figure below, a Derived Values node for the maximum temperature has been
selected from the Outputs tab to serve as a data display object.

Select Content Preview
[] Labels on top o .
Inputs Outputs  Graphics = Ribbon buttons
Available: Selected:
© % Model (ro0t) v [} outputs
v () Global Definitions ~ @ Model (root)
v P| Parameters | ~ B Resutts Main
s Length (L) ~ E% Derived Values —_——
=+ Bolt radius (rad_1) st Yolume Maximum 1 ! v Inputs
&= Thickness (tbb) i
2 Width (wbb) | Length: 2 cm
2 Maximum element size (mh) | Width s em
55 Heat transfer coefficient (htc) | Applied voltage: 20 mv
=+ Applied voltage (Viof) |
v [E Results I v Outputs
~ Ff Tobles i
5 Maximum and Minimum Values o (TR
Ff Teble 1

+ Add Form ¢ Edit Form — Remove Form

GTemplate
Help 0 Concel [MfDone L

After exiting the wizard, you can edit the size and font color as well as other
settings for input fields and data display objects.

The Graphics Tab

The Graphics tab displays the model tree nodes that can serve as graphics objects:
Geometry, Selection, Mesh, and Results. In the figure below, a Temperature plot
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node has been selected. When using the Basic layout template, this selection

determines the default plot shown when the app is started.

e O w ® o> SN % busharmph - COMSOL Multiphysics

File

Select Content Preview

[] Labels ontop Fle  Home

Inputs | Outputs  Graphics | Ribbon buttons
Available: Selected:
v % Model (root)
v (B Resuts
Wl Temperature (ht) Main

= Tibolts ~ Inputs

Length s
Width: 5
Applied voltage: 20

Bl Current Density ~ Outputs

Temperature: 0.001235 K

eTempme
relp € conca [ Done

The Ribbon Buttons Tab

m
mv

aal- v b

The Ribbon buttons tab displays the model and application tree nodes that can be
run by clicking a button in the ribbon in the application user interface. Examples
of such tree nodes are Plot Geometry, Plot Mesh, Compute Study, and cach of the
different plot groups under Results. In addition, you can add buttons for GUI
Commands, Forms, and Methods. Note that in this example no Forms or Methods are

available yet.
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In the figure below, buttons have been added corresponding to the actions: Plot
Geometry, Plot Mesh, Compute Study, Plot Electric Potential, Plot Temperature, Plot
Current Density, and Reset Window Layout.

Select Content Preview

[ Labels on top

Inputs | Outputs _ Graphics Ribbon buttons

2]

Current  Res
en

Auailable: Selected:

O 6UI Commands v @ GUI Commands | Geomety Meh Compute  Electic  Temperature
> [ File Commands ~ [ Main Window Commands { Euteniclie) (bt)
raphics Commands Reset Window Layout

A\ Plot Mesh 1 Length: 9 em

© [ Results s Compute Study 1 Width: s m
W Plot Electric Field (Ec) v [@ Results Applied voltage: | 20 mv
Wl Plot Electric Potential (Ec)
Nl Plot Temperature (Ht) ~ Outputs

Bl Plot Current Density

Temperature: 0.001235K

@ el
B e a[an:e\ [ pone

The Reset Window Layout option is available under GUI Commands > Main Window
Commands > Reset Window Layout. The application consists of two subwindows,
one for the inputs and outputs and one for the graphics. The Reset Window Layout
button will reset the two subwindows in the application to their original size. The
Subwindows templates are similar to the Basic template but additionally enable you
to detach, move around, and dock the subwindows. In this case, the Reset Window
Layout operation will rearrange all subwindows to their original position and size.
Using the Form Editor, you can add buttons that run your own custom command
sequences or methods.

For an example of using the Single form template, see the Introduction to
COMSOL Multiphysics manual.

EXITING THE WIZARD

Click Done to exit the wizard. This automatically takes you to the Form Editor.

TESTING THE APPLICATION

You can now click Test Application in the Test section of the ribbon.

Test pp Test in Web
Application  C s Browser ~

Test
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The figure below shows the running application.

@ Untitled.mph - Electrical Heating in a Busbar - o X
File  Home

A A = @ @

Geometry  Mesh  Compute

Temperature
(h)

~ Inputs. Q@@ Lrzk ¢ |< - BHO @8
Length: ] m
Width: 5

Volume: Temperature (K) Max/Min Volume: Temperature (K)
Appled voltage: 20 mv 320
~ Outputs

Temperature: 330.4K

323

SAVING AN APPLICATION

To save an application, from the File menu, select File > Save As. Browse to a folder
where you have write permissions, and save the file in the MPH-file format. The
MPH-file contains all of the information about the application, including
information about the embedded model created with the Model Builder.
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Themes

The Settings window for Themes is displayed when you click the Themes node in
the application tree. It lets you change the overall appearance of the user interface
and forms with settings for Application theme, Image export theme, Text color,

Background color, Font, Font size, Bold, Italic, and Underline.

Application Builder

Ty Elv B~

v [&] tubular_reactor.mph (root)
ﬁ Inputs
% Themes
¥ D Main Window
~ [ Forms
D main
D input
D description
D information
¥ D simulationEvents
¥ D emailServer
> % Graphics
Events
» = Declarations
> [ Methods
» [ Libraries

Settings

Themes

~ Themes

Application theme: Default

Image export theme: Default

~ Appearance

Text color: Systemn
Background color: Systemn
Font: Systemn

Font size: Systemn
Applies to new form objects
[] Bold

[] Italic
[] Underline

pt

The default is that all new forms and new form objects inherit these settings when

applicable.
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The Form Editor

Use the Form Editor for user interface layout to create forms with form objects
such as input fields, graphics, buttons, and more.

The Individual Form Settings Windows

The figure below shows the application tree node and Settings window for a form.

Application Builder

v [&] tubular_reactor.mph (root)
ﬁ Inputs
% Themes
¥ D Main Window
~ [ Forms
D main
D input
D description
D information
¥ D simulationEvents
¥ D emailServer
> % Graphics
Events
» = Declarations
> [ Methods
» [ Libraries

Settings

Form

MName:  main
Title: Main

lcon: Default
[] Show in Model Builder

v Size
Initial size: Automatic
~ Margins

Horizontal: 0

Vertical: 0
~ Dialog Settings

Store changes: On request
[] Resizable
Vertically scrollable

» Grid Layout for Contained Form Objects

~ Appearance

Text color: Inherit
Background color: Transparent
Background image: MNeone

~ Events

On load: initializeApplication >
On close: None -

Each form has its own Settings window with settings for:

+ -

* Name used to reference the form in other form objects and methods.

» Form Title that is used in applications with several forms.
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¢ lcon shown in the upper-left corner of a dialog.

« Initial size of the form when used as a dialog or when the Main Window is sct
to have its size determined by the form.

 Margins with respect to the upper-left corner (Horizontal and Vertical).

* Choices of when to store changes in dialogs (Store changes), sce also
“Showing a Form as a Dialog” on page 75.

* Choices of whether the form should be Resizable or not and Vertically
scrollable or not when used as a dialog.

» Table with the formatting of all columns and rows included in the form (Grid
Layout for Contained Form Objects).

 Appearance with settings for Text color, Background color, and Background
image.

 Events that are triggered when a form is loaded or closed. (On load and On
close.)

Double-click a form node to open its window in the Form Editor. Alternatively,
you can right-click a form node and select Edit. Right-click a form window tab to
see its context menu with options for closing, floating, and tiling form windows.

@ Preview D main X
¥ Close
> Close All but This
Input and C Float
————|
~ Input
Maximize

Activation er |
5 Tile Vertically

r_r_ Tile Horizontally |

1
1
1
1
1
: Thermal con
1
1
\

Heat of react

SKETCH AND GRID LAYOUT MODES

When adding a form using the Blank or Single form layout templates, the
Application Builder defaults to sketch layout mode, which lets you use fixed object
positions and size. The other layout templates use the grid layout mode. Sketch
layout mode is useful when you want control over the absolute positioning of form
objects, such as when creating dialogs. Many, but not all, of the instructions in the
“The Form Editor” on page 54 assume that the Form Editor is in sketch layout
mode unless otherwise specified. For information on grid layout mode, see
“Sketch and Grid Layout” on page 113.
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If you use the Single form template and follow the same steps as for the earlier
example using the Basic template, then the Form Editor will result in an form as
shown in the figure below, after dragging to reorganize the buttons.

[@ Preview  [Jform1 x
v

»
Length: 9 m @ QM@- dov by e
Width: H !

Applied voltage: 20 mv
Temperature:  D.001235K

A A
A A
N\ i

Geometry Mesh

=
Temperature

Compute i

Current Electric
Density Potential eq)

In this case, no ribbon is created and you can freely position form objects, such as
buttons and edit fields, by dragging them. This is beneficial in some cases,
however, the size of the graphics object will be fixed when using the Single form
layout template. This is because for this template the sketch layout mode is used
and automatic resizing of an app is only supported with the grid layout mode. To
learn how to create resizable graphics objects, see “Automatic Resizing of
Graphics Objects” on page 124.

Note that any type of application that you create using templates can also be built
using manual steps by starting from a Blank form or Single form template, however,
using templates accelerates this process.

INITIAL SIZE OF A FORM
There are two options for the initial size of a form:
* Manual lets you enter the pixel size for the width and height.

+ Automatic determines the size based on the form objects that the form
contains. If you are using grid layout mode and there are columns or rows
set to Grow, then the size is not defined by the form objects. In this case, the
size is estimated using the Form Editor grid size as a base point. (It will
typically be slightly larger.) You can change the grid size by dragging the
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right or bottom border of the grid. For more information on grid layout
mode, see “Grid Layout” on page 116.

Settings

Form

MName:  form1 =

Title: l:‘ main
lcon: Default ~| |4
Show in Model Builder

~ Size

Initial size: Automatic

|Automatic h
> Margin panyal |

Local Forms

Forms can be local to other forms, which enables you to create a better structure
when developing your applications. For instance, a complicated global form made
up of many different subforms can have the auxiliary forms as local forms,
displayed as children in the application tree.

v [&] finned_pipe.mph (root)
ﬁ Inputs
% Themes
> D Main Window
~ [ Forms
D rain
~ D geometry
~ [ Forms

E] innerMone
E] innerStraightGrooves
E] outerMone
E] outerDiskStackedBlades
E] outerCircularGrooves
E] outerHelicalBlades
E] outerHelicalGrooves
D operatingConditions
D solverSettings
D information
> % Group 1
Events

You can add a local form by, for example, right-clicking a global form and
selecting Local Form. A global form always appears directly under the Forms node

in the application tree.
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Form Editor Preferences

To access Preferences for the Form Editor, choose Preferences from the File menu
and select the Forms node in the tree.

O Preferences
TE Forms
v Application Builder
~ Forms
Grid Mode Show COMSOL layout templates in the Form Wizard
Sketch Mode
> Methods
Client-Server

Default layout mode: Sketch ~

Computing
Email

Files

Geometry

Graphics

Help

Libraries

LiveLink Connections
Mesh

Model Builder

Model Manager
Physics Builder
Results

Save

> Security
Updates

> UserInterface

The Forms node and its child nodes, Grid Mode and Sketch Mode, includes settings
for changing the defaults for layout mode, margins, sketch grid, and layout
templates.

Form Objects

POSITIONING FORM OBJECTS

You can easily change the positioning of form objects such as input fields, graphics
objects, and buttons in one of the following ways (which methods are applicable
depends on which layout mode you are using):

+ Click an object to select it. A selected object is highlighted with a blue
frame.

* To select multiple objects, use Ctrl+click. You v
can also click and drag to create a selection R B . T
box in the form window to select all objects Width: . “m
within it. Applied voltage: 20 Pl

Temperature: 0.001235K
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* Hold and drag to move to the new position. Blue guidelines will aid in the
positioning relative to other objects.

 In sketch layout mode, you can also use the keyboard arrow keys to move
objects. Use Ctrl+arrow keys to fine tune the position.

In the figures below, a Plet button is being moved from its original position. Blue
guide lines show its alignment relative to the unit objects and the Compute button.

v
ot ° e aa@-@l - dr | e-BrBHO0 @8
Width: 5 om

Applied voltage: 20 mV
Temperature:  D.001235K

Compute

Temperature
(ht)

RESIZING FORM OBJECTS
To resize an object:
» 7Click an object to select it.

* Hold and drag one of the handles, shown as blue dots, of the highlighted
blue frame. If there are no handles, this type of form object cannot be
resized.

Note that some form objects that cannot be resized in grid mode can be resized

in sketch mode.

COPYING, PASTING, DUPLICATING, AND DELETING AN OBJECT

To delete an object, click to select it and then press Delete on your keyboard. You
can also click the Delete button in the Quick Access Toolbar.
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You can copy-paste an object by pressing Ctrl+C and Ctrl+V. Alternatively, you
can right-click an object to get menu options for Copy, Duplicate, Delete, and more.

@ Preview D form1 X

v

[ 2
ength: E cm Qa@- Lov bz
Width: -5

. Create Local Method
Applied voltage: 20

Ternperature: 0.007235 K Copy as Code to Clipboard 3
SooCut Ctrl+X
E] Copy Ctrl+C
[F] Duplicate Ctrl+Shift+D
M Delete Del
Settings
B g
H Hep F1

To paste an already copied object, right-click an empty area in the form and
right-click again. Depending on the copied object, a Paste menu option will be
shown. In the figure below, an Input Field has previously been copied and as a
result, a Paste Input Field option is shown.

@ Local Form

New Method
Form Objects 3
Scalar 3
Array 1D r
Array 2D »

%> Choice List

E’ Preview Form

Zoom 100% 3
Copy as Code to Clipboard »
Wb Cut Ctrl+X
5] Copy Ctrl+C
% Paste Input Field Ctrl+V
E—E Duplicate Ctrl+5Shift+D
i Group Ctrl+G
M Delete Del
=[ Rename F2
B Ssettings
B Hep F1
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ADJUSTING POSITION AND SIZE BY THE NUMBER OF PIXELS

When in sketch layout mode, you can adjust the position and size of an object by

typing the number of pixels in the Position and Size section of its Settings window:

 Click an object to select it. Make sure its Settings window is shown. If not,
double-click the object or click the Settings button in the Form tab.

o Edit the numbers in the Position and Size section.

~ Position and Size

Width: Manual -
20

Height: Manual -
20

Positionx: 180

Positiony: 240

The Position and Size section will have different options depending on the type of
form object. For grid layout mode, there are additional settings for the position of
the object with respect to rows and columns. For details, see “Sketch and Grid
Layout” on page 113.

CHANGING THE APPEARANCE OF DISPLAYED TEXT

For form objects that display text, the Appearance section in the Settings window
lets you change properties such as the text displayed, font, font color, and font
size. For some form objects, such as a button, the size of the object will adapt to
the length of the text string.
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In the figure below, the Settings window for a text label object is shown.

@ Preview D main X Se‘[‘[lﬂg 5
T Text Label
>
Input and Description Mame:  inputAndDescription ,%

[] Multiline text
= dnput Text: Input_and_description
Activation energy: 75362 Jimol

Thermal conductivity: 0,559 Wime k)

Heat of reaction: -B4666 Jimaol

» Position and Size
v Appearance

~ Reactor Description jfexticolor: TR s

Background color:  Transparent .
Font: Default font T

Font size: 12 - | pt
[ Bold
[ ltalic
[] Underline
State
Visible
Enabled

Inlet: A, B

By using grid layout mode (see “Sketch and Grid Layout” on page 113) you can
gain further control over the size of form objects, such as setting an arbitrary size
for a button.

SELECTING MULTIPLE FORM OBJECTS

If you select more than one form object, for example, by using Ctrl+click, then the
Settings window will contain a set of properties that can be shared between the
selected objects. Shared properties will always originate from the Appearance
section, the Position and Size section, or the Events section.

THE NAME OF A FORM OBJECT

A form object has a Name, which is a text string without spaces. The string can
contain letters, numbers, and underscore. In addition, the reserved names root
and parent are not allowed. The Name string is used in other form objects and
methods to reference the object. The path to the object is shown as a tooltip when
hovering over the Name field in the Settings window.

INSERTING FORM OBJECTS

You can insert form objects in addition to those created by the Form Wizard. In
the Form ribbon tab, in the Form Objects section, you can quickly select some of
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the most common form objects: Input Field, Button, Checkbox, Text Label, Data

Display, and Graphics.

e 4 & W » N ad I S
File Home  Form
I Input Field Text Label
(2% Button Data Display More
[] Checkbox [ Graphics Objects v

Form Objects

] Grid

T Sketch

EEB®ED

G

Show Arrange
rid Lines v

Sketch

Additional form objects are available from the More Objects menu button.

[ Input Field Text Label E’

(2% Button Data Display More

[] Checkbox [ Graphics Objects ~
Form Objects Input

Application Builder

T+ Elv A Labels
Type filter te Unit
~ tubular_reactormph (root) Display
ﬁ Inputs
% Themes [5] Web Page
> 7] Main Window
v & Forms == Progress Bar
D main [4 Message Log
D input
D description Subforms
D information
Form
> D simulationEvents E‘
> D email Server Composite
> Graphics File|
Events P File Import
» = Declarations 8 Radio Button
> [ Methods
» [ Libraries Miscellaneous
[T] Text
=¥ Slider
i Toolbar

] Grid

T Sketch

Toggle Button

Gri

=]

Show Arrange
id Lines v

Combo Box

Equation

Image

Gauge

Results Table

Form Collection

Information Card Stack

Selection Input

List Box
Knob

Form Toolbar

Row Settings ~

Ei

" Insert

:[l Column Settings +

— Line

O Video

Log

Card Stack

El Array Input

EEH Table

T Hyperlink
Spacer

The remainder of this section, The Form Editor, only describes the types of form
objects that are added by the Form Wizard. The form objects added by using the

wizard may include:
* Button

¢ Graphics

¢ Input Field

* Text Label (typically associated with Input Field)
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* Unit (typically associated with Input Field)
¢ Data Display

However, when using Data Access (see page 107), the additional form objects may
be added, including:

¢ Checkbox

¢ Combo Box

For more information on the checkbox, combo box, and other form objects, see
“Appendix A — Form Objects” on page 236.

EVENTS AND ACTIONS ASSOCIATED WITH FORMS AND FORM OBJECTS

You can associate objects such as buttons, menu items, ribbon buttons, forms, and
form objects with actions triggered by an event. An action can be a sequence of
commands including global methods or local methods. Local methods are not
accessible or visible outside of the forms or objects where they are defined. The
events that can be associated with an object depend on the type of object and
include: button click, keyboard shortcut, load of a form (On load), close of a form
(On close), change of the value of a variable (On data change), and focus gained.

Using Ctrl+Alt+click on a form object opens any associated method in the
Method Editor. If there is no method associated with the form object, a new local
method will be created, associated with the form object, and opened in the
Method Editor. If the form object has an associated command sequence, this
sequence is converted to code and inserted in the local method.

Editor Tools in the Form Editor

The Editor Tools window is an important complement to the Form Wizard and the
Insert Object menu for quickly creating composite form objects. To display the
Editor Tools window, click the corresponding button in the Main group in the
Home tab.

"5 Data Access = settings
Eﬁ Record Method Editor Tools
[EA Compiler

Main
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You can right-click the nodes in the editor tree to add the same set of form objects
available with the Form Wizard.

Editor Tools

= Edit Node =T =

% Themes

D Main Window
> B Forms
» @ GUI Commands
» [ Libraries
v & Model (root)
v () Global Definitions
~ P Parameters 1
25 Length (L)
8.5 Bolt radius (rad_1)
2.5 Thickness -
25 Width (w Input
85 Maximur Output
2.5 Heat tran
a5 Applied v
4 Default Model Inputs
= Materials
~ [l Compenent 1 (comp1)
>
>
>
>
>
>

=¢ EditNode

= Definitions

WA Geometry 1

22 Materials

+\_ Electric Currents (ec)

) Heat Transfer in Solids (ht)
iy Multiphysics

A Mesh 1

» ~db Study 1

> [El Results

w

Input Output Graphics Button

When a node is selected, the toolbar below the editor tree shows the available
options for inserting an object. You can also right-click for a list of these options.

Depending on the node, the following options are available:
e Input
An Input Field, Checkbox, Combo Box, or File Import object is inserted as follows:

- Inserts an Input Field using the selected node as Source. It is accompanied by
a Text Label and a Unit object, when applicable.

- Inserts a Checkbox using the selected node as Source.

- Inserts a Combo Box using the selected node as Source. A choice list is
automatically created, corresponding to the list in the node. This option is
only available when used with Data Access (see page 107) to make the
corresponding node available in the editor tree.

- Inserts a File Import object using the selected node as File Destination.
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¢ Output

- Inserts a Data Display object accompanied by a Text Label when applicable.

- Inserts a Results Table object when the selected node is a Table.
* Button

- Inserts a Button object with a command sequence running the selected node.
¢ Graphics

- Inserts a Graphics object using the selected node as Source for Initial Graphics

Content.

* Edit Node

- Brings you to the Settings window for the corresponding model tree node.
The Editor Tools window is also an important tool when working with the
Method Editor. In the Method Editor, it is used to generate code associated with

the nodes of the editor tree. For more information, see “Editor Tools in the
Method Editor” on page 190.

Button

Clicking on a Button is an event that triggers an action defined by its command
sequence. The main section of the Settings window for a button allows you to:

+ Edit the form object Name of the button.

» Edit the Text displayed on the button.

» Use an lcon instead of the default rendering of a button.
e Set the button Size to Large or Small.

e Set the button Style to Flat, Raised, or Outlined.
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* Add a Tooltip with text that is shown when hovering over the button.

* Add a Keyboard shortcut by clicking the input field and entering a
combination of the modifier keys Shift, Ctrl, and Alt together with another
keyboard key. Alt must be accompanied by at least one additional modifier.

Settings

MNarne: button1 =
Text: Compute

lcon: = compute 32 ~ + [=
Size: Large =
Style: Flat =
Tooltip: Run simulation

Keyboard shortcut:  CTRL+S

Note that the settings for a ribbon button, defined as Item in a Ribbon Section, arc
very similar to that of a button.
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CHOOSING COMMANDS TO RUN

The section Choose Commands to Run lets you control the action associated with a
button-click event. The figure below shows the Settings window for a button that
triggers a sequence of four commands.

~ Choose Commands to Run "B

> [ Forms
B GUl Commands
v [ Methods
method1
method2
[fifi Libraries
v & Model (root)
» () Global Definitions
> [ Component 1 (compl)
v oo Study 1
[= stationary
Edit Mode Run [ca| Plot Set Value Show
Show as Dialog Import File Enable
Disable

w

w

L
Command lcon | Arguments

Compute Study 1 =
Plot Electric Potential... form1/graphics1
Plot Temperature (ht) form1/graphics1
method2 B

big BE -

A menu, ribbon, or toolbar item will also provide a Choose Commands to Run
section in its Settings window, and the functionality described in this section
applies. For more information on using menu, ribbon, and toolbar items, see
“Graphics Toolbar” on page 85, “The Main Window Editor” on page 137,
“Table” on page 311, and “Toolbar” on page 322.

To define a sequence of commands, in the Choose Commands to Run section, select
anode in the editor tree. Then click one of the highlighted buttons under the tree,
or right-click and select the command. In the figure below, the Geometry node is
selected and the available commands Run and Plot are highlighted. Click Run to

add a geometry-building command to the command sequence. Click Plot to add
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a command that first builds and then plots the geometry. The option Edit Node
will take you to the corresponding node in the model tree or the application tree.

~ Choose Commands to Run "5

¥ % Forms
» @ GUI Commands
> g Methods
» [ Libraries
~ < Model (root)
» () Global Definitions
v Component 1 (compl)

&

= Definitions
A Geometry 1
22 Materials

v viviv il

A

Electric Currents (ec)

=g Edit Node » Run [Z3 Plot Set Value Show

Show as Dialog Import File Enable Disable

You do not need to precede a Plot Geometry command with a Build
Geometry command (that you get by clicking Run). The Plot Geometry
command will first build and then plot the geometry. In a similar way, the
Plot Mesh command will first build and then plot the mesh.

The command icons highlighted for selection are those applicable to the particular
tree node. This is a list of the command icons that may be available, depending
upon the node:

Run

Plot

Set Value
Show

Show as Dialog
Import File
Enable

Disable

Some commands, such as the various plot commands, require an argument. The
argument to a plot command, for example, defines which of the different graphics
objects the plot should be rendered in.
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The example below shows the Settings window and command sequence for a
Compute button as created by the Form Wizard. This button has a command
sequence with two commands: Compute Study | and Plot Temperature.

~ Choose Commands to Run =

3 Forms

B GUl Commands

EE Methods

[fifi Libraries

& Model (root)

» () Global Definitions

L5l

v v v v

> [ Component 1 (compl)
v oo Study 1
[= Stationary
> [fre Solver Configurations
v {E| Results
Edit Node Run [ca| Plot Set Value Show
Show as Dialog Import File Enable Disable

L
Command lcon | Arguments

Compute Study 1 =
Plot Temperature (ht) form1/graphicsi

tLEEE-#

The Plot Temperature command has one argument, form1/graphicsi.
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To add or edit an input argument, click the Edit Argument button below the
command sequence, as shown in the figure below.

L i
Command lcon | Arguments O Edit Argument x
Compute Study 1 = v & Forms
Plot Temperature (ht) form1/graphicsi v [ formi
graphics1

t L REEr

Edit Argument

@_‘ Use as Argument

Selected argument:
[ graphics1
OK Cancel

To reference graphics objects in a specific form, the following syntax is used:
formi/graphics2, form3/graphicsi,and so on. Ifa specific form is not specified,
for example, graphicsi, then the form where the button is located is used.

To control the order and contents of the sequence of commands, use the Move Up,
Move Down, and Delete buttons located below the command sequence table.
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CONVERTING A COMMAND SEQUENCE TO A METHOD

A sequence of commands can be automatically converted to a new method, and
further edited in the Method Editor, by clicking Convert to Method.

~dh

~ Choose Commands to Run =

> [ Forms
» @ GUI Commands
> [ Methods
» [ Libraries
v & Model (root)

» () Global Definitions

> [ Component 1 (compl)

v oo Study 1

E Stationary
> [fre Solver Configurations

v {E| Results

Edit Mode Run (3] Plot Set Value Show
Show as Dialog Import File Enable Disable

L

Command lcon | Arguments
Compute Study 1 =
Plot Temperature (ht)

Plot Electric Potential (...

form1/graphicsi

from1/graphicsi

SE~ @
> Dialog Actio ’. Convert to Method
5E Convert to Form Method

‘ Convert to Local Method

> Position anc

> Appearance

Open the new method by clicking Go to Method.

L
Command lcon | Arguments
method1 B

f==3 I"E . - @#
> Dialog Actions
> Position and Size

> Appearance
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You can also create a method that is local to a form or form object by
clicking Convert to Form Method or Convert to Local Method, respectively.

The method contains calls to built-in methods corresponding to the
commands in the commend sequence, as shown in the figure below.

@ Preview methodl X
model.study("stdl”).run();
useGrophics{model.result("pg2"), "froml/graph

3 useGraphics(model.result("pgl"), "fo

In this example, the first line:
model.study("std1").run()
runs the model tree node corresponding to the first study std1 (the first study
node is called Study | unless changed by the user). The second and third lines:
useGraphics(model.result("pg2"), "formi/graphicsi");
useGraphics(model.result("pg1"), "formi/graphics2");
use the built-in method useGraphics to display plots corresponding to plot
groups pg1 and pg2, respectively. In this example, the plots are displayed in two
different graphics objects, graphics1 and graphics2, respectively.

For more information on methods, see “The Method Editor” on page 184.

SETTING VALUES OF PARAMETERS AND VARIABLES

The Set Value command allows you to set values of parameters and variables that
arc available in the Parameters, Variables, and Declarations nodes. In addition, Set
Value can be used to set the values of properties made accessible by Data Access (see
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page 107). The figure below shows a command sequence used to initialize a set of
model parameters and a string variable.

» (Choose Commands to Run B
4 < Model (root)
4 () Global Definitions
4 pP; Parameters 1

2.5 Activation energy (E)
8.

n

Frequency factor (4)

2.5 Thermal conductivity (ke)

8.5 Diffusion coefficient (Diff)

Overall heat-transfer coefficient (Uk)
8.5 Heat of reaction (dHnx)

2.5 |nlet temperature (T0)

a.

n

Edit Mode Run Plot Set Value Show

Show as Dialog Import File Enable Disable

" Command

Set E of Parameters 1

Set ke of Parameters 1
Set dHrx of Parameters 1
Set str of String

Arguments
75352
0.559
-34666

arp

M-

To learn how to perform the same sequence of operations from a method, select
Convert to Method under the command table.

CHANGING WHICH FORM Is VISIBLE

A button on a form can also be used to display a new form. This can be done in
two ways. The first is to use the Show command, which will replace the original
form with the new form. The second is to use the Show as Dialog command. In this
case, the new form will pop up as a dialog over the current form, and will usually
request input from the user.
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In the section Choose Commands to Run, you can select the Show command. The
figure below shows the command sequence for a button with a command Show

form3.

[{er

» (Choose Commands to Run

4 B Forms
D form1
D form2
D form3

I @ GUI Commands
b [ Libraries
& Model (root)

= Edit Node Run Plot Set Value I:l Show

Show as Dialog Import File Enable Disable

Command lcon | Arguments
Show form3 I:l

M-

This command will leave the form associated with the button and make the
specified form visible to the user.

SHOWING A FORM AS A DIALOG

In order to use the Show as Dialog command, begin with the Choose Commands to
Run section and select the form that you would like to show. The figure below
shows an example of the settings for a button with the command Show form2 as

dialog.

[{er

» (Choose Commands to Run

4 B Forms
D form1
D form2

I @ GUI Commands
b [ Libraries
[ < Model (root)

=# Edit Node Run Plot Set Value I:l Show
[Z] Show as Dialeg Import File Enable Disable

L
Command lcon | Arguments
Show forma2 as dialog
=% . -
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With these settings, clicking the button in the application will launch the following

dialog corresponding to form2:

3 Help X

You are running version 2.1
of this application. For help
please call 123-436-72830.

OK

The form2 window in this example contains a text label object and an OK button,

as shown in the figure below.

@Preview Dform‘l chrmi x

h

You are running version 2.1
of this application. For help
please call 123-456-7830.

oK

X
MName: button1 E
Text: oK
lcon: MNone ~| |4
Size: Small =
Style: Raised =
Tooltip:
Keyboard shortcut:

Choose Commands to Run B

¥ Dialog Actions

Close dialog
Store changes

In the Settings window, the Dialog Actions section has two checkboxes:

¢ Close dialog

¢ Store changes

In the example above, the Close dialog checkbox is selected. This ensures that the
form2 window is closed when the OK button is clicked. Since form2 does not have
any user inputs, there is no need to select the Store changes checkbox.

Typical dialog buttons and their associated dialog actions are:

BUTTON DIALOG ACTIONS

oK Close dialog and Store changes
Cancel Close dialog

Apply Store changes
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A dialog blocks any other user interaction with the application until it is closed.
In order to control when data entered in a dialog is stored, there is a list in the
Dialog Settings scction of the Settings window of a form where you can select
whether to store data On request or Immediately when the change occurs, as shown
in the figure below.

Settings

Mame: form1 ,@

Title: Form 1

lcon: Default ~| &
Show in Maodel Builder

> Size

> Margins

~ Dialog Settings

Store changes: On request -

[] Resizable ~ On request
Vertically scr|| Immediately |

When the Store changes option On request is sclected, the variables that have been
changed by the user in the dialog will not be updated until the OK button (or
similar) in the dialog has been clicked. This requires that the Store changes
checkbox is selected, in the Settings window of the OK button. When the option
Immediately is sclected, variables changed by the user in the dialog is updated
immediately including while the dialog is still open.

When Vertically scrollable is cleared, the form will never get any vertical scrollbar.
Instead, the scrollbar will appear on the form objects inside the form, if possible.
To obtain a satisfactory result, the form has to be created in grid mode. The form
object which should get the scrollbar must be in a row with setting Grow Row and
its alignment set to Fill Vertically.
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APPEARANCE

In the Settings window for a button, the Appearance scction contains font settings
as well as settings that control the state of the button object.

~ Appearance

Text color: Inherit -
Background color:  Transparent -
Font: Default font -

Font size: Default size > pt

[] Bold
[] Italic
[] Underline

State
Visible
Enabled

Changing the Enabled and Visible State of a Form Object
Whether or not the button object should be Visible or Enabled is controlled from
the checkboxes under the State subsection. The Appearance scction for most form
objects has similar settings, but some have additional options; for example, input
field objects.
A button, or another form object, with the Visible checkbox cleared will not be
shown in the user interface of the running application. A form object with the
Enabled checkbox cleared will be disabled, or “grayed out”, but still visible. The
state of a form object can also be controlled using built-in methods. For example,
assume that a Boolean variable enabled _or_disabled is used to determine the
enabled /disabled state of a button with Name button3. In this case, you can
control the state of the button as follows:

setFormObjectEnabled("button3", enabled_or_disabled);

In a similar way, the call
setFormObjectVisible("button3", visible_or_not);

lets a Boolean variable visible or_not control whether the button is shown to
the user or not.

For more information, see “GUI-Related Methods” on page 359 and the
Application Programming Guide.
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Graphics

Each Graphics object gets a default name such as graphics1, graphics2, and so
on, when it is created. These names are used to reference graphics objects in
command sequences for buttons, menu items, and in methods. To reference
graphics objects in a specific form, use the syntax: form1/graphics2,
form3/graphics1, and so on.

SELECTING THE SOURCE FOR INITIAL GRAPHICS CONTENT

In the Settings window for a graphics object, use the section Source for Initial
Graphics Content to sct the plot group or animation to be displayed as default. To
select, click Use as Source or double-click a node in the tree. If a solution exists for
the displayed plot group, the corresponding solution will be visualized when the
application starts. The figure below shows the Settings window for a graphics
object with a Temperature plot selected as the source.

Settings

Graphics

MName: graphicsl =5
Zoom to extents on first plot

~ Source for Initial Graphics Content

v & Model (root)
> [ Component 1 (compl)

v {E| Results

Nl Electric Potential (ec)
V@ Electric Field (ec)

Iﬁ Temperature (ht)

V@ Current Density

@_‘Use as Source %, Clear Source =# Edit Node

Selected source:

VB Temperature (ht)

In addition to Results plot nodes, you can also use Animation, Selection, Geometry,
and Mesh nodes as the Selected source.

Selecting the Zoom to extents on first plot checkbox ensures that the first plot that
appears in the graphics canvas shows the entire model (zoom extents). This action
is triggered once the first time that graphics content is sent to the graphics object.

In the section Data Picking, below Source for Initial Graphics Content, selecting the
Enable data picking checkbox makes the graphics object interactive so that you can,
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for example, click on a plot at a particular point and retrieve a numerical value for
the temperature at that coordinate. For more information, see “Data Picking” on
page 94.

APPEARANCE

For a graphics object, the Appearance section of the Settings window has the
following options:

* Include an lcon, such as a logo image, in the upper-right corner.

 Set the background Color for 2D plots.

e Set a flat or graded background color for 3D plots by choosing a Top color
and Bottom color.
v Appearance

lcon: o logo_graphics.png - + =
Background for 2D plots

Color: Use default -
Background for 3D plots

Top color: Use default -

Bottom color: Use default -
State

Visible

Enabled

In addition, the subsection State contains settings for the visible and enabled state
of the graphics object. For more information, see “Changing the Enabled and
Visible State of a Form Object” on page 78.
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The figure below shows an application where the background Top color is set to
white and the Bottom color to gray. In addition, the standard plot toolbar is not

included.

@ Untitled.mph - Electrical Heating in a Busbar

Length: 9 cm
Width: 3 cm
Applied voltage: 20 my

Temperature: 3304K

aa@-@ by yEen -

vy =

Geometry Compute

<-B- BEHO @3

Surface: Current density norm (A/m?)

m

-0.02

x10°
10

About
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GRAPHICS COMMANDS

In the editor tree used in a command sequence of, for example, a button, the
Graphics Commands folder contains commands to process or modify a graphics
object. The figure below shows a command sequence with one command for
printing the contents of a graphics object.

~ Choose Commands to Run "5

> [ Forms
~ @ GUI Commands
¥ File Commands
v [‘u Graphics Commands
Zoom Extents
‘[ Zoom to Selection
[@ Reset Current View
= Scene Light
@ Environment Reflections
(& Show Skybox
[#2 Rotate Environment
[ Transparency
B0 Orthographic Projection
@ Print
5 Select All
! Clear Selection

.: Show Selection Colors
= Show Material Color and Texture

Edit Node P Run [za| Plot Set Value Show
Show as Dialog Import File Enable Disable

L
Command lcon | Arguments
Print lgl form1/graphicsi

The available Graphics Commands include:
¢ Zoom Extents

- Makes the entire model visible.
¢ Reset Current View

- Resets the currently active view to the state it had when the application was
launched; also see “Views” on page 88.

¢ Scene Light

- Toggles the scene light (on or oft).
* Transparency

- Toggles the transparency setting (on or oft).
¢ Orthographic projection

- Enable orthographic projection (as opposed to perspective projection).
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¢ Print
- Drints the contents of the graphics object.
e Select All
- Selects all objects.
¢ Clear Selection
- Clear the selection of all objects.
¢ Show Selection Colors
- Enable visualization of selection colors.
¢ Show Material Color and Texture
- Enable visualization of material color and texture.

Note that the many of these commands have corresponding toolbar buttons in the
standard graphics toolbar. See the next section “Graphics Toolbar”.

Plot While Solving

To let the user monitor convergence, you can plot the results while solving. In this
example, assume that the Plot option is enabled for Results While Solving. This
option is available in the Settings window of a Study node in the model tree, as
shown in the figure below.

= Compute

Label: Time Dependent
Study Settings

¥ Results While Solving

Plot
Plot group: | Velocity (spf) | (3
Update at: Time steps taken by solver -

Probes: All =

Update at: | Time steps taken by solver -

You can include a method that calls the built-in sleep method for briefly
displaying graphics information before switching to displaying other types of
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graphics. Insert it in a command sequence after a plot command, as shown in the
figure below.

" Command lcon | Arguments
Plot Mesh 1 form1/graphics1
Plot Velocity (spf) form1/graphics1
sleepABit @

Compute Study 1 =

td =bgbE- 4

In this example, the sleepABit method contains one line of code:
sleep(1000); // sleep for 1000 ms

For more information on the method sleep, see “sleep” on page 364.

In the command sequence above, the Plot Velocity command comes before the
Compute Study command. This ensures that the graphics object displays the
velocity plot while solving.

USING MULTIPLE GRAPHICS OBJECTS

Due to potential graphics hardware limitations on the platforms where your
application will be running, you should strive to minimize the number of graphics
objects used. This is to ensure maximum portability of your applications. In
addition, if you intend to run an application in a web browser, there may be
additional restrictions on how many graphics objects can be used. Different
combinations of hardware, operating systems, and web browsers have different
limitations.

In this context, two graphics objects with the same name but in different forms
count as two different graphics objects. For example, form1/graphics1 and
form2/graphics2 represent two different graphics objects. In addition, if a
graphics object is used in a subform (see “Form” on page 280), then each use of
that subform counts as a different graphics object.

To display many different plots in an application, you can, for example, create
buttons, toggle buttons, or radio buttons that simply plot to the same graphics
object in a form that does not use subforms.

If you need to use methods to change a plot, use the useGraphics method. For
more information on writing methods, see “The Method Editor” on page 184.
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The example code below switches plot groups by reusing the same graphics object,
based on the value of a Boolean variable.
if (my_boolean) {
useGraphics(model.result("pg1"), "formi/graphicsi");
my_boolean=!my_boolean; // logical NOT to change between true and false
} else {
useGraphics(model.result("pg2"), "formi/graphicsi");
my_boolean=!my_boolean;

CLEARING THE CONTENTS OF A GRAPHICS OBJECT

You can clear the contents of a graphics object by a call to the useGraphics
method, such as:

useGraphics(null, "/formi/graphicsi");

which clears the contents of the graphics object graphics1 in the form form1.

GRAPHICS TOOLBAR

The type of tree node used in the Source for Initial Graphics Content determines the
type of toolbar that is shown. The toolbar will be different depending on the space
dimension and whether the referenced source is a Geometry, Mesh, Selection, or
Plot Group node. For example, the Plot Group node displays an additional Show
Legends button.

In the Settings window of a graphics object, in the Toolbar section, you can control
whether or not to include the graphics toolbar, as well as its position (Below,
Above, Left, Right). In addition, you can choose between the options Small or Large
for lcon size, Background color, and whether to Include standard toolbar items or
not.

v Toolbar

Position: Above =
lcon size: Small =
Background color: White =

Standard toclbar
Include standard toolbar items: Default =
Place standard toclbar before custom items

Custom toolbar items

L
MName lcon | Text Tooltip
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Graphics Toolbar for Geometry and Mesh

The figure below shows the standard graphics toolbar as it appears when the
Geometry or Mesh node, for a 3D model, is used as a Source for Initial Graphics
Content.

QaQ@~ @ lvrkm - <o B 3ERF &3

Graphics Toolbar for Selection

When the Source for Initial Graphics Content is set to a Selection, the graphics
toolbar will contain three additional items: Zoom to Selection, Select Box, and
Deselect Box. This is shown in the figure below.

QeQ@A~r Bl Lzl ¢ & G- <-B-raERM @8
For more information on selections, see “Selections” on page 90.

Graphics Toolbar for Plot Groups

The figure below shows the standard graphics toolbar as it appears when a 3D Plot
Group node is used as a Source for Initial Graphics Content.

Qa@~ B Lrerznm - o B BEO S

If the Source for Initial Graphics Content is set to an Animation node, then additional
buttons for playing the animation are added to the graphics toolbar, as shown in
the figure below.

HENEF @a@~- @ drriwm - || 8- BEO &S

Custom Graphics Toolbar Buttons

In the Toolbar section, you can also add custom buttons to the graphics toolbar.
Use the buttons under the table to add or remove custom toolbar buttons (items).
You can also move toolbar buttons up or down, add a Separator, and Edit a button.
The figure below shows a standard graphics toolbar for results with four additional
buttons to the right.

Qaf- rmErEr dr (¢ B-r R @8 Ad =S
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The figure below shows the corresponding settings and table of graphics toolbar
items.

v Toolbar

Position: Above -
lcon size: Small -
Background color: Default -

Standard toclbar

Include standard toolbar items: Custom -
[*] Player: MNormal -
&, Zoom: MNormal -
<L~ Gotoview: MNormal ar
(5 Rotate: MNormal -
= Select box: MNormal ar
€ Deselect box: Hidden -
View: Mormal -
& Image: Normal -

Place standard toolbar before custom items

Custom toolbar items

" MName lcon | Text Tooltip
geometry ‘)\ Geometry
optimize CJ Optimize
compute | = Compute
settings {‘:’} Settings

BEE
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To edit the command sequence for a toolbar item, click the Edit button to open
the Edit Custom Toolbar Item dialog.

3 Edit Custem Toolbar ltem

General ' Choose commands to run

Mame: outlet
Text: Qutlet
Icon: i select_boundaries.png
Tooltip: Outlet

Keyboard shorteut:  CTRL+C|
State

Visible

Enabled

0K

Cancel

3 Edit Custem Toolbar ltem

General Choose commands to run

B Forms
b @ GUI Commands
b [l Libraries
4 % Model (root)
b @ Global Definitions
4 [ Compenent 1 (compl)
4 = Definitions

4 Ty, Selections

& Inlet
& Outlet
b el View 1
Run [ Plot 7 Set Value || Show || Show as Dialog | ImportFile () Enable
Disable
"
Command Icon | Arguments
Plot Outlet form1/graphics1
SafE-
oK Cancel

This dialog has settings that are similar to those of a button or a toolbar item with

the contents divided into two or three tabs depending on if the item is a toggle
item or not. For details, see “Button” on page 66 and “Toolbar” on page 322.

Views

In the graphics toolbar of an application, the Go to Default View button (for 3D

graphics only) will reset the current view to the default view. If you click the arrow

@ BRIk

Go to Default View

next to this button, a menu will be displayed with all applicable views. The
currently active view is indicated with a check mark.

vzl S [
Go to View 1
Go to View 5

<

Go to View 6

Reset Current View

F R

Go to VX View

Go to ZV View

W

Go to ZX View
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In addition to a list of all views, there is an option Reset Current View that will reset
the currently active view to the state it had when the application was launched.

ANIMATIONS
You can display animations in an application by using a Results > Animation node
as the Source for Initial Graphics Content.

Settings
Graphics

MName: graphicsl 5
Zoom to extents on first plot

~ Source for Initial Graphics Content

<

& Model (root)
> [ Component 1 (compl)
v {E| Results
Nl Electric Potential (ec)
V@ Electric Field (ec)
VB Temperature (ht)
V@ Current Density

Animation 1

@_‘ Use as Source %, Clear Source =# Edit Node
Selected source:

[# Animation 1
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To run the animation, use the Form Wizard or the Editor Tools window to create
a command from, for example, a button that runs a Results > Animation node.

Settings

Button

MName: button3 =
Text: Play Animation

lcon: “LL animate_32.png - + =
Size: Large =
Style: Flat =
Tooltip:

Keyboard shortcut:
~ Choose Commands to Run ]

v {E| Results
> 2% Derived Values

EH Tables

W@ Electric Potential (ec)
Ii Electric Field (ec)

I'i Temperature (ht)

V@ Current Density

~ {& Export

[# Animation 1

oW W W v

= Edit Node Run Plot Set Value Show

Show as Dialeg Import File Enable Disable

L1
Command lcon | Arguments

Export Animation 1 = form‘l_."rahics‘l

:

==

When using the Form Wizard or Editor Tools, the animation button will have the
following default appearance:

[LT

Play
Animation

SELECTIONS

Selections in the Model Builder

In the Model Builder, named selections let you group domains, boundaries,
edges, or points when assigning material properties, boundary conditions, and
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other model settings. You can create different types of selections, for example, by
adding subnodes under the Component > Definitions node, as shown in the figure
below. You can also create selections generated by geometry or mesh sequences.
These can be reused throughout a model component.

~ [l Component 1 {comp1)
v = Definitions

[.1;] Bounda 4= Variables
» View 1 Variable Utilities 4
/| Geometry 1 Equation Contributions 4
> igs Materials X
> &3 Solid Mech;  "unetions '
> A Mesh 1 Selections b Explicit
LI =)
Study 1 Probes Y% Ball
> [ Results =
Physics Utilities * T8 Box
Monlocal Couplings 4 [& Cylinder
Pairs ' E Union
Coordinate Systems 4 'El: Intersection
[==  Infinite Elernent Domain o Difference
i Perfectly Matched Layer % Complement
Shared Properties [N Adjacent
Control Variables * o& Logical Expression
Surrogate Model Sarmpling 4 Selection List
wLa Wi =y .
| e &) Color Selections
@ Show More Options... 43 Reset Colors from Theme
2 Mode Group M Remove Selection Colors

== Group by Type
. Update Probes

H Hep F1

As an example of how selections can be used, consider selections for boundary
conditions. When you select which boundaries should be associated with a certain
boundary condition, you can click directly on those boundaries in the graphics
window of the COMSOL Desktop environment. This is the default option called
Manual selection (see below). These boundaries will then be added to a selection
that is local to that boundary condition. Named selections instead let you define
selections that can be reused for several different kinds of boundary conditions
within a Component by just selecting from a drop-down list. The figure below
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shows an Explicit selection given the name Inlet Boundaries with an associated
boundary (1).

Model Builder ~ ®|| Settings -
= 1 ®Er i 9~ Explicit
c Label: Inlet Boundaries =

v & micromixer_app.mph (root)
> (@) Global Definitions ¥ Input Entities

~ [l Component 1 {comp1) {comp 1}

v = Definitions Geometric entity level: Boundary =
2= Variables 1 {varl} 1 =]
_I” Step 1 (step1) {step 1} ‘ B —
v g Selections ‘. i\’_']
= Inlet Boundaries {sel}
% Outlet Boundaries {sel2}
w All Fluid Domains {sel3}
w All Fluid Boundaries {sel4}
'El= Fluid Walls {dif 1} [] All boundaries
av Average 1 (aveop_inlet) {aveop 1} [] Group by continuous tangent
av Average 2 (aveop_outlet) {aveop2}
[ Boundary System 1 (sys1) {sys1} ¥ Output Entities

> [ View 1 {view?}

4| Geometry 1{geom1}

> igs Materials

~ =% Laminar Flow (spf] {spf!
= Fluid Properties 1 {fo 1}
= Initial Values 1 {init1}

Selected boundaries =

¥ Color

Color: MNone =

The figure below shows the Settings window for an Inlet boundary condition
where the Inlet Boundaries sclection is used. In this example, there is also an Outlet
Boundaries sclection.

Settings =i

Label: Inlet1 E

¥ Boundary Selection

Selection: [ Inlet Boundaries v|

| 1Manua|
‘ All boundaries

Inlet Boundaries

Outlet Boundaries

For convenience, in addition to the Manual option, there is also a shortcut for All
boundaries.
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Selections in the Application Builder

The Explicit sclections, created under Definitions, or by geometry or mesh
sequences, let you group domains, boundaries, edges, or points based on entity
number, and the example below illustrates how to work with this type of selection.
Explicit sclections can be made interactive in an application, but other types of
selections, such as a coordinate-based Box selection, are shown in read-only mode.

You can allow the user of an application to interactively change which entities
belong to an Explicit selection with a Selection Input object or a Graphics object. In
the example below, the embedded model has a boundary condition defined with
an Explicit selection. Both a Selection Input object and a Graphics object are used
to let the user select boundaries to be excited by an incoming wave.

0.1
-0.17] l I

-0.47]

-0.57]

-0.67

-0.77]

T T T T
1.4 1.6 1.8 2 2.2
— B —
\-::@ . .
7 &

The user can here select boundaries by clicking directly in the graphics window,
corresponding to the Graphics object, or by adding geometric entity numbers in a
list of boundary numbers corresponding to a Selection Input object.

To make it possible to directly select a boundary by clicking on it, you can link a
graphics object to an Explicit selection, as shown in the figure below. Select the
Explicit selection and click Use as Source. In the figure below, there are two Explicit
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selections, Excitation Boundary and Exit Boundary, and the graphics object
graphics2 is linked to the sclection Excitation Boundary.

<

ettings v RX

MName: graphics] =
Zoom to extents on first plot

¥ Source for Initial Graphics Content

4 & Model (root)
4 T Component 1 (comp1)
4 = Definitions

4 g Selections
ﬁ Excitation Boundary
& Exit Boundary

WA Geometry 1

A Mesh 1

b IE Results

% Clear Source Edit Mode

Use as Source
Selected source:

& Excitation Boundary

When a graphics object is linked directly to a selection in this way, the graphics
object displays the geometry and the user can interact with it by clicking on the
boundaries. The boundaries will then be added (or removed) to the
corresponding selection.

To make it possible to select by number, you can link a Selection Input object to
an explicit selection. For more information, see “Selection Input” on page 302.

The Editor Tools window provides a quick way of adding a Graphics object or a
Selection Input object that is linked to an Explicit selection. To get these options,
right-click an Explicit selection node in the editor tree.

You can let a global Event be triggered by an Explicit selection. This allows a
command sequence or method to be run when the user clicks a geometry object,
domain, face, edge, or point. For more information on using global events, see
“Events” on page 149 and “Source For Data Change Event” on page 151.

For an example of how to use selections in an add-in, see the Application
Programming Guide.

DATA PICKING

In the Settings window for a graphics object, select the Data picking checkbox to
make the graphics object interactive so that you can, for example, click on a plot
at a particular point and retrieve a numerical value for the temperature at that
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coordinate. In the figure below, in the section Target for Data Picking, a scalar
double variable Tvalue is selected. This variable is declared under the Declarations
node. In the running application, the value of the temperature at the pointer
position will be stored in the variable Tvalue.

Settings

Graphics

MName: graphicsl 5
Zoom to extents on first plot

~ Source for Initial Graphics Content

v & Model (root)
> [ Component 1 (compl)

v {E| Results

Nl Electric Potential (ec)
V@ Electric Field (ec)
| Temperature (ht)
V@ Current Density

@_‘Use as Source %, Clear Source =# Edit Node

Selected source:
VB Temperature (ht)
~ Data Picking @+ 5

[] Enable data picking
Target for data picking

v = Declarations
v 25 Double
sl Tvalue

@_‘Use asTarget ', Clear Target Sp Edit Node
Selected target:

25 Double=TValue

If the Target for Data Picking is a 1D double array, then the stored value will instead
correspond to the x,y (2D) or x, ¥, and z coordinates at the clicked position.

The Target for Data Picking can be any one of the following:
 Scalar double variable

* 1D double array

e Domain Point Probe

* Boundary Point Probe

» Graphics Data declaration

For more information on Graphics Data declaration, see “Graphics Data” on page
181.
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Input Field

An Input Field allows a user to change the value of a parameter or variable. In the
Form Wizard, when a parameter or variable is selected, three form objects are
created:

+ A Text Label object for the parameter or variable description.

* An Input Field object for the value.

* A Unit object (if applicable) that carries the unit of measure.

By selecting a parameter or variable using the Editor Tools window, the same three
form objects are created.

Assuming you do not use the Editor Tools window: To insert an additional input
field, click the Input Field button in the Form Objects section of the ribbon Form
tab. In the Form Editor, you link an input field to a certain parameter or variable
by selecting it from the tree in the Source section and click Use as Source. In the
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Source section of the Settings window, you can also set an Initial value. The figure
below shows the Settings window for an input field.

Settings

Input Field

MName:  inputfieldl =
Editable

Tooltip:

v Source @+ "5

Declarations
Model (root)
v () Global Definitions
~ P; Parameters 1
a3 Length (L)
8.5 Bolt radius (rad_1)

en

@_‘ Use as Source =g Edit Node

Selected source:
=5 Parameters 1=Length (L)

Initial value: From data source -

Value: 9
~ Data Validation

Unit dimension check: ~ Append unitto number
Unit expression: cm
Mumerical validation

Filter: Double -
[] Lower bound

Comparison type: Greater than or equal

Value: 0

[] Upper bound

Comparison type: Less than or equal

Value: 1000

Error message:

Invalid input

In addition to parameters and variables, input fields can use an Information node
as Source.

The default setting for the Initial value is From data source. This means that if the
source is a parameter, then the initial value displayed in the input field is the same
as the value of the parameter as specified in the Parameters node in the Model

Builder. The other Initial value option is Custom value, which allows an initial value
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different from that of the source. If the Editable checkbox is cleared, then the Initial
value will be displayed by the application and cannot be changed. This makes it
possible to use an Input Field an alternative to, for example, a Text Label object for
displaying text.

You can add a Tooltip with text that is shown when hovering the mouse pointer
over the input field.

The header of the Source section contains buttons for easy access to tools that are

used to make additional properties and variables available as sources to the input
field.

v Source @+ 3
» = Declarat| Create New Declaration and Use It as Source
oy

v & Model (root) — -
~ Source ® + "5
> = Del ; - - -

— = - Switch to Model Builder and Activate Data Access
~ Source @+ B ~ M

w

= D% Create New Form Declaration and Use It as Source
& Model (root)

<

The Create New Declaration and Use It as Source button can be used to add new
variables under the Declarations node. For more information, see “Declarations”
on page 159. The Create New Form Declaration and Use It as Source button can be
used to add new variables under the Declarations nodes local to forms, as shown
below.

¥ D Main Window
~ [ Forms
v D form1

v = Declarations
abe String

Events
The Switch to Model Builder and Activate Data Access button can be used to access

low-level model properties as described in the next section. For more information
on Data Access, see “Data Access in the Form Editor” on page 107.
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DATA VALIDATION

The Data Validation section of the Settings window for an input field allows you to
validate user inputs with respect to units and values.

~ Data Validation

Unit dimension check: ~ Append unitto number
Unit expression: my

MNumerical validation
Filter: Double -
Lower bound

Comparison type: Greater than or equal -
Value: 0

Upper bound

Comparison type: Less than or equal -
Value: 1000

Error message:

Invalid input

When creating an input field in the Form Wizard, the setting Append unit to
number is used when applicable. This setting assumes that a user enters a number
into the input field, but it can also handle a number followed by a unit using the
COMSOL square bracket [ ] unit syntax. If the Unit expression is mm, then 1[mm]
is allowed, as well as any length unit, for example, 0.1[cm]. An incompatible unit
type will display the Error message. A parameter that has the expression 1.23[mm],
and that is used as a source, will get the appended unit mm and the initial value
displayed in the edit field will be 1.23.

The Unit dimension check list has the following options:

* None

¢ Compatible with physical quantity

¢ Compatible with unit expression

* Append unit to number (default)

¢ Append unit from unit set

A value or expression can be highlighted in orange to provide a warning when the
user of an application enters an incompatible unit, which is any unit of measure

that cannot be converted to the units specified in the Data Validation settings.
Enable this feature by selecting Compatible with physical quantity or Compatible
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with unit expression. In addition, the user will see a tooltip explaining the unit
mismatch, as shown in the figure below.

Length: Ikal m
Width: 3em] Deduced unit is [kg], expected is [m]
Applied voltage:  20[mV] v

Ternperature: 3304K

If there is a unit mismatch, and if no further error control is performed by the
application, the numeric value of the entered expression will be converted to the
default unit. In the above figure, 9[kg] will be converted to 9[m].

A button Add Unit Label is available to the right of the Unit dimension check list.

~ Data Validation

Unit dimension check: ~ Append unitto number v |-

Unit expression: m Add Unit Label

Clicking this button will add a unit label to the right of the input field if there is
not already a unit label placed there.

The None option does not provide unit validation.

Numerical Validation
The options Append unit to number, Append unit from unit set, and None allow you
to use a filter for numerical validation of the input numbers.

~ Data Validation

Unit dimension check: Mone -

MNumerical validation

Filter: Double -
Lower bound None
Double

Comparison type: (
Integer

Value: 0 Regular expression

The Filter list for the option None has the following options:
* None

¢ Double

* Integer

¢ Regular expression

The Filter list for the options Append unit to number and Append unit from unit set
only allows for the Double and Integer options.
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The Double and Integer options filter the input based on the Lower bound and
Upper bound values. If the input is outside of these values, the Error message is
displayed. You may use global parameters in these fields. If global parameters are
used, you can define such parameters with or without units. If you use global
parameters without a unit, then only the numerical value of these parameters is
considered. For example, consider data validation of an input field for a length
parameter L with unit cm. Further, assume that a global parameter Lmax is used as
the Upper bound value. If you would like the maximum value of L to be 15 cm,
then the following values for the parameter Lmax will work: 15 (with no unit),
15[cm], 0.15[m], 150[mm], and so on.

For the Append unit from unit set option, the Lower bound and Upper bound values
are always with respect to the Initial value for the unit set by the unit set. For more
information on unit sets, see “Unit Set” on page 173.

The Regular expression option, available when the Unit dimension check is set to
None, allows you to use a regular expression for matching the input string. For
more information on regular expressions, see the dynamic help. Click the help
icon in the upper-right corner of a window and search for “regular expression”.

For more advanced requirements, note that virtually any kind of validation of the
contents of an input field can be made by calling a method using the Events section
in the Settings window of an input field.

For additional information on how to use more advanced Data Validation features

and how to use method code to perform data validation, see the Application
Programming Guide.

Error Message

You can customize the text displayed by the Error message. During the
development and debugging of an application, it can sometimes be hard to deduce
from where such errors originate. Therefore, when using Test Application,
additional debugging information is displayed, as shown in the figure below.

& Error x

Prong length must be 10 to 2500 mm.

() Details

- Form object: Input field
- Path: mainComputer/pronglLengthlnput
Must be a number: 10 £ x £ 2500

The debugging information typically consists of the type of form object, the path
to the form object, and the reason for the failure; for example, 10<=x<=2500.
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No debugging information is added when launching an application by using the
Run Application option or COMSOL Server.

NUMBER FORMAT

The Number Format section contains a Use input display formatting checkbox. If

selected, it enables the same type of display formatting as a Data Display object.
~ MNumber Format

Use input display formatting

Precision: 4
MNotation: Automatic -

Exponent: Power of 10 -
For more information, see “Data Display” on page 104.

APPEARANCE

In addition to color and font settings, the Appearance section for an input field
contains a Text alignment setting that allows the text to be Left, Center, or Right
aligned.

~ Appearance

Text color: Inherit =
Background color:  White =
Text alignment: Left -
Font: Lt
Center

Font size: Right pt
[] Bold
[] Italic

State
Visible
Enabled

Whether the input field should be Visible or Enabled is controlled from the
checkboxes under the State subsection. For more information, see “Changing the
Enabled and Visible State of a Form Object” on page 78.
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Unit

In the Settings window for a Unit object, you can set the unit to a fixed string, or
link it to an source, such as an input field. The figure below shows the Settings
window for a unit object.

Settings

Unit

MName:  unitl =
Label: From reference -

[] LaTeX markup

~ Source for Label

~ [ Forms

v D mainComputer
[ targetFrequencylnput
1 frequencyTolerancelnput
prenglengthinput
3 radiuslnput
1 inputfieldl

¥ D mainSmartphone

& Model (root)

w

Use as Source Edit Mode

Selected source:

[ pronglengthlnput

When adding an input field using the Form Wizard, a unit object is automatically
added when applicable. By default, the unit is displayed using Unicode rendering.
As an alternative, you can use LaTeX rendering by selecting the LaTeX markup
checkbox. Then, the display of units will not depend upon the selected font.

Text Label

A Text Label object simply displays text in a form. When adding an input field using
the Form Wizard, a Text Label object is automatically added for the description
text of the associated parameter or variable. There is a checkbox allowing for
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Multiline text. If selected, the Wrap text checkbox is enabled. The figure below
shows the Settings window for a Text Label object.

Settings

Text Label

MName: textlabelPronglength 5
[] Multiline text

Text: Prong length:

~ Position and Size

Harizontal alignment: Left -
Vertical alignment: Middle -
Width: 23
Height: 20

Row:

6
Column: 1
Row span: 1

1

Column span:

Cell margin

Cell margin: From parent form -

~ Appearance

Text color: Inherit -
Background color:  Transparent =
Font: Default font -
Font size: 1l > pt
[] Bold

[] Italic

[] Underline

To insert an additional Text Label, click the Text Label button in the ribbon Form
tab, in the Form Objects section. The contents of the section Pesition and Size will
change depending on if you are working in sketch layout mode or grid layout
mode.

Data Display

A Data Display object is used to display the numerical values of scalars and arrays.
If there is an associated unit, it will be displayed as part of the Data Display object.
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SOURCE

In the Settings window for a data display object, in the Source section, select a node
in the model tree. Then click the Use as Source button shown below. Valid
parameters, variables, and properties include:

* The output from a Derived Values node, such as a Global Evaluation or a Volume
Maximum node

» Variables declared under the Declarations > Scalar, 1D Array, and 2D Array
nodes

» Properties made available by using the Data Access tool; See “Data Access in
the Form Editor” on page 107

* One of the following Information node variables, which are under the root
node and under each Study node:

- Expected Computation Time

This is a value that you enter in the Expected field in the Settings window of
the root node.

- Last Computation Time (under the root node)

The is the last measured computation time for the last computed study.
- Last Computation Time (under a study node)

This is the last measured computation time for that study.

When you start an application for the first time, the last measured times are
reset, displaying Not available yet.

USING THE FORM WIZARD FOR GENERATING DATA DISPLAY OBJECTS

In the Form Wizard in, for example, the Inputs/outputs tab, only the Derived Values
nodes will generate Data Display objects. Variables under Declarations and
constants made available with Data Access will instead generate Input Field objects.

When a Derived Values node is selected, two form objects are created based on the
corresponding Derived Values node variable:

 a Text Label object for the Description of the variable
* a Data Display object for the value of the variable
The settings for these form objects can subsequently be edited. To insert

additional data display objects, use the Insert Object menu in the ribbon and select
Data Display.

NUMBER FORMAT

The Number Format scction lets you set the Precision, Notation, Exponent, and Unit.
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The figure below shows an example with data display objects for the variables Coil
resistance and Coil inductance. A formatted unit label is automatically

displayed as part of the object if applicable.

@ Preview D form1 X Sett"“gs
Data Display
Name:  datadisplayl =
Coil resistance:  0.001235 [ LaTeX markup
Coilinductance:  0.001235 Tooltip:
- Source & E

= Declarations

@ Model (root)

I (1) Information

[ ~do Study 1

[ ~do Study 2

4 ([ Results

4 £ Derived Values

Global Evaluation 1
l@ Global Evaluation 2

[ 8

E‘ Use as Source =g Edit Node
Selected source:

l@ Global Evaluation 1

¥ Number Format
Precision: 4
Motation: Automatic -

Exponent: | Power of 10 -

RENDERING METHOD

By default, the unit of a data display object is displayed using Unicode rendering.
As an alternative, you can use LaTeX rendering by selecting the LaTeX markup
checkbox. Then, the data display does not rely on the selected font.

A formatted display of arrays and matrices is only supported with LaTeX
rendering. The figure below shows a 2D double array (see page 167) displayed
using a Data Display object with LaTeX markup selected.

1 1 1 1 1 1 1
08 06 03 02 01 01 01
1 1 1 1 1 1

,_.
coo
oo
=&
oo
BEE
o0~
@&
~ o~

106 |



You can add a Tooltip with text that is shown when hovering over the data display
object.

Data Access in the Form Editor

The Settings window of many types of form objects has a section that allows you
to select a node in a tree structure that includes the model tree, or parts of the
model tree, and parts of the application tree. Examples include the Source section
of an input field or the Choose Commands to Run section of a button. There are
many properties in the model and application trees that are not made available by
default, because there may be hundreds or even thousands of properties, and the
full list would be unwieldy. However, these “hidden” properties may be made
available to your application by a technique called Data Access.

The remainder of this section gives an introduction to using Data Access, with
examples for input fields and buttons.

DATA ACCESS FOR INPUT FIELDS

By default, you can link input fields to parameters and variables defined in the
model tree under the Parameters or Variables nodes and to variables declared in
the application tree under the Declarations node. To access additional model tree
node properties, click the Switch to Model Builder and Activate Data Access button
in the header of the Source section of the input field Settings window, as shown in
the figure below.

~ Source @+ B

E‘EJ Switch to Model Builder and Activate Data Access

en

w

You can also access it from the Application group of the Developer tab in the Model
Builder workspace

A " Data Access

> -
Application Test Application

Builder

Application

or from the Home tab in the Application Builder workspace.

D " Data Access = settings
MNew MNew

Eﬁ Record Method Editor Tools
Form v Method v @3 Compiler
Main
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Then, when you click on a model tree node, checkboxes appear next to the
individual settings. In the figure below, the checkbox for an Electric potential
boundary condition is selected:

File Home  Definitions Geometry Materials  Physics Mesh  Study Results  Developer

A % Data Access MNew Method Lb @

P Test Application E. Record Method

Application Method Run Run Stop |
Builder Call ~ Method + Method Call ~
Application Create Methods Method Calls Run Code
Model Builder Settings
— =+ 1t | =St~ Electric Potential
ype Titertext ¢ Label:  Electric Potential 1 =
v & busbar.mph (root)
v () Global Definitions ~ Boundary Selection
Fi Parameters 1
2% Default Model Inputs Selection: = Manual -
=) Materials =+
43 L]
~ [l Component 1 {comp1) B —
» = Definitions El f=]
¥ Geometry 1 & ;;
> igi Materials N
~ +\_ Electric Currents {ec)
i Current Conservation 1
23 Electric Insulation 1
o= |nitial Values 1 » Override and Contribution
mw Electric Potential 1 > Equation
m Ground 1
» |IE) Heat Transfer in Solids (ht) v Electric Potential
> & Multiphysics
5 X Meshp‘l Y Electric potential:
> ~do Study 1 Vo 05 v
> [El Results

> Constraint Settings
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The figure below shows the Settings window for an input field. The list of possible
sources for this field now contains the Electric potential.
Settings

MName:  inputfield3 =5
[ ] VI Editable

Tooltip: l:‘

v Source @+ B

» = Declarations
~ < Model (root)
() Global Definitions

et

W Busbar (comp1)
~ +\_ Electric Currents (ec)
~ (m Electric Potential 1
iz Electric potential (VO]

@_‘ Use as Source =g Edit Node

Selected source:
abe Electric Potential 1=Electric potential (V0)

Initial value: From data source -

Value: Vot

In addition, as seen in the figure above, Data Access makes it possible to access the
Editable checkbox and the Tooltip text of the input field form object. In addition
to the settings of the Model Builder, Data Access lets you access certain properties
of the Application Builder.

Data Access can be used for buttons to set the value of a parameter, variable, or a
model property. For example, you can create buttons for predefined mesh element
sizes. The settings shown in the figure below are available when, in the Settings

window of the Mesh node, the Sequence type is set to User-controlled mesh. In this
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example, the Predefined property for Element Size has been made available and then
selected.

Model Builder Settings
— =+ 1t | & =t L A4 Size

Type filter text ¢ ¥ Build Selected [E§ Build All

~ @ busbar.mph (root) Label:  Size =
» () Global Definitions
~ [l Component 1 {comp1) Element Size

Definitions
Geometry 1 Calibrate for:

>
> igs Materials l:‘ General physics =
> *%_ Electric Currents (ec) _

il (®) Predefined -
> |l Heat Transfer in Solids (ht] * rredeiine Nermal
¥ .{E Multiphysics O Custom

~ A Mesh 1 .
> Element Size Parameters

Free Tetrahedral 1
» ~db Study 1

> [El Results
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The figure below shows the Settings window for a button used to create a mesh
with Element Size > Predefined set to Fine.

Settings
Button
MName: button3 E
Text: l:‘ Fine
lcon: l:‘ /& mesh 32png + + =
* . 1 Size: Large =
_,f_\\ Style: Outlined -
. A .
Fine Tooltip: l:‘
= - - Keyboard shortcut:
v Choose Commands to Run A

» W Geometry 1

» g Materials

> % Electric Currents (ec)

» |IE) Heat Transfer in Solids (ht)

> .y Multiphysics

~ /M Mesh1

[ size

8.5 Predefined size (hauto)

% Free Tetrahedral 1

» ~db Study 1

> [E Results

=y Edit Node Run [Z& Plot Z# Set Value Show
Show as Dialog Import File Enable Disable

L
Command lcon | Arguments
Set hauto of Size i |4
Plot Mesh 1 graphics1
u B

In the above example, a Set Value command is used to set the value of the
Predefined mesh size (hauto) property. The property Predefined mesh size (hauto)
corresponds to the following settings in the Size node shown earlier:

PREDEFINED MESH SIZE VALUE
Extremely fine 1
Extra fine - Extra coarse 2-8
Extremely coarse 9

The value of the hauto property is a double and can take any non-negative value.
For non-integer values, linear interpolation is used for the custom mesh



parameters. You can, for example, let a slider object adjust the predefined mesh
size. For more information on the slider object, see “Slider” on page 316.

In general, for individual model tree properties, you can quickly learn about their
allowed values by recording code while changing their values and then inspecting
the automatically generated code. For more information, see “Recording Code”
on page 194.

You can also use a combo box object to give direct access to all of the options from
Extremely fine through Extremely coarse. For more information, see “Combo Box”

on page 243.

SUMMARY OF DATA ACCESS

The table below summarizes the availability of Data Access for form objects and
events, as well as menu, toolbar, and ribbon items.

FORM OBJECT, EVENT, OR ITEM

SECTION IN SETTINGS WINDOW

Input Field
Button

Toggle Button, Menu Toggle ltem,
and Ribbon Toggle Item

Checkbox

Combo Box

Data Display

Graphics (Graphics Toolbar ltem)

Form Collection

Card Stack

Information Card Stack
Radio Button

Text

List Box

Slider

Toolbar (Toolbar ltem)
Menu Item

Ribbon Item

Event (Global)

Source
Choose Commands to Run

Source and Choose Commands to Run

Source
Source
Source
Choose Commands to Run

Active Pane Selector
Tiled or Tabbed

Active Card Selector

Active Information Card Selector
Source

Source

Source

Source

Choose Commands to Run
Choose Commands to Run
Choose Commands to Run

Choose Commands to Run

Source for Data Change Event
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A global event, menu, ribbon, or toolbar item provides a Choose Commands to Run
section in its Settings window, to which the functionality described above in the
section on buttons also applies. Global events and many form objects provide a
Source section in its Settings window, and the functionality described above in the
section on input fields applies. For information on global events, menus, ribbons,
and toolbar items, see “Graphics Toolbar” on page 85, “The Main Window
Editor” on page 137, “Events” on page 149, “Table” on page 311, and
“Toolbar” on page 322.

Sketch and Grid Layout

The Form Editor provides two layout modes for positioning form objects: sketch
layout mode and grid layout mode. The default is sketch layout mode, which lets
you use fixed positions and sizes of objects in pixels. Use grid layout mode to
position and size objects based on a background grid with cells. In grid layout
mode, a form is divided into a number of intersecting rows and columns, with at
most one form object at each intersection. This layout mode is recommended for
designing a resizable user interface, such as when designing an application to be
run in a web browser on multiple platforms.

SKETCH LAYOUT
Switch between sketch and grid layout mode by clicking Sketch or Grid in the

Layout group in the ribbon Form tab.

Grid = [@]a]
=

£ Sketch Show Arrange

Grid Lines v

Layout Sketch
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The Sketch group in the Form tab has two options: Show Grid Lines and Arrange.
The Arrange menu allows you to align groups of form objects relative to each

other.
— [o]a] Row Settings ~
on
Show frErEE Column Settings ~

Grid Lines v
ket |7 Align Left
jform‘l |:[| Align Center
[1 align Right
O Align Top
i align Middle
| Align Bottom

Sketch Grid

The Show Grid Lines option displays a sketch grid to which objects are snapped.
Note that the grid used in sketch layout mode is different from the grid used in
grid layout mode. The default setting for sketch layout mode is to show no grid
lines. Without grid lines visible, a form object being dragged is snapped relative to

the position of the other form objects.

If the Show Grid Lines option is selected, the upper left corner of a form object
being dragged is snapped to the grid line intersection points.

Grid pr on
=
1T Sketch

Show  Amange nsert
Gridlines - -

Layout Sketeh
Q) Preview  [Jforml x

v

>

Length: 9 e
Width: 5 em
Applied voltage: 20 mv
Temperature: 0001235 K

Compute

>
Show Test P

P Preview
Errors Application  Cha

Form

Editor Errors Test

laa@a-@ -tk ¢ <-B- DED @8



In the Settings window of the form, you can change the settings for the sketch
grid:

Column width

Row height

Align grid to margin

Snap zone

- Aslider allows you to change the snap zone size from Small to Large

Snap only to grid

- Clear this checkbox to snap both to the grid and the position of other form
objects

v Sketch Grid

Column width: 100
Row height: 20
[] Align grid te margin

Snap zone:
o .

Small Large

Snap only to grid

Position and Size

The sketch layout mode is pixel based, and the positioning of form objects is
indicated as the coordinates of the top-left corner of the form object measured
from the top-left corner of the screen. The x-coordinate increases as the object
moves to the right, and the y-coordinate increases as the object moves from the
top of the screen to the bottom. You can set the absolute position of a form object
in the Position and Size scction of its Settings window.

~ Position and Size

Width: Manual A
20

Height: Manual A
20

Positionx: 180

Positiony: 240

Form objects are allotted as much space as required or as specified by their Width

and Height values. Form objects are allowed to overlap, when working in sketch
layout mode.
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Button and toggle button form objects have an Automatic and Manual option for
the Width and Height values. The Manual option allows for pixel-based input and
the Automatic option adapts the size of the button to the size of the Text string.

GRID LAYOUT
Switch to grid layout mode by clicking Grid in the Layout group in the ribbon.

@ Grid Row Setti nsert ~ v ells n@j Rows & Columns

1T Sketch

Layout Sketch Grid

The buttons and menus in the ribbon Grid group give you easy access to
commands for:

+ Changing the row and column growth rules between Fit, Grow, and Fixed,
which determine the layout when the user interface is resized (Row Settings
and Column Settings).

 Inserting or removing rows and columns (Insert and Remove).
» Aligning form objects within grid cells (Align).
* Merging and splitting cells (Merge Cells and Split Cells).

» Extracting a rectangular array of cells as a subform and inserting it into a new
form (Extract Subform).

e Defining the number of rows and columns (Rows & Columns).
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The Form Settings Window and the Grid
After switching to grid layout mode, the form window shows blue grid lines.

[&] Preview [ mainComputer X
v

- e———
Form i
A = 8 W B o B 2
| Geometry ~ Compute Plot Sound Report Reset Help Home |
Geometry & Material

ea@-@ -k ¢r <-B-r BEN @3
| M Find prong lengtly

Target freguency: 440 Hz
Frequency tolerance: 01 Hz
Prang length: L, 75 mm
Radius: ro 25 mm
Material: Steel b
|
[ S
| S—t
Tr
Sound
Play sound when computed
Sound duration: 1 s
Computed frequency: 0 Hz

To define the number of rows and columns, click the Rows & Columns button in
the ribbon.

3 Rows & Columns *

Rows: 17
Columns: 7

0K Cancel
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The section Grid Layout for Contained Form Objects in the Settings window shows
column widths and row heights.

~ (Grid Layout for Contained Form Objects

" Column | Width Size
1 Fit v |N/A
2 Fit v [ N/A
3 Fit v |[N/A
4 Fit v |N/A
5 Fixed ~ |96

6 Fit v |N/A
7 Grow v [ N/A
" Row Height Size
1 Fit v | N/A
2 Fit v |N/A
3 Fit v [ N/A

To interactively select a form, as displayed in the Form Editor, click the top-left
corner of the form.

Georr

A blue frame is now shown. To interactively change the overall size of a form, you
can drag its right and bottom border. The form does not need to be selected for
this to work.

Note that if you switch from sketch to grid layout mode, all rows and columns will
have the setting Fit and the handles for the frame will not be displayed. If any of
the rows and columns have the Height or Width sctting set to Grow, then the frame
will display handles for resizing in the vertical or horizontal direction, respectively.
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The size of the interactively resized frame will affect the initial size of the form only
if the Initial size setting is set to Automatic. The size of the frame will also affect the
initial size of the Main Window if its Initial size setting is set to Use main form’s size.

Settings

Form

form1
l:‘ main

Default =
Show in Model Builder

MName:
Title:

lcon:

~ Size

Initial size: Automatic

| Automatic

> Margin panyal

Rows and Columns

Settings
Main Window
~ General

Title:
[] Show filename in title
tuning_fork_main_%}l.png - 4+

Classic menu

Tuning Fork

lcon:
Menu type:
Main window type: Single window

Status bar: MNeone

~ Main Form

Form: main hd

Prefer inner scrollbars
v Size

Initial size: Maximized

=

[] Center 0| Maximized

Use main form's size
v About Manual

Click the leftmost cell of a row to select it. The leftmost cells are only used for

selecting rows; form objects cannot be inserted there. When a row is selected, the
Row Settings menu as well as the Insert and Remove commands are enabled in the
ribbon tab. The figure below shows the fourth row highlighted.

Geometry  Compute

Geometry & Material
Find prong Ieng
Target frequency:

Frequency tolerance:

Prong length: L

Radius: r
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Similarly, to select a column, click the cell at the top. This cell cannot contain any
form objects. The figure below shows the third column highlighted. In this case,
the Column Settings menu is enabled in the ribbon tab.

> Form T o
A = |@ m
i Geometry Compute Plot Sound
Geometry & Material
Find prong Ieng
Target frequency: 440 Hz
Frequency tolerance: 0.1 Hz
Prong length: L, |75 = mm

The Row Settings and the Column Settings have the same three options:

* Fit sets the row height or column width to the smallest possible value given
the size of the form objects in that row or column.

* Grow scts the row height or column width to grow proportionally to the

overall size of the form.

* Fixed sets a fixed value for the number of pixels for the row height or column

width.

=

EH Fit Row
% Grow Row
E Fixed Row

r[l‘ Column Settings +
L Ins
HB Fit Column

HE Grow Column

[D] Fixed Column

You can interactively change the row height and column width by dragging the

grid lines.

v

>£\

Geometry

In this case, the number of pixels will be displayed and the Row Settings or Column
Settings growth policy will be changed automatically to Fixed.

120 |



As an alternative to changing the Row Settings or Column Settings from the ribbon,
you can right-click in a row or column (the light-blue area to the left or at the top
of the form) and select from a menu.

I_ E] Local Form o

New Method
Form Objects 3

Scalar 3
Array 1D 3
Array 2D 3

<z» Choice List

Fit Row

Grow Row

Fixed Row

Insert Above

Insert Below

Remove Row

W 80 LD M [0 R He

Extract Subform

Zoom 100% r
Copy as Code to Clipboard 3
SoCut Ctrl+X

E] Copy Ctrl+C

[F] Duplicate Ctrl+Shift+D
= Group Ctrl+G
Delete Del

=[ Rename F2

Settings

B
B Hep F1
The menu shown when right-clicking a row or column also gives you options for

inserting, removing, copying, pasting, and duplicating rows or columns.

Cells

Click an individual cell to select it. A selected cell is shown with deeper blue grid
lines.

he 5 cm

You can select Merge Cells and Split Cells to adjust the cell size and layout of your
form objects.
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When in grid layout mode, you can specify the margins that are added between
the form object and the borders of its containing cell.

~ Position and Size

Harizontal alignment: Fill =

Vertical alignment: Middle =

Minimum width: Manual =
90

Height: 17

Row: 2

Column: 2

Row span: 1

Column span: 3

Cell margin

Cell margin: From parent form -
MNone

> Appearance From parent form

= Custom

In the Settings window of a form object, the Position and Size section has the
following options for Cell margin:
* None
- No cell margins
* From parent form (default)
- The margins specified in the Settings window of the form; See “Inherit
Columns and Cell Margins” on page 128
e Custom

- Custom margins applied only to this form object

If the Horizontal alignment or Vertical alignment is set to Fill and the growth policy
of the column or row allows the form object to be resized, then you can specify a
minimum width or height, respectively. The minimum size can be set to Manual
or Automatic. The Manual option lets you specify a pixel value for the minimum
size. The Automatic option allows for a minimum size of zero pixels, unless the
form object contents require a higher value. The minimum size setting is used at
runtime to ensure that scroll bars are shown before the form object shrinks below
its minimum size.

Depending on the type of form object contained in a cell, the Width and Height
values can be set to Automatic or Manual, as described in “Position and Size” on
page 115.

You can click and drag a rubber box to select multiple cells.
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Aligning Form Objects

The Align menu gives you options for aligning form objects within a cell. You can

also let a form object dynamically fill a cell horizontally or vertically.

||:| Merge Cells
(=}

Align HH split Cel

¥ @ Extract Subform

= Fill Horizentally
E- align Left
Align Center
Align Right

Fill Vertically
Align Top
Align Middle

Align Bottom

As an alternative, you can right-click a form object and select from a context menu.

| ©

Report Reset Help

=

Create Local Method

W

Bme 5 x

Edit Method
Align
Row

Column
Extract Subform

Copy as Code to Clipboard
Cut

Copy
Duplicate
Delete

Settings

Help

=

Home

r Fill Horizontally

4 Align Left

4 Align Center

Align Right

v Fill Vertically
Ctrl+ X Align Top
Ctrl+C Align Middle
Ctrl+Shift+D Align Bottom
Del
F1
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Drag and Drop Form Objects

You can drag and drop form objects to move them. Click a form object to select
it, and then drag it to another cell that is not already occupied with another form
object.

Thermal conductivity:  0.559 W/meK)
Heat of reaction: -84666 Jimol
Compute |

If you drop the object in an already occupied cell, then the objects switch places.

Automatic Resizing of Graphics Objects

If you use one of the more sophisticated Form Wizard templates you will
automatically get a layout with a resizable graphics object.

If you don’t use these templates, then, in order to make the graphics object of an
application resizable, follow these steps:

» Change the layout mode of the form containing the graphics object from
sketch to grid layout mode.

* Change the Height setting for any row covering the graphics object to Grow.
To change this, click the leftmost column of the row you would like to
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access. Then, change the Height setting in the Settings window of the form.
Alternatively, right-click and select Grow Row.

E] Local Form

New Method
Form Objects 3
Scalar r
Array 1D 3
Array 2D 3

<z»  Choice List

e

Fit Row
Grow Row

Fixed Row

Insert Above

W0 M (I ER

Insert Below

mm

.. Remove Row

o

Extract Subform

Zoom 100% r
Copy as Code to Clipboard 3
SoCut Ctrl+X

E] Copy Ctrl+C

[F] Duplicate Ctrl+Shift+D
= Group Ctrl+G
Delete Del

=[ Rename F2

5 Settings

H Hep F1

+ Change the Width for any column covering the graphics object to Grow. To
change this, right-click the uppermost row of the column you would like to
access and select Grow Column.

* Select the graphics object and change both the Horizontal alignment and
Vertical alignment to Fill. You can do this from the Settings window or by
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right-clicking the graphics object and selecting Align > Fill Horizontally and
Align > Fill Vertically.

Create Local Method

Align 3 Fill Horizontally
Row v o Align Left
Column 4 Align Center
r5l Extract Subform Align Right
Copy as Code to Clipboard » Fill Vertically
g6 Cut Ctrl+X Align Top
[ Copy Ctrl+C Align Middle
|_:E| Duplicate Ctrl+Shift+D :  Align Bottom
M Delete Del
5 Settings
Help F1

Following the steps above, you may find it easier to make graphics objects
resizable by performing grid layout mode operations, such as adding empty rows
and columns as well as merging cells. If you are already in grid layout mode, then
a graphics object will default to Fill in both directions.

Extracting Subforms

You can select a rectangular array of cells in a form and move it to a new form.
First, select the cells by using Ctrl+click or Shift+click.

Sound

Play sound when computed

Sound duration: 1 5
Computed frequency: 1] Hz

Then, click the Extract Subform button in the ribbon.

Merge Cells B Rows & Col
|D|:| erge Ce mE ows & Columns
. Split Cell
Align e
¥ @ Extract Subform
Grid
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This operation creates a new form with the selected cells and replaces the original
cells with a form object of type Form. In the Settings window of the subform, the
Form reference points to the new form containing the original cells.

[Q] Preview  [[] mainComputer
v

Geometry & Material

Find prong Ieng
Target frequency:

Frequency tolerance:

Prong length: L
Radius: r
Material:

[ mainComputer: form1

I
]

I
N

3

S M M |

———.

Sound

Play sound when computed

r

Sound duration:

Computed frequency:

1
o

Hz

@ Preview D mainComputer

A

Sound duration:

Computed frequency:

D mainComputer: form1 X

Hz

Settings

Form

Name:  subform3 =
Form: [= form1 = | =

[] Add border

~ Position and Size
Horizontal alignment:  Fill
Vertical alignment: Fill

Minimum width: Automatic

Minimum height: Automatic
Row: 12
Colurmn: 1
Row span: 2
Colurmn span: 4
Cell margin
Cell margin: None

~ Appearance

Visible
Enabled
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Inherit Columns and Cell Margins

By using subforms, you can organize your user interface, for example, by grouping
sets of input forms. The figure below shows part of a running application with two
subforms for Beam dimensions and Reinforcement bars.

Beamn dimensions

Height of the beam: 200[mm] m
Width of the beam: 300[mm] m
Length of the beam: 4[m] m

Reinforcement bars

Diameter of the bar: 10[mm] m
MNumber of bar layers: 2

Layer spacing: 20[mm] m
Distance from surface of first rebars layer: 10[mm] m
Width spacing: 60[mm] m
Minimal lateral distance from rebars to beam

surface: 10[mm] m
MNumber of bars across the width: 5

For more information on adding subforms to a form, see the previous section and
“Form” on page 280.

When aligning subforms vertically, as in the example above, you may want to
ensure that all columns are of equal width. For this purpose, you can use the
Inherit columns option in the Settings window of a subform. The figure below
shows part of the Settings window for the Beam dimensions subform (left) with
Name geometry_beam and for the Reinforcement bars subform (right) with Name
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geometry_rebars. The geometry_rebars subform has its Inherit columns set to
geometry_beam.

Mame: geometry_beam

Title: Beamn dimensions

-

"

Size

Margins

Dialog Settings
Section Settings

Grid Layout for Contained Form Objects

Colurnn Width Size
1 Fixed - | 280
2 Fixed ~ | 100
3 Fixed - | 45
4 Grow - || N/A
" Row Height Size
1 Fit - || N/A
2 Fit MILTES
3 Fit - || N/A
Inherit columns: | Mone -

Cell margins

Horizontal: 5

Vertical: 3

Mame: geometry_rebars
Title: Reinforcement bars
Size
Margins
Dialog Settings

Section Settings

¥ Grid Layout for Contained Form Objects

" Row Height
Fit

Fit
Fit
Fit
Fit
Fit

~ @ | e w |

Fit

Inherit columns: | geometry_beam
Cell margins

Horizontal: 5

Vertical: 3

Size
N/A
N/A
N/A
N/A
N/A
N/A
N/A

In the subsection Cell margins, you can specify the Horizontal and Vertical margins
that are added between form objects and the borders of their containing cells.

These settings will affect all form objects contained in the form, with their
individual Cell margins sct to From parent form; Sce “Cells” on page 121.
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Show Errors

When using the Form Editor or Main Window Editor, there is a toggle button
Show Errors in the ribbon.

ows & Columns »
Show Test
Errors Application
Editor Errors

@ Preview D form1 X

v

Length: 9 cm
Width: 5 cm
Applied voltage:

cm
Temperature: 0.00125?K

When enabled, any object that is in an error or warning state, for example, a
missing source for an input field object, will show an icon in the corner of that
object. This makes it easy to locate errors in a form or main window design. By
default, the Show Errors button is disabled.

Copying Between Applications

You can copy and paste forms and form objects between multiple COMSOL
Multiphysics sessions running simultaneously. You can also copy and paste within
one session from the current application to a newly loaded application.

In grid layout mode, a cell, multiple cells, entire rows, and entire columns may be
copied between sessions.

When you copy and paste forms and form objects between applications, the copied
objects may contain references to other forms and form objects. Such references
may or may not be meaningful in the application to which they are copied. For
more information on the set of rules applied when pasting objects, see “Appendix
B — Copying Between Applications” on page 326.

When copying and pasting between applications, a message dialog will appear if a
potential compatibility issue is detected. In this case, you can choose to cancel the
paste operation.
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Using Forms in the Model Builder

Forms without graphics form objects can be used in the Model Builder. You can
use this functionality to create customized Settings windows for, for example,

common or repetitive tasks.

To use a form, right-click Global Definitions and select the form under Settings

Forms.

~ & busbar.mph (root)
v (1) Global Definitions
Fi Parameters 1
4 Default Model Inputs
=) Materials
> [l Component 1 {comp1)
» ~db Study 1
v {E| Results
Datasets
=L~ Views
> 2% Derived Values
> [ Tables
h. Color Tables
Nl Electric Potential (ec)
I'.’ Electric Field (ec)
VB Temperature (ht)
V@ Current Density
Export
[# Reports

o v

Pi

Parameters

Variables

Variable Utilities

Equation Contributions
Functions

Geometry Parts

Mesh Parts

Default Model Inputs
Materials

Load and Constraint Groups
Reduced-Order Modeling
Thermodynamics
Parameter Estimation
Cosimulation for Simulink
Method Calls

Settings Forms

Extra Dimensions

Show More Options...

Mode Group

|

busbar_controls_form

You can control whether a form should be visible or not in the Model Builder as
a Settings Form via the Show in Model Builder checkbox. This checkbox is available
in the Application Builder in the Settings window of the corresponding form.

Settings

Form

Mame:  busbar_controls_form
Title: l:‘ Busbar Controls

lcon: Default
Show in Model Builder
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Once added to the model tree, the form is shown as a Settings window, shown in
the figure below.

Model Builder Settings
“— ® St iy W Bushar Controls
o ®
~ & busbar.mph (root)
v () Global Definitions Length: 9 cm

Fi Parameters 1 Width: 5 em
45 Default Model Inputs P 20 v
=) Materials pRied valtage: m
™ Busbar Controls 1 Temperature: 3304 K

> [l Component 1 {comp1)
» ~db Study 1

v {E| Results

Datasets

|~ Views

> 2% Derived Values
> [ Tables
h. Color Tables

>£\

Geometry

Compute

» I'.’ Electric Potential (ec)
» I'.’ Electric Field (ec)

To show a Settings Form you can:
 Click the corresponding model tree node.

» Select it from the Settings Form menu button in the Developer tab in the
ribbon.

+ Show it as a dialog by selecting it from the Show Dialog menu button in the
Developer tab in the ribbon.

Developer
r
Stop Break Java Sett
v Shell For
“ode

For reusing a Settings Form between sessions, you can create an Add-in. For more
information, see “Creating Add-ins” on page 225.
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Inputs

When starting an application from the operating system command line, you can
provide input arguments. In the application tree, you specify such input
arguments under the Inputs node.

Application Builder -
— Etv Elv ¥~ |E|

v [&] my_app_input.mph (root)
v ﬁ Inputs
freq
% Themes

¥ D Main Window

Command-line arguments are automatically written to the declarations you define
as Selected source, in the corresponding Settings window for an Application

Argument. They can be used, for example, to provide input data or configuration
settings.

Settings
Application Argument
Name: freq
* Source ®
4 = Declarations
[ Boolean
[» 123 Integer
4 122 Double
123 fg
153 targetfq
123 ftol
apc String

Use as Source Edit Mode
Selected source:

123 Double=targetfq

¥ Help Text

The target frequency of the simulation.

Command-line arguments can be used when starting applications with COMSOL
Multiphysics, COMSOL Server, as well as when starting applications that have
been compiled with COMSOL Compiler. In the example below, for a compiled
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application in Windows®

value 400.

, an input argument freq is given that takes a (double)

BEX Administrator: Command Prompt — O »

For COMSOL Multiphysics, the corresponding command would be
comsol.exe -run myapp.mph -appargnames freq -appargvalues 400
When running this command, you need to be positioned in the COMSOL

Multiphysics installation directory where the executable comsol. exe is located, for
example

C:\Program Files\COMSOL\COMSOL63\Multiphysics\bin\win64
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Alternatively, you can copy and paste the COMSOL Multiphysics 6.3 Windows®
Desktop shortcuticon (in order to keep the original shortcut), right-click the icon,
and select Properties; as shown in the figure below.

= ~

12 COMSOL Multiphysics 6.3 Properties *
Security Details Previous Versions
General Shortcut Compatibility
}] COMSOL Muttiphysics 6.3

Target type: Application

Target location: wing4

Target: OMSOLEI Multiphysicsbinwinb4\comsol exe'|
Start in: "C:\Program Files\COMSOLNCOMSOLE3 \Multiph

Shortcut key:  [MNone

Run: Nomal window e
Comment:
Open File Location Change Icon... Advanced...

(al'8 Mannal Arrh
You can, for example, modify the Target text field to be:
"C:\Program Files\COMSOL\COMSOL63\Multiphysics\bin\win64\comsol.exe" -run
myapp.mph -appargnames freq -appargvalues 400

To provide input arguments with special characters, you need to use single quotes.
The following example of a compiled application shows how to provide a file path,
such as for a configuration file, as an input argument:

myapp.exe -appargnames configfile -appargvalues 'C:\\COMSOL\\my_conf.dat'

If you have multiple input arguments, they are separated by commas, for example:

myapp.exe -appargnames a,b,configfile -appargvalues
3.2,5.4,'C:\\COMSOL\\my_conf.dat'

For COMSOL Server, you can provide the arguments directly in the address field
of your browser (URL); for example:
http://<host:port>/app/myapp_mph?appargnames=freq&appargvalues=400

You can also use a file declaration as an input argument. This is useful, for example,
when you want to let users supply input files. For example:
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comsol.exe -run file_arguments.mph -appargnames interpfile -appargvalues
'C:\data\functions\simpleinterp.txt'

This example uses an application argument interpfile, which is linked to a file
declaration to read the interpolation file simpleinterp.txt when launching the
application. This file is then used in an interpolation function in the application’s
embedded model.

Note that in order to use units, you need to use nested quotes. For example,
-appargvalues "'500[m]','500[s]'".
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The Main Window Editor

In the application tree, the Main Window node represents the main window of an
application and is also the top-level node for the user interface. It contains the
window layout, the main menu specification, and optional ribbon, and
subwindow specifications. The Main Window Editor, visible whenever the Main
Window node is active, lets you design menu bars, ribbon tabs, and subwindows.

GENERAL

The Settings window contains a General section with the following settings:
o Title

¢ Show filename in title

* lcon

¢ Menu type

* Main window type

+ Status bar

Settings

vial

~ General

Title: Helical Static Mixer
Show filename in title

lcon: Default = &

Menu type: Ribbon >
Main window type: Single window -
Status bar: Progress .

The Title is the text at the top of the main window in an application, with the Icon
shown to the far left of this text. By default, the Title is the same as the title of the
model used to create the application. Keep the Show filename in title checkbox
selected if you wish to display the file name of the application to the left of the
Title.

In the leon list, select an image from the library or add an image (*.png) from the
local file system to the library and use it as an icon. If you add a new image, it will
be added to the image library and thereby embedded into the application. You can
also export an icon by clicking the Export button to the right of the Add Image to
Library and Use Here button.
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The Main Window node of the application tree has one child node, named Menu
Bar. Using the Menu type setting, you can change this child node from Classic menu
to Ribbon.

The Main window type sctting lets you select the type of application layout:
Subwindows or Single window. The Subwindows option makes it possible to
organize forms into subwindows that, while the application is running, can be
detached and docked.

The Status bar list controls what is shown in the status bar. From the list, select
the Progress option to display a progress bar, otherwise, select None. Note that you
can also create custom progress bars by writing method code.

MAIN FORM

The Main Form section is visible if the Main window type is sct to Single window. It
contains a reference to the form that the main window displays.

~ Main Form

Form: settings > | |2

Prefer inner scrollbars

This setting is important when using a form collection because it determines
which form is displayed as the main window when the application is opened for
the first time.

WINDOW LAYOUT

The Window Layout section is visible if the Main window type is sct to Subwindows.
¥ Window Layout

Column Width
1 50
2 130

Row Height
1 100
[] Allow dragging between subwindows

[] Show form header in subwindows with a single form

Subwindows can be defined in the lower part of the Main Window Editor. You
work with subwindows in a way that is similar to forms when in grid mode. For
more information, see “Subwindows” on page 146.
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SIZE

In the Size section, the Initial size setting determines the size of the main window
when the application is first started.

~ Size

Initial size: Maximized =

[] Center on screen
There are three Initial size options:

* Maximized results in the window being maximized when the application is
run.

» Use main form’s size uses the size of the main form; See “The Individual Form
Settings Windows” on page 54. The main form is defined by the Main Form
section. This option further adds the size required by the main window
itself, including: the window frame and title bar, main menu, main toolbar,
and ribbon. This size is computed automatically.

* Manual lets you enter the pixel size for the width and height. In this case,
nothing is added to the width and height. When using this option, you need
to ensure that there is enough room for the window title, ribbon, and menu

bar.

In addition, there is a Center on screen checkbox that is applicable to any Size
setting that does not correspond to a maximized window.

When the Main window type is sct to Subwindows, the Use main form's size option
is not applicable and is therefore removed. In this case, the Initial size is changed
to Maximized.

For more information on the Use main form’s size option, see “The Form Settings
Window and the Grid” on page 117.

ABOUT DIALOG

The About Dialog scction contains settings for customizing parts of the About This
Application dialog, which contains legal information.
~ About Dialog

Placement: Automatic =
Show COMSOL information

Custom text:

The Placement option lets you choose between Automatic, File menu, Ribbon,
Lower-right corner, or Lower-left corner. The Lower-right corner and Lower-left
corner options will place a hyperlink referencing the About This Application dialog
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in the corresponding corner of the application user interface. If selected, the Show
COMSOL information checkbox will display the COMSOL software version and
product information. Any text entered in the Custom text field will be displayed
above the legal text in the dialog. In the Custom text field, words containing https
or www will be interpreted as hyperlinks, if possible. For example,
https://www.comsol.com or www.comsol.com will be replaced with a hyperlink.

LANGUAGE LOCALIZATION
The Language Localization section contains settings for the localization of the
application.

¥ Language Localization

Localization

Language: | From preferences -

From preferences

tubular_reactor_en_US.properties (English)
tubular_reactor_de_DE.properties (German)
tubular_reactor_zh_CM.properties (Chinese, Simplified)

The Localization setting determines whether the application should be localized
using language files or not and is disabled by default. The Language setting
specifies the language files that are used for localization. By default, the From
preferences option is selected and the language used when running the application
is determined by the language preference setting in COMSOL Multiphysics,
COMSOL Server, or a compiled application. For more information on
localization, see the Application Builder Reference Manual.
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Menu Bar and Toolbar

The Menu Bar node can have Menu child nodes that represent menus at the top
level of the Main Window.

4 [&] Untitled.mph [root)

ﬁ Inputs
% Themes

- D Main Window
- E Menu Bar
4 [Z] File {menu}
El Save {item1}
El Save As {item2}
EI Menu 2 {menu2}
EI Menu 3 {menu3}
b B Forms
Events
[ = Declarations
I [y Methods
b [ Libraries

For the Menu Bar option, you can also add a Toolbar node. The Toolbar node and
the Menu nodes have the same type of child nodes.

4 [&] Untitled.mph [root)

ﬁ Inputs
% Themes

- D Main Window
- E Menu Bar
4 [Z] File {menu}
El Save {item1}
El Save As {item2}
EI Menu 2 {menu2}
EI Menu 3 {menu3}
i Toolbar
b B Forms
Events
[ = Declarations
I [y Methods
b [ Libraries
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MENU, ITEM, AND SEPARATOR

The child nodes of the Menu and Toolbar nodes can be of type Menu, Item, Toggle
Item, or Separator, exemplified in the figure below:7

4 [&] Untitled.mph [root)
E Inputs
% Themes

- D Main Window
- E Menu Bar
4 [Z] File {menu}
El Save {item1}
El Save As {item2}

=]

El Report {item3}

[ Exit {itemd}
4 EI Menu 2 {menu2}
] ttem 1 fitem1}
Toggle ltem 1 {toggle_item1}
@ Menu 3 {menu3}
4 ¥u Toolbar

] ttem 1 fitem1}

4 EI Menu 1 {menul}
[ ttem 1 fitem1}
Toggle ltem 1 {toggle_item1}

[ % Forms
A Menu node has settings for Name and Title.

ettings

v

MName:  menul

Title: Menu 1

A Menu node can have child Menu nodes that represent submenus.

A Separator displays a horizontal line between groups of menus and items, and has
no settings.

The Settings window for an Item node is similar to that of a button and contains a
sequence of commands. Just like a button, an item can have associated text, an
icon, and a keyboard shortcut. For more information, see “Button” on page 66.
In a similar way, the Settings window for a Toggle Item node is similar to that of a
toggle button.
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The figure below shows the Settings window for an Item associated with a method
for saving an application using the command Save Application As.

Settings = L1
Mame: savels E
Text: Save As

lcon: [4] save_as.png - |+ =

Keyboard shortcut:  CTRL+ALT+5
State

Visible

Enabled

» (Choose Commands to Run B

b B Forms
4 @ GUI Commands
- File Commands
Save Application
[ Save Application As
Save Application on Server

Edit Mode P Run Plot Set Value Show
Show as Dialog Import File Enable

Disable
L

Command lcon | Arguments
Save application as =

M-

The figure below shows an example of an application with a File menu.

File
Save Ctrl+5
@ Save As Ctrl+ Alt+5 >Z—\
(i) About rometry

You can enable and disable ribbon, menu, and main toolbar items from methods.
For more information, see “Appendix E — Built-In Method Library” on page
353.

Ribbon

You can opt to add a Ribbon node to the Main Window instead of a Menu Bar. The
Ribbon node contains the specifications of a ribbon with toolbars placed on one or

| 143



several tabs. For the Ribbon option, a File menu is made available directly under the
Main Window node.

RIBBON TAB AND RIBBON SECTION

Child nodes to the Ribbon node are of the Ribbon Tab type. Child nodes to a Ribbon
Tab are of the Ribbon Section type. Child nodes to a Ribbon Section can be of the
Item, Toggle Item, Menu, or Separator type.

The Item and Menu options provide the same functionality as described previously
for the Menu Bar and Toolbar. A Separator added as a child to a Ribbon Section is a
vertical line that separates groups of Items and Menus in the running application.
A Separator is displayed as a horizontal line in the application tree. The figure
below shows an example.

4 E] tubular_reactor.mph (root)
ﬁ Inputs
% Themes

- D Main Window
4 [F] FileMenu
El Save {save} 4:. — @
4 EI%;::EAS fsavels) Reset Compute Report  Help
4 ™ Home {home}
- Input {input}
El Reset {reset}
4 Simulation {simulation}
El Compute {compute!
4 Documentation {documentation}
El Report {report!
5] Help {help)

File Home

Input | Simulation | Documentation

b B Forms
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Interactive Editing of Menus and Ribbon Tabs

When creating menu and ribbon items, you can interactively position them in the
Main Window Editor by dragging.

App 'Cet'on Bu' der Al ! @ Preview D Main Window X

cotLE

Type filter text (& C
~ li_battery_pack_designer.mph (root) Bary Battery Compute FAJE
ﬁ Inputs Cell Pack Parameters C
% Thernes MNavigation
v D Main Window
> [E File Menu
~ [+ Ribbon = )
v [™] Home {homeTab) Battery Cell  Battery Pacl

v MNavigation {navigationSection}
Battery Cell {batteryCeliToogle}
Battery Pack {batteryPackToogle} Battery capacity:

v Battery Cell {batteryCellSection}

El Compute Parameters {computeParameters}
El Open Circuit Voltage {openCircuitVoltage}
El Experimental Data {experimentalData}

¥ Properties

Reference temperature:

¥ Open Circuit Voltage

You can right-click the Main Window Editor, for example, a ribbon section, and
add additional items from a context menu.

@ Preview D main D Main Window X

(I Open Circuit Voltage (7] Cell Voltage ™ — D] {7} Slice
b

- / Experimental Data (]} Voltage Losses A - |~ Graph
Battery Battery Compute Update Mesh Compute Temperature R
Cell Pack Parameters Cell State-of-Charge Mesinn Animate
Mavigation Battery Cell E’ Menu y Pack
Battery Cell (5] item
. & Toggle ltem

~ Properties e M| ™
E Separator

Battery capacity: 4 Ah

Copy as Code te Clipboard 3

Reference temperature: 25 qE
5/6 Cut Ctrl+X

* Open Circuit Voltage B Copy CtrlsC

b =

State-of-charge (1) Open circuit voltage (V) [ Pasteltem Ctrl+V
[F] Duplicate Ctrl+Shift+D
[ Delete Del
=[ Rename F2
E Settings
L+t SsSVvEDQ Properties

Help F1

w Experimental Data
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Subwindows

You can organize your forms and form collections into subwindows that can be
resizable and detachable. In the Main Window node, if you change the Main window
type to Subwindows, the lower part of the Main Window Editor becomes a
workspace for the layout of subwindows.

fude: 0001235 um
ook

21908 23268

Note that the New Form Wizard templates Basic, Subwindows, sections, and
graphics; and Subwindows, tabs, and graphics will create applications containing
subwindows.

The Main Window Editor has a window scale feature, available in the lower left
corner. Use this to get a better overview of the subwindow layout.

25%
508
75%
100%
150%
200%
300%
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The Window Layout section is visible if the Main window type is sct to Subwindows.

- 1 X
¥ General

Title: Helical Static Mixer

Show filename in title

lcon: Default ~| |4
Menu type: Ribbon =
Main window type: Subwindows =
Status bar: Progress =

¥ Window Layout

Column Width
1 50
2 130

Row Height
1 100
[] Allow dragging between subwindows

[] Show form header in subwindows with a single form

Working with subwindows is similar to working with forms in grid mode. You can
insert columns to the left and to the right of existing columns. Rows can also be
added above and below existing rows, and rows and columns can be deleted. Grid
cells can be merged and then split again. On the ribbon of the Main Window
Editor, there is a Rows & Columns button that enables you to quickly create a layout
with a specified number of rows and columns.

The sizes of the rows and columns can be specified interactively by dragging. They
can also be specified manually in the Window Layout section, in the Settings
window of the Main Window.

The column width and row height settings are not interpreted as absolute width
and height, but rather summed together, and each individual row and column size
is then interpreted as a fraction of the total size. A percentage value is displayed in
the column and row headers in the Subwindows layout area.

The Allow dragging between subwindows setting controls whether forms can be
dragged and moved between the different parts of the subwindow area.

The Show form header in subwindows with a single form setting controls whether
to the forms, which are alone in a subwindow, should have a header. This setting
is only available when dragging between subwindows is disabled.

Only one type of object can be placed in each of the grid cells used to define the
window layout. This is called a subwindow object and is automatically added to a
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grid cell as soon as it is created. The Settings window for a subwindow object is
shown in the figure below.

LA

ettings v RX

Subwindow
¥ Forms

4 B Forms

D operatingConditions
D geometry

D results

D information

Add to Subwindow Edit Mode

" L. Vertically
Form Initially open | Closable <crollable

D settings ~ O ~

Default form: settings =

This Settings window makes it possible to set which forms that are open in
different subwindows. In the table below the model tree in the Forms section, you
can specify if the form is Initially open in the subwindow, if it is Closeable, and if it
is Vertically scrollable. A form that is Closeable will have a cross icon in the window
title for closing it.

Since a form can only be shown in one subwindow, the Forms section, containing
the available forms, is filtered to only show forms that have not yet been added to
a subwindow. Also, the Forms section only shows global forms and not local forms.

When starting an application, each form that has been added to the Forms section,
and where the checkbox in the Initially open column is selected, is shown in the
corresponding subwindow. The Title of the form is used as the title on the
corresponding tab.

The Default form sctting specifies which form is initially active in the subwindow
when launching the application.
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Events

An event is any activity (for example, clicking a button, typing a keyboard
shortcut, loading a form, or changing the value of a variable) that signals a need
for the application to carry out one or more actions. Each action can be a sequence
of commands of the type described earlier, or may also include the execution of
methods. The methods themselves may be local methods associated with
particular forms or form objects, or global methods that can be initiated from
anywhere in the application. The global methods are listed in the Methods node of
the application tree. The form methods are listed under the nodes of the respective
form. The local methods are defined in the Settings windows of the forms or form
objects with which they are associated. When a form object has an associated
method, it may be opened for editing by performing a Ctrl+Alt+click on the
object. If the Ctrl+Alt+click is performed on a form object that has no method,
then a new local method, associated with the object, will be created and opened
for editing.

The events that initiate these actions may also be global or local. The global events
are listed in the Events node of the application tree and include all events that are
triggered by changes to the various data entities, such as global parameters or
string variables. Global events can also be associated with the startup and
shutdown of the application. In addition, Timer events can be used to periodically
trigger events based on a set time interval (delay). The local events, like local
objects, are defined in the Settings windows of the forms or form objects with
which they are associated.

Event nodes trigger whenever the source data changes, regardless of if it is changed
from a method, form object, or in any other way. Events associated with form
objects only trigger when the user changes the value in the form object.
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Events at Startup and Shutdown

Global or local methods, as well as command sequences, can be associated with
the events at startup (On startup) and shutdown (About to shutdown) of an
application. To access these events, click the Events node in the application tree.

Application Builder Settings
- t Etv Elv B~ 3 Events

v Events
v [&] tuning_fork.mph (root)
ﬁ Inputs On startup: runOnStartup ~| B+~
% Themes
¥ D Main Window
> B Forms
Events
» = Declarations
> [ Methods
» [ Libraries

About to shut down: runOnShutdown - Bt~

A shutdown event is triggered when:

* The user of an application closes the application window by clicking the Close
Application icon in the upper-right corner of the application window

» The Exit Application command is issued by a form object

* A method is run using the command exit()

A method run at a shutdown event can, for example, automatically save critical
data or prompt the user to save data. In addition, a method run at a shutdown
event may cancel the shutdown by returning a Boolean true value.

LIMITATIONS WITH ON STARTUP EVENTS

Methods used for an On startup event cannot utilize Application Builder
functionality related to graphics or user interfaces. This is due to the fact that an
On startup cvent is run before the full application user interface is loaded. For
example, a method that is used for initializing graphics, such as Zoom Extents,
needs to be run as an On load event for a form and not as a global On startup event.
Another example is showing a dialog using a built-in method such as confirm. In
this case, no dialog will be shown and the operation will simply be ignored.

Global Events

Right-click the Events node and choose Event to add an event to an application.
An event listens for a change in a running application. If a change occurs, it runs
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asequence of commands. In the figure below, when the value of the string variable
SpanWidth is changed, the method setResultsStatus is run.

I U Forms
4 [E Events

event]

event?
O event3
O eventd
O events
O events
O event?
O event?
O events
B eventld
O eventll
O event12
O event13
I = Declarations

w Source for Data Change Event el

I = Declarations
4 & Model (root)
4 () Global Definitions
4 P Parameters 1

12 Width of one span (SpanWidth)
123 Number of spans (NumSpans)
123 Total length of beam (TotLength)
123 Beam height (BeamHeight)
123 Beam thickness (BeamThickness)
123 Intensity of the pressure load (LoadIntensity)

Use as Source Edit Node
Selected source:

123 Parameters 1=Width of one span (SpanWidth)

o

v Choose Commands to Run B

[ Forms
u GUI Commands

= Declarations
Methods
compute
setResultStatus
reportState
updateDisp2d
updateDispld
updateResult
animate

3
3
3
pl

Edit Node Run Plot Set Value Show
Show as Dialeg Import File Enable Disable

"
Command lcon  Arguments
setResultStatus

Note that since this type of event has global scope and is not associated with a
particular form, the full path: /form1/graphics1 needs to be used when
referencing graphics objects.

The following two sections describe the options available in the Settings window

of an event.

SOURCE FOR DATA CHANGE EVENT

This section presents a filtered view of the tree from the Application Builder
window. The nodes represent some sort of data or have children that do.
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You can extend the list of available data nodes by clicking on the Switch to Model
Builder and Activate Data Access button in the header of the section Source For Data
Change Event.

~ Source for Data Change Event @ B

N Switch to Model Builder and Activate Data Access |

»

Dec
Model (root)

en

For more information, see “Data Access in the Method Editor” on page 192.

Note that Explicit selections are also allowed as Source for Data Change Event. This
allows a command sequence or a method to be run when the user clicks a
geometry object, domain, face, edge, or point. The figure below shows a dialog
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for a global event that opens a form panel as a dialog when the user changes the
contents of the Explicit selection named Outlet Boundaries.

X

LA

etting

(%]

Mame: eventl
+ Source for Data Change Event @ B

= Declarations
4 & Model (root)
I () Global Definitions
4 |§ Component 1 (comp1)
4 = Definitions
[
4

2= Variables 1
& Selections
& Inlet Boundaries
ﬁ Outlet Boundaries
% All Fluid Domains

@_‘ Use as Source =g Edit Node
Selected source:

& Outlet Boundaries

» (Choose Commands to Run 5

4 B Forms
D main
D cad
D mesh
D transport
D flow
D results
D panel

I @ GUI Commands

=# Edit Node Run Plot Set Value I:l Show
[Z] Show as Dialeg Import File Enable Disable

L
Command lcon | Arguments
Show panel as dialog

=% . -

CHOOSE COMMANDS TO RUN

In the Settings window for an Event, the section Choose Commands to Run is similar
to that of a button and allows you to define a sequence of commands. For more

information, see “Button” on page 66.
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Timer Events

Timer events adds a Timer that controls how often a command sequence is
triggered. This functionality can be used to operate an app as a digital twin. Each
time a delay has elapsed, a command sequence that you define is run. The
command sequence can include method calls, as shown in the figure below.

Settings v RX

(I,

mer

Mame: timerl =
Delay: 2 s
Enabled

¥ Choose Commands to Run =

> B Forms

» [ GUI Commands
¥ Events
v [ Methods

plotFunction
» [ Libraries
» 4 Model (root)

Edit Mode Run [3| Plot Set Value Show

Show as Dialog Import File Enable Disable

L
Command lcon | Arguments

plotFunction @

bg BE -
You can use a Timer that accepts input from various external sources such as a
hardware sensor, an external database, or a web service. Subsequently, it updates
the app based on the acquired data.
In the Delay field, specify the delay time, in seconds, that the timer should wait
before executing the command. The default delay is set to 1 second, determining
the frequency at which the event is triggered.

The Timer is enabled by default. If you want to disable the triggering of timer
events, clear the Enabled box.
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Form and Form Object Events

Form and form object events are similar to global events, but are defined for forms
or individual form objects. These events can have an associated list of commands
in a command sequence, or refer directly to a global, form, or local method.

EVENTS TRIGGERED BY DATA CHANGE

For certain types of form objects, you can specify a method or command sequence
to run when data is changed. This setting is available in the Events section of the
Settings window of a form object, as shown in the figures below.

~ Events

On data change:

On focus gained:
o

~ Events

On data change:

On focus gained:

Mone - + -
Create Global Method
Create Form Method
Create Local Method

Create Command Sequence

method1 - Bt~

MNeone A P2

The drop-down list On data change contains None (the default), any available
methods under the Methods node of the application tree or under the Methods
node of the corresponding form, and a local method or command sequence
(optional).

The form objects supporting this type of event are:

Input Field
Checkbox
Combo Box
Graphics

File Import
Array Input
Radio Button
Text

List Box
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¢ Table
o Slider

Buttons have associated events triggered by a click. Menu, ribbon, and toolbar
items have associated events triggered by selecting them. The corresponding
action is a command sequence defined in the Settings window of a button object
or item. Note, however, that such command sequences can also be used to run
methods. For more information on command sequences, see “Button” on page
66.

INPUT ARGUMENTS

Clicking Create Global Method or Create Form Method will open a dialog where you
can edit the name of the method to be created. Clicking Create Local Method will
create a local method with an automatically created name indicating the form and
type of event, see “Local Methods” on page 207. The method so created has a
first argument called newvalue which is based on the form object type. The
argument added to the method will contain the new value in the form object when
the event is triggered. The newly created method is also selected in the application
tree and opened in the editor area.

For example, assume that you create a method based on an input field that links
to a global parameter, as shown in the figure below.

@ Pre'view Dflow x method! D results Sett',-.gs - X
Input Field

>
Menvelocty [0 dums s =

Editable
Tooltip:

~ Source @+ "B

Declarations
Model (root)
4 () Global Definitions
4 pP; Parameters 1
8.5 |nlet concentration (c0)
8.5 Diffusion coefficient (D)
8.5 Mesh element size parameter (h_max)
5B Mean velocity (U_mean)
a5 |nlet width (a)
== Laminar velocity profile normalization constant (alpha)
=5 Geometry scale ([geometryScale)

Y
$m

Use as Source Edit Node
Selected source:
=5 Parameters 1=Mean velocity (U_mean)
Initial value:  From data source -

Value: 10000
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The Settings window for the method created in this way is shown in the figure
below.

Settings

MName:  method1
Show in Model Builder

~ Inputs and Output
Inputs

L1
MName Type Default Description

newValue String >

The variable newvalue will then contain the new value of the Mean velocity entered
by the user of the app. This functionality makes it possible to write method code
for processing input data and provides a general way of checking the input data in

an app.
Selecting Multiple Form Objects

You can specify an On data change event for multiple form objects simultaneously
by using Ctrl+click and then selecting the method or command sequence to run.
In this way, you can, for example, quickly specify that a data change event initiated
by any of the selected form objects should run a method that informs the user that
plots and outputs are invalid. This functionality is not available for all
combinations of form objects.

EVENTS TRIGGERED BY LOADING OR CLOSING A FORM

Forms can run methods or command sequences when they are loaded (On load)
or closed (On close).

v Events
On load: method1 - Ej + -
On close: method2 - Bt~

This type of event is available in the Settings window of a form and is typically used
when a form is shown as a dialog, or to activate forms used as panes in a form
collection. Note that a method that is used for initializing graphics, such as Zoom
Extents, nceds to be run as an On load event for a form and not as a global On
startup cvent.
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EVENTS TRIGGERED BY FOCUS

Certain form objects can have an On focus gained event, which is similar to an On
data change cvent. This type of event is triggered when the user control associated
with a form object comes into focus, for example, when clicking an input field. In
general, a form object comes into focus when it becomes the target of keyboard
input by the action of a mouse click or when cycling focus using the Tab-key.

~ Events
On data change: MNeone - P2
On focus gained: checklnput ~ Bt

The form objects supporting this type of event are:
¢ Input Field

* File Import

* Text

Using Local Methods

Events can call local methods that are not displayed in the application tree. For
more information on local methods, see “Local Methods” on page 207.
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Declarations

The Declarations node in the application tree is used to declare global variables and
objects, which are used in addition to the global parameters and variables already
defined in the model. Variables defined under the Declarations node are used in
form objects and methods. In form objects, they store values to be used by other
form objects or methods. Variables that are not passed between form objects and
methods, but that are internal to methods, do not need to be declared in the
Declarations node. In methods, variables defined under the Declarations node have
global scope and can be used directly with their name. For information on how to
access global parameters defined in the model tree, see “Accessing a Global
Parameter” on page 216.

You can create a Declarations node that is local to a form. Such Declarations for a
form can only be used in that particular form, including form objects and methods
that are local to the form.

These are the different types of global Declarations:
¢ Scalar

e Array ID

¢ Array 2D

¢ Choice List

* File

 File Type

 Unit Set

¢ Shortcuts

¢ Graphics Data

Form Declarations can only be of the types:
* Scalar

e Array ID

e Array 2D

* Choice List
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Right-click a Declarations node to access the declaration types or use the ribbon.

> B Forms
¥ Events
» = Declarations
> B Methods Array 1D '
» [ Libraries Array 2D 3
<z» Choice List
3 File
Unit Set
[2) File Type
[*] Graphics Data
= MNode Group
H Hep F1

Note that Shortcuts are not created from this menu but by clicking the Create
Shortcut button next to the Name in the Settings window of a form object or by
using Ctrl+K for a selected form object.

To create Declarations that are local to a form, right-click the corresponding form

and select the variable type, as shown below.

E Main Window
4 | Forms

Dform‘l
[ formz Edit

[ form3 New Method

El Events
el ; Declaration Scalar b | =80 String
1::- Integer Array 1D 4 Boolean
i“:f g:zzlll Array 2D b | 123 Integer
285 Array 10 < Choice List 122 Double
b Methods E] Preview Form
b [ Libraries

Copy as Code to Clipboard L4

Variables that are local to a form are organized under a Declarations node that is a
child node to the form, as shown below.

~ [ Forms
v D form1

v = Declarations
== Double

D form2
D form3

Events

The first three types of declarations, Scalar, Array 1D, and Array 2D, can be of the
following data types:

e String

¢ Boolean
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* Integer
* Double

In addition to right-clicking the Declarations node, you can click the Create New

Declaration and Use It as Source button in the Source section of many types of form
objects.

Settings

Input Field

MName:  pronglengthinput =[
Editable

Tooltip:  10-2500 mm

~ Source @+ B

» = Declarati
> A

E1 Create New Declaration and Use It as Source
Model (rooty

This will open a dialog that lets you quickly declare scalar variables.

3 Create and Use Declaration *
MName: var
Data type: String =
Initial value:

0K Cancel

USING DECLARATIONS AS INPUT ARGUMENTS TO COMMANDS

Certain commands used in the commands sequence of, for example, a button can
take an input argument. For more information, see “Button” on page 66.
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The figure below shows a command sequence that includes a Plot Temperature
command with an input argument formi/graphics.

" Command lcon | Arguments 3 Edit Argument X
Compute Study 1 =
= - v [ Forms
form1/graphics1 - D form1
graphics1

t 1 SighE- [#

Edit Argument

@_‘ Use as Argument
Selected argument:
[ graphicsl
QK Cancel

You can use declarations as input arguments to commands.

To use a scalar variable, 1D array, or 2D array as input arguments, you use the
corresponding variable name. To access a single element of an array, or a row or
column of a 2D array, use indexes. For example, to access the first component in
a 1D array my_variable, you use my_variable(1). A 2D array element can be
retrieved as a scalar by using two indexes, for example, my_matrix(2,3). The
indexes can themselves be other declared variables, for example, my_variable(n).

For commands requiring a graphics object as an input argument, only string type
declarations are allowed with appropriate indexes, if necessary. If there is a
graphics object named graphics1 and also a string declaration named graphics1,
then the contents of the string declaration will be used. An exception is if single
quotes are used, such as 'graphics1', in which case the graphics object
graphics1 is used. This rule is also applied to other combinations of commands
and input arguments.

THE NAME OF A VARIABLE

The Name of a variable is a text string without spaces. The string can contain
letters, numbers, and underscores. The reserved names root and parent are not
allowed and Java® programming language keywords cannot be used.
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Scalar

Scalar declarations are used to define variables to be used as strings, Booleans,
integers, or doubles.

STRING

A scalar string variable is similar to a global parameter or variable in a model, but
there is a difference. A parameter or variable in a model has the restriction that its
value has to be a valid model expression, while a scalar string variable has no such
restrictions. You can use a string variable to represent a double, integer, or
Boolean by using conversion functions in a method. For more information, see
“Conversion Methods” on page 366. You can also use a string variable as a source
in many form objects, such as input fields, combo boxes, card stacks, and list
boxes.

The figure below shows the Settings window for the string variables
solutionState and meshSize.

Settings

List of Variables

MName Initial value Description
solutionState nosclution Solution status
1
meshSize normal !The current mesh size

T = = gk .

String declarations, as well as other declarations, can be loaded and saved from or
to a file by using the Load from File and Save to File buttons below the List of
Variables table.

The Load from File and Save to File buttons are used to load and save from/to the
following file formats:

o Text File (.txt)
+ Microsoft® Excel Workbook (. x1sx)
- Requires LiveLink™ for Excel®

* CSV File (.csv)
+ Data File (.dat)
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The drop-down list where these file formats can be selected is shown in the figure
below.

Text File (*txt) -

[ Text File (*tet) |
Microsoft Excel Workbook (*xlsx)
C5V File (*.csv)

Data File (*.dat)

All Files (*%)

To illustrate the use of declared strings, the figure below shows the Settings
window of a card stack object where the string variable viewCard is used as the
source (Active Card Selector).

- L X
MName:  cardstack] =
v Active Card Selector @+ 5

4 = Declarations
4 =oc String

18 viewCard
123 viewText
123 viewText2DRad
123 solution_state
123 geom_state
123 report_format
123 target_state
123 inXpolRatio
123 gutXpolRatio

Use as Source Edit Mode
Selected source:

123 String=viewCard

For more information on using card stacks, see “Card Stack” on page 285.
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BOOLEAN

You can use a Boolean variable as a source in checkboxes, other form objects, and
methods. A Boolean variable can have two states: true or false. The default value
is false. The figure below shows the declaration of two Boolean variables.

Settings

Boolean

List of Variables

MName Initial value Description
validinput true Boolean
P T
geomlnitialization | false |Boolean
= o

Example Code

In the example code below, the Boolean variable bvar has its value controlled by
a checkbox. If bvar is true, then Plot Group 4 (pg4) is plotted in graphicsi.
Otherwise, Plot Group 1 (pgl) is plotted.
if (bvar) {
useGraphics(model.result("pg4"),"graphicsi1");
} else {
useGraphics(model.result("pg1"),"graphics1");

}

INTEGER AND DOUBLE

Integer and double variables are similar to strings, with the additional requirement
that the value is an integer or double, respectively.

Settings Settings
Integer Double
List of Variables List of variables
" 44 . o
Mame Initial value | Description Name Initial value | Description
n_of_digits 3 Mumber of significant digits element_size_low 0.5 Value for course mesh
n_steps 0 Mumber of iterations slement_size_mediu... |0.38 Value for normal mesh
element_size_high 00.25 Value for fine mesh
v -
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Array ID

The Array ID node declares one or more named arrays of strings, Booleans,
integers, or doubles that you can access from form objects and methods. The
number of elements in a 1D array is not restricted in any way, and you can, for
example, use a 1D array to store a column in a table with a variable number of
rows. The Settings window contains a single table, where you specify one variable
array per row. In the figure below, two double arrays are declared, xcoords and
ycoords.

Settings

Array

List of Variables

L]

MName Initial values | Mew element | Description
xcoords 10.2,-0.2,03,0... | 0.0 x-coordinates
ycoords 10.0,1.0,0.0,-1... | 0.0 y-coordinates

t == R +

The values in the column New element value are assigned to new elements of the
array when a row is added to a table form object. Arrays for strings, Booleans, and
integers are similar in function to arrays of doubles.

INITIAL VALUES

The Initial values can be a 1D array of arbitrary length. To edit the initial values,
click the Edit Initial Values button below the List of Variables. This opens a dialog
where the value of each component can be entered. See the figure below for an
example of a 1D array of doubles.

3 Edit Initial Values *

Enter 1D array of doubles:
0.2

-0.2

0.3

0.1

0.96

-0.01

0K Cancel
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ARRAY SYNTAX

An array definition must start and end with curly braces ({ and }) and each
element must be separated with a comma. When you need special characters inside
an array element (spaces and commas, for example), surround the element with
single quotes ('). The table below shows a few examples of 1D arrays:

ARRAY SYNTAX RESULTING ARRAY

{1, 2, 3} A 3-element array with the elements |, 2,
and 3

{} An empty array

{'one, two', 'three by four'} A 2-element array with elements containing
special characters

{{1, 2, 3},{'one, two', 'three by A 2-element array containing a 3-element

four'}} array and a 2-element array

Array 2D

The Array 2D node declares one or more 2D arrays that you can access using form
objects and methods. In the figure below, the 2D double array xycoords is
declared.

Settings

List of Variables

Mame Number of colu  Initial values Mew element value | Description
xycoords 2 - !{{0.3,0.2},{-0.2\.D.d},... 0.0 xy-coordinates
2 =
= - 4

INITIAL VALUES

The default (or initial) value can be a 2D array of arbitrary size. To edit the initial
values, click the Edit Initial Values button below the List of Variables. This opens a
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dialog where the value of each component can be entered. See the figure below
for an example of a 2D array of doubles.

3 Edit Initial Values *

Enter 2D array of doubles:

0.3 0.2
-0.2 0.4
01 0.01
0.4 -0.1
0.004 0.3

-0.55 0.314
t ahll=

0K Cancel

ARRAY SYNTAX

The table below shows a few examples of 2D arrays:

ARRAY SYNTAX RESULTING ARRAY

{{}} An empty 3D array
{{'5"','6"},{'7",'8"}} A 2-by-2 matrix of strings
{{1, 2, 3}, {4, 5, 6}} A 2-by-3 matrix of doubles

For 2D arrays, rows correspond to the first index so that {{1,2,3},{4,5,6}} is
equivalent to the matrix:

123
456

Assuming that the above 2-by-3 matrix is stored in the 2D array variable arr, then
the element arr[1][0] equals 4.

To interactively define the Initial values of a 2D array, select the Undefined option
for the Number of columns. The Edit Initial Values button opens a dialog where the
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number of rows and columns can be interactively changed, as shown in the figure

below.

3 Edit Initial Values

Enter 2D array of doubles:

L

1

2

0.0 0.0
0.0 0.0
0.0 0.0
0.0 0.0
0.0 0.0
0.0 0.0
t ik

Choice List

0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0

OK

Cancel

The Choice List node contains lists that can be used by combo boxes, radio
buttons, or list boxes. The Settings window for a choice list contains a Label, a
Name, and a table with a Value column and a Display name column. Enter the
property value (Value) in the first column and the corresponding text to display to
the user (for example, in a combo box list) in the second column (Display name).
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The Value is always interpreted as a string. In the example below, mat1 will become
the string "mat1" when returned from the combo box.

Settings

Label:  Aluminum Alloys =5

MName:  choicelist]

List Content

4 Value Display name
mat1 Aluminum 3003
mat2 Aluminum 6063
mat3 Aluminum, generic

[ 1

\ -

As an alternative to creating a choice list by right-clicking the Declarations node,
you can click the Add New Choice List button in the Settings window for form
objects that use such a list, as shown in the figure below.

Choice List @ +
Available: Selected: Add New Choice List
<> Simulation Type List {simulal <2 Material {materialList}

<> Choice List 1 {choicelist1}

[] Allow other values

In addition you can click the adjacent Add New Form Choice List to create a choice
list local to the form.

ACTIVATION CONDITION

You can right-click the Choice List node to add an Activation Condition subnode.
Use an activation condition to switch between two or more choice lists contingent
on the value of a variable. For an example of using choice lists with activation
conditions, see “Using a Combo Box to Change Material” on page 252.
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File

File declarations are primarily used for file import in method code when using the
built-in method importFile. For more information on the method importFile
and other methods for file handling, see “File Methods” on page 354. However,
an entry under the File declaration node can also be used by a File Import object.
The figure below shows the Settings window of a file declaration.

Settings
File

Label:  File1
MName: filel
File Location

Target directory:  Temporary =

Access using: upload:///filel

The file chosen by the user can be referenced in a form object or method using
the syntax upload:///file1,upload:///file2, and so on. The file name handle
(file1, file2, and so on) can then be used to reference an actual file name picked
by the user at run time.

For more information on file declarations and file handling, see “Appendix C —
File Scheme Syntax” on page 328.

File Type

The File Type declaration lets you use a custom file type with a custom file
extension. The custom file declaration will then become available in the File Import
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form object as well as in the dialogs shown when using the methods importFile
and fileSaveAs.

Settings
File Type

Label:  File Type 1
MName: filetypel

~ Definition
Description: My File Type

L - .
Filename extensions

*myfile
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Unit Set

The Unit Set node contains lists that can be used by combo boxes, radio buttons,
or list boxes for the purpose of changing units. The Settings window for a unit set
contains two sections: Unit Groups and Unit Lists.

Settings

Label:  Unit Set 1 =

MName:  unitset]

Unit Groups
L1
Value Display name
sl sl
imperial Imperial
T =3
Initial value: sl o,
~  Unit Lists
3 2
MName sl Imperial
length cm in
potential my my
T + =3

Each row in the Unit Groups table is a unit group that represents a collection of
units with a particular meaning in the context of the application user interface.
Each column represents a group of units labeled by a Value and a Display name.

Each row in the Unit Lists table is a unit list with columns containing units with
the same dimension, for example, mm, cm, dm, m, and km. The headings of the
Unit Lists table are Name and the Display names are defined in the Unit Groups
section. A unit list specifies the possible units that a form object that references the
Unit Set can switch between when running the application.

The figure above demonstrates the use of a Unit Set for an application that allows
for switching between metric and imperial units. In this example, two unit groups
are defined: SI and Imperial. The Label of the Unit Set has been changed to Unit
System.
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The Value column contains string values that represent the current choice of unit
group. These string values can be manipulated from methods. The Display name
column is the string displayed in the user interface. The Initial value list contains
the default unit group (SI in the example above).

In the example above, the Unit Lists table has three columns: Name, SI, and
Imperial. The Sl and Imperial columns are created dynamically based on the groups
in the Unit Groups section. Each row in the table corresponds to a physical quantity
such as, in this example, length and potential. Each column in the table
corresponds to the allowed units of 1length and units of potential, respectively.

The figure below shows an example application where a combo box form object
is used to choose between the SI and Imperial unit groups.

Length: 9 cm Length: 3.5433070866141 in
Width: 5 cm Width: 1.9685039370078 in
Applied voltage: 20 my Applied voltage: 20 my
Temperature: 3304 K Temperature: 3304 K
Compute Compute

Unit system: sl - Unit systerm: Imperial =

sl

Imperial

174 |



The figure below shows the Settings window of a combo box using the Unit Set of
the above example as the Source.

Settings

Combo Box

MName: combobox =
~ Source @+ "B
v = Declarations

Unit Set 1 {unitset1}
» < Model (root)

Use as Source Edit Mode

Selected source:

Unit Set 1 {unitset1}

Initial value: From data source -
~ Choice List @+
Available: Selected:

Unit Set 1 {unitset1}

[] Allow other values

In this way, a Unit Set can be used instead of a Choice List to create a combo box
for unit selection. Instead of a combo box, you can use a list box or a radio button
object in a similar way.
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The two figures below show the corresponding Settings windows for the two input
fields for Length and Applied voltage.

Settings Settings
nput Field Input Field
Name:  inputfield1 B Name:  inputfield3 B
Editable Editable
Tooltip: Tooltip:
~ Source @+ F ~ Source @+ g
= Declarations = Declarations
v @ Model (root) v @ Model (root)
v (7 Global Definitions v (7 Global Definitions
v Pj Parameters 1 v Pj Parameters 1
sl Length (L) =5 Length (L)
25 Bolt radius (rad_1) 25 Bolt radius (rad_1)
25 Thickness (tbb) 25 Thickness (tbb)
25 Width (whb) 25 Width (whb)
25 Maximum element size (mh) 25 Maximum element size (mh)
25 Heat transfer coefficient (htc) 25 Heat transfer coefficient (htc)
=5 Applied voltage (Vtot) =l Applied voltage (Vtot)
Use as Source S Edit Node Use as Source S Edit Node
Selected source: Selected source:
o5 Parameters 1=Length (L) o5 Parameters 1=Applied voltage (Vot)
Initial value:  From data source - Initial value:  From data source -
Value: 9 Value: 20
~ Data Validation ~ Data Validation
Unit dimension check:  Append unit from unit set = Unit dimension check:  Append unit from unit set =
Unit set: Unit Set 1 {unitset1} | 3 Unit set: Unit Set 1 {unitset1} - 3
Unit list: length (cm,in) - Unit list: potential (mV,mV) -
Numerical validation Numerical validation
Filter: Double - Filter: Double -
Lower bound Lower bound
Comparison type:  Greater than or equal - Comparison type:  Greater than or equal -
Value: 5 Value: 0
Upper bound Upper bound
Comparison type:  Less than or equal - Comparison type:  Less than or equal -
Value: 15 Value: 100

Error message: Error message:

Invalid input Invalid input

The Unit dimension check is sct to Append unit from unit set. The Unit set is set to
Unit System {unitsetl} (the user-defined label for the Unit Set declaration used in
this example). The Unit list is set to length and potential, respectively. When using
Append unit from unit set, the Numerical validation section (under Data Validation)
refers to the Initial value of a Unit Set; in this case, em and mV, respectively. The
Lower bound and Upper bound values are scaled automatically when the application
is run and the unit is changed by the user of the application. For more information
on the settings for an input field object, see “Input Field” on page 96.
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The figures below illustrate the use of two Unit Set declarations for separately
setting the unit for length and potential, respectively.

v = Declarations
Length: 9 cm Length Units {unitset 1}
Width: 5 crm Potential Units {unitset2}
Applied voltage: 20 mV B Methods

» [ Libraries

Temperature: 3304 K

Compute
Length unit: cm =

Potential unit: my =

The figures below show the corresponding Settings window for the Unit Set
declarations.

Settings Settings
Unit Set Unit Set
Label:  Length Units = Label:  Potential Units =
MName:  unitset] MName:  unitset2
Unit Groups Unit Groups
L L

Value Display name Value Display name
cm cm W W
m m my my
inch inch
Initial value: cm - Initial value: my -
v Unit Lists v Unit Lists
k2 MName cm m inch " MName v my
length cm m in potential W my

+ +

Note that, in this example, by using three Unit Set declarations, you can have
individual length unit settings for the Length and Width input fields. The figure
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below shows such an example, where three combo boxes have been used to
replace the unit labels and each combo box uses a separate Unit Set declaration as
its source.

Length: 9 cm -
Width: 1.9685039370078  inch =
Applied voltage: 20 my -

Temperature: 3304 K

Compute

When more flexibility is required, you can combine the use of a Choice List and a
Unit Set. For example, for a combo box, you can use the Unit Set as the Selected
source (string) and select a Choice List that is not a Unit Set.

Shortcuts

Form objects and other user interface components are referenced in methods by
using a certain syntax. For example, using the default naming scheme
form3/button5 refers to a button with the name button5 in form3 and
form2/graphics3 refers to a graphics object with the name graphics3 in form2.
You can also change the default names of forms and form objects. For example, if
form1 is your main form, then you can change its name to main.

To simplify referencing form objects as well as menu, ribbon, and toolbar items by
name, you can create shortcuts with a custom name. In the Settings window of an
object or item, click the button to the right of the Name field and type a name of
your choice.

Settings 3/ Create Shortcut X
S MName: reportButton
MName: reportButton = [] Update methods
Text: Report
P Create Shortcut (Ctrl+K) oK Cancel
lcon: # report_32.png - =
Size: Large -
Style: Flat -
Tooltip:

Keyboard shortcut:

To create or edit a shortcut, you can also use the keyboard shortcut Ctrl+K.
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All shortcuts that you create are made available in a Shortcuts node under

Declarations in the application tree.

¥ Events
v = Declarations
= Boolean
123 Integer
25 Double
abe String
<Z» Material {materiall ist}
<Z» Simulation Type List {simulationTypeList}
=] Shortcuts
> [ Methods
» [ Libraries

In the Settings window for Shortcuts below, two shortcuts, plot_temp and

temp_vis, have been created for a button and a graphics object, respectively.

Settings

Shortcuts
List of Shortcuts

L
MName Target

reportButtonTablet toolbarTablet/reportButtonTablet
targetFrequencyTextSmart... | mainSmartphone/targetFrequencyTextSmartphone
targetFrequencylnputSrma... | mainSmartphone/targetFrequencylnputSmartphone
frequencyToleranceText5.. | mainSmartphone/frequencyToleranceTextSmartphone
frequencyTolerancelnputs... | mainSmartphone/frequencyTolerancelnputSmartphone
pronglengthlnputSmartp... | mainsmartphone/pronglengthlnputSmartphone
targetFrequencyUnitSmart... | mainSmartphone/targetFrequencylnitsmartphone
frequencyTolerancelnitS.. | mainSmartphone/frequencyToleranceUnitSmartphone
plotButtonSmartphone toolbarsmartphone/plotButtonSmartphone
playSoundButtonSmartph... | toolbarsmartphone/playSoundButtonSmartphone
reportButtonSmartphone | toolbarSmartphone/reportButtonSmartphone

Description
Shortcut to Button
Shortcut to Text label
Shortcut to Input field
Shortcut to Text label
Shortcut to Input field
Shortcut to Input field
Shortcut to Unit
Shortcut to Unit
Shortcut to Toolbar
Shortcut to Toolbar
Shortcut to Toolbar

The shortcuts can be referenced in other form objects or in code in the Method

Editor. The example below shows a shortcut, temp_vis, used as an input

argument to a temperature plot.

L
Command lcon | Arguments
Plot Temperature (ht) tempVis
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Shortcuts are automatically updated when objects are renamed, moved, copied,
and duplicated. They are available in methods as read-only Java® variables, just like
string, int, double, and Boolean declarations.

Using shortcuts is recommended because it avoids the need to adjust Method
Editor code when the structure of the application user interface changes.

Shortcuts are also available in the Model Builder, for use with the Application
Builder. In the Settings window of a model tree node, click the button to the right
of the Label field and type a name of your choice.

Settings Graphics

Block e a@- &

) Build Selected » [E8 Build All Objects B

Label: Block 1 =

v Object Type Create Shorteut (Ctrl+K)
Used in Application Builder

Type: Solid =

3 Create Shortcut *

Name:  blkl

[] Update methods

0K Cancel

The custom name of a shortcut becomes available as a global variable in methods
and will be used, for example, when recording code or new methods, as shown in
the figure below.

@ Preview methodl X

", new int[]{2,1,1});

", new int[]{2,3,1});
blkl.set("size", new int[]{2,3,5});

4  model.component("compl”).geom{"geoml").runf{"blkl™);
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Graphics Data

A Graphics Data declaration node is used to pick data at a specific coordinate from
a graphics object based on mouse clicks by the user. The figure below shows the
corresponding Settings window.

Settings

Graphics Data

Label:  Graphics Data 1 =5

MName: graphicsdatal
v Initial Values

Coordinate: 0,00

Results evaluation: 0

~ Initial Values for 3D Geometry Source

Geometric entity level: Domain -

Domain settings

Line entry method: Point and surface normal =
Depth along line: 0
Point being modified: First point -

The Initial Values section contains default values for the extracted data properties
Coordinate and Results evaluation. The section Initial Values for 3D Geometry Source
contains settings for the selection methods available when the Source for Initial
Graphics Content of a graphics object is set to a geometry node.
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The different properties of a graphics data declaration are available from the Editor
Tools window as shown in the figure below.

Editor Tools TAX
Sy EditNode =t El

D Main Window
I U Forms
[ u GUI Cormmands
4 = Declarations
[=] Graphics Data 1{graphicsdatal}
22 Coordinate (Coord)
8.5 Results Evaluation (Eval)
anc Geometric Entity Level (Edim)
avc Line Entry Method (Method)
5.5 Depth Along Line (Depth)
=5c Point Being Modified (Twopoint)
b B2 Array 1D Double
123 |nteger

Fi

anc String
i Methods
[fifi Libraries
& Model (root)

To use a Graphics Data declaration node for data picking, select the Data picking
checkbox in the Settings window of a graphics object and select the Graphics Data
node as the Target for Data Picking, as shown in the figure below.

Settings

Graphics

MName: graphicsl =
Zoom to extents on first plot

> Source for Initial Graphics Content
v Data Picking @+ B
Enable data picking

Target for data picking

v = Declarations
» 85 Double
Graphics Data 1{graphicsdatal}

Use as Target %, Clear Target Edit Node
Selected target:
[=] Graphics Data 1{graphicsdatal}

GRAPHICS DATA FROM RESULTS

When the Source for Initial Graphics Content of a graphics object is set to a plot
group node, then the Results Evaluation value corresponds to the field value at the
position determined by the mouse pointer. The Coordinate value corresponds to
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the coordinate at that position. Note that in the Model Builder, this corresponds
to the data displayed in the Evaluation 2D or Evaluation 3D tables.

The figure below shows a data display object where the Coordinate property is used
as Source.

Settings

Data Display

MName:  datadisplay2 =5
LaTeX markup

Tooltip:

~ Source @+ "B

v = Declarations

» 85 Double

~ [=] Graphics Data 1{graphicsdatal}
25 Coordinate (coord)
8.5 Results evaluation (eval)
abe Geometric entity level (edim)
abe Line entry method (method)
=5 Depth along line (depth)
abc Point being modified (twopoint)

@_‘ Use as Source =g Edit Node
Selected source:

5.2 Graphics Data 1 {graphicsdatal}==Coordinate (coord)

You can also use the Coordinate property as the Source for an array input object.
The Results Evaluation property can be used as the Source for several form objects
including data display and input field objects.

GRAPHICS DATA FROM GEOMETRY

The settings Geometry Entity Level, Line Entry Method, Depth Along Line, and Point
Being Modified only apply when the Source for Initial Graphics Content of a graphics
object is set to a 3D geometry node. These settings provide the same point
selection methods as a Domain Point Probe, when Geometry Entity Level is set to
Domain; and Boundary Point Probe, when Geometry Entity Level is set to Boundary.
The settings Line Entry Method, Depth Along Line, and Point Being Modified arc only
applicable when Geometry Entity Level is set to Domain.
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The Method Editor

Use the Method Editor to write code for actions not included among the standard
run commands of the model tree nodes in the Model Builder. The methods may,
for example, execute loops, process inputs and outputs, and send messages and
alerts to the user of the application.

The Java® programming language is used to write COMSOL methods, which
means that all Java® syntax and Java® libraries can be used. The Method Editor
supports Java 11 syntax. In addition to the Java® libraries, the Application Builder
has its own built-in library for building applications and modifying the model
object. The model object is the data structure that stores the state of the
underlying COMSOL Multiphysics model that is embedded in the application.
More information about these built-in methods can be found in “Appendix E —
Built-In Method Library” on page 353 and in the Application Programming
Guide.

The contents of the application tree in the Application Builder are accessed
through the application object, which is an important part of the model object.
You can record and write code using the Method Editor that directly accesses and
changes user interface aspects of the running application, such as button texts,
icons, colors, and fonts.

There are global methods, form methods, and local methods. Global methods are
displayed in the application tree and are accessible from all methods and form
objects. Form methods are displayed in the application tree as child nodes to the
form it belongs to. A local method is associated with a form object or event and
can be opened from the corresponding Settings window. For more information
about local methods, see “Local Methods” on page 207.

A number of tools and resources are available to help you create code for
methods. These are covered in the following sections and will make you
more productive by allowing you to copy-paste or autogenerate blocks of
code, for example.

Converting a Command Sequence to a Method

In the Form Editor, select Convert to Method from the menu button displayed in
the Settings window below an existing command sequence. The command
sequence is automatically replaced by an equivalent method. In the same way you
can select Convert to Form Method and Convert to Local Method.
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Consider a case where you have created a compute button and you want to be
alerted by a sound when the computation has finished. Now, we will see how this
could be done using the Method Editor (this can also be done without writing
code, see later in this section).

You will also learn how to do this without using the Method Editor later in this
section. The figure below shows the Settings window of the Compute button.

Settings

Button
MName:
Text:
lcon:
Size:

Style:
Tooltip:

button1 =
Compute
= compute_32.png > |+ =
Large *
Outlined =

Compute and Plot Temperature and Current Density

Keyboard shortcut:  CTRL+T

~ Choose Commands to Run

® Forms

B GUl Commands
= Declarations
EE Methods

[fifi Libraries

& Model (root)

v v v v v

er

> () Global Definitions

L5l

> [l Component 1 (compl)
v oo Study 1
|= stationary
> [fre Solver Configurations

v {E| Results

> 2% Derived Values

= Edit Node

Run Plot Set Value Show

Show as Dialog Import File () Enable () Disable

L]
Command

lcon | Arguments

Compute Study 1 =

Plot Temperature (ht) form1/graphicsi
Plot Current Density form2/graphics2
t SeE- #
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Select the Convert to Method option below the command sequence.

" Command lcon | Arguments
Compute Study 1 =

Plot Temperature (ht) form1/graphics1
Plot Current Density form2/graphics2

t f==3 . -
> Dialog Actio ’. Convert to Method
‘ Convert to Form Method
> Position ant ..
‘ Convert to Local Method

> Appearance

The command sequence in this example is replaced by a method, method3.

Click the Go to Method button. The Method Editor opens with the tab for
method3 active.

L
Command lcon | Arguments

method3 B

bz P -

In the Method Editor, add a call to the built-in method playSound to play the
sound file success.wav, available in the COMSOL sound library, by using the
syntax shown in the figure below.

@ Preview method3 X
model.study("stdl”).run();
useGrophics(model.result({"pg3"), "fo
useGrophics(model.result({"pg5"), "fo

4  playSound("success.wav");

rm

The newly added line is indicated by the green bar shown to the left.
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Note that in the example above, you do not have to use the Method Editor. In
the command sequence, select the file success.wav under Libraries > Sounds and
click the Run command button under the tree, as shown in the figure below.

Settings

Button
MName:
Text:
lcon:
Size:

Style:
Tooltip:

button1 =
Compute
= compute_32.png >~ + =
Large =
Outlined =

Compute and Plot Temperature and Current Density

Keyboard shortcut:  CTRL+T

~ Choose Commands to Run =

¥ [‘u Graphics Commands
¥ D Main Window Commands
> <& Model Commands
» = Declarations
v [fifi Libraries
v i) Sounds

123 sUCCEss.wWav

123 failwav

123 neutral.wav
~ & Model (root)
» () Global Definitions

L5l

> [l Component 1 (compl)
v o Study 1

=g Edit Node P Run [Z3] Plot Set Value Show
Show as Dialog Import File Enable Disable

" Command
Compute Study 1
Plot Temperature (ht)
Plot Current Density

Play 'success.wav'

t -

lcon | Arguments

However, there are many built-in methods that do not have corresponding
command sequence nodes. For more information, see “Appendix E — Built-In
Method Library” on page 353.
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FORM OBJECT WITH ASSOCIATED METHOD

A form object that has an associated method is indicated with a special icon in the
Form Editor, as shown in the figure below. In this example, both the checkbox
called Find prong length and the Compute button have associated methods.

Compute

Performing Ctrl+Alt+Click on the form object opens the method in the Method
Editor. If there is no method associated with the form object, a new local method
associated with the form object will be created and opened in the Method Editor.

If the associated method has a compile error, then this is shown with a different
icon, as shown in the figure below.

Compute
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Language Elements Window

The Language Elements window in the Method Editor shows a list of some

language constructs. Double-click or right-click one of the items in the list to

insert template code into the selected method.

Language Elements

~ language constructs

»

w

oW W W W W

See also “Language Element Examples” on page 213.

Array operations (for double, int, boolean, string)
Block statements

Do-while

For-M

For-each

If

If-else

Instanceof expression
Multiline comment
Switch

Try-catch

While

With

Conversions

Server file handling utilities
External and utility libraries
Model Builder

User interface

Utility functions

Variables
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Editor Tools in the Method Editor

To display the Editor Tools window, click the corresponding button in the Main
group in the Home tab.

"5 Data Access = settings
Eﬁ Record Method Editor Tools
[EA Compiler

Main

When using the Editor Tools window in the Method Editor, you can right-click a
node in the editor tree to generate code associated with that node. Depending on
the node, up to eight different options are available:

¢ Get

e Set

e Set All

¢ Create

* Run

e Enable

 Disable

* Edit Node

Selecting one of the first seven options will add the corresponding code to the

currently selected method. The Edit Node option brings you to the Settings
window for the model tree node.
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The figure below shows an example of a node with six options.

Editor Tools
S EditNode =t v El ~

% Themes

D Main Window

> B Forms

» @ GUI Commands
Declarations
Methods

[fifi Libraries
&
>

&P m

>
>
>
~ Model (root)

() Global Definitions
> [ Component 1 (compl)
v oo Study 1
[= stationary

> [fre Solver Configurations Get
> [ Results é’* Set All
[ Create
(®) Enable
() Disable
=¢ EditNode

Get Set gq Set All [ Create Run (&) Enable () Disable

When a node is selected, the toolbar below the editor tree shows the available
options for generating code.

The Editor Tools window is also an important tool when working with the Form
Editor. For more information, see “Editor Tools in the Form Editor” on page 64.

KEYBOARD SHORTCUTS

Consider a method with a line of code that refers to a model object in the
following way:

model.result("pg3").feature("surfi1").create("hght1", "Height");
If you position the mouse pointer in "surf1" and press F11 on the keyboard,
right-click and select Go to Node, or click Go to Node in the ribbon, then the
corresponding Surface plot note is highlighted in the Editor Tools window.

Click Edit Node to open its Settings window. For more information on keyboard
shortcuts, see “Appendix D — Keyboard Shortcuts” on page 350.
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Data Access in the Method Editor

To access individual properties of a model tree node, click the Data Access button
cither in the Main section of the Home tab, in the Application Builder, or in the
Application section of the Developer tab in the Model Builder ribbon.

A " Data Access
Application P Test Application
Builder
Application
Alternatively, for certain form objects, you can click the Data Access button in the
header of the Source section of the Settings window. See also “Data Access in the

Form Editor” on page 107.

Data Access needs to be enabled this way because a model typically contains
hundreds or even thousands of properties that could be accessed, and the list
would be too long to be practical.

When you click a model tree node, such as the Heat Flux node in the figure below,
checkboxes appear next to the individual properties. This example is based on the
busbar tutorial model described in Introduction to COMSOL Multiphysics.

In the figure below, the checkboxes for Heat transfer coefficient and External
temperature are sclected:

> % Electric Currents (ec) Monsolid v
~ I[F Heat Transfer in Solids (ht)
o= Solid 1 ~ Heat Flux
Dmm o
e Initial Values 1 Flux type:
25 Thermal Insulation 1
& Lieat Flux 1 l:‘ Convective heat flux -
> .y Multiphysics Heat transfer coefficient:
> £ Mesh1 l:‘ User defined -
» ~db Study 1
5 @ Results Heat transfer coefficient:
h htc W/(mK)
External temperature:
U l:‘ User defined -
293.15[K] K

192 |



If you switch to the Editor Tools window, you will see additional nodes appear
under the Heat Flux node. Right-click and use Get or Set to generate code in an
active method window, as shown in the figure below.

Editor Tools

= EditNode =t v E| v

% Themes

D Main Window
> B Forms
» @ GUI Commands
» = Declarations
> g Methods
» [ Libraries
~ < Model (root)
» () Global Definitions
~ [l Compenent 1 (comp1)
» = Definitions
» Y Geometry 1
> igi Materials
> 3 Electric Currents (ec)
~ I[F] Heat Transfer in Solids (ht)
= Solid1
&= Initial Values 1
== Thermal Insulation 1
v (mw Heat Flux 1
abe External temperature (Text)
abc Heat transfer coefficient (h)

> iy Multiphysics Get
> /5 Mesh 1 A Set
> ~on Study 1 B .
> [ Results Z¢ EditNode

In the example above, Get and Set for the Heat transfer coefficient and the External
temperature properties will generate the following code:

model.component("comp1").physics("ht").feature("hf1").getString("Text");
model.component("comp1").physics("ht").feature("hf1").getString("h");

model.component("comp1").physics("ht").feature("hf1").set("Text",
"293.15[K]");
model.component("comp1").physics("ht").feature("hf1").set("h", "htc");
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Recording Code

Click the Record Code button in the Code section of the Method Editor ribbon to
record a sequence of operations that you perform using the model tree, as shown
in the figure below.

Language Elements  [a = B+C »d=
[r#] Languag [\/1 @ E 2

El i
e oS ExpIs o Check Gote Record Use Create Local
E‘. Record Method Syntax Mode  Code  Shortcut Variable

Code

Certain operations in the application tree can also be recorded, including methods
used to modify the user interface while the application is running such as changing
the color of a text label.

To record a new method, click the Record Method button. This button is also
available in the Main section of the Home tab of the Form Editor or Method Editor
ribbon.

"5 Data Access = settings

New Eﬁ Record Method Editor Tools
Method v €8 Compiler
Main

In addition, you can click the Record Method button in the Developer tab of the
Model Builder ribbon.
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While recording code, the COMSOL Desktop windows are surrounded by a red
frame:
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To stop recording code, click one of the Stop Recording buttons in the ribbon of
either the Model Builder or the Application Builder.

"9 Data Access Mew Method [ABC] = B+C - 3=
= = DT T
A o - v Ej u n T
Application P =L pphication E. SEpEELE Check  Goto Stop Use Create Local
Builder Syntax Mode | Recording Shortcut Variable
Application Create Methods Code

The previous section on Data Access explained how to set the values of the Heat
transfer coefficient and the External temperature properties of the busbar tutorial
model. To generate similar code using Record Code, follow these steps:

» Create a simple application based on the busbar model (MPH-file) available
in the Application Libraries under COMSOL Multiphysics > Multiphysics.

e In the Model Builder window, click Record Method, or with the Method
Editor open, click Record Code.

+ Change the value of the Heat transfer coefficient to 5.
e Change the value of the External temperature to 300[K].
e Click Stop Recording.

» Ifitis not already open, open the method with the recorded code.

The resulting code is listed below:

model.component("comp1").physics("ht").feature("hf1").set("h", 5);
model.component("comp1").physics("ht").feature("hf1").set("Text",
"300[K]1");
Note that in File > Preferences you can enable the use of with() statements in
order to make the code more compact. For more information on the use of
with(), see “The With Statement” on page 215.

To generate code corresponding to changes to the application object, use Record
Code or Record Method, then go to the Form Editor and, for example, change the
appearance of a form object. The following code corresponds to changing the
color of a text label from the default Inherit to Blue:

app.form("formi1").formObject("textlabell").set("foreground", "blue");

For more information on modifying the model object and the application object,
see the Application Programming Guide.

Use the tools for recording code to quickly learn how to interact with the model
object or the application object. The autogenerated code shows you the names of
properties, parameters, and variables. Use strings and string-number conversions
to assign new parameter values in model properties. By using Data Access while
recording, you can, for example, extract a parameter value using get, process its
value in a method, and set it back into the model object using set. For more
information on Data Access, sce “Data Access in the Method Editor” on page 192.
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Checking Syntax

Click Check Syntax in the ribbon to see messages in the Method Errors and Warnings
window related to syntax errors or unused variables.

=ec| Language Elements  [»

1 = B+C nd=
- _ v Z] @ Ur
e oS ExpIs o Check Gote Record Use Create Local
=@ Record Method Syntax Mode  Code  Shortcut

Variable
Code

In addition to messages in the Method Errors and Warnings window, syntax errors
are indicated with a wavy red underline, as shown in the figure below.

@Preview rethod] X

model.study("=tdl").runi);
useGraphics(model.result("pg3"),

"forml/graphics1l");
I playSound("success. way) :|
Method Errors and Warnings TRX
@ 1Eror b 0Wamings
Method Line Message
@ | method1 3

String literal is not properly closed by a double-quote
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Find and Replace

Click Find in the Quick Access Toolbar, or user the keyboard shortcut Ctrl+F, to
open a dialog used to find and replace strings in methods, as shown in the figure
below.

a1 Find in Methods X
I ES
Find: method1{)
- ' Replace with: mymethod1()|
Find (Ctrl+F) - _—
. Find in methods Direction

(@ Current (@ Forward
O Al ) Backward

[] Case sensitive

Find Mext Replace
Find All Replace All
Close

The Quick Access Toolbar is located above the ribbon to the left, in the
COMSOL Desktop user interface.
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Model Expressions Window

The Model Expressions window in the Method Editor shows a list of predefined
expressions used as input and output arguments. Double-click or right-click one
of the items in the list to insert an expression:

Model Expression RS

(%]

[» Global definitions
[> Materials
4 Component 1 (compl)
[» Definitions
[* Frames
4 Geometry
[» Curvature (Spatial)
> Mormal
[» Tangent 1
[ Tangent2
4 Coordinate
¥ - x-coordinate
y - y-coordinaty @j Insert Expression
z - z-coordinate
dom - Entity index
[ Mesh
[» Electric Currents
[* Heat Transfer in Solids
4 Builtin
[» Mathematical constants
[» Mathematical functions
[» Operators
[> Physical constants

| 199



Use Shortcut

If you look at the example below, you will notice that the two last lines of code
begins with model.result(”pg1”).

=1 [re Language Elements [aBC] = B+C
=] S

nad=
A “T

Jzva External Java Library E‘;ll\dodel Expressions v

B ] Revert to . Check Goto Record Use  Create Local

C External C Library Saved E’RECUM Method Syntax Mode Code Shortcut  Variable
Libraries Edit Code

@ Preview rethod] X

-l with(model.result().dataset("cptl”));
set("pointx"”, pointx);
set("pointy"”, pointv);
endwith();
model.result("pgl”).feature( "pttrajl”).set("expr", new String[]{xexpr, vexprl}l;
model.result(“pzl”).runi) ;|

The Use Shortcut button simplifies code by replacing these instances with a variable
name.

In the example above, the mouse pointer has been positioned at the first
occurrence of model.result(”pg1”). Click the Use Shortcut button to transform
the source code into what is shown in the figure below.

@ Preview rethod] X

-l with(model.result().dataset("cptl”));
set("pointx"”, pointx);
set("pointy"”, pointy);
endwith();
pointplot.feature( pttrajl”).set("expr", new String[]{xexpr, vexprl}l;
pointolot.runi);

The code starting with the prefix model.result(”pg1”) has been replaced with
the variable pointplot. When you click the Use Shortcut button, a Use Shortcut
dialog opens where you can enter a suitable variable name in the Name field, in this
case pointplot.

3 Use Shorteut *

Mame:  pointplot]
[] Update all methods
OK Cancel
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This variable is stored as a shortcut in the Declarations node, as shown in the figure

below together with the corresponding Settings window.

I U Forms

Events Sett Pgs
4 = Declarations Shortcuts
anc String
= shortcuts List of Shortcuts
I By Methods "
MName Target Description
pointplot Results/result/pgl Shortcut to 20 plot group

Syntax Highlighting, Code Folding, and Indentation

Different language elements in the code are displayed using different styles. Refer

to the figure below for an example:

= with(model.result("pgl”));

set("looplevel™, new String[1{"7"}); // The first real eigenfregquency always

endwith();
model.result().numerical( gevl").setResult();

/f Plot the solution in the graphics for the selected device
String graphics = "";
=] if (device.equals("computer”}) {

graphics = "/mainComputer/graphics1l";
H
-] else if (device.equals("tablet")) {
graphics = "/mainTablet/graphicsl";

-l else if (device.equals("smartphone”}) {

graphics = "/mainSmartphone/graphics1";
H
useGrophics(model.result("pgl”), graphics);
zoomExtents{graphics);

isGeometryfctive = false;

setProgress(188);
= if (isPlaySound) {
playSoundForFrequency();
H

This example includes five styles:

» Keywords, such as if, else, for, while, double, and int are displayed in

bold blue font
* Built-in methods are displayed in italic blue font
« Strings are displayed in red font

+ Comments are displayed in green font

¢ The remainder of the code is displayed in black font
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You can customize the syntax highlighting theme in the Preferences window. See
the next section Method Editor Preferences.

You can expand and collapse parts of the code corresponding to code blocks that
are part of for, while, if, and else statements. This feature can be disabled, as
described in the next section “Method Editor Preferences”.

When writing code, use the Tab key on your keyboard to automatically indent a
line of code and insert white spaces where needed. As an alternative, you can
right-click in the Method Editor and select Indent and Format, as shown in the
figure below.

while (k < MAXITERATIONS && Math.abs(fl) > toleranceFrequency) {

£2 = f1;
computedFreqg[ _ T
F1 = compute, =1 Go to Mode F11
carry = L1; | 24 Goto Method Ctrl+Alt+Double-click
L1 = L1-f1%(
L2 = carry; | O Undo Ctrl+Z
L1 = Math.ma I
ko= k+l; -
setProgress Zoom 100% r
H v
L1 = Math.roun| d& Cut Ctrl+X 3 de
model.parami). |_—‘E| Copy Ctrl+C
/ifq = fa;
if (Math.abs(f ﬁ Paste Ctrl+V
error("Compu ﬁ Delete Del IS+
H
3 § Selectal Ctrl+A
else { // "Find —
setProgress(@, || Indent and Format Tab
setProgress(25) 15 Create Local Variable Ctrl+1
computedFreque "Lp"
== Toggle Comment Ctrl+7

setProgress(75

Indentation and whitespace formatting also happen automatically when the
keyboard focus leaves the Method Editor. You can disable this behavior in
Preferences in the Method section by clearing the Indent and format automatically
checkbox.

Using the context menu shown above, when right-clicking, you can toggle
comments on and off for an entire block of code that you have selected. This is
available by selecting Toggle Comment from the menu or the keyboard shortcut
Ctrl+7.

THE NAME OF A METHOD

The Name of a method is a text string without spaces. The string can contain
letters, numbers, and underscores. The reserved names root and parent are not
allowed and Java® programming language keywords cannot be used.
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Method Editor Preferences

To access the Preferences for the methods, choose File > Preferences and select the
Methods node in the tree.

@ Preferences X
EE Methods
~ Application Builder ] View all code

>_Foms | ] Clase brackets automatically

. Methods ! [] Generate compact code using 'with' statements

Syntax Highlighting

Client-Sorver Enable cade folding
> Computing [¥] Indent and format automatically
> Email [¥] Generate code using component syntax
> Files [] Ask for confirmation before running methods
7 Geometry Zoom level: | 100 B>
> Graphics
> Help
> Libraries
> LiveLink Cannections

Mesh
> Model Builder

Model Manager
> Physics Builder
> Results

Save
> Security

Updates
> UserInterface

Factory Settings

Factory Settings for Al Import Export oK Cancel

By default, the Method Editor only shows the most relevant code. To see all code
in a method, select the View all code checkbox.

The Close brackets automatically checkbox controls whether the Method Editor
should automatically add closing brackets, such as curly brackets {}, brackets [],
and parentheses ().

The Generate compact code using ‘with’ statements checkbox controls the
utilization of with statements in automatically generated code. For more
information, see “The With Statement” on page 215.

If the Enable code folding checkbox is selected, you can expand and collapse parts
of the code corresponding to code blocks associated with for,while, if,and else
statements.

Selecting the Indent and format automatically checkbox will ensure that code is
consistently indented and formatted.

The Generate code using component syntax option will generate method syntax that
also includes the model component scope.
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Clear the option Ask for confirmation before running methods in the Model Builder
if you do not want to confirm when running methods in this way.

Under the Syntax highlighting node, the Theme list contains a few predefined
themes. Choose User defined to define a syntax highlighting mode where the
colors can be assigned to individual language elements.

Ctrl+Space and Tab for Code Completion

While typing code in the Method Editor, the Application Builder can provide
suggestions for code completions. The list of possible completions are shown in a
separate completion list that opens while typing. In some situations, detailed
information appears in a separate window when an entry is selected in the list.
Code completion can always be requested with the keyboard shortcut Ctrl+Space.
When accessing parts of the model object, you will get a list of possible
completions, as shown in the figure below:

@ Preview rmethod] X
I model.m|
massProp() Returns all mass properties.
massProp(String tag)
material() Returns: ProbeFeaturelist
material(String tag) List of mass properties
mesh()
rnesh(String tag)
methodCall()
methodCall{String tag)
model(])
maodel{String compTag)

eeeaeaaaeeee

Select a completion by using the arrow keys to choose an entry in the list and press
the Tab or Enter key to confirm the selection.

If the list is long, you can filter by typing the first few characters of the completion
you are looking for.

For example, if you enter he first few characters of a variable or method name and
press Ctrl+Space, the possible completions are shown:

@ Preview method] X
int ival, iva2, iva3;
iv

ival

ival

e

iva3
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In the example above, only variables that match the string iv are shown. This
example shows that variables local to the method also appear in the completion
suggestions.

You can also use Ctrl+Space to learn about the syntax for the built-in methods that
are not directly related to the model object. Type the name of the command and
use Ctrl+Space to open a window with information on the various calling
signatures available.

@ Preview Dform‘l methodl X

I p1aysound
@ playSound(String name)

@ playSound(double hz, int milliseconds) Plays a signal with given frequency and duration.

Parameters:
hz Frequency in Hz.
milliseconds Duration in milliseconds.

For a list of available built-in methods, you can use the Language Elements window
described on page 189 or see “Appendix E — Built-In Method Library” on page
353.

Similar information is displayed in a tooltip when hovering over the different parts
of a method call, property name, declaration, or shortcut.

model.result("pgl”).feature(" ptt|'a:' 1"y set("expr", new String[]{xexpr, vexprl});

model.result("pgl").run(); Create a point trajectories plot to visualize trajectories

of geometric points.
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The keyboard shortcut Ctrl+Space can also be used in the Model Builder. For
example, when typing in an Expression field in Results, use Ctrl+Space to see
matching variables, as shown in the figure below.

Settings ~ 4| Graphics
aaq-

Label: Surface =

¥ Data

Dataset: From parent >

 Expression = %v

Expression:

dif

4 Compeonent 1 (compl)
4 Solid Mechanics
4 Displacement
solid.disp - Displacement magnitude - m
4 Builtin
4 Operators
4 Integration and statistics
diskavg(r, expr) - Average on the disk with radius r
diskavg(r, expr, N] - Average on the disk with radius r
diskint(r, expr] - Integral on the disk with radius r

Creating Local Variables

You can automatically set the type of a local variable. For example, you can type
X = model.geom()

and click the Create Local Variable button in the Code group of the Method tab in
the ribbon.

[aBC] = B+C na=
v E] e Cr

Check Goto Record Use  Create Local
Syntax Mode Code Shortcut  Variable

The code is then changed to

GeomList x = model.geom()

where GeomList is the data type of model.geom().
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Local Methods

You can add local methods to buttons, menu items, and events. Local methods do
not have nodes displayed under the Methods node in the application tree. In the
method window for a local method, its tab displays the path to its associated user
interface component, as shown in the figure below for the case of a checkbox

object.

main: checkbox1: onDataChange X

setFormObjectEditable("main/inputfieldl™,
setFormObjectEditable("main/inputfields”, findlength);
setFormObjectEnobled("main/inputfields"”, findlength);

Ifindlength);

In the Form Editor, you can right-click a form object and select Create Local

Method from a menu, as shown in the figure below.

Length: «9 s cem
Width: 5 Create Local Method
Applied voltage: 20 Copy as Code to Clipboard
Temperature: 0.00 5’6 Cut Ctrl+X
El Copy Ctrl+C
[F] Duplicate Ctrl+Shift+D
[ Delete Del
E Settings
g
Help Fi
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LocAL METHODS FOR BUTTONS, MENU ITEMS, AND GLOBAL EVENTS

For buttons, ribbons, menus, toolbar items, and global events, you can add a local
method by selecting Convert to Local Method from the toolbar menu button under
the sequence of commands, as shown in the figure below.

v

» (Choose Commands to Run =

b B Forms
I @ GUI Commands
b [ Libraries
4 & Model (root)
I () Global Definitions
I @ Component 1 (compl)
4 o Study 1
[= stationary
[Fre Solver Configurations

I
4 [ Results
I

2% Derived Values

Edit Mode Run Plot Set Value Show

Show as Dialog Import File Enable Disable

L

Command lcon | Arguments
Compute Study 1 =
Plot Temperature (ht) form1/graphicsi

bR~
. . | #E convert to Method
Dialog Actiof : envertte °
i ‘ Convert to Form Method
Position and|
‘ Convert to Local Method
Appearance

The function of this button is similar to the Convert to Method and Convert to Form
Method buttons, described in the section “Creating a New Method” on page 18.
The only difference is that it creates a local method not visible in the global
method list in the application tree. It also opens the new method in the Method
Editor after creating it. Ctrl+Alt+Click can be used as a shortcut for creating the
local method. Clicking the button Ge te Method will open the local method. The
figure below shows a call to a local method associated with a button.

"
Command lcon  Arguments
onClick B

5

Go to Method
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To avoid any risk of corrupting code in a local method, you are unable to use
Convert to Method when there is a local method present in the command sequence.

LOCAL METHODS FOR FORM AND FORM OBJECT EVENTS

To add a local method for a form or form object event, select the Create Local
Method option in the Events section of the Settings window. The selected On data
change method changes from None to Local method, as shown in the figure below,
and the Method Editor is opened.

¥ Events

On data change: Local method - Ej + -

To open an existing local method in the Method Editor, click the Go to Source
button. Select Remove Local Method from the menu to delete the local method.

As an alternative to Ctrl+Alt+Click, you can right-click a form object and select
Edit Local Method from its context menu.

Applied voltage: +20 s my
Edit Lacal Method
Copy as Code to Clipboard 3
5 Cut Ctrl+X
E] Copy Ctrl+C
[F] Duplicate Ctrl+Shift+D
[ Delete Del
B Settings
B Help F1

For more information, see “Events” on page 149.

Methods with Input and Output Arguments

A method is allowed to have several input arguments and one output argument.
You define input and output arguments in the Settings window of an active

method window. If the Settings window is not visible, click Settings in the Method
tab of the ribbon. The figure below shows a method with two input arguments,
var and coords; and one output, coordsout. The method adds random values to
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the array, coords. The degree of randomness is controlled by the input variable
var. The new values are stored in the array coordsout.

e

review method1 X tht'ngs L x
int len = coords.length; e
coordsout = new double[len]; Viethad
o for (int k = 8; k < len; k++) { Mame:  method?
double dx = Math.random()-8.5; . .
coordsout[k] = coords[k]+varrdx; [ Show in Madel Builder
) * Inputs and Qutput
Inputs
L] - .
Mame Type Default Description Unit
war Double |20 Variation
coords Array 1D dc = {0.9,0.8,1.1,1.2} Coordinates
+
Output:  Array 1D double -
MName:  coordsout

When you call another method from a method, Ctrl+Alt+double-click opens the
window for that method. A method is allowed to call itself for the purpose of
recursion.

Debugging

For debugging purposes, click in the gray column to the left of the code line
numbers to set breakpoints, as shown in the figure below.

[ Prev

diew  [Z] computeAndUpdateResults
.

[ runFrequencyStudy

* Computes the frequency. Used in the method computeAndUpdateResults.

* Uses the prong length as input and outputs the frequency.

x

if (isFindLength) { // The input is a double when Find prong length is ac
model.param().set(“Lp", pronglLength+"[mm]");

¥

// Compute the freguency by running Study 1

@ model.study(“stdl").run();
// In case there was no solution included in the application file
// Need to set pointer to last eigenvalue in the results node in case thi

€15 model.result().numerical( gevi”).setIndex( levelinput”, “"last”, @);
model.result().numerical( “gev2").setIndex( nput”, "last”, @);
double[][] d = model.result().numerical(“gevl”).getReal();
outputFrequency = d[@][8];

100% ~

Call Stack

Method Line

runFregquencyStudy 15

computeAndUpdateResults 29
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Data Viewer

Name
v Pj Parameters 1
> a5 lp
> ash

» a5

3 85 Lh
v = Declarations
== computedFrequency
aue device
isFindLength
isGeometryActive

[SRE=RE-]

isInitialized

5]

isPlaySound
abc material
abe solutionState
123 soundDuration
=5 targetFrequency
&5 toleranceFrequency
o= prongLength
=5 outputFrequency

Value

0.08314678944203713 m
0.0035 m

0.0025 m

0.04m

413.2570127504355
“computer”

true

true

true

true

“steel”
“nosolution”

1

4400

0.1
£3.14678944203713
0.0



In the ribbon, the Debug group contains the tools available for debugging
methods. When you run the application, the method will stop at the breakpoints.
Click the Step button to go to the next line in the method. The figure above shows
a method currently stopped at the line highlighted in yellow. The Data Viewer
window, seen to the right in the figure above, opens when a method is paused at
a breakpoint. Using the Data Viewer window, you inspect and modify local
variables, declarations, and parameters, while debugging.

The Call Stack window, below the method window, as seen in the figure above,
also opens when a method is paused at a breakpoint. You can select a method in
the call stack see the corresponding variables in the Data Viewer window.

Click Continue to run the method up until the next breakpoint. Click Stop to stop
running the method and exit. You can also stop the execution of a method while
testing an application by using the keyboard shortcut Ctrl+Pause. A dialog
appears, as shown below.

€ Error e

Method stopped.

OK

Click Break to suspend method execution at the next reached line in method code,
as if there had been a breakpoint there. Click Step Into to step into the next
method, if possible. The option Step Out continues until the current method
returns. Use Remove All to remove all break points. Instead of removing, you can
disable all break points by clicking Disable All.

To get an overview of all breakpoints, you can open the Breakpoints window, as
seen in the figure below. To open this window, click the corresponding button in
the Method tab, in the ribbon section Breakpoints.

Breakpoints *  Call Stack - A
\g of

Enabled | Method Line
4 computeAndUpdateResults 19
™ P P
4 computeAndUpdateResults 23
™ P P
4 runFrequencyStud 1
™ quencyStudy
4 runFrequencyStud 15
™ quencyStudy
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You can enable and disable individual breakpoints, either from the Breakpoints
window or by right-clicking a breakpoint in the gray column to the left of the code
line numbers, as shown below.

/f Compute the fregquency by running Study 1

. moadal studul Tet AT mand e
% Remove Breakpoint Ctrl+B
@) Disable Breakpoint CtrlaShiftep | L"Cluded in the application ile

eigenvalue in the results node in case th
(=] model.result().numerical("gevl").setIndex("looplevelinput™, "last", @);
model.result().numerical("gev2").setIndex("looplevelinput™, "last", @);

Click the Debug Log to display customized debugging messages in a separate Debug
Log window, as shown in the figure below.

[@] Preview computeAndUpdateResults X

setProgress (28);

double ¥l = computedFrequency-targetFrequency;

L1 = L1-F1#((L1-L2)/(F1-¥2)); // The Secant method

debuglog("L1:");

debuglog(Ll);

L2 = carry;

L1 = Math.max(L1l, le-3);

int k = 2;

= while (k < MAXITERATIONS &8 Math.abs(f1) > toleranceFrequency) {

debuglog("k:");
debuglog(k);
2 = f1;
computedFrequency = runFrequencyStudy(L1);
f1 = computedFrequency-targetFrequency;
carry = L1;
L1 = L1-F1#((L1-L2)/(F1-¥2));
debuglog("L1:");
debuglog(Ll);
L2 carry;
L1 Math.max(L1l, le-3);
k = k+1;
setProgress (k*188/MAXITERATIONS) ;

Debug Log
RN

L1:
83.14520446182314
k:

82.08962614347057
82.13086822307024

82.12567276341492

As an alternative to using the Data Viewer window, you can use the debuglLog
command a to display the value of variables in the Debug Log window. The code
below illustrates using the debugLog command to display the values of strings and
components of a 1D double array.

int len=xcoords.length;
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if (selected==0) {
for (int i = 0; 1 < len; i++) {
double divid=double(i)/len;
xcoords[i] = Math.cos(2.0*Math.PI*divid);
ycoords[i] = Math.sin(2.0*Math.PI*divid);
debugLog("x:");
debugLog(xcoords[i]);
debugLog("y:");
debugLog(ycoords[i]);
debugLog("selected is 0");
}
}

Note that you can also use the Java Shell and Chatbot windows while debugging.
For more information on these tools as well as built-in methods for debugging,
see “Debug Methods” on page 362 and the Application Programming Guide.

The Model Object

The model object provides a large number of methods, including methods for
setting up and running sequences of operations. The Convert to Method, Record
Code, Editor Tools, and Language Elements utilitics of the Method Editor produce
statements using such model object methods. For more information and example
code related to the model object and its methods, see “Appendix C—Language
Elements and Reserved Names” in the book Introduction to COMSOL
Multiphysics, the Application Programming Guide, as well as the Programming
Reference Manual.

Language Element Examples

The Java® programming language is used to write COMSOL methods, which
means that Java® statements and syntax in general can be used. This section
contains simple examples of some of the most common language elements. For
more information and examples, see the Application Programming Guide and
the Programming Reference Manual.
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UNARY AND BINARY OPERATORS IN THE MODEL OBJECT

The table below describes the unary and binary operators that can be used when
accessing a model object, such as when defining material properties and boundary
conditions, and in results, expressions used for postprocessing and visualization.

PRECEDENCE LEVEL SYMBOL DESCRIPTION

I () {3 grouping, lists, scope

2 ~ power

3 ! -+ unary: logical not, minus, plus

4 [] unit

5 * |/ binary: multiplication, division

6 + - binary: addition, subtraction

7 < <= > >= comparisons: less-than, less-than or equal,
greater-than, greater-than or equal

8 == I= comparisons: equal, not equal

9 && logical and

10 || logical or

element separator in lists

UNARY AND BINARY OPERATORS IN METHODS (JAVA® SYNTAX)

The table below describes the most important unary and binary operators used in

Java® code in methods.

PRECEDENCE LEVEL SYMBOL DESCRIPTION

| ++ -- unary: postfix addition and subtraction

2 ++ -- + - unary: addition, subtraction, positive sign,
negative sign, logical not

3 * | % binary: multiplication, division, modulus

4 + - binary: addition, subtraction

5 ! Logical NOT

6 < <= > >= comparisons: less than, less than or equal,
greater than, greater than or equal

7 == l= comparisons: equal, not equal

8 && binary: logical AND

9 || binary: logical OR

10 ? conditional ternary




PRECEDENCE LEVEL SYMBOL DESCRIPTION
Il

+= -= *= [=  assignments

12 , element separator in lists

ACCESSING A VARIABLE IN THE DECLARATIONS NODE

Variables defined in the Declarations node are available as global variables in a
method and need no further declarations.

BUILT-IN ELEMENTARY MATH FUNCTIONS

Elementary math functions used in methods rely on the Java® math library. Some
examples:

Math.sin(double)
Math.cos (double)
Math.random()
Math.PI

THE IF STATEMENT
if(a<b) {
alert(toString(a));
} else {
alert(toString(b));
}

THE FOR STATEMENT

// Iterate i from 1 to N:

int N=10;

for (int i = 1; i <= N; i++) {
// Do something

}

THE WHILE STATEMENT

double t=0,h=0.1,tend=10;
while(t<tend) {
//do something with t
t=t+h;
}

THE WITH STATEMENT

// Set the global parameter L to a fixed value
with(model.param());
set("L", "10[cm]");
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endwith();

The code above is equivalent to:
model.param().set("L", "10[cm]");

ACCESSING A GLOBAL PARAMETER
You would typically use the Editor Tools window for generating code for setting
the value of a global parameter. While in the Method Editor, right-click the
parameter and select Set.
To set the value of the global parameter L to 10 cm:

model.param().set("L", "10[cm]");

To get the global parameter L and store it in a double variable Length:

double Length=model.param().evaluate("L");
The evaluation is in this case with respect to the base Unit System defined in the
model tree root node.
To return the unit of the parameter L, if any, use:

String Lunit=model.param().evaluateUnit("L");
To write the value of a double to a global parameter, you need to convert it to a
string. The reason is that global parameters are model expressions and may contain
units.
Multiply the value of the variable Length with 2 and write the result to the
parameter L including the unit of cm.

Length=2*Length;

model.param().set("L", toString(Length)+"[cm]");
To return the value of a parameter in a different unit than the base Unit System,
use:

double Length_real = model.param().evaluate("L","cm");
If the parameter is complex valued, the real and imaginary part can be returned as
a double vector of length 2:

double[] realImag = model.param().evaluateComplex("Ex","V/m");

COMPARING STRINGS

Comparing string values in Java® has to be done with .equals () and not with the
== operator. This is due to the fact that the == operator compares whether the
strings are the same objects and does not consider their values. The below code
demonstrates string comparisons:

boolean streg=false;
String a="string A";
String b="string B";
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streq=a.equals(b);
// In this case streg==false

stregq=(a==b);
// In this case streq==false

b="string A";
streq=a.equals(b);
// In this case streg==true

ALERTS AND MESSAGES

The methods alert, confirm, and request display a dialog with a text string and
optional user input. The following example uses confirm to ask the user if a direct
or an iterative solver should be used in an application. Based on the answer, the
alert function is then used to show the estimated memory requirement for the
selected solver type in a message dialog:
String answer = confirm("Which solver do you want to use?",
"Solver Selection","Direct", "Iterative");
if (answer.equals("Direct")) {
alert("Using the direct solver will require about 4GB of memory when solving.");
} else {
alert("Using the iterative solver will require about 2GB of memory when
solving.");
}

Running Methods in the Model Builder

Running methods in the Model Builder is similar to calling methods from
applications with the most important difference being that from the Model
Builder methods can directly modify the model object in the current session.
Running methods from the Model Builder can be used to automate modeling
tasks that consist of several manual steps. For example, in a model with multiple
studies, you can record code for the process of first computing Study 1; then
computing Study 2, which may be based on the solution from Study 1; and so on,
with customized code in between the calls to Study 1 and Study 2.

From the Model Builder you can call methods directly through Method Calls or
using the options available in the Developer tab in the ribbon, described later in
this section. You can call methods indirectly through Settings Forms, for example,
by calling a method at the click of a button. For more information on Settings
Forms, sce “Using Forms in the Model Builder” on page 131.

In contrast to methods that are called from applications, methods called from the
Model Builder cannot use built-in graphics methods such as printGraphics,
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useGraphics, and zoomExtents. This restriction is due to the fact that a Settings
Form cannot include a graphics object.

Methods called in the Model Builder may have input and output arguments. Input
arguments to such methods that are called directly, and not indirectly from a

Settings Form, are given by adding a Method Call node under Global Definitions, sce
“Method Calls” on page 222.

CONTROLLING WHICH MODEL TREE NODE SHOULD BE ACTIVE

To control which model tree node should be active after running a method in the
Model Builder you can use the built-in method selectNode. For example, a
method modifying the geometry can have as its last line of code:

selectNode (model.component("compi1").geom("geomi"));

which will display the geometry and select the Geometry node.
The method selectNode has no function when used in an application.

GENERATING A REPORT AUTOMATICALLY AFTER COMPUTING

As an example of using a method from the Model Builder, consider the process of
first computing the solution and then generating a report. This can be automated
by first recording the corresponding operations in the Model Builder and then
running a method.
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Let us start from the busbar example described in the book Introduction to

COMSOL Multiphysics. You can load this example MPH-file from the
Application Libraries, as shown in the figure below.

Application Libraries

C* Refresh ] Update COMSOL Application Libraries

[fifi Applications
[fifi Acoustics
[fifi Chemical Engineering
[fifi Diffusion
[fifi Electromagnetics
[fifi Equation Based
[fifi Fluid Dynamics
[fifi Geophysics
[fifi Heat Transfer
[fifi Meshing Tutorials
[fifi Multiphysics
® busbar_box
O bushar_geom
® bushar

free convertion

4 [3@ COMSOL Multiphysics
/
/
/
/
/
/
/
/
/
/
4

¢ Open the model.
e In the model tree, right-click the Reports node under Results.

* Seclect Brief Report.

+ Change the Output format to Microsoft® Word (this example would also

work with the default HTML format).

 Click the Browse button and select a file name in a location on your system

that you have write permissions to, for example
C:\COMSOL\BusbarReport.docx

 Click Write to generate and save the report to file.

A
E;:;l G‘en-erate [Z] Preview Selected Preview All | # Write|
Label: Report1 =
Template
¥ Format
Output format: Microsoft Word =
Filename: CACOMSOL\BusbarReport.docx | W& Browse » [55 +

[] Always ask for filename
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+ Close the Microsoft® Word document that was automatically opened.

* Click the Developer tab in the ribbon (of the Model Builder) and click the
Record Method button. Click OK in the dialog that opens.

Home  Definitions  Geometry  Materials  Physics Mesh  Study  Results Developer  Report 1

A " Data Access New Method ‘:-::‘

b Test Application E'. Record Method +
Application Update
Builder Forms
Application Create Methods Method Calls Run Methods Forms

* In the model tree, right-click the Study I node and select Compute (or use the
ribbon option for Compute).

* In the model tree, right-click the Report | node and select Write (if prompted
to overwrite, answer Yes). Close the Microsoft® Word document that was
automatically opened.

e Click the Developer tab in the ribbon and click the Stop Recording button.

Home  Definitions  Geometry  Materials  Physics

A " Data Access MNew Method |+
b Test Application =m Stop Recording

Application Method
Builder Call -
Application Create Methods Method Calls

* You can now switch over to the Application Builder, by clicking on the
Application Builder button in the ribbon, and see the recorded method in the
application tree and in the Method Editor.

Home  Methoc

tility Class

[ Language Elements  [15c]
El1Model Expressions

] e ¢ W

Jzva External Java Library

Revert to Check Goto Record Use  CreateLocal Debug
 External C Library Saved [ Record Method Syntax Mode Code Shortcut Variable Log
Libraries Edit Code Debug
Application Builder ~§ [3]Preview []forml method] X
=t- zi- @ [@ model.sol("soll").feature("s i27).feature( mgl”).feature( pr).feature( so
i model.sol("s0ll").feature( i2").feature( ngl").feature( pr").
& model.sol("soll").feature( i2").feature("mgl").Feature( po”).
« [Z] busbar.mph (raot) model.sol("s0l1").feature("s i2").feature( ngl").feature( po”).
A Inputs model.sol("s0l1").feature("s i2").feature( mgl").feature( po").feature( so
=, Themes model.sol("s0ll").feature( i2").feature( mgl").feature( "cs").create("dl
model.sol("s0ll").feature( i2").feature( mgl").feature( cs").feature( 0l
> 7] Main Window set( lver™, "par
v @ Forms model.sol( ).feature("s1").feature("i2").feature( ngl").feature( cs").feature( dl
] form1 .set( perturb”, 1.8E-13);
Events model.sol({"s0ll").feature("s1").feature().remove( FcDes");
= Declarations model.sol("sol1").attach("stdl");
« B Methods model.sol{"s0l1"). runAll();
e model. result( pel”).run();
> [ Libraries model. result().report("rotl”).run();

For more information on code generated from the Study node, see the
Application Programming Guide.
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* Here you can inspect and edit the generated code and also change the name
of the method to, for example, compute_and_report.

LA

X

(%]

etting

MName: compute_and_report

Show in Madel Builder

* Go back to the Model Builder by clicking on the Model Builder button in the
ribbon.

* In Global Definitions > Parameters, change the Length to 15[cm].

Model Builder ~ */| Settings -
- T v By S
.
=] Label: Parameters 1 E
~ & busbar.mph (root) ¥ Parameters
v (1) Global Definitions
Pi Parameters 1 " Mame Expression Value Description
4 Default Model Inputs L 0.15m Length
%) Materials rad_1 6lrmm] 0.006 m Bolt radius
. :: Etzr;::"em (comp ) thb 5[mm] 0.005 m Thickness
v [E Results whb 5[cm] 0.05m Width
¥ Datasets mh 3[mm] 0.003 m Maximum elermnent size
» 2% Derived Values hte SIW/mA2/K] |5 W (mPK) Heat transfer coefficient
> [ Tables Vot 20[mV] 002V Applied voltage

> §@ Electric Potential (ec)
> §@ Electric Field Norm (ec)
> |l Temperature (ht)
> §@ lsothermal Contours (ht)
> §@ Current Density
Export
v [# Reports
¥ Report 1

 In the ribbon, click on the Developer tab and select compute_and_report from
the Run Method menu (if prompted to confirm, answer Yes).

Geormetry Materials Physics Mesh Study Results

New Method L» @

E Record Method

Method Run
Call - Methed ~
compute_and_report [

Depending on your security settings, you may get an error message. 1o avoid this
error, open File > Preferences, go to the Security page, and change File system access
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to All files. You can change this back to its default setting after running this
example.

Note that you can create multiple methods and call them from the Model Builder.

METHOD CALLS

A call, in the Model Builder, to a method for a specific set of input argument
values can be made by adding a Method Call node under Global Definitions. To add
a Method Call node, right-click Global Definitions and select one of the methods that
you have created. The figure below shows a Method Call to a method for creating
a geometric array.

Model Builder - -
- = Ste Elv =~
4 & heat_transfer_model.mph (root)
4 () Global Definitions
Pi Parameters 1 Label: Create Array =

2 Materials

Create Array
4 |§ Component1 (comp1)
I
I

Tag: methodcalll

Method: create_array

= Definitions ¥ Inputs
Geormnetry 1
2 Materials K-position: 1
I 8 Heat Transfer in Solids (ht) Y-position: 25
A Mesh 1
b~ Study 1 X-displacement: 1.75
b B Results Y-displacement: o
Rotation anble: 15
Scaling: 1

Number of objects: 13

The user interface layout of a Metheod Call cannot be customized. Instead, for

customizing use a Settings Form, see “Using Forms in the Model Builder” on page
131.

You can run, stop, or edit a Method Call by clicking the corresponding toolbar
button in the Settings window, as shown in the figure below.

Laeate Array

Tag: rethodcalll
Method: create_array
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This functionality is also available from the Developer tab in the ribbon of the
Model Builder, as shown in the figure below.

Physics  Mesh  Study  Results  Developer

=

Method Run Run
Call - Methed - |Methed Call -
Method Calls Create Array

The figure below show the corresponding method’s Settings window in the
Application Builder with the definitions of the input arguments.

Settings TAX

Mame: create_array

Show in Madel Builder

¥ Inputs and Output

Inputs
" MName Type Default Description Unit
xb Double > |1 X-position
yb Double > |25 ¥-position
dx Double * |1.75 X-displacement
dy Double - ||0 Y-displacement
ang Double > |15 Rotation anble
scl Double > |1 Scaling
no Integer > |13 MNumber of obje...

_l’_

Output: MNone =

You can add multiple Method Call nodes for the same method where each call can
contain a different set of input argument values.

There is no direct way of using output arguments from a method in the Model
Builder. However, you can use calls to the built-in method message to display
variables used in a method in the Messages window in the COMSOL Desktop
environment. The following example shows how to display the value of two
double variables width and depth in the Messages window:

message ("Width: "+toString(width));

message ("Depth: "+toString(depth));
For debugging, you use the general techniques outlined in the section
“Debugging” on page 210.
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For reusing a Settings Form between sessions, you can create an Add-in. For more
information, see “Creating Add-ins” on page 225.
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Creating Add-ins

To customize the workflow in the Model Builder, you can use a Method Call or a
Settings Form. However, these are associated with a specific MPH-file, and you
may want to reuse them between sessions or share them with colleagues. To make
this possible, you can create an add-in based on a Method Call, Settings Form, or a
custom ribbon tab. Such add-ins can then be stored in a user-defined add-in
library. In addition, COMSOL Multiphysics comes with built-in add-in libraries.
For the add-ins in the built-in library, you can review their Application Builder
settings, including forms and methods, to quickly learn how to build your own
add-ins. Creating an add-in is similar to creating an application, with a few
differences. Add-ins do not have their own graphics window, but instead use the
main Graphics window in the Model Builder. An add-in should work, or give
controlled error messages, for any type of model.

To create an add-in, start from a form that you have created in the Application
Builder and click Add-in Definitions in the Home tab of the ribbon, as shown below.

£ Add-in Definition
[ELy Editor Tools —

Application
Argument

Add-in Inputs

Right-click the Add-in Definitions node in the application tree and select Form
Definition.

Application Builder

“— =t - i

v [&] Untitled.mph (root)
2= Add-in Definition

E Inputs 2%, Create Add-in Fg
% The.mes. D Form Definition
¥ D Main Window
B Forms Method Definition
Events ™1 Ribbon Tab Definition
= Declarations [ Ternplate Definition
EE Methods
» [ Libraries = MNode Group
[ Delete Del

The figure below shows the Settings window for the Form Definition. Here, you can
type a Label for the add-in form as well as select which form to use for the add-in.
The Label will be displayed in the user-defined add-in library. You can select

whether the form should be displayed as a Settings form in the model tree or as a
dialog. The Allow multiple settings forms checkbox is used to allow for more than
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one instance of the Settings form in the model tree. The Description is displayed in
the add-in library and as a tooltip when choosing among add-ins in the ribbon.

X

Label: Image to Curve

Form: main B
Show as: Settings form

[] Allow multiple settings forms

¥ Description

Use the contour plot of an imported image to create an

interpolation curve, which can be included as part of a 2D
model or 30 work plane.
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Click the Add-in Definition node to sce its Settings window, as shown below.

Settings =3
Add-in Definition
£k, Create Add-in

¥ Add-in
Filename: image_to_curve.mph & Browse
Label: Image to Curve

Unique identifier.  com.comsol.addins.mph.image_to_curve

¥ Protection

Editing password:

¥ Presentation

Description

This add-in lets you use an image as a starting point for an analysis. An
interpolation curve is created from a contour plot of an imported image.
This interpolation curve can then be used as part of a 2D model or 3D work
plane.

Preview image: | image_to_curve.png - + =

Preview (recommended size 440 = 215 px)

The Filename is the location of the add-in MPH-file in the user-defined add-in
library. This location can be on a shared network drive if you wish to share the
add-in with your colleagues. The Label will be displayed in the Add-in Libraries
window. The Unique identifier is what identifies the add-in and is intended to be

unique for any COMSOL Multiphysics session. The unique identifier is

recommended to be in a format similar to <company name>.<Add-in name> ;for
example, my_company.my_add-in. The Editing password will be applied to the
created add-in and is different from the editing password that you can specify in

the root node Settings window of the MPH-file used to create the add-in.
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To create the add-in, which is a special type of MPH-file, click the Create Add-in

button.

£k, Create Add-in

Create Add-in (F8)
It

As an alternative to a Form Definition you can use a Ribbon Tab Definition to create
one or more ribbon tabs with customized buttons (items) and menus. The figures
below show the settings for an add-in that defines a custom ribbon tab with menus

and buttons.

Application Builder
Zte B v Po

i

~ E] colored_selections.mph (root)
v Eiz Add-in Definition
[™] Colored selections
ﬁ Inputs
% Themes
v D Main Window
[E] File Menu
~ [ Ribbon
~ [ Colored selections {ribbontab 1}
~ Selections {ribbonsection 1}
~ EI Select {menu}
Domains {toggle_item}
Boundaries {toggle_item2}
El Generate {item 1}
[ Clear fitema)}
~ Settings {ribbonsection2}
[+ settings fitem1}
[+] Reset {item2}
~ [ Forms
¥ D settings
Events
» = Declarations
v [ Methods
initialize
checkComponent
updateGeometrySelection
componentDim
isDefinedByMesh
autoRandomColoredSelections
clearAutoColoredSelections
reset

raries

[
o

> (il
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Label: Colored selections

Ribbon tab: Colored selections {ribbontab1} = E

¥ Description

The Colored Selections add-in lets you automatically color
all domains or boundaries for easier identification. Colors
are selected at random, and you can adjust the tint or
shade to your preference.



The figure below shows this custom ribbon tab after it has been added from the
Add-in Libraries.

P DR > i M B -
Home  Definitions Geometry  Materials  Physics  Mesh  Study  Results  Developer Colored Selections
G | A
» < Oy =
Select Generate  Clear Settings Reset

v Domains Settings
m Boundaries - a
. ¥ *|| Settings ~1l||e

Add-in Libraries

To use an add-in from the Add-in Libraries, you first need to enable it. In the
Developer tab in the Model Builder, click Add-in Libraries.

Developer
— \
: Bp \
O @ E C )
Settings Update Show Add-in  Refresh  Clear
Form - Forms Dialog - Libraries Add-ins Add-ins

In the list of add-ins, select the checkboxes of those add-ins that you want to
enable.

B hwed®E » T

Home  Definitions  Geometry  Materials
Add-in Libraries

+ Add Add-in (™ Refresh

v [@ COMSOL Multiphysics

» ESY colored_selections
» ESY image_to_curve

> [ ESY mesh_partition_with_ball

> [ ESY pid_controller

» R planar_cut

> [ ESY state_space_controller

% AC/DC Module

©»% Chemical Reaction Engineering Module

9 Plasma Module
@ subsurface Flow Module
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Once enabled, the corresponding add-ins will be displayed when clicking the
Add-ins button in the Developer tab.

T~ L L AR
Add-ins| Add-in Refresh  Clear Compare

- Libraries Add-ins Add-ins
Image to Curve
DImagetoCur\re ’
Planar Cut
DPIanarCut

Image to Curve

Use the contour plot of an imported image to
create an interpolation curve, which can be
included as part of a 2D model or 30 work plane.

ﬂ Press F1 for more help.

The figure below shows the Settings Form for one of the built-in add-ins.

Model Builder v

+— = =t~

h

Filter %) Contour \)\ Curve 7 Reset

Browse |4 Plot
~ & busbar.mph (root)

v (1) Global Definitions ¥ Image
Fi Parameters 1

3 Image (i2m_im) x: size 735 px
45 Default Model Inputs y: size 750 px
i Materials Image width:  0.25 m
[ Image to Curve 1
~ [@ Component 1 {comp 1) Filename: beam_cross_section.png Browse...

» Definitions Filter: Gaussian =

’ Geornetry 1 Pasitive image

> igi Materials

> +\_ Electric Currents (ec) * Contour

» |IE) Heat Transfer in Solids (ht)

» _{;} Multiphysics Automatic contour threshold

> /5 Mesh 1 Contour threshold
> ~do Study 1 R

> B Results

If you want to review and edit the Application Builder settings for a built-in
add-in, you can open the corresponding MPH-file. In a typical Windows®
installation, the built-in add-in library is located at:

C:\Program Files\COMSOL\COMSOL63\Multiphysics\addins
You can browse to a user-defined add-in library by clicking the Add User Add-in
Library button at the bottom of the Add-in Libraries window.

i

Add User Add-in Library
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The user-defined add-in library will be displayed alongside the built-in add-in
libraries, as shown below.

Home Definitions Geormetry Materials
Add-in Libraries

* Refresh

4 [fiff My Add-ins
4 #% busbar_cantrols
D Busbar Controls
b @ COMSOL Multiphysics
I £ RF Module

You can also click the Add Add-in button at the top of the Add in Libraries window
to browse to a user-defined add-in which will then be copied to a standard location
in the COMSOL Multiphysics installation folder (typically at
C:\Users\paul\.comsol\v63\addins or similar).

B @R > iy

File Home  Definitions  Geometry  Materials

Add-in Libraries

-in (¥ Tes
—+ Add Add-in (* Refresh

v [@ COMSOL Multiphysics
> &% colored_selections

Workflow When Creating and Editing Add-ins

When creating and editing add-ins, you will find it useful to have two sessions of
COMSOL Multiphysics open at the same time: one session for the original add-in
MPH-file where you work mostly in the Application Builder, and one session for
testing the add-in in the Model Builder. When testing an add-in using the Model
Builder, make sure to test for a great variety of models, including models of
different spatial dimensions as well as models with more than one model
component. Use the Refresh Add-ins button to make sure you always use an
updated version of the add-in you are editing.

2 o C O\
— = \s
Add-ins Add-in  Refresh  Clear
- Libraries Add-ins Add-ins
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Libraries

In the application tree, the Libraries node contains images, sounds, and files to be
embedded in an MPH-file so that you do not have to distribute them along with
the application. In addition, the Libraries node may contain Java® utility class
nodes and nodes for external Java® and C libraries, as well as Add-ins. For more
information on using utility classes and external libraries, see the Application
Builder Reference Manual.

Application Builder M

L~ @

“— Et -

4 [&] Untitled.mph [root)
ﬁ Inputs
% Themes
[ D Main Window
B Forms
Events
= Declarations
EE Methods
4 [fffi Libraries
[#] Images
=i Sounds
fE3 Files
(Z) utill
) util2
(Z) util3

o External Java Library 1
C External C Library 1 {nativel}
25 Add-in1

Embedded files can, for example, be referenced in form objects or in methods by
using the syntax embedded:///file1, embedded:///file2, and so on. For
example, to reference the image file compute.png, use the syntax
embedded:///compute.png.

Note that you are not required to have the file extension as part of the file name;
instead, arbitrary names can be used. To minimize the size of your MPH-file,
delete unused images, sounds, or other files.

To manage files loaded by the user of an application at run time, you have
several options, including using File declarations and File Import form
objects. For more information on files to be loaded at run time, “File” on
page 171, “File Import” on page 290, and “Appendix C — File Scheme
Syntax” on page 328.

232 |



Images

The Images library contains a number of preloaded sample images in the PNG file
format to be used as icons in apps. If you wish to embed other image files, click
the Add File to Library button below the List of Images. A large selection of icons
is available in the COMSOL installation folder in the location data/icons.
Images can be referenced in image form objects, in methods, or, in the form of
icons, in various form objects. For images used as icons, two sizes are available:
16-by-16 pixels (small) and 32-by-32 pixels (large).

X

List of Images

Na'me Description
animate_32.png COMSOL sample image
animate.png COMSOL sample image
clear_32.png COMSOL sample image
clear.png COMSOL sample image
compute_32.png COMSOL sample image
compute.png COMSOL sample image
comscl_32.png COMSOL sample image
comsol.png COMSOL sample image
delete_32.png COMSOL sample image
delete.png COMSOL sample image

S+ 0B
Preview
i3

Supported image formats are JPG, GIF, BMP, and PNG.

To preview an image, click the name of the image in the List of Images. The image
is displayed in the Preview section

To export a selected image, click the Export Selected Image File button to the right
of the Preview button.

Sounds

The Sounds library contains a few preloaded sounds in the WAV-file format. If you
wish to embed other sound files, click the Add File to Library button below the List
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of Sounds. A larger selection of sounds is available in the COMSOL installation
folder in the location data/sounds.

Settings =328
Sounds

List of Sounds

MName Description
fail.wav COMSOL sample sound
neutral.wav COMSOL sample sound
SUCCESS.Wav COMSOL sample sound
_l’_

To play a sound, click the name of the sound and then click the Preview button
below the List of Sounds.

Click the Export Selected Sound File button to the right of the Preview button to
export a selected sound.

To play a sound in an application, add a command in the Settings window of a
button, ribbon, menu, or toolbar item. In the Choose Commands to Run section,
select the sound and click the Run button below the tree. This adds a Play
command to the command sequence, as shown in the figure below.

» (Choose Commands to Run B

b B Forms
I @ GUI Commands
4 [fffj Libraries
4 i) Sounds
123 sUCCEssWav
123 failwav
123 peutralwav

=¢ Edit Node » Run Plot Set Value

Show Show as Dialog Import File
Enable Disable

Command lcon | Arguments
Play 'success.wav' >
=% . -

In methods, you can play sounds using the built-in method, playSound, such as:

playSound("success.wav");
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Files

The Files library is empty by default. Click the Add File to Library button to embed
files of any type in your application.

Settings
List of Files
] .

MName Copied from
datal.txt CACOMSOL\datal.bet
data2.txt CACOMSOL\data2. bt
data3.txt CACOMSOL\datad. et

mydata.csv CACOMSOL\mydata.csv

_;’_ \

X

Description
File
File
File
File

Use embedded:///filename to refer to a file with the name filename

in the application.

Click the Export Selected File button to the right of the Add File to Library button

to export a selected file.

_;’_ \

Usze “— e to refer to a file with the name filename
in th| Export Selected File

The embedded files can be referenced in a method by using the syntax
embedded:///datal.txt, embedded:///data2.txt, and so on. For more

information, see “File” on page 171, “Appendix C — File Scheme Syntax” on

page 328, and “File Methods” on page 354.
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Appendix A— Form Objects

This appendix provides information about forms and form objects and expands
upon the section “The Form Editor” on page 54.

List of All Form Objects

The items followed by a * in the following list have already been described in detail
in that section. The remaining items are discussed in this appendix.

e Input
- Input Field*
- Button*
- Checkbox
- Toggle Button
- Combo Box
» Labels
- Text Label*
- Unit*
- Equation
- Line
» Display
- Data Display*
- Graphics*
- Web Page
- Image
- Video
- Progress Bar
- Gauge
- Log
- Message Log
- Results Table
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* Subforms
- Form
- Form Collection
- Card Stack
» Composite
- File Import
- Information Card Stack
- Array Input
- Radio Button
- Selection Input
* Miscellaneous
- Text
- List Box
- Table
- Slider
- Knob
- Hyperlink
- Toolbar
- Form Toolbar

- Spacer

Checkbox

A Checkbox has two values: on for selected and off for cleared. The state of a
checkbox is stored in a Boolean variable in the Declarations node.
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USING A CHECKBOX TO CONTROL VISUALIZATION

The figure below is from an application where a deformation plot is disabled or
enabled, depending on whether the checkbox is selected.

Deformation el DEfD"TTEtiDE‘L

—
Compute Compute

&

The screenshot on the left shows the running application. The screenshot on the
right shows the corresponding form objects in grid layout mode.

In the example below, the state of the checkbox is stored in a Boolean variable
deformation, whose Settings window is shown in the figure below.
Settings X

List of Variables

» . g
MName Initial value Description
deformation | true Deformation
= #

238 |



The figure below shows the Settings window for the checkbox.

Settings =3
Check Box
Mame:  checkbox1 =

Text: Deformation

Tooltip:
~ Source @+ 5

4 = Declarations
4 @ Boolean
deformation
[ =bc String

Use as Source Edit Mode
Selected source:
E Boolean=deformation
Initial value: Custom value =

Initial state: Selected =

Value for selected: on

Value for cleared:  off
Position and Size

Appearance

¥ Events

On data change: Local method - Ej + -

You associate a checkbox with a declared Boolean variable by selecting it from the
tree in the Source section and clicking Use as Source.

The text label for a checkbox gets its name, by default, from the Description ficld
of the Boolean variable with which it is associated.

The Initial value of the variable deformation is overwritten by the Value for
selected (on) or the Value for cleared (off) and does not need to be edited. When
used in methods, the values on and of f are aliases for true and false, respectively.
These values can be used as Booleans in if statements, for example.

The code statements below come from a local method that is run for an On data
change event when the value of the Boolean variable deformation changes.

model.result("pgl1").feature("surfi1").feature("def").active(deformation);
useGraphics(model.result("pg1"), "graphicsi");
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USING A CHECKBOX TO ENABLE AND DISABLE FORM OBJECTS

The figure below shows a part of an application where certain input fields are
disabled or enabled, depending on if the checkbox is selected.

Find
Find prong length: [
Target frequency: 440 Hz

The figure below shows the Settings window for a checkbox associated with a
Boolean variable findlength used to store the state of the checkbox.

- X
MName:  checkboxl E
Text:
Tooltip:
v Source ® + e
4 = Declarations
4 Boolean
1 findlength
& Model (root)
E‘ Use as Source =g Edit Node
Selected source:
123 Boolean=findlength
Initial value: Custom value -
Initial state: Cleared -

Value for selected: on

Value for cleared:  off

The code statements below come from a local method that is run for an On data
change event when the value of the Boolean variable findlength changes.

setFormObjectEditable("main/inputfield1", !findlength);
setFormObjectEditable("main/inputfield5", findlength);
setFormObjectEnabled("main/inputfield5", findlength);
setFormObjectEditable("main/inputfield6", findlength);
setFormObjectEnabled("main/inputfield6", findlength);
solution_state = "inputchanged";
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Toggle Button

A Toggle Button object is a button with two states: selected and deselected, as
shown in the figure below.

(= B

Heat Source Heat Source

The information in this section is also applicable to Menu Toggle Item and Ribbon
Toggle Item.

USING A TOGGLE BUTTON TO ENABLE AND DISABLE A HEAT SOURCE

The two states of a toggle button are typically stored by linking it to a Boolean
variable. The figure below shows the Settings window of a button that enables and
disables a heat source depending on its state. The Boolean variable heat_source
is selected in the Source section.

Settings v RX
Toggle i_bij’-

Name: togglebutton =
Text: Heat Source

lcon: B heat_transfer 32png = -+ [=
Selected icon: B heat_transfer 32png = -+ [=
Size: Large =
Style: Flat =
Tooltip:

Keyboard shortcut:
-+ Source FAF

4 = Declarations
4 @ Boolean
heat_source

Use as Source Edit Mode
Selected source:

E Boolean=heat_source

Initial value: From data source =

Value for selected: on

Value for cleared:  off
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Enabled corresponds to the Boolean variable heat_source being equal to true,
which in turn corresponds to the toggle button being selected. Disabled
corresponds to the Boolean variable heat_source being equal to false, which in
turn corresponds to the toggle button being deselected. The Icon is displayed
when the toggle button is not selected. When the toggle button is selected, the
Selected icon is displayed.

Below the Source section is the Choose Commands to Run section, with a choice for
Action that represents two different commands for Select and Deselect. The figure
below shows the Settings window for Deselect with a command Disable Heat Source.

v Choose Commands to Run i
[ u GUI Cormmands
[ = Declarations
b [ Libraries
4 & Model (root)
4 im Component 1 (compl)
[ = Definitions
b YA Geometry 1
I 5z& Materials
4 |[@ Heat Transfer in Solids (ht)
|&= Heat Source 1

= Termnperature 1

# Edit Node Run Plot Set Value Show
Show as Dialeg Import File (&) Enable @) Disable

Action: | Deselect -
"
Command lcon  Arguments
Disable Heat Source 1 @
-~

==
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The next figure shows the command sequence for Select with a command Enable
Heat Source.

+ (Choose Commands to Run e

b [ Libraries
4 & Model (root)
I () Global Definitions
4 im Component 1 (compl)
[ = Definitions
Y4, Geometry 1
I 5z& Materials
4 |[@ Heat Transfer in Solids (ht)
|&= Heat Source 1
= Temperature 1
mw Heat Flux 1

=# Edit Node Run Plot Set Value Show
Show as Dialeg Import File (&) Enable @ Disable

Action: | Deselect -

» Select
Com

Deselect
Enable HearsooreeT ™

==

A toggle button is similar to a checkbox in that it can be linked to a Boolean
variable. For a toggle button, you define the action by using a command sequence,
whereas for a checkbox, you define the action by using an event. This is described
in the next section. For simultaneous control of multiple toggle buttons you can
link to a String variable, instead of a Boolean variable. This enables you to group
the behavior of multiple toggle buttons similar to that of a radio button.

Combo Box

A Combo Box can serve as either a combination of a drop-down list box and an
editable text field or as a drop-down list box without the capability of editing.

USING A COMBO BoX TO CHANGE PARAMETERS IN RESULTS

To illustrate the use of a combo box, consider an application where the user selects
one of six different mode shapes to be visualized in a structural vibration analysis.
This example uses a Solid Mechanics physics interface with an Eigenfrequency
study and is applicable to any such analysis.
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These six mode shapes correspond to six different eigenfrequencies that the user
selects from a combo box:

Frequency: | Fundamentaltone =

Fundamental tone
Overtone 1
Overtone 2
Overtone 3
Overtone 4
Overtone 5

In this example, the combo box is used to control the value of a string variable
mode. The figure below shows the Settings window for this variable.

Settings =3
5tring
List of Variables

L . g
MName Initial value Description
mode 7 Mode number
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Selecting the Source
The figure below shows the Settings window for this combo box.

- X
Mame: combobox] E
¥ Source & E
4 = Declarations

4 =wc String

=2 mode

Use as Source Edit Mode
Selected source:

asc String=mode
Initial value: | From data source -
+ Choice List ® +

Available: Selected:
<%» Choice List 1 {choicelist1}

[] Allow other values

In the Source section, you select a scalar variable that should have its value
controlled by the combo box and click Use as Source. In the Initial values list of the
Settings window of the combo box, choose a method to define a default value for
the combo box. The options are First allowed value (the default) and Custom
default. For the Custom default option, enter a default value in the associated field.
The default value that you enter must exist among the allowed values.

Choice List

The vibrational modes 1-6 correspond to trivial rigid body modes and are not of
interest in this application, hence the first mode of interest is 7. A choice list allows
you to hide the actual mode values in the model from the user by only displaying
the strings in the Display name column; the first nonrigid body modes are named
Fundamental tone, Overtone 1, Overtone 2, and so on.
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In the section for Choice List, you can add choice lists that contribute allowed
values to the combo box. The Choice List declaration associated with this example
is shown in the figure below.

[E] ~
[ ! Events . Settinds -ax
4 = Declarations - ==
<Z» Choice List 1 {choicelist1} Choice List
abc Sty
" Label:  Choice List 1| =

Methods
Mame: choicelist]

List Content

" Value Display name

7 Fundamental tone
8 Overtone 1

9 Overtone 2

10 Overtone 3

1 Overtone 4

12 Overtone 5

\

The string variable mode is allowed to have one of these six values: 7, 8,9, 10, 11,
or 12. The text strings in the Display name column are shown in the combo box.
In the Settings window of the combo box, you can select the Allow other values
checkbox to get a combo box where you can type arbitrary values. Such combo
boxes can accept any value and are not restricted to the values defined by the
choice lists. In this example, however, only six predefined values are allowed.

For more information on choice lists, see “Choice List” on page 169.

Events

In the Events section, specify a method to run when the value of the combo box,
and thereby the string variable used as the source, is changed by the user. In the
present case, the value of the variable mode is changed, and a local method is run,
as shown below.

¥ Events

On data change: Local method - Ej + -

The code for the local method is listed below.

with(model.result("pg1"));
set("looplevel", new String[]{mode});

endwith();

model.result("pg1").run();
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This code links the value of the string mode to the Eigenfrequency setting in the

Plot Group pg1. In this case, the string svar takes the values "7", "8", "9", "10",
|I11 II’ Or I|12I|'

The code above can be generated automatically by using the recording facilities of
the Method Editor:

* Go to the Model Builder and, in the Developer tab, click Record Method.

* By default, when using an Eigenfrequency study for a structural mechanical
analysis, a Mode Shape plot group is created. In this plot group, change the
Eigenfrequency from mode 7 to mode 8. In the figure below, this corresponds
to changing from 440 Hz to 633.52 Hz in the Settings window for the Mode
Shape plot group.

Settings R

3D Plot Group

ot

[l Plot M= 4= = =4

Label: Mode Shape (solid) =
¥ Data
Dataset: Study 1/Solution 1 » 24
Eigenfrequency (Hz): | 440 - |
. 0.014514i
Selection 0.018255i |
Title 0.027698i |
Plot Setti 0.0019687 |
v
21 S 0.0083763
Wiew: Automatic 0023353
Show hidd titi 4“0
[] Show hidden enti I|633.52 |

[ Propagate hiding ti ;-
[[] Plot dataset edges 11658

Color: From then 2756.8

Frame: Material | ._.31‘?5'6

» Click Stop Recording.

The resulting code is shown below.

with(model.result("pg1"));
set("looplevel”, new String[]{"8"});

endwith();

model.result("pg1").run();
Now change the string "8" with the variable mode to end up with the code listing
above. This will be stored in a method, say, method1. To create the local method
associated with the combo box, copy the code from method1. Then, delete
method1.
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Using Data Access

A quicker, but less general way, of using a combo box is to use Data Access in
combination with Editor Tools. For the example used in this section, you start by
enabling Data Access and, in the Settings window of the Mode Shape plot group,
select the Eigenfrequency, as shown in the figure below.

Settings =i

30 Plot Group

FIOT Lroup

[Ea Plot M= 4= =» =b

Label: Mode Shape (solid) =
¥ Data

Dataset: l:‘ Study 1/Solution 1 (soll) =4
Eigenfrequency (Hz): 633.52 =

In the Editor Tools window, the Eigenfrequency parameter is visible as Loop Level.
To create a combo box, right-click Loop Level and select Input.

Editor Tools TAX
= Edit Node =T ~

% Themes

b [ Main Window
b B Forms
I @ GUI Commands
I = Declarations
I [y Methods
b [ Libraries
4 & Model (root)
I () Global Definitions
I @ Component 1 (compl)
[~ Study 1
4 [ Results
I Datasets
I+ &2 Derived Values
I E Tables
4 |8 Mode Shape (solid)
abe Eigenfrequencw (Hz) {lnonlevel i=11
b [ Surface 1 Input
3 Eigenfrequencies| Output
Export
I [# Reports =¢ Edit Node

The generic name Loop Level is used for a solution parameter. If a solution has two
or more parameters, then there are two or more loop levels to choose from.
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The figure below shows the Settings window of the corresponding combo box.

- 1 X
MName: combobox] 5]
~ Source @+ B
[ = Declarations
4 & Model (root)
I () Global Definitions
4 [ Results
4 |8 Mode Shape (solid)
afF Eigenfrequency (Hz) (looplevel, i=1)
Use as Source Edit Mode
Selected source:
abe Mode Shape (solid)=Eigenfrequency (Hz) (looplevel, i=1)
Initial value: From data source =
+ Choice List ® +
Available: Selected:
<&> Material {materiallist} abe Eigenfrequency (Hz) (looplevel, i=1)

<Z» Simulation Type List {simulationTypeList}

[] Allow other values

The choice list Loop Level is automatically generated when inserting a combo box
using Editor Tools. Note that a choice list generated in this way is not displayed
under the Declarations node and cannot be modified by the user. For greater
flexibility, such as giving names to cach parameter or cigenfrequency value, you
need to declare the choice list manually, as described in the previous section.

USING A CoMBO Box To CHANGE TIMES

The time parameter list specified in a Time Dependent study step can be used in
many places under the Results node. In an application, the individual time
parameters can be accessed in a similar way to what was described in the last
section for parameters, by using Data Access in combination with Editor Tools.
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In the Settings window in the figure below, Data Access has been used to access the
Time parameter list in a temperature plot.

A
Plot = 4= = =4|
Label: Temperature, 3D (ht) =
¥ Data
Dataset: l:‘ Reveolution 20 v F
Time (s): 70 —

In Editor Tools, a handle to the Time list is now available, as shown in the figure
below.

Editor Tools TAX
= Edit Node =T ~

% Themes
D Main Window
b B Forms
I @ GUI Commands
b [ Libraries
4 & Model (root)
I () Global Definitions
[» &= Component 1 (compl)
[~ Study 1
Study 2
Results
Datasets
=L~ Views
2% Derived Values
EH Tables
VB Temperature, 30 (ht)
abe Time (5] (looplevel. i=11
™ Surfa Input
! Isotherm Output
\ Temperal
B lsotherm S#  Edit Node
o Ternperature, 10

[
vavv@é

v v v v

o Temperature Difference, 10
Export
[# Reports
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By selecting Input, you can create a combo box using it as Source, as shown in the
figure below.

Settings =3
Combo Box

MName: combobox] E
-+ Source FAF

= Declarations
4 & Model (root)

4 [ Results
4 |@ Temperature, 30 (ht)
=1 Time (s) (looplevel, i=1)

Use as Source Edit Mode
Selected source:

abe Temperature, 30 (ht)=Time (5] (looplevel, i=1)

Initial value: From data source =
+ Choice List ® +
Available: Selected:

abe Time (s) (looplevel, i=1)

The combo box can be used for multiple purposes, for example, to update a plot
corresponding to a different time parameter. In order for a plot to automatically
update when a user uses the combo box to select a new time parameter, add an
event to the combo box at the bottom of its Settings window. In the figure below,
a method plotT is called for updating a temperature plot.

¥ Events

On data change:  plotT v 4+~

The line of code below shows the contents of the method plotT:
model.result("pgl1").run();
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The end result is a combo box in the application user interface, shown in the figure
below, which automatically updates a temperature plot when the user selects a new
value for the Time list.

Time (s): 70 -

o]

120
130

Interpolation

USING A CoOMBO BoxX To CHANGE MATERIAL

Consider an application where combo boxes are used to select the material. In this
case, an activation condition (see “Activation Condition” on page 170) can also
be used for greater flexibility in the user interface design.

The figure below shows screenshots from an application where the user can choose
between two materials, Aluminum or Steel, using a combo box named Material. A
second combo box called Alloy shows a list of Aluminum alloys or Steel alloys,
according to the choice made in the Material list.

Material: Aluminum -

Aluminum
Steel
Alloy: Aluminum 3003 =

Material: Aluminum - Material: Steel -
Alloy: Aluminum 3003 = Alloy: Steel AISI 4340
Aluminum 3003 Steel AlSI 4340
Aluminum 6063 Structural steel, generic
Aluminum, generic
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The material choice is implemented in the embedded model using global materials

and a material link, as shown below.

Model Builder

-

4

= v =1

4 & Steel_rod.mph (root)

4 () Global Definitions
Pi Parameters 1

4 iE Materials
[» 5g= Aluminum 3003-H18 (mat1)
[» 2g= Aluminum 6063-T83 (mat2)
[ 2g= Aluminum (mat3)
I Szi Steel AISI 4340 {matd)
[» Eg= Structural steel (mat3)
Component 1 {comp 1)
= Definitions
A\ Geometry 1
2 Materials

==& Material Link 1 (matink1)
[ +\_ Electric Currents (ec)
I» {[E Heat Transfer in Solids (ht)
iry Multiphysics
A5 Mesh 1
[ ~do Study 1
b {8 Results

[ 8
N |

-

Label: Material Link 1

Geometric Entity Selection
Geometric entity level: | Domain

Selection: All domains

Active

Cverride

¥ Link Settings

Material: | Aluminum 8063-T23 (mat2)

-

MNone

Aluminum 3003-H18 (mat1)
Aluminum 6063-T83 (mat2)
Aluminum (mat3)

Blec] Steel AlSI 4340 (mat4)

Structural steel (mat53)

¥ Mate

EYEEiEY

Density rtho
Thermal conductivity k_iso ..
Relative permeability mur_i...

Coefficient of thermal expansi... |alpha_...

Young's modulus E
Poisson's ratio nu

Bt

2700[kg...
201[W/(...
-
23.4e-6[...
69e9[Pa]
033

Each material is indexed with a string: mat1, mat2, ..., mat5. An event listens for
changes to the value of the global variable alloy, where the value is controlled by

a combo box. When the value is changed, the method listed below is run.
with(model.material("matlnk1"));

set("link", alloy);

endwith();
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The figure below shows the declaration of two string variables, material and
alloy, which are controlled by the Material and Alloy combo boxes, respectively.

Settings
5tring

List of Variables

"

MName Initial value Description
material aluminum Material
alloy mat1 Alloy

The application utilizes three choice lists: Aluminum Alloys, Steel Alloys, and
Material.

Activation Condition
An activation condition is used for the Aluminum Alloys and Steel Alloys choice lists,
as shown in the figure below.

4 = Declarations
4 &> Aluminum Alloys {choicelist 1}
<Z» Activation Condition {actcond 1}
4 &> Steel Alloys {choicelist2}
<z» Activation Condition {actcond 1}
<Z» Material {choicelist3)
anc String
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The Settings window for the Material combo box is shown below.

Settings
Combo Box
Mame: combobox]

+ Source

4 = Declarations
4 =oc String
18 material
123 alloy
@ Model (root)

Use as Source Edit Mode
Selected source:

123 String=rnaterial
Initial value: | First allowed value

¥ Choice List

Available: Selected:

<> Aluminum Alloys {choicelist]} <> Material {choicelist3}
<> Steel Alloys {choicelist2}

[] Allow other values

Note that the Material combo box uses the material string variable as its source.
The Material choice list is used to define a discrete set of allowed values for the
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material string variable. The Settings window for the Material choice list is shown
below.

Label:  Material

MName:  choicelist3

List Content

»
Value Display name
aluminum Aluminum
steel Steel
LY
T l - I g

256 |



The Settings window for the Alloy combo box is shown in the figure below.

MName: combobox2 E
+ Source .:_E. + =

4 = Declarations
4 =vc String
123 material

13 alloy
& Model (root)

-

E‘ Use as Source =g Edit Node

Selected source:

123 String=alloy
Initial value: | First allowed value
¥ Choice List ® +

Available: Selected:
<& Material {choicelist3}

2> Aluminum Alloys {choicelist] }
<> Steel Alloys {choicelist2}

[] Allow other values
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Note that the Alloy combo box uses both the Aluminum Alloys and the Steel Alloys
choice lists. The choice list for Aluminum Alloys is shown in the figure below.

Settings
Choice List
Label:  Aluminum Alloys E

MName:  choicelist]

List Content

4 Value Display name
mat1 Aluminum 3003
mat2 Aluminum 6063
mat3 Aluminum, generic
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The activation condition for the Aluminum Alloys choice list is shown in the figure
below.

- X
Label:  Activation Condition

MName:  actcondl

+ Source & E

4 = Declarations
4 =oc String
15 material
123 alloy
& Model (root)

E‘ Use as Source =g Edit Node

Selected source:

123 String=mnaterial
¥ Condition

»
Activating values

aluminum

==

[1 Invert condition on input values

USING A CoMBO Box To CHANGE ELEMENT SIzE

When creating a combo box, you can use the Data Access functionality to
reproduce the features of a combo box that exists within the Model Builder. For
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example, consider an application where a combo box is used to change the
element size in a mesh, as in the figure below.

Element size: | MNormal -

Extremely fine
Extra fine
Finer

Fine

MNormal

Coarse

Coarser
Extra coarse

Extremely coarse

Switch to the Model Builder and select the Mesh node (we assume here that the
model has just a single mesh). In the Settings window of the Mesh node, select
User-controlled mesh (if not already selected). In the Size node, directly under the
Mesh node, select the option Predefined. Click Data Access in the ribbon. This gives
access to the combo box for a predefined element size, as shown in the figure
below.

Settings v

% Build Selected [§§ Build All
Label: Size E

Element Size

Calibrate for:

General physics -
® predefined /]| Normal =
) Custom

Select the green checkbox to the left of the list to make it available as a source for
a combo box in the Application Builder. Then, when you return to the Application
Builder, you will find that the choice list for mesh size is now revealed as a
potential Source in the Settings for a new combo box.
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To insert the combo box object, you have two alternatives:

+ Sclect Combo Box from the Insert Object menu in the ribbon. In the Settings
window for the combo box, select the node Predefined size (hauto) in the
Source section and then click the Use as Source button.

 In the Editor Tools window, sclect the node Predefined size (hauto) under the

Mesh > Size node. Then right-click and select Input, as shown in the figure
below.

Settings Editor Tools X > 1
= Edit Node =T ~

% Themes
D Main Window
b B Forms
I @ GUI Commands
b [ Libraries
4 < Model (root)
4 () Global Definitions

Fi Parameters 1

2 Materials
4 |§ Component 1 (comp1)
= Definitions
WA Geometry 1
[ @ Solid Mechanics (zolid)
4 A Meshl

Size
8.5 Predefined Size (Hauto)
4% Free Tetra Input
[+~ Study 1 —
4 [® Resuhl‘;:s et
Datasets Z¢ EditNode
ez Derived Values
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The corresponding Settings window for the combo box is shown in the figure
below.

Settings Tax
Name: combobox! E
v Source @+ "3

= Declarations
4 & Model (root)
I () Global Definitions
4 im Component 1 (compl)
4 S Mesh1

s[5 Predefined size (hauto)

E‘ Use as Source =g Edit Node
Selected source:

8.5 Size=Predefined size (hauto)

Initial value: | From data source -
¥ Choice List ® +
Available: Selected:

8.5 Predefined Size (Hauto)

[] Allow other values

Changing the Initial value to From data source ensures that the element size setting
of the model, in this case Normal, is used as the default element size in the
application. The choice list, Predefined size (hauto), from the Model Builder is now
selected as the choice list for your combo box in the Application Builder. This
choice list does not appear as a choice list under the Declarations node of the
application tree because it is being referenced from the Model Builder. Therefore,
if you want a list with a more limited set of choices, you cannot edit it. Instead,
you have to remove the predefined list as the Source of your combo box and create
a new choice list of your own by declaring it under the Declarations node. For
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example, you can create a choice list with three entries, as shown in the figure
below.

Settings TAX

m

Label:  Choice List 1 =

Mame: choicelist]

List Content

L
Value Display name
4 Fine
5 Mormal
6 Coarse
\

To learn which values are used by the Element size list in the model, use Record a
New Method and change the value from Normal to Fine, then to Coarse, and then
back to Normal. Click Stop Recording and read the values in the autogenerated
code. The Element size property name is hauto and the values for Fine, Normal, and
Coarse arc 4, 5, and 6, respectively, as implied by the automatically generated code
shown in the lines below.

with(model.mesh("mesh1").feature("size"));
set("hauto", "4");
set("hauto", "6");
set("hauto", "5");
endwith();
The hauto property can also take non-integer values. For more information on
Element size, see “Data Access for Input Fields” on page 107.

USING A UNIT SET INSTEAD OF A CHOICE LIST

If the combo box will be used for the purpose of changing units, then a Unit Set
can be used instead of a Choice List (you still select it in the Choice List section of
the Settings window of the combo box).
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Equation

An Equation object can display a LaTeX equation by entering the expression in the
Enter equation in LaTeX syntax ficld.

X

Name:  equationl =
* Equation = % ov

Enter equation in LaTeX syntax:
-\nabla \cdot (k \nabla u) (]
Equation preview

-V (kVu)
¥ Position and Size

Width: 67
Height: 20
Positionx: 644
Position y: 368

¥ Appearance

Text color: | Inherit -

Fontsize: | Default size v opt
State

Visible

Enabled

A preview is shown of the rendered LaTeX syntax after leaving the text field.
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Line

Use the Line form object to add a horizontal or vertical line to a form, which can
be used, for example, to separate groups of form objects. For the horizontal line
option, you can also add text that appears within the line.

Settings =3
Line
Mame: linel =
¥ Settings
Orientation:

Horizontal =

[ Include divider text
Text:

¥ Position and Size

Width: 200
Height: 1

Positionx: 303
Position y: 268

¥ Appearance

Line thickness: 1

Line color: Default =
Text color: Inherit =
Font: Default font =

Font size: Default size v pt

[] Bold
[] Italic
State
Visible
Enabled
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Web Page

A Web Page object can display the contents of a web page as part of the user

interface.

You can specify the page source in four different ways from the Source list:

Use the setting Native browser on Windows to control which browser is used in the

ettings v RX

Al

MName: webpagel =
Mative browser on Windows: Chromium™ =
¥ Source

URL -
Page URL:

https:/fwww.comsol.com/products

Browser preview

W COoOMSOoL Q MENU

The COMSOL Product
Suite

¥ Position and Size

Width: 240
Height: 100
Positionx: 20
Positiony: 442

¥ Appearance

Visible

Use the default option Page to enter HTML code in a text area below the
list, enclosed by the <html> and </html> start and end tags.

Use the URL option to link to a web page on the Internet.

Use the File option to point to a local file resource containing HTML code.
Type the name of the file in the File field or click Browse to locate the file on

the local file system.

Use the Report option to embed an HTML report. The Browser preview is

not active for this option.

Windows® version of COMSOL Multiphysics.
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Image

Use an Image form object to add an image to a form. An image object is different
from a graphics object in that an image object is not interactive. Choose an image
file from one of the library images, accessible from a drop-down list, or by clicking
the Add Image to Library and Use Here button to select a file from the local file
system. The figure below shows the Settings window for an image object
referencing the image comsol_32.png, defined in the Libraries node.

Settings v RX
Image

Mame:  imagel =
Image: = Picturel.png | 4| B

¥ Position and Size

[] Stretch image

Harizontal alignment: Left =
Vertical alignment: Top =
Width: 157
Height: 749
Rowe: 1
Column: 1
Row span: 1
1

Column span:

Cell margin

Cell margin: From parent form =

¥ Appearance

Visible
Enabled

If you select an image file from your file system, this file will be embedded in the
application and added to the list of Images under the Libraries node.

While you can change the x- and y-position of the image, the width and height
settings are determined by the image file. However, if you use the grid layout
mode, then there is an additional setting Stretch image which, if activated, will
automatically scale the image to fill the available grid cell space.

You can paste images from the clipboard to a form window by using
Ctrl+V. For example, you can copy and paste images from the
PowerPoint® slide presentation software. Such images will be added
automatically to the Images library and embedded in the application. The
names for pasted images are automatically set to: pasted_image_1.png,
pasted_image_ 2.png, and so on.
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Video

A Video object embeds a video file in a form. The supported video file formats are
MP4 (.mp4), OGV (.ogv), and WebM (.webm). However, not all video file
formats are supported on all platforms. When running an application by
connecting to COMSOL Server from a web browser, which formats are supported
depend on the web browser and may vary with different versions of the same web
browser. When running an application with the COMSOL Client and with
COMSOL Multiphysics, the Internet Explorer version installed on your computer
is used as a software component for displaying the video object.

After added to a form, the Video object is represented, in the Form Editor by an
image, as shown in the figure below.

The figure below shows the Settings window for the Video object.

Settings Tax
MName: videaol E
Video: instructionswebm  + |+ =

Show video controls
[] Start automatically

[] Repeat
[ Initially muted

Mative browser on Windows: Chromium™ (CEF) -

¥ Position and Size

Width: 420
Height: 300
Positionx: 20

Positiony: 20
¥ Appearance

Visible

The available settings are:

¢ Show video controls
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e Start automatically
* Repeat
¢ Initially muted

The option Show video controls enables the video controls such as Play and Stop.

The option Initially muted is intended for the case where you want to play a video
with the sound initially turned off. For example, if the video is set to start
automatically, it can be useful to let the user choose whether the sound should be
on. The user can enable the sound either from the video controls, if the Show video
controls checkbox is selected, or by right-clicking in the video player.

Use the setting Native browser on Windows to control which browser is used in the
Windows® version of COMSOL Multiphysics.

Progress Bar

A Progress Bar object displays a customized progress bar, or set of progress bars,
based on a value that is updated by a method. Use a progress bar to provide
feedback on the remaining run time for an application. The figure below shows
the Settings window of a progress bar object with one progress level.

Settings

Progress Bar

MName: progressharl =
Include model progress

Progress levels: | One -

Cancel button
Close dialog when canceled

¥ Position and Size

Width: 375
Height: 100
Positionx: 20

Positiony: 20
¥ Appearance

Visible
Enabled

Note that the built-in progress bar that is visible in the status bar of an application
is controlled by the Settings window of the Main Window node. By default, the
built-in progress bar shows the progress of the built-in COMSOL Multiphysics
core algorithms, such as geometry operations, meshing, and solving. By using the

| 269



setProgress method, you can customize the information shown in the built-in
progress bar. For more information, see “Progress Methods” on page 364 and the
Application Programming Guide.

The figure below shows the Settings window of a progress bar object with two
progress levels.

Settings
Progress Bar
MName: progressharl =

Include model progress
Progress levels: | Two

Cancel button
Close dialog when canceled

In this example, the progress bar object is part of a form progressform used to
present a two-level progress bar and a message log.
The figure below shows the corresponding progress dialog in the running

application.

3 Progress

Computing frequency.

Compute

Cancel

MNumber of degrees of freedom solved for: 24012,
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The figure below shows the form progressform.

D progressform X

h

Progress message

Progress message .

Cancel

Messages

The code segments below show typical built-in methods used to update the
progress bar and the message log.

// show progress dialog:
dialog("progressform");
setProgressBar (" /progressform/progressi", 0, "Computing prong length.");

/| code for iterations goes here:
lastProgress = 20;
/1

// update message log:

message("Iteration Number: " + k);

message ("Frequency: " + Math.round(fgq*100)/100.00);
message("Length: " + Math.round(L1*100)/100.00);

// update progress bar:

setProgressInterval("Computing frequency", lastProgress,
k*100/MAXITERATIONS) ;

// more code goes here:

/1

// finished iterating:
setProgressBar("/progressform/progressi", 100);
closeDialog("progressform");
In the example above, the central functionality for updating the two levels of
progress bars lies in the call

setProgressInterval("Computing frequency", lastProgress,
k*100/MAXITERATIONS).
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For detailed information on the built-in methods and their syntax, see “Progress
Methods” on page 364 and the Application Programming Guide.

Gauge

Use a Gauge form object to add a radial gauge to a form. This object is similar to
the knob form object but is read-only and used to display a value by the position
of a needle or arrow of a gauge. Optional tick marks and labels are used to indicate
the range of values that the gauge can display. In addition to tick marks and labels,
you can optionally configure a color scale to indicate the values. The figure below
shows a gauge object together with a data display object, displaying the maximum
stress in a structural mechanics application.

100
80 , y , 120
Y /

3745 MPa
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The Settings window for a gauge object is similar to that of a knob object.
However, there are some differences. For example, there is no Events section for a
gauge object. The figure below shows the Settings window for a gauge object.

Settings TAX

Mame: gaugel ,@
Minimum value: 0

Maximum value: 200

Number of steps: 20

Tooltip:

~ Source @+ 5

= Declarations
& Model (root)
(1) Global Definitions
4 [ Results
4 2% Derived Values
wl Volume Maximum 1

[ 8

Use as Source Edit Mode
Selected source:
max Volume Maximum 1
Initial value: From data source =
Unit
Number Format
Position and Size

¥ Appearance

Scale: Tick marks and all labels =
MNeedle color: Default =
Sweep angle: 270 deg

Color ranges

" Start value | End value | Start color End color
0 200 u

You can select any parameter, variable, or declared scalar variable as a source.
Select from the application tree and click Use as Source.

You determine the range of values for the data source by defining the Minimum
value, Maximum value, and Number of steps for the gauge.
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You can enter a Tooltip that is shown when hovering over the gauge. The settings
for units are similar to that of a slider or knob.

In the Initial value list, sclect From data source or Custom value for the initial value
for the gauge.

The figure below shows the Unit, Number Format, and Position and Size sections.
* Unit
Method: Append unit to number ~| |4
Unit expression:  MPa

¥ MNumber Format

[] Custom label formatting
Precision: 4
Motation: Automatic

Exponent: Power of 10

¥ Position and Size

Width: 128
Height: 128
Radius: Automatic =

Positionx: 151

Positiony: 181

The Unit section is similar to that of a slide or knob object.
In the Number Format section, you can specify a custom format for the tick labels.

The Position and Size section will have different contents depending on if the form
is using sketch mode or grid mode. You specify the Width and the Height is
automatically set to the same value as the Width (the Height edit field is disabled).
The Radius value specifies the radius for the tip of the gauge object's needle. By
default this is calculated automatically, but you can set it manually to make sure
that gauge objects placed next to each other have the same needle radius.
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The figure below shows the Appearance section.

¥ Appearance

Scale: Tick marks and all labels =
MNeedle color: Default =
Sweep angle: 270 deg

Color ranges
L]

Start value | End value | Start color End color
0 200 u

_l’_

The Needle color takes its Default value from the current color theme.

You can specify a sequence of color ranges for the gauge. Click the Add button in
the table toolbar to add another color range, which opens a dialog.

3 Color Range X
Start value: 0

End value: 200

Start color: Green =

End color: Red =

oK Cancel

In this dialog you give the start and end values for a color range as well as the start
and end color. To edit an existing color range, select its row in the table and click
the Edit button. The Move up and Move down buttons can be used to reorder the
color ranges and the Delete button deletes the color ranges in the selected rows.

The Start color and End color can take the value Transparent which means that they
get the same color as the current background color.

If the End value is less than the Start value, then the color range is rendered
backward.

Log

The Log form object adds a log window that displays messages from the built-in
COMSOL Multiphysics core algorithms, such as geometry operations, meshing,
and solving.
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The Include standard log toolbar checkbox is selected by default. When selected,
the toolbar in the Log window that you see in the COMSOL Desktop is included
in the application.

Settings
Log
Name: logl E

[] Include standard log toolbar

¥ Position and Size

Horizontal alignment: | Fill -
Vertical alignment: Fill -
Minimum width: Automatic -
Minimum height: Autornatic -
Row: 6
Column: 6
Row span: 1
Column span: 1
Cell margin
Cell margin: From parentform =

The figure below shows a part of an application user interface containing a log
window.

RNy =

Selution error estimates for segregated groups

2.3e-016, 0.0006&

Residual errcr estimates for segregated groups

9.4e-009, 38

Stationary Solver 1 in Sclution 1: Solution time: 1 =5
Physical memcry: 1.99% GB
Virtual memory: 2.12 GB

Message Log

The Message Log object adds a window where you can display messages to inform
the user about operations that the application carries out. Implement this feature
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using the built-in message method with syntax: message (String message). See
also “GUI-Related Methods” on page 359.

hMessage Log

Mame: messages] =

Include standard message log toolbar
Show COMSOL messages
[] Add timestamps to messages.

¥ Position and Size

Horizontal alignment: | Fill -

Vertical alignment: Fill -

Minimum width: Manual -
350

Minimum height: Manual =
150

Rowe: 3

Column: 1

Row span: 1

Column span: 1

Cell margin
Cell margin: From parentform =

You can also display the value of a variable, for example: message (double
xcoordinate).

The Include standard message log toolbar checkbox is selected by default. When
selected, the toolbar in the Messages window that you see in the COMSOL
Desktop is included in the application. The Show COMSOL messages checkbox is
selected by default to enable messages from the built-in COMSOL Multiphysics
core algorithms, such as geometry operations, meshing, and solving. Clear the
checkbox to only allow messages from the application itself. You can include time
stamps to message by selecting the Add timestamps to messages checkbox.
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The figure below shows a customized message window with convergence
information from a method (left) and the corresponding Message Log form object
(right).

Iteration Mumber: 1 P
Frequency: 406.04
Length: 82.6
Iteration Mumber: 2
Frequency: 427.82
Length: 81.26
Iteration Mumber: 3
Frequency: 440.78
Length: 81.35
Iteration Mumber: 4
Frequency: 439.98
Length: 81.34

Results Table

The Results Table object is used to display numerical results in a table.

@S o @O BE
t Temperature
0.0000 |2.6482E-5
10.000 |-2.0938E-7
20.000 |5.7008E-6
30.000 |[5.2716E-5
40.000 |1.4153E-4
50.000 |2.4552E-4
60.000 |3.3034E-4
70.000 |3.9170E-4
80.000 |4.4674E-4
90.000 |4.8283E-4
100.00 |5.0449E-4
110.00 |5.0547E-4
120,00 |5.3835E-4
130.00 [5.3073E-4
140,00 |5.2329E-4
150.00 |5.1631E-4
160.00 |5.2391E-4

17000 |5 1o0nnc A

The source of the results table data is taken from Results and can be a child node
of Derived Values, a Table, or an Evaluation Group. In the figure below, a Table node
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is used as the source (by selecting this option in the tree and then clicking Use as
Source.)

Settings TAX

MName: resultstablel =
Include standard results table toolbar
Show headers

¥ Source

4 & Model (root)

4 JE:I, Results
4 2% Derived Values
2% Point Evaluation 1
4 [ Tables
FH Table1
Table 2

@_‘Use as Source %, Clear Source =# Edit Node
Selected source:

B Table2

By clearing the Show headers checkbox, you can choose to hide the column
headers of the results table.

RESULTS TABLE TOOLBAR

The Include standard results table toolbar checkbox is selected by default. When
selected, a toolbar is included that provides the following buttons:

Full Precision

Automatic Notation

Scientific Notation

Engineering Notation

Decimal Notation

Rectangular Complex Numbers

Polar Complex Numbers

Copy Table and Headers to Clipboard
Export

The Export button is used to export to the following file formats:

Text File (.txt)
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« Microsoft® Excel Workbook (.x1sx)
- Requires LiveLink™ for Excel®

* CSV File (.csv)
+ Data File (.dat)

This is shown in the figure below.

Text File (*txt) -

[ Text File (*tet) |
Microsoft Excel Workbook (*xlsx)
C5V File (*.csv)

Data File (*.dat)

All Files (*%)

CONTROLLING RESULTS TABLES FROM METHODS

There is a built-in method useResultsTable() for changing which table is shown
in a particular results table form object. For more information on this built-in
method, see “GUI-Related Methods” on page 359.

Form

A form object of the type Form is used to organize a main form in one or more
subforms. To embed a subform, you create a link to it by selecting the form you
would like to link to from the Form reference of the Settings window for the
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subform. The figure below shows an example where one of the cells of a form

mainComputer has a link to the subform form1.

@ Preview D mainComputer: form1

D mainComputer X Cettin v X
= Settings
Form
Y fm
! A - @9 |))) E Name: subform3 =)
1 H
! Geometry Compute Plat Sound Repc | Form: [ formt Mg
! [] Add border
Geometry & Material @ | v Position and Size
Find prong length Horizontal alignment: | Fill -
Target frequency: 440 Hz Vertical alignment: Fill -
Frequency tolerance: 0.1 Hz Minimum width: Automatic -
Pang Iength: Lp 75 mm Minimum height: Automatic -
. Row: 2
Radius: ro 25 mm
Columm: 1
Material: Steel ~ Row span: 7
‘ Lp Column spam: 4
I Cell margin
Cell margin: Mone -
r
Tr ¥ Appearance
Sound [#] Visible
Enabled
Play sound when computed

The figure below shows the referenced form form1, which is a local form to the
form mainComputer.

App 'Cet'on B i d,:,r Al ! D mainComputer D mainComputer: form1 X @ Preview
A ulide o
- Et~ El~
; » T
4 %”'l”g-f:'k'mph (root) Geometry & Material
nputs I
T2 Themes | ¥ Find prong Iengt
b [ Main Window - ) )
4 B Forms | arget frequency: 440 I—z
£ main Frequency tolerance: 0.1 Hz
D selectllSize 1
[ information Prong length: L, 75 mm
el D mainComputer | )
4 B Forms Radius: r 25 mm
I Material: Steel v
I [y Methods

D toolbarComputer

If you are using grid layout mode, then you can quickly create subforms using the
Extract Subform button in the ribbon. See “Extracting Subforms” on page 126.
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Form Collection

A Form Collection object consists of several forms, or panes, presented in a main
form. In this example, there are four forms that appear as tabs in a single main
window.

1%
Results Name:  collection2 B
Te Conversion  Temp profiles  Conversion profiles Type: Tiled ortabbed e
Qa@- PR @ g go I Tiled or Tabbed @+ F
I Active Form Selector @+ 5
¥ Forms ‘:‘B‘ aF
4 B Forms
™7 input
™7 description
™7 information
™7 simulationEvents
™7 emailServer
Add to Form Callection =4 Edit Node
| e Visible | Yertically
scrollable
[ |temperature & [EA
[ conversion ™ [
[ | temperatureProfile & =4
[ | conversionProfile & =4
v R e
Default form: | temperature -

There are four different layout options. From the Type list, choose between:
 Tabs, the default setting, which displays the forms using tabbed panes.

« List, which displays a list to the left of the form panes, where you can select
the form to display.
 Sections, which displays each form in a separate section.

* Tiled or tabbed, which displays the forms in one of two ways depending on
the value of a Boolean variable. For more information, see the description
later in this section.

In the Forms section you can select which forms to display in the Form Collection.
These will be displayed in the app in the order they appear in the list. You can
change the order by clicking the Move Up and Move Down buttons.

The Default form list specifies which form to be shown by default. This setting is
not available for the option Sections.
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You can control which tab (or list entry) is active by linking to a string variable in
the section Active Form Selector.

~ Active Form Selector @+ 5

4 = Declarations
4 abec String
= activePlot
abe solutionState
abc emailTo
abe emailServerHost

% Clear Source Edit Mode

Use as Source
Selected source:

abe String=activePlot

The string variable needs to be equal to one of the form names in the form
collection, such as temperature or conversion in the example above. Otherwise,
it will be ignored.

If you change the value of the form selector activePlot in the above example, in
a method that will be run at some point (a button method, for example), then the
form with the new value will be activated, as shown in the example below.

activePlot="conversion”; /* Activate the conversion form on completion of
this method */
For a form collection with the Type set to Sections, the Active Form Selector has no
effect. Using an Active Form Selector is optional and is only needed if you wish to
control which tab is active by some method other than clicking its tab. To remove
a string variable used as an Active Form Selector, click the Clear source toolbar
button under the tree.
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The Tiled or tabbed option displays the forms in one of two ways depending on
the value of a Boolean variable used as source in a Tiled or Tabbed section at the
top of the Settings window.

Settings TAX

Mame: collection2 =
Type: Tiled or tabbed -
~ Tiled or Tabbed & E

4 = Declarations
4 @ Boolean
= isSendEmail
= isPlayTada
isPlotTiled
@ islnitialized

2 iePacmsid P il
Use as Source Edit Mode
Selected source:

& Boolean=isPlotTiled

Tiled mode settings
Add borders in tiled mode

Tiling strategy: Colurnns first =

Number of columns: 2

The tabbed mode is identical to a form collection with the Type set to Tabs. In tiled
mode, all the forms are shown simultaneously in a grid. The layout for the tiled
mode can be controlled by the settings in the subsection Tiled mode settings.

In the table below the Forms section you can select which forms should be Visible,
by selecting the corresponding checkbox. For a form collection of the type
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Sections, you can, in addition, control which forms should be Collapsible and
Expanded.

Settings = L8
Mame: collectionl E
Type: Sections =
+ Forms ':‘E' A
Add to Form Collection Edit Mode

L - =

Forms Visible | Collapsible | Expanded
D geometry =4 & ~
[ |operating... | [+ =4 =4
[ |results =4 =4 =4
[ |information | [ =4 =4

Card Stack

A Card Stack is a form object that contains cards. A Card is another type of form
object, one that is only used in the context of a card stack. Flip between cards in
a card stack to show one at a time. You associate a card stack with a data source
that controls which card to show. Each card specifies a value that is compared
against the data source of the card stack. The card stack shows the first card with
the matching value. If no cards match, nothing is shown.

USING A CARD STACK TO FLIP BETWEEN GRAPHICS OBJECTS

Consider an application where the graphics shown to the user depend on the value
of a scalar variable. This variable may change when a user clicks, for example, a
radio button. The variable may also change depending on a computed value; for
example, the value of a Global Evaluation node in the model tree.
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The figure below shows the card stack object in the Form Editor.

In this example, the card stack contains cards with graphics objects.
The figure below shows a card stack Settings window with five cards and a string
variable display as its Active Card Selector.

Settings = L1

Mame:  hintsGlossaryCardstack =
w Active Card Selector & E
4 = Declarations

[ =bc String

[» =5 Double

4 @ Boolean
@ islnitialized
isShowHintsGlossary
& Model (root)

@_‘ Use as Source =g Edit Node
Selected source:

@ Boolean=isShowHintsGlossary

¥ Cards

L A
Card Activating value
—hintsGlossary |true

+ &
¥ Position and Size
By clicking a row in the table of cards in the Cards section, followed by clicking

one of the toolbar buttons below the table, you can perform the following
operations on cards:

¢ Delete
« Edit
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¢ Add Card

¢ Duplicate

Each row in the table contains the name of the card in the Card column and their
associated activating values in the Activating value column. The stack decides
which cards to display based on their activating values. In this example, the
activating value is a Boolean variable.

Clicking the Add Card button displays the following dialog.

3 Add Card X
Card type: Local -
Name: Local
L Existing form
Activating value: “vereres
oK Cancel

By default, the Card type is set to Local, which means that the card is defined locally
in its containing card stack object. If the Card type is set to Existing form, then you
can instead select one of the existing forms. The settings for an Existing form are
accessed directly from the Form Editor by clicking its node or by clicking the Edit
button in the Card section of the corresponding card stack Settings window.

The figure below shows the Settings window of a Card as shown after clicking Edit
in the table in the section Cards.

Settings TAX
d

Go to Card Stack

Mame:  electricPotential
¥ Card Activation
Activating value:  electricPotential

Margins
Grid Layout for Contained Form Objects

Appearance
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To access locally defined cards, right-click the card stack in a form window to
select between the different cards in the card stack, as shown in the figure below.

Edit card1
Edit card2
Edit card3
Edit card4
Edit card5

Duplicate card1
[5] Duplicate card2
[B] Duplicate card3
E—E Duplicate cardd
[B] Duplicate cards

Align 3
Row 3
Column 3

r5) Extract Subform

Copy as Code to Clipboard 3
$ocut Ctri+X
[ Copy Ctrle C
[B] Duplicate Ctrl+Shift+D
M Delete Del
Settings
Help l

From this menu, you can also duplicate cards.

To edit cards, you can also use Alt+Click, which opens a dialog that lets you select
multiple cards at once.

3 Open Cards X

Select cards to open:

card1
card2
card3
card4
card3

oK Cancel
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The figure below shows card1 of the card stack resultsCardstack with a
graphics form object.

@ Preview D main D main: resultsCardstack: cardl X D main: resultsCardstack: card3 D main: resultsCardst
h 4

Qea@-B LrEzhk/ - +-BREM @S

In the Position and Size section you can change the alignment and size of the card
stack and cards.

¥ Position and Size

Harizontal alignment: Left =
Vertical alignment: Fill =
Width: Manual -
328

Minimum height: Automatic =
Adjust size to selected card

Row: 1

Column: 3

Row span: 1

Column span: 1

Cell margin
Cell margin: MNone =

¥ Appearance

Visible
Enabled

When selected, the Adjust size to selected card checkbox makes it possible to have
the card stack adjust its size to the currently selected card. When not selected, the
card stack will be as large as the largest card, regardless of which card is selected.
Before version 5.6, the card stack always took the size of'its largest individual card,
which meant that even small or empty cards still took up space in the layout. Now,
when a card is empty, the card stack will disappear, which is a desirable feature in
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many cases. Using it you can for example have a dynamic documentation card
stack appear and disappear depending on the user’s actions.

File Import

A File Import object is used to display a file browser with an associated input field
for browsing to a file or entering its path and name. It is used to enable file import
by the user of an application at run time, when the file is not available in the
application beforehand.

Consider an application where a CAD file can be selected and imported at run
time, as shown in the figure below.

CADfileto analyze:  C\pipex_b Browse...

The corresponding File Import object is shown in the figure below.

CAD file to analyze: Browse... |+
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The Settings window for the File Import object has a section File Destination. In this
section, you can select any tree node that allows a file name as input. This is shown
in the figure below, where the Filename for a geometry Import node is selected.

Settings = L8
MName: fileimportl =
Style: Outlined =
lcon: = import_32.png - + =
Button text:  Browse...
Dialog title:  File import
File types:

COMSOL Multiphysics File (*.mphtxt; *.mphbin; ...)

All 3D CAD Files (*.step; *.stp; *a_b; "2t )

All 3D Importable Geometry Files (*.mphtxt; *.mphbin; ..)

All 3D Importable Mesh Files (*.mphtxt; *.mphbin; ..)

+®
Allow entering filename
¥ File Destination @

w

= Declarations
& Model (root)
~ [l Component 1 (comp1)
v W Geometry 1
~ [& Import 1 (imp1)
2% Filename (filename)
abe Filename (meshfilename)

<

> igi Materials
> [El Results

@_‘ Use as Source =g Edit Node
Selected source:

abc Import 1 (imp1)=Filename (filename)

Access using:  upload:///geom1/imp1/filename
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In this application, the File types table
specifies that only CAD files are allowed.
You can further control which File types are
allowed by clicking the Add and Delete
buttons below the list of File types. Clicking
the Add button displays the dialog shown to
the right:

By clicking the Create New File Type and Use
It you can use your own file format. The
figure to the right shows a custom file type.
Adding a custom file type in this way will
also create a File Type declaration, as shown
in the figure below.

~ = Declarations
[ File 1 ffite
[2] My File Type {filetype}
) Methods
» [ Libraries

3 Add

File types:
All Files (*%)
All 2D CAD Files (*.dxf; *.mphtxt; *.mphbin; ...)
All 2D Importable Files (*.mphtct; *.mphbin; ..
All 2D Importable Files (*.mphtct; *.mphbin; ..
All 2D Mesh Files (*.mphtxt; *.mphbin; *fla; ...
All 3D Importable Files (*.mphtct; *.mphbin; ...
All COMSOL Files (*.mph; *.class)
All Excel Files (*xlsx; *xls; *xlsh; *xlsm)
All Excel Files (*xlsx; *xlsm)
All GDS/MNETEX-G Files (*.asc; *.gds)

oK Cancel

3 Create and Use Declaration *

Label: My File Type
MName: filetype
Description: My File type

L - .
Filename extensions

|*.myfile

oK Cancel

ALTERNATIVES TO USING A FILE IMPORT OBJECT

If an input field for the file path and name is not needed, then there are other
methods for file import that allow a user to pick a file in a file browser. For
example, you can use a menu, ribbon, toolbar item, or a button to open a file
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browser. The figure below shows the Settings window of a button used to import
a CAD file.

Settings v RX
Button i

MName: button1 =
Text: Import Geometry

lcon: “ import_32.png ~| |4+ | B
Size: Large =

Style: Outlined =

Tooltip:

Keyboard shortcut:

b

» (Choose Commands to Run 5

b B Forms
I @ GUI Commands
b [ Libraries
4 < Model (root)
4 |§ Component 1 (comp1)
[ = Definitions
4 0 Geometry 1
4 & Import 1 (imp1)
abc Source (type)
abe Filename (filename)
abe Filename (meshfilename)

= Edit Node Run Plot Set Value Show

Show as Dialeg T Import File Enable Disable

Command lcon | Arguments
Impeort file to Import 1 (imp1) 1
Plot Geometry 1 form1/graphics1
Zoom extents form1/graphics1
oE -

A File Import object can also reference a File declaration. For more information, see
“File” on page 171. For more information on file handling in general, see
“Appendix C — File Scheme Syntax” on page 328.

The built-in method that corresponds to the command Import file is importFile.
For example, for importing an image you can use:

success=importFile("filel1",new
String[]{"ALL_IMPORTABLE_IMAGES","PNG","JPEG","BMP","GIF"});
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Information Card Stack

An Information Card Stack object is a specialized type of Card Stack object used to
display information on the relationship between the inputs given by the user to an
application and the solution. The figure below shows a portion of a running
application in which an information card stack is used together with information
on the expected computation time.

¥ Information

Expected computation time: 5 seconds

I.f'_-“\.l Last computation time: 65

y,

The corresponding form objects are shown below:

@ Preview D rain D information X
v

>
Expected computation time: 5 seconds

/»  Solution not yet available.
.\/:.
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The figure below shows the Settings window where a string variable
solutionState is used as the source.

v 1 X
Mame: infocard] 5|
¥ Active Information Card Selector @ + B

4 = Declarations
4 abec String
abe activePlot
=i solutionState
abc emailTo
abe emailServerHost
@_‘ Use as Source =g Edit Node

Selected source:

abe String=solutionState
¥ Information Cards

L A
Activating valu | lcon | Text

nosclution Solution not yet available,
inputchanged A\ | Theinput data has changed since previous solution was computed,
solutionexists i | Last computation tirme:

_l’_

There are similarities with a Card Stack object, but for the Information Cards, each
card has an icon and text. In the figure above, the string variable values

nosolution, inputchanged, and solutionexists control which information
card is shown.

| 295



In this example, the information card stack is accompanied by a data display object
where a model tree information node for the Expected Computation Time is used
as the source. The figure below shows its Settings window.

sSettings VLB

L R

Mame:  datadisplayl =

[] LaTeX markup
Tooltip:  Intel Xeon E5-1650 v3 @3.50 GHz

~ Source @+ 5

| Declarations
4 & Model (root)
4 (1) Information
L&l Expected Computation Time
= Last Computation Time
I () Global Definitions
[ ~do Study 1

E‘ Use as Source =g Edit Node
Selected source:

= Information=Expected Computation Time

Note that information nodes in the model tree are only shown when working with
the Application Builder. They are made available in the Source section in the
Settings window for form objects, when applicable.

You can also find information nodes with Last Computation Time under each study.
The information node Last Computation, found directly under the Model node, will
correspond to the computation time for the last computed study.

Information nodes can be used as a source for input field objects, text objects, and
data display objects. For input field objects and text objects, in order for the
information nodes to be accessible, the Editable checkbox has to be cleared.
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The Expected Computation Time take its data from the root node of the application
tree, as shown below.

¥ Protection

Editing not protected Set Password

Running not protected ~ Set Password
¥ Used Products
COMSOL Multiphysics

Unit System

¥ Presentation

Title: Tubular Reactor with Jacket

Description:  This app demanstrates the following:

» Emailing a report when the computation is
finished

» User-defined email server settings

» Playing a sound when the computation is

Author: COmMsOL
Computation time
Expected: 5 seconds

Last: 5s

If the computation time is predominantly spent in a method, such as when the
same study is called repeatedly, then you can manually measure the computation
time by using the built-in methods timeStamp and setLastComputationTime.
For more information, see “Date and Time Methods” on page 364.

Array Input

An Array Input object has an input table used to enter array or vector-valued input
data. An array input object supports string arrays as data sources. You can add an
optional label, symbol, and unit.
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USING AN ARRAY INPUT OBJECT FOR 3D POINT COORDINATE INPUT

Consider an application where the user enters 3D coordinates for a point where
the stress is evaluated. The figure below shows a screenshot from an application
with an array input, button, text label, and data display object.

Point coordinates:

0,001

-0,001

0,0005

Evaluate stress at point

Won Mises stress at point: 40,16 MPa
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The figure below shows the Settings window of the array input object.

LA
[4¥]
=
3]
]
(V]
]
-
X

Name: arrayinput1 =
Length: 3
Show vector as: Table =
+ Source @ + B
4 = Declarations
4 55 Array 1D Double
55 sampleCoords
Use as Source Edit Mode
Selected source:
22 Array 1D Double=sampleCoords
Initial value: Custom value =
L]
Value
0.0
0.0
0.0
¥ Layout Options

Label position: ~ Above
Label text: Point coordinates

[ Include symbol

Symbol (LaTeX encoded): sampleCoords

[ Include unit

Custom unit
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The Array Input form object uses a Source named sampleCoords, which isa ID
Array of type Double. This array is created prior to the creation of the Array Input
object by declaring an Array ID Double with the following Settings.

Settings TAX

rray 10 uble

List of Variables

»
MName Initial values Mew element v | Description
sampleCoords | {0.0,0.0,0.0} 0.0 Point coordinates

In the Settings window of the array input object:

+ In the Length ficld, enter the length of the array as a positive integer. The
default is 3.

* From the Show vector as list, choose Table (the default) to show the array
components as a table, or choose Components to show each array component
as a separate input field with a label.

 In the Value table, enter the initial values for the components in the array.

* The Layout Options section provides settings for adding optional labels and
units to the array input.

In this example, when the user clicks the button labeled Evaluate stress at point,
the following method is run:

with(model.result().dataset("cpt1"));
set("pointx", sampleCoords[O0]);
set("pointy", sampleCoords[1]);
set("pointz", sampleCoords[2]);
endwith();

where the values pointx, pointy, and pointz will be used subsequently as
coordinates in the evaluation of the stress.

Radio Button

A Radio Button object has a fixed number of options from which you can choose
one. It is most useful when you have just a handful of options.
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USING RADIO BUTTONS TO SELECT A LOAD

Consider an application where the user can select one of three predefined loads,
as shown in the following figure.

Applied force:

® High load (300 N)
2 Medium load (150 N)
O Light load (50 N)

The corresponding Settings window is shown below, where the global parameter
F is used as the source.

Settings

MName: radiobutton =
Orientation: Vertical
* Source & E

[ = Declarations
& Model (root)
4 () Global Definitions
4 Py Parameters 1
a3 Applied force (F)

[ 8

@_‘ Use as Source =g Edit Node
Selected source:

5.5 Parameters 1=Applied force (F)

Initial value: First allowed value
« Choice List @ +

Available: Selected:
<> Choice List 1 {choicelist1}

The Orientation can be set to Vertical (default) or Horizontal.

In the Initial value list, choose the manner in which the initial selection of the radio
button should be made. The options are From data source, First allowed value (the
default), and Custom value. For the Custom value option, select from a list of the
allowed values given by the choice list.
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In the Choice List section, you can add choice lists that contribute allowed values
to the radio button object, where each valid value represents one radio button.

The radio button names are taken from the Display name column of their
associated choice list. The figure below shows the choice list used in this example.

Settings v RX

A o

Label:  Choice List 1 =

Mame: choicelist]

List Content

L
Value Display name
300 High load (300 M)
150 Medium load (150 N)
50 Light load (30 M)
\

USING A UNIT SET INSTEAD OF A CHOICE LIST

If the radio button will be used for the purpose of changing units, then a Unit Set
can be used instead of a Choice List (You still select it in the Choice List section of
the Settings window of the radio button object).

Selection Input

In the Application Builder, you can allow the user of an application to interactively
change which entities belong to an Explicit selection with a Selection Input object
or a Graphics object. For more information on selections, see “Selections” on page
90.
You can choose to use a graphics object as the source of a selection without
having any selection input object. You can also link both a graphics object
and a selection input object to the same explicit selection.
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In the example below, the embedded model has a boundary condition defined
with an Explicit selection. Both a Selection Input object and a Graphics object are
used to let the user select boundaries to be excited by an incoming wave.

0.1

-0.47]
0.5
0.6 |
-0.77]
I I I T T
1.4 1.6 1.8 2 2.2
= B —
=3 = N
7 &

The user can select boundaries here by clicking directly in the graphics window
corresponding to the Graphics object or by adding geometric entity numbers in a
list of boundary numbers corresponding to a Selection Input object.

To make it possible to directly select a boundary by clicking on it, you can link a
graphics object to an explicit Selection used to group boundaries, as shown in the
figure below. Select the explicit selection and click Use as Source.
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In the figure below, there are two explicit selections, Excitation Boundary and Exit
Boundary, and the graphics object graphics2 is linked to the selection Excitation

Boundary.

ettings

ranhics

[P

MName: graphics]
Zoom to extents on first plot

¥ Source for Initial Graphics Content

4 & Model (root)
4 T Component 1 (comp1)
4 = Definitions
4 g Selections
ﬁ Excitation Boundary
& Exit Boundary
WA Geometry 1
A Mesh 1

b IE Results

Use as Source %, Clear Source Edit Mode

Selected source:

& Excitation Boundary

When a graphics object is linked directly to an explicit selection in this way, the
graphics object displays the geometry and the user can interact with it by clicking
on the boundaries. The boundaries will then be added (or removed) to the

corresponding explicit selection.
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To make it possible to select by number, you can link a selection input object to
an explicit selection, as shown in the figure below.

Name:  selectioninputl =
¥ Source

4 & Model (root)
4 T Component 1 (comp1)
4 = Definitions
4 g Selections
ﬁ Excitation Boundary
& Exit Boundary

@_‘Use as Source % Clear Source =# Edit Node

Selected source:

& Excitation Boundary

¥ Graphics to Use When Active

4 B Forms
el D form1
[ graphicsl
graphics2

@_‘ Use Graphics =g Edit Mode
Selected graphics:
[ graphics2

In a selection input object, you can copy, paste, remove, clear, and zoom into
selections.

You can have events associated with selections. The On data change event will be
triggered when the selection is changed. If you have a local method associated
with this event, you will get a method with an integer array argument. The
method is called with the new entities of the selection. The On activate event will
be triggered when the Activate Selection button is clicked.

¥ Events

On data change: modifiedSelection - Ej + -

On activate: activatedSelection - E:I + -
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Text

A Text object is a text field with default text that is taken from a string variable or
an Information node. The Settings window for a text object is shown below.

Settings = L1
Mame: textl =
[] Editable

Wrap text
-+ Source FAF

4 = Declarations
4 abec String

i svar

& Model (root)

@_‘ Use as Source =g Edit Node
Selected source:

abe String=svar

Initial value: From data source =

Select a string variable or Information node from the tree in the Source section and
then click Use as Source. In the Value field, enter the initial text. By default, the
Initial value text is taken from this field. To instead use the string variable for the
Initial value text, change the Initial value setting to From data source.

The Editable checkbox is cleared by default. If selected, the text object can be used,
for example, to type comments in a running application. If the text is changed by
the user, it is stored in the string variable that is used as the data source, regardless
of the Initial value setting.

The Wrap text checkbox is selected by default. Clear this checkbox to disable
wrapping of the text. A scroll bar appears if the text does not fit.

For more information on Information nodes, sce “Data Display” on page 104.

List Box

A List Box object is similar to a radio button object, except that it allows for the
simultaneous selection of multiple options.
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USING A LIST BOX TO SUPERIMPOSE VIBRATIONAL MODES

Consider an application where the first six vibrational modes of a mechanical part
can be superimposed and visualized by selecting them from a list box, as shown in
the figure below.

Superimposed modes: a |- ey RO R [O] B
o
Mode 1
Mode 2
Mode 3
Mode 4

Mede 5
Mode 6

| Plot Shape |

As an alternative, the following figure shows that a list can be displayed as a dialog.

aQa@~- & -

Superimposed modes:

Mode 1 @ add %
Mode 3
Mode 4 Allowed values:
Mode 2
Mode 5
Mode &
+

| Plot Shape |
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The Settings window for the list box of this example is shown in the figure below.

Settings =3
List Box

Mame: listbox1 =5
-+ Source FAF
4 = Declarations

4 255 Array 10 String
2 svarlD
[» =5 Double

[ @ Boolean

Use as Source Edit Mode
Selected source:

255 Array 1D String=svar1D

Initial value: First allowed value =
+ Choice List ® +
Available: Selected:

<> Choice List 1 {choicelist1}

Select values in: List box

The Select values in list allows you to choose between two alternatives, List box or
Dialog, for displaying the list.

You can use any scalar or array declaration as a source. Select from the tree and
click Use as Source. If you use a string array as the source, you can, in the running
application, select more than one item in the list using Shift+Click or Ctrl+click.
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For other sources, you can only select one value from the list. This example uses a
1D string array svariD. Its Settings window is shown below.

List of Variables

L33

MName Initial values  New element value  Description
svarl D 1,23456} (1 Array 1D String
Tt 15

In the Choice List section, you can add choice lists that contribute allowed values
to the list box. The figure below shows the choice list used in this example.

Settings

Choice List

Label:  Choice List 1 =
Mame:  choicelist]

List Content

" Value Display name
7 Mode 1
a Mode 2
9 Mode 3
10 Mode 4
1 Mode 5
12 Mode &
YEHE

The vibrational modes 1-6 correspond to trivial rigid body modes and are not of
interest in this application, hence the Value column starts at 7. The choice list
allows you to hide the actual mode values in the model from the user by only
displaying the strings in the Display name column. The first nonrigid body modes
arec named Mode 1, Mode 2, and so on.

The method below uses the COMSOL Multiphysics operator with () to visualize
the superimposed modes. This example is somewhat simplified, since it ignores the
effects of amplitude and phase for the modes.

String withstru="0";
String withstrv="0";
String withstrw="0";
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for(int i=0j;i<svariD.length;i++){
withstru=withstru + "+" + "with(" + svariD[i] + ",u)";
withstrv=withstrv + "+" + "with(" + svariD[i] + ",v)";
withstrw=withstrw + "+" + "with(" + svariD[i] + ",w)";

}

with(model.result("pg7").feature("surfi1").feature("def"));
setIndex("expr", withstru, 0);
setIndex("expr", withstrv, 1);
setIndex("expr", withstrw, 2);
endwith();
useGraphics(model.result("pg7"),"/form1/graphics8");
zoomExtents("/form1/graphics8");

Assuming the user selected the modes 1, 3, and 5 by using the list box, the method
creates an expression with(1,u)+with(3,u)+with(5,u). This expression is then
used for the x-displacement (dependent variable u) in a displacement plot. In a
similar way, the method automatically creates expressions for the variables v and w
associated with the y- and z-displacement, respectively. Note that the command
with(), used in the results in the example above, is different from the built-in
with() command used to shorten syntax that is described in “With, Get, and Set
Methods” on page 368.

USING A UNIT SET INSTEAD OF A CHOICE LIST

If the list box will be used for the purpose of changing units, then a Unit Set can
be used instead of a Choice List (You still select it in the Choice List section of the
Settings window of the list box).
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Table

A Table Object represents a table with rows and columns that can be used to define
input or output. The figure below shows an example of a running application with
a table object used to accept input in three columns.

Flow rate and fluid properties:

" Flow rate (sccm)
100

200

300

1000

250

700

2000

600

+

Molecular weight (kg/mol)
0.032

0.028

0.146

0.004

0.032

0.004

0.04

0.028

HE & LS

Dynamic viscosity (Pa-s)
2E-5

1.78E-5

1.38E-5

1.9E-5

2E-5

1.9E-5

2.1E-5

1.78E-5

The figure below shows the corresponding form object and its Settings window.

[@] Preview [ input X
v

Settings

>

Input
Pipe length:
Pipe diameter:

Temperature:

Process chamber pressure:

Spacing between pipes:

2[m]
35[mm]
300[K]
10[Torr]
0.125[m]

Flow rate and fluid properties:

Table

Mame:  tablel
m Show headers
o [ Automatically add new rows

[] Sortable
Pa ~ Sources

4 = Declarations
4

55 Array 1D String
2l

" Flow rate (scem)
100
200
300
1000
250

Molecular weight (kg/mol)

0.032 2E-5
0.028 1.78E-5
0.146 1.38E-5
0.004 1.9€-5
0.032 2E-5
0.004 1.9€-5
0.04 2.1E-5
0.028 1.78E-5
4 4ddxWy)

Dynamic viscosity (Pa-s)

3 flow_rate
2l molecular_weight
2 dynamic_viscosity

Addto Table =~ Edit Node
"
Header Width
Flow rate (sccm) 120
Molecular weight (... | 160
Dynamic viscosity (.. | 160
-
{z
~ Toolbar
Position: | Below
leonsizes | Small
»
Neme Icon | Text
localitem
Iocalitem2 1
localitem3 +
localiternd =
localitems
localitemt
process] Z
process2 &
process3 4
+8

[m}
[m}
O

™
™
™

Grow  Editable  Alignment

Left
Left
Left

Tooltip
Move up
Move down
Add

Delete

Load from file
Save to file
Process 1
Process 2
Process 3

%

e+

Data source

~  Data ‘flow...
~ Data 'mol

~  Data'dyn...
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In this example, the data source references three 1D string arrays. You can select
any type of array as the source and then click Add to Table.

Three checkboxes control the overall appearance of the table:

* Show headers

¢ Automatically add new rows

* Sortable

The Automatically add new rows checkbox ensures that an additional empty row is
always available when a user is filling out a table. If all of the 1D string arrays,
which are used as a source to the table, have nonempty values for New element
value in their declaration Settings window, then this functionality is deactivated. In

this case, new rows can only be added by clicking the Add button in the associated
table toolbar, if such a button has been made available.

The Sortable checkbox makes it possible to sort the table with respect to a
particular column by clicking the corresponding column header.

The Sources section contains a table with five columns:

¢ Header

¢ Width

¢ Grow

* Editable

* Alignment

¢ Data source

Each row in this table defines a column in the table object. The option Grow allows

individual columns to grow when a form is resized. This option is only applicable
to grid mode and if the Horizontal alignment of the table is set to Fill.
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In the example, the string arrays define the initial values for the rows
corresponding to the three columns, as shown in the figure below:

List of Variables

" MName Initial values MNew element Description
flow_rate {"100','200",'300°,"1000",'250,'700",'2000",'600"} 100 Flow rate
molecular_weight {'0.032','0.028','0.146",'0.004','0.032','0.004','0.04','0.028"} 0.032 Molecular weight
dynamic_viscosity {'2E-5',1.78E-5'1.38E-5"'1.9E-5",'2E-5','1 .9E-5",'2.1E-5',"1 . T8E-5"} [1.78E-5 Dynamic viscosity
tiseEH#

You can control which source that determines the number of rows in the table. To

set this, right-click the corresponding array declaration in the Sources section and
select Set as Synchronizing Source.

¥ Sources
122 Array 10 Integer

255 Array 1D String

255 cName

4 = Declarations
[
Pl

255 cColor

20 cinterpolation

203 annstr

Array 10 Bo| S Edit Node
Array 2D Dol = Add to Table

Array 2D Str o
3 Tables @ Setas Synchronizing Source
]

oE

oG o o
Bin ogin o

ouo oo’

b [=] Graphics Data 1{graphicsdatal}

TOOLBAR

In this section, you can select which toolbar items (buttons) should be used to
control the contents of the table. The Pesition list defines the location of the
toolbar relative to the table and provides the following options:

¢ Below

¢ Above
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o Left
* Right

The lcon size setting allows you to choose Small or Large icons.

To add an item to the toolbar, click the Add Toolbar Item button below the table.

¥ Toolbar

Position: Below

lcon size: Small

L]
MName lcon | Text
localitem5
localitemt
process] &,
process2 iy
process3 PLN
= =

~ Position and siz Add Toolbar ltem

Tooltip

Load from file
Save to file
Process 1
Process 2

Process 3

The following dialog is then shown.

3 Toolbar ltems

1t Move Up
L Move Down
-+ Add
=y Delete
Load from File
Save to File
2 Process 1
Add>> 4% Process2
2. Process3
Purge
= Clean
\. Clear Table

<<Remove

7z Clear Table and Load from File

Custom ltem...

Custom Toggle ltem...
oK Cancel

You can always add the following items:

* Move Up
¢ Move Down
* Add

¢ Insert Above

314 |




* Delete

¢ Clear Table

¢ Load from File

¢ Clear Table and Load from File

¢ Save to File

In addition, you can add customized items by clicking Custom Item or Custom

Toggle Item in the Toolbar Items dialog. The figure below shows the Edit Custom
Toolbar Item dialog used to define a customized button. The dialog has two tabs
for a regular item and three tabs for a toggle item.

3 Edit Custom Toolbar ltem

General  Choose commands to run

MName: purge
Text: Purge
leon: == pipe_purge.png -
Tooltip: Purge
Keyboard shortcut:
State
Visible
Enabled

OK

Cancel

x

@ Edit Custom Toolbar ltem

General  Choose commands to run

i B Forms

b @ GUI Commands
4 = Declarations
4 255 Amray 1D String
282 flow_rate
282 molecular_weight
282 dynamic_viscosity
b =be String
b @ Methods
b [l Libraries
I <# Model (root)

Run Plot
Disable

Set Value Show Show zs Dialeg

"

Command
Set flow_rate of Array 1D String
Set molecular_weight of Array...

Icon | Arguments

Set dynamic_viscosity of Array.

«

Import File Enable

7 | {'2000','2000','2000", 200", 2000', 200", 200..
7 | ['0.028.'0.028',0.028, 0.028','0.028, 0.028","
7 |['1.78E-51.78E-5,1.78E-5,1.78E-5, 1.78E ..

0K Cancel

The Choose commands to run tab is similar to that of menu, ribbon, and toolbar

items, as well as buttons.

The Load from File and Save to File buttons are used to load and save from/to the

following file formats:
o Text File (.txt)

« Microsoft® Excel Workbook (. x1sx)

- Requires LiveLink™ for Excel®

e CSV File (.csv)
» Data File (.dat)
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This is shown in the figure below.

Text File (*txt) -

[ Text File (*tet) |
Microsoft Excel Workbook (*xlsx)
C5V File (*.csv)

Data File (*.dat)

All Files (*%)

The allowed separators are comma, semicolon, and tab for CSV files, and space
and tab for DAT and TXT files.

Slider

A Slider is a form object for choosing numerical input using a slider control.

USING A SLIDER TO CHANGE THE MAGNITUDE OF A STRUCTURAL LOAD

Consider an application where the magnitude of a load can be changed by a slider
control, such as in the figure below.

Applied force: 150 N

In this example, the slider is accompanied by an input field that is used to display
the selected value.
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The Settings window of the slider is shown in the figure below.

Settings TAX

Slider

Mame: sliderl =

Minimum value: 0
1000

Maximum value: 1000

Number of steps: 20

Orientation: Horizontal =
Tooltip:
~ Source @+ B

Declarations
@ Model (root)
4 () Global Definitions

[ 8
N

4 Py Parameters 1
= Applied force (F)

Use as Source Edit Mode
Selected source:

5.5 Parameters 1=Applied force (F)

Initial value: From data source =
¥ Unit
Method: Append unit to number *

Unit expression: N

In this example, the slider uses a global parameter F as its source. You can select
any parameter, variable, or declared scalar variable as a source. Select from the
application tree and click Use as Source.

You determine the range of values for the data source by defining the Minimum
value, Maximum value, and Number of steps for the slider. The Orientation can be
Horizontal or Vertical. You can also set a Tooltip that is shown when hovering over
the slider. The Append unit to number option lets you associate a unit with the
slider. This unit is appended to the number using the standard bracket notation,
such as [N], before being passed as a value to the source variable. In the example
above, the input field and the slider both have the setting Append unit to number
activated. As an alternative to Append unit to number, you can choose Append unit
from unit set. See “Unit Set” on page 173 for more information.
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In the Initial value list, select From data source or Custom value for the initial value
for the slider.

In the Events section, in addition to specifying which method to call for an On data
change event, you can select the Trigger while dragging checkbox. This setting
determines if the event method should be called continuously while the slider is
being dragged or only upon its release.

¥ Events

On data change: plotDisplacement - B+~
Trigger while dragging

This setting can be useful if the method that is called by the On data change event
is computationally heavy, so that there is a lag when dragging the slider.

Knob

A Knob is a form object for choosing numerical input using a control knob, similar
to a slider.

USING A KNOB TO CHANGE THE ANGLE OF A CRANE ARM

Consider an application where the angle of a truck mounted crane arm can be
changed by control knobs, such as in the figure below (which uses a dark theme).

Crientation and Extension

In this example, the knobs are accompanied by input fields that are used to display
the selected value.
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The Settings window of one of the knobs is shown in the figure below.

Settings = L1
MName: knob1 =
Minimum value: -13
Maximum value: 90

Number of steps: 33

Mouse movemnent: Distance =
Tooltip: -152=value==90
~ Source @+ B

4 = Declarations
4 abec String

abe solutionState
=2 Anglel
abc RelAng
abe Extlen
abe Fel
abe Fe2
abe Fe3
abe results
abe cylCapl

Use as Source Edit Mode
Selected source:

abe String=Anglel

Initial value: From data source =

In this example, the knob uses a string variable Angle1 as its source. You can select
any parameter, variable, or declared scalar variable as a source. Select from the
application tree and click Use as Source.

You determine the range of values for the data source by defining the Minimum
value, Maximum value, and Number of steps for the knob.

The Mouse movement can be Distance, Vertical, or Circular. Distance changes the
value with a linear mouse movement in any direction. Vertical changes the value
when you move the mouse vertically. Circular changes the value when you make a
circular mouse movement. A physical control knob is usually controlled with a
circular movement. However, when using a mouse this is usually not the most
convenient way. Instead, use a linear mouse movement by selecting Distance or
Vertical.

You can also set a Tooltip that is shown when hovering over the knob. The settings
for units are similar to that of a slider.

In the Initial value list, sclect From data source or Custom value for the initial value
for the knob.
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In the Events section, in addition to specifying which method to call for an On data
change event, you can select the Trigger while dragging checkbox. This setting
determines if the event method should be called continuously while the knob is
being dragged or only upon its release.

¥ Events

On data change: updateGeometryAndSolutionState 39+

[] Trigger while dragging

This setting can be useful if the method that is called by the On data change cvent
is computationally heavy, so that there is a lag when dragging the knob.

Hyperlink

A Hyperlink object embeds a hyperlink in a form. The figure below shows an
example of a hyperlink.

COMSOL Web Page
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The figure below show the corresponding Settings window.

Settings

Hyperlink

MName:  hyperlinkl E
Text: COMSOL Web Page

URL: www.comsol.com

¥ Position and Size
Width: 105
Height: 15
Positionx: 20

Position y: 490
¥ Appearance

Background color: | Transparent -

Font: Default font e

Font size: Default size v opt

[] Bold
[] Italic

State
Visible
Enabled

The Hyperlink object supports the types of URLs that you can use in a web
browser, including;:

Web Page: When a user clicks the hyperlink for a web page, it opens in the
user’s default browser. The URL string needs to be on the form
protocol://address, where protocol is the transmission protocol; for
example, HTTP or HTTPS. The web address can be partial or complete, but
it is recommended to use a complete web address.

Email: An email address is specified on the form mailto:emailaddress. This
will launch the user’s default email application program and prepare a new
message where the To field is set to the address specified. This way of
interactively sending an email from a COMSOL application is different from
using the built-in method. For more information on the built-in methods
for email, see “Email Methods” on page 356.
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Toolbar

A Toolbar object contains the specifications of a toolbar with toolbar buttons. The
figure below shows a toolbar with several buttons.

Browse Plot Filter Contour Curve Reset

The Settings window for this toolbar is shown in the figure below.

Settings =3
Toolbar
MName: mainToolbar =
lcon size: Small -
¥ Toolbar ltems
L .
MName lcon | Text Tooltip
browse Browse Load image file
plot Plot Plot imported image
process Filter Plot filtered image
plotContour ) | Contour Plot image contours
generateCurve A | Curve Generate curves from con...
factory 3 | Reset Reset to factory settings
BEE

Each row in the Toolbar Items table contains either an Item or Toggle Item
corresponding to a toolbar button or toggle button, respectively, or a Separator.
Use the buttons below the table to add items or separators, change the row order,
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or delete a row. Click the Edit button to display the Settings window associated
with each row. The figure below shows the Settings window of the Browse item.

O3 Edit Custom Toolbar ltem

General  Choose commands to run

Name: browse

Text: Browse
Icon: open.png
Toottip: Load image file
Keyboard shertcut:

State
Visible

Enabled

oK

Cancel

O Edit Custom Toolbar ltem

General Choose commands to run

> & Forms

> @ GUI Commands
>

> =

Declarations
Form Declarations

v [ Methods
importimage
generateContour
generateCurve
createNodes
cleanup

[Z] measureContour

Run [oa| Plot Set Value Show Show as Dialog Import File
Disable

"
Command Icon | Arguments
importimage ]
bg 0B~

0K

Enable

Cancel

The text in the Tooltip ficld will be shown as a tooltip when hovering over the

toolbar button. The text in the Text field will be shown next to the icon, if any;

otherwise just the text is shown. Similarly you can choose to just have an icon and
no text. The lcon list, the Keyboard shortcut ficld, and the Choose commands to run
tree represent the same functionality as a button object. For more information, see

“Button” on page 66.

Form Toolbar

A Form Toolbar is a form object that can be added to a form's header area and will
display intelligently based on the form's context. For instance, if the form is used

in a subwindow or as a settings form, the toolbar will be fixed at the top, even
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when the content below scrolls out of view. This ensures that the toolbar can

always be easily accessible.

Model Builder

— = Et -

h

~ & Untitled.mph (root)
v () Global Definitions
Fi Parameters 1
2 Materials
[ Image to Curve 1
v [l Component 1 {comp1)
» = Definitions
¥ Geormnetry 1
2 Materials
£ Mesh 1

> [El Results

Settings

Image to Curve

Browse Plot Filter “# Contour
~ Image
X1 size
y: size

Image width

Filename none

Filter. Gaussian
Positive image

v Contour

Automatic contour thresheld

Contour threshold

Curve Reset

X
X
m

Browse...

If the form is used in a section within a form collection, the toolbar appears in the
section header, offering a convenient location for section-specific commands.

The figure below shows the Settings window of the Form Toolbar used in the Image

to Curve add-in.

Settings

Form Toolbar

[@ Preview [ main %
Browse (4 Plot < Filter ) Contour '\ Curve 4 Reset
v
> R R e

1~ Image
! .
1 size 0
i
L 0
"y size 0
| Image width:  0.25
I
(Filename:  nene
i
| Filter: Gaussian

Positive image
~ Contour

Automatic contour threshald
Contour threshold: 033

v Curve

Name: mainToolbar

Icon size: Small

!
.
px |~ Toolbar ltems
\
P B
! Name lcon | Text
m
| browse Browse
Browse.. |
. plat Plot
; process ¥ |Filter
; plotContour | ) | Contour
) I
g generateCurve | /%, | Curve
0
' factory ) |Reset
\
\
\
2o
\
! #GHEHE
.
|
\

> Appearance

Tooltip
Load image file

Plot imported image

Plot filtered image

Plot image contours

Generate curves from contours

Reset to factory settings

The Toolbar Items table is similar to the table of the Toolbar form object described

in the previous section.

324 |



Spacer

A Spacer object is invisible in the user interface and is only used when working in
grid layout mode. It defines a space of fixed size that you can use to ensure that
neighboring form objects have enough space to show their contents. Typically,
you would use a spacer next to a table or graphics object to ensure that they are
rendered properly. If the user resizes the window so that it becomes smaller than
the size of the spacer, the effective size of the window is maintained by displaying
scroll bars. The figure below shows the Settings window of a spacer object.

Settings
Spacer
MName:  spacerl E

¥ Position and Size

Horizontal alignment: | Left -
Vertical alignment: Top -
Width: 40

Height: 20

Row: 8

Column: 10

Row span: 1

Column span: 1

Cell margin
Cell margin: From parent form
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Appendix B— Copying Between Applications

Many nodes in the application tree can be copied and pasted between applications,
including: forms, form objects, menu items, methods, Java® utility methods,
external libraries, file declarations, choice list declarations, menus, menu items,
ribbon sections, ribbon tabs, and ribbon items.

When you copy and paste forms, form objects, and items between applications, the
copied objects may contain references to other objects and items. Such references
may or may not be meaningful in the application to which it is copied. The
following set of rules apply when objects are pasted from the clipboard:

* A declaration referenced in a form object or menu item is included when
copying the object, but is not necessarily pasted. It is only pasted if there is
no compatible declaration present. If a compatible declaration exists, that is
used instead. A compatible declaration is defined as one having the same
name and type. For example, a string declaration is not compatible with an
integer declaration. An existing declaration may have an invalid default, but
no such check is done when pasting.

» A referenced global parameter may have a different unit, but will still be
considered compatible.

* A form or form object directly referenced from another form object is not
included automatically when copying objects. The direct reference will point
to an existing object if it has the same name. If the original reference is
among the copied objects, then that object will be used in the reference
instead of any existing objects having the same name. The name of the
copied reference will be changed to avoid name collisions.

* No objects in the model tree will be automatically copied, for example, a
graphics object referring to a geometry or an input field referring to a
low-level setting exposed by Data Access. If the reference points to an object
that exists in the model tree of the target application, then that reference will
be used.

» References to nonexistent objects will be attempted to be removed when
pasted. An exception is command sequences in buttons, where all commands
are kept and marked as invalid if they point to a nonexistent reference.

* Local methods are included in the copy-paste operation. However, no
attempt is made to update the code of the method. This also applies when
copying a global method.

* Arguments to commands in the command sequence of a button or a menu
item will be left as is.
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» Allimage references are automatically copied and added to the image library
when applicable. If there is an existing image with the same name, it will be
used instead of the copied version.

* No files, sounds, or methods are automatically copied if referenced to.
However, methods can be copied and pasted manually.

» All pasted objects that have a name that conflicts with that of an existing
object will be renamed. Any references to the renamed object from other
pasted objects will be updated.
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Appendix C — File Scheme Syntax

The handling of files may be an important feature of an application. For example,
the application may require a spreadsheet file with experimental data as input, a
CAD file to be imported, or a report to be generated and exported. The
Application Builder provides tools for reading and writing entire files or portions
ofa file. The way that this is done will vary depending on the system where the
application is running. The file system may be difterent on the computer running
COMSOL Multiphysics, where the application is developed, and on the computer
where COMSOL Server is installed and the application will run once it is
deployed. For more in-depth information on reading and writing various types of
data to file, see the Application Programming Guide.

File Handling with COMSOL Server

In general, you cannot read and write files to local directories when running
applications with a web browser or the COMSOL Client for Windows®. The
application and its methods are run on the server and have no knowledge of the
client file system (where the web browser or COMSOL Client is run).

However, there are techniques for transferring files to and from the client file
system when running an application both with a web browser and the COMSOL
Client.

A File Import object can be used to ask the user for a file. The user then browses
to a file on the client file system, which is then uploaded to the COMSOL Server
file system and becomes available to the application and its methods. This can be
used, for example, to provide a CAD file or an experimental data file from the user
at run time. This is covered in the section “File Import” on page 334.

In a command sequence of, for example, a button, you can export data generated
by the embedded model by running a subnode of the Export or Report nodes. This
is covered in the section “File Export” on page 341.
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SAVING AND OPENING FILES USING FILE COMMANDS

In the editor tree used in a command sequence, the File Commands folder contains
commands to save and load applications and files, as well as exiting an application.

Settings

Button

MName: helpButton

Text: Help

lcon: B help_32.png -
Size: Large

Style: Flat

Tooltip: Open the PDF docurnentation.
Keyboard shortcut:  CTRL+0

+ Choose Commands to Run

b B Forms

4 @ GUI Commands

- File Commands
Save Application
[ Save Application As
Save Application on Server
[ Save Application on Server As
Open File
L SaveFile As
Exit Application
I Cfy Graphics Commands
Edit Mode P Run Plot Set Value Show

Show as Dialog Import File Enable Disable

L
Command lcon | Arguments

Open file

M-

X

embedded:///tuning_fork.pdf

The command Open File will pick any file from the server produced by a method,
the model, or embedded with the application, and open it using the associated
application on the client. This can be used, for example, to open a PDEF file in the
client file system, or show a text file or an image exported from the model on the
client side. In the figure above, an Open File command is used to open the PDF
documentation for an application. The corresponding PDF file is embedded in the
application by being stored in the Libraries > Files node. Files located there are
referenced using the embedded: /// file scheme syntax described in the next
section, “File Scheme Syntax” on page 331.
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To open files from a method, use the built-in method fileOpen; see also
“Operating System Methods” on page 356.

To save a file, use the command Save File As, which is similar to Open File. It will
take any file from the server file system and display a Save As dialog to the user
where the user can browse to a client location to save the file. This is similar to
downloading files from a link within a web browser. In the figure below, a Save
File As command is used to save a CAD model that is stored in the Libraries > Files
node.

» (Choose Commands to Run b

b B Forms
4 @ GUI Commands
- File Commands
Save Application
[ Save Application As
Save Application on Server
[ Save Application on Server As
Open File
L SaveFile As
Exit Application
| [‘u Graphics Commands

Edit Mode P Run Plot Set Value Show Show as Dialog

Import File Enable Disable

L]
Command lcon | Arguments
Save file as L | embedded:///exhause_manifold.x_t

M-

To save files from a method, use the built-in method fileSaveAs; See also “GUI
Command Methods” on page 362. For more information on saving and exporting
files, see “File Export” on page 341.

The Save Application and Save Application As commands are available for use in the
command sequence for certain form objects. The Save Application As command
will display a Save As dialog where the user can specify a client path where the
entire application will be saved.

Similarly, the Save Application on Server and Save Application on Server As
commands are available to save the entire application on the server file system. For
information on the corresponding built-in methods, see “GUI Command
Methods” on page 362.

In summary, both uploading and downloading files from the client file system is
supported, but, due to web browser and system security settings, the application
can never do it silently in the background without the user browsing to the source
or destination location of the file.
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MoDEL COMMANDS

In the editor tree used in a command sequence, the Model Commands folder
contains two commands: Clear all solutions and Clear all meshes. Usc these
commands to make the MPH-file size smaller before saving an application by
erasing solution and mesh data, respectively.

+ (Choose Commands to Run ]

I U Forms

- u GUI Cormmands
I [ File Commands
I & Graphics Commands
4 & Model Commands
H‘é Clear All Solutions
H‘;’ Clear All Meshes

Declarations

Methods

[fifi Libraries

@ Model (root)

-
&0 m

Edit Mode Run Plot Set Value
Show Show as Dialog Import File
Enable Disable

"
Command lcon  Arguments
- y
Clear all solutions “3
u
Clear all meshes “3
iE -

File Scheme Syntax

To make applications portable, the Application Builder allows you to use virtual

file locations using file schemes. A file scheme can be seen as a pointer to a file on
the file system, but the application does not need to know where the file is actually
stored (this is set in the Preferences window, see below.)

Different file schemes exist for different purposes:

e The user file scheme is for files that should be persistent between different
runs of an application by the same user.

* The common file scheme behaves in the same way, but is for files that should
be shared between all users.

e The temp file scheme is for files that should be removed as soon as the
application is closed.
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e The dbfile file scheme is for file versions that are stored in a Model Manager
database.

* The embedded file scheme is used to store files in the application itself. This
can be useful if you want to make the application self-contained and send it
to someone else.

» The upload file scheme is for files that are uploaded to the application by the

user at runtime, such as a CAD file to which the user browses.

The table below summarizes all available file schemes.

SCHEME

REFERS TO

DEFAULT PATH

TYPICAL USAGE

embedded:///

upload:///

temp:///

user:///

common:///

dbfile:///

Files embedded in
the application using
Libraries > Files.

Files to be uploaded
by the user at run
time.

Files in a random
temporary directory,
which is unique for
each started
application instance.
These files are
deleted when the
application is closed.

Files in a directory
shared by all
applications for the
current user.

Files in a directory
shared by all users.

File versions stored in
a Model Manager
database.

N/A

Determined by the
Target directory in
the Settings window
of the File declaration

A random
subdirectory to the
folder for temporary
files, as determined
by the settings in
Preferences > Files

Determined by the
settings in
Preferences > Files

Determined by the
settings in
Preferences > Files

N/A

Experimental data,
CAD files, mesh files,
interpolation data

Experimental data,
CAD files, mesh files,
interpolation data

Temporary files
produced by
command sequences
or methods, or data
export to a file saved
on the client (for use
with COMSOL
Server)

Output from
methods to be saved
between sessions

Files shared between
many users or
applications

Experimental data,
CAD files, mesh files,
interpolation data

For more information on files in the Libraries node accessible by the
embedded:/// syntax, see “Libraries” on page 232.
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The table below summarizes the usage of the different file schemes. In the table,
a check mark means that this scheme is available and (r) means that it is the
recommended scheme. The dbfile file scheme is available for all usages.

USAGE EMBEDDED  UPLOAD TEMP USER COMMON
File is used as input V (n S \

File is output \ @) \

Method reading a file V (n S S \ \
Method writing a file \ \ @) \

File is client-side V J \ () \ \

You can set the preferences for the paths to temporary, user, and common files in
the Files page of the Preferences window, which is accessible from the File menu,

as shown in the figure below.

2 Preferences
EE Files
v Application Builder
> Forms
>  Methods
Client-Server

Folder for temporary files (temp:///):

Folder for user files (user///):

) [CAU

C:\Users\paulAppData\Local Temph

CA\Users\paull.comsol\vE2\applicationsifiles\user

Folder for commeon files (c

Computing

paull.c ommon

Libraries> Files

Declarations> File (upload:///):

Email

Use /i to referto a file with the name filename in the application.

v Files
Recovery
Geometry
Graphics
Help
Libraries

Livelink Connections
Mesh
Madel Builder

Model Manager
Physics Builder
Results

Save
Security
Updates
User Interface

Factory Settings for Al Import. Export.

Use upload:///

1o referto a file with the name filename in the application

Factory Settings

oK

W5 Browse
¥ Browse

P& Browse

Cancel
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File Import

CAD IMPORT USING THE MODEL TREE AND A FILE IMPORT OBJECT

A File Import object is used to display a file browser with an associated input field
for browsing to a file or entering its path and name. It is used to enable file import
by the user of an application at run time, when the file is not available in the
application beforehand. You can directly link a File Import object to a file Import
node in the model tree; for example, a CAD Import node. Consider an application
where a CAD file can be selected and imported at run time, as shown by the figure
below.

CADfileto analyze:  C\pipex_b Browse...

The corresponding File Import object is shown in the figure below.

CAD file to analyze: Browse... |+
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The Settings window for the File Import object has a section File Destination. In this
section, you can select any tree node that allows a file name to be input. This is
shown in the figure below, where the Filename for the Import node is selected.

Settings = L8
MName: fileimportl =
Style: Outlined =
lcon: = import_32.png - + =
Button text:  Browse...
Dialog title:  File import
File types:

COMSOL Multiphysics File (*.mphtxt; *.mphbin; ...)

All 3D CAD Files (*.step; *.stp; *a_b; "2t )

All 3D Importable Geometry Files (*.mphtxt; *.mphbin; ..)

All 3D Importable Mesh Files (*.mphtxt; *.mphbin; ..)

+®
Allow entering filename
¥ File Destination @

w

= Declarations
& Model (root)
~ [l Component 1 (comp1)
v W Geometry 1
~ [& Import 1 (imp1)
2% Filename (filename)
abe Filename (meshfilename)

<

> igi Materials

> [El Results

@_‘ Use as Source =g Edit Node
Selected source:

abc Import 1 (imp1)=Filename (filename)

Access using:  upload:///geom1/imp1/filename

If you do not wish to use a File Import object, you can directly reference a Filename
from a button or an item in a menu, ribbon, or toolbar, or alternatively create a
method that calls the built-in method importFile as an event, for example

importFile("filel");

assuming there is a file declaration filel.
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The figure below shows a ribbon item used for geometry import together with its
Settings window.

o2 - q
Settings 1%
[tem
E_ Name: import =
Import
Text: Import
lcon: = import_32.png -| |4+ B
Size: Large =
Tooltip:
Keyboard shortcut:
State
Visible
Enabled
« (Choose Commands to Run i

4 < Model (root)
I () Global Definitions
4 |§ Component 1 (comp1)
[ = Definitions
4 Y Geometry 1
4 & Import 1 (imp1)
abc Source (type)
abe Filename (filename)
abe Filename (meshfilename)

I 5z& Materials

Edit Mode Run Plot Set Value Show
Show as Dialog Import File Enable Disable

" Command lcon | Arguments
Set type of Import 1 (imp1) i [file
Impeort file to Impoert 1 (imp1) 1

Plot Geometry 1 rnain/graphics1
Zoom extents rnain/graphics1
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In the Settings window above, the command Import file to Import | will open a file
browser for the user to select a file, as shown in the figure below.

(e = | Applications - O *
“ Home Share View o
&« v A <« applications » CFD_Module » Applications v O Search Applications »

A

MName Date modified Type Size
7 Quick access

| | pipex_b X_B File 4KB
& Creative Cloud Files | | split_recombine_geom.x_b : ¥_B File 125 KB
& OneDirive | | star_chip_geom.x_b 2018-12-10 16:04 ¥_B File G KB
[ This PC
¥ Metwork

3 itemns =

The preceding command Set Type of Import allows you to filter the file extensions
displayed in the file browser. The available arguments are: file, mesh, native,
cad, and ecad.

The subsequent commands build and plot the geometry and zoom out using
zoom extents.

For more information on the File Import object, see “File Import” on page 290.

FILE IMPORT IN METHODS

Continuing the example of the previous section, assume that we click Convert to
New Method in the Settings window. The corresponding lines of code show how
CAD import can be accomplished from a method:

importFile (model.geom("geomi1").feature("imp1"), "filename");
useGraphics(model.geom("geom1"), "main/graphicsi");
zoomExtents("main/graphics1");

The first line illustrates using the built-in method importFile. For more
information on the method importFile and other methods for file handling, see
“File Methods” on page 354 and the Application Programming Guide.

FILE ACCESS AND FILE DECLARATIONS

At the bottom of the Settings window of a File Import object, you can see which
file scheme syntax to use to access an imported file from a method (next to Access
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using:). The figure below shows an example where a File Destination and Filename
are used.

Selected source:

123 Import 1 (imp1)=Filename (filename)

Access using:  upload:///geoml/imp1/filename

The file scheme syntax, upload:///geomi/imp1/filename, needs to be used
whenever accessing this file.

As an alternative, you can use a File declaration under the Declarations node.
(However, File declarations are primarily used for file import from method code.)
In this case, the file chosen by the user can be referenced in a form object or
method using the syntax upload:///file1, upload:///file2, and so on. The
file name handle (file1, file2, and so on.) can then be used to reference an
actual file name picked by the user at run time. See also “File” on page 171.

This syntax can also be used in any file browser text fields within the Model
Builder nodes. The figure below shows a file reference used in the Filename field
of the Import model tree node for a model using geometry import.

Settings =i
mpEort

[ Build Selected = [E8 Build All Objects 2

Label: Import1 =
¥ Import

Source:

Any importable file =
Filename:

upload:///filel + -

W& Browse = [& Import

However, a quicker way is to link a file import object directly to the Filename ficld,
as described previously in the section “CAD Import using the Model Tree and a
File Import Object” on page 334.
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IMPORTING EXPERIMENTAL DATA

Consider an application where the user is providing a file with experimental data
at run time. The figure below shows the file import object of such an application
as it appears in grid layout mode.

Experimental Data
Impedance measurement file: Browse...

2

The figure below shows the Settings window of the corresponding file import
object and its link to a file declaration.

LA

%]
4
-
X

etting

MName: fileimportl =
Button text:  Browse...
Dialog title:  File import
File types:
C5V File (*.csv)

_l’_
Allow entering filename

¥ File Destination &5

4 = Declarations
File 1 {experimental.csv}

@_‘ Use as Source =g Edit Node

Selected source:
E File 1 {experimental.csv}

Access using:  upload:///experimental.csv

Position and Size
Appearance
¥ Events
On data change: updateResults ~ Bt

On focus gained: MNone A P2
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In this application, the File types table specifies that only CSV files are allowed. The
Settings window for the File declaration is shown in the figure below.

Settings “ L83

Tl

Label:  experimental

MName: experimental.csv

File Location
Target directory: | Temporary v
Access using: upload:///experimental.csv

The file declaration serves as the “destination” of the imported data, which is
written to the file upload:///experimental.csv.

Note that the file extension .csv used in the declaration is optional and that the
file picked by the user at run time can have any name. For example, the file name
picked at run time can be my_data.csv, but when referenced in method code, the
abstract file handle name experimental.csv is always used.

In order to make it possible to run the application without having to first provide
experimental data, a file containing default experimental data is embedded in the
application. This default data file is used by the application by accessing it with the
embedded:/// file scheme syntax, as shown in the figure below.

In this example, which uses the Optimization Module, the application performs a
least-squares fit to the experimental data.

Model Builder - * Settings
R = v B i~ Global Least-Squares Objective
4 %@ li_battery_impedance.mph (root)
b (3 Global Definitions Label: Global Least-Squares Objective 1 =
‘ ! ;Drgfzi:iet?;:sl'mmp?} ¥ Experimental Data
b/, Geometry 1 Data source:
I 5z& Materials File S
b 77 Lithium-lon Battery {liion)
el CJ Optimization {opt) Filename:
4 (%) Global Least-Squares Objective 1 embedded:///experimental_default.csv Browse...
CJ Parameter Column 1
c{ Value Column 1 ¥ Experimental Parameters
CJVaIueCDIumn}l "
I A Mesh 1 Mame Expression
[ ~do Study 1
[ ~cf Study 2
b {8 Results + a9 )
Expression:
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The following method handles the logic to determine if user-provided
experimental data files exist or if the default data set should be used.
if (exists("upload:///experimental.csv")) {
with(model.physics("opt").feature("glsobj1"));
set("fileName", "upload:///experimental.csv");
endwith();
}
else{

String s_data = confirm("No experimental data file was uploaded. Do you
want to use the embedded data?", "Experimental Data", "Yes", "Cancel
Parameter Estimation");

if(s_data.equals("Cancel Parameter Estimation")){

return;

}
}

If a user-provided file exists, the code replaces
embedded:///experimental_default.csv

with
upload:///experimental.csv

in the physics interface glsobj1.

More information on file import can be found in the Application Programming
Guide.

File Export

FILE EXPORT USING THE MODEL TREE

In a command sequence of, for example, a button, you can export data generated
by the embedded model by running a subnode of the Export or Report nodes.

In the model tree, the Export node may contain several types of subnodes for file
export, including:

¢ Data

¢ Plot

¢ Mesh

¢ Table

¢ 3D Image

¢ 2D Image

* ID Image

¢ Animation
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The Settings window for each of these nodes contains an Output section with a
field for Filename. The figure below shows the Settings window for an Export > Plot
node.

Settings

Plot

(* Refresh [[= Export

Label: Plot1 =
¥ Plot

Plot group: | 1D Plot Group 3 - |Z
Plot: Line Graph 1 | [
¥ Qutput

File type: Text -
Filename: Browse...
Always ask for filename

Data format: Spreadsheet -
If multiple curves: | Append as rows -

You can leave the Filename ficld blank, as shown in the figure above. In the
command sequence of, for example, a button, you can run the corresponding
Export > Plot node and, at run time, it will open a file browser window for the user
to select a location and file name, as seen in the figure below.

"
Command lcon  Arguments

Export Plot 1 {plotl} =

While developing an application, you may need to use the Model Builder
repeatedly to check the exported data. In this case, you can use the Filename field
for a test file and, by selecting the Always ask for filename checkbox, a file browser
will still be opened at run time.
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In a similar way to the Export subnodes, each Report subnode has a Format section
with a Filename field, as seen in the figure below.

¥ Format

Output format: Microsoft Word -
Filename: Browse...
[] Always ask for filename

Open finished report

["] Disable cross-reference hyperlinks

Microsoft Word template: Default =
Start new page at section level: | Level 1 -
Enumerate sections to level: Level 3 -

By running a Report subnode, a file browser window is opened for the user to
select a location and file name for the report.

For more detailed control over file import and export, you can instead use a file
scheme.

FILE EXPORT USING A TEMPORARY FILE

Some applications may need to produce temporary files, and this is accomplished
by using the temp:/// file scheme. The temporary files are stored in a random
temporary directory, which is unique for each started application instance. These
files are deleted when the application is closed. Temporary files can be produced
by command sequences or methods, or output to be saved on the client when used
with COMSOL Server.
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The example below shows the Settings window of an Export > Plot node that is
used to export plot data as numerical values.

Settings

Plot

(* Refresh [[= Export

Label: Plot1 =
¥ Plot

Plot group: | 1D Plot Group 3 | [

Plot: Line Graph 1 | [

¥ Qutput

File type: Text -
Filename: temp:///lineplot.bd Browse...

[] Always ask for filename
Data format: Spreadsheet -

If multiple curves: | Append as rows -

The Filename in its Output section is set to temp:///lineplot.txt.

To make it possible to save the plot in this example, a button is created. In the
Settings window for the button, in the section Choose Commands to Run, first create
the output graph file by choosing the Export > Plot node created above and
clicking Run. Second, choose GUI Commands > File Commands > Save File As and
click Run again.
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In the Output section of the button Settings, sct the filename to the name of the
temporary file created by the Export Plot command, in this case,
temp:///lineplot.txt.

Settings = L1
Button

Mame: button3 E

Text: Save Line Plot

lcon: MNone ~| |4

Size: Small =

Tooltip:

Keyboard shortcut:

+ Choose Commands to Run 5

b B Forms

4 @ GUI Commands
- File Commands
Save Application
[ Save Application As
Save Application on Server
[ Save Application on Server As
Open File
L SaveFile As
Exit Application
3 [‘u Graphics Commands

Edit Mode P Run Plot Set Value Show
Show as Dialog Import File Enable Disable

L
Command lcon | Arguments
Export Plot 1 =
Save file as 1 temp:///lineplot.bet
oE -
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The Save File As command provides a dedicated Edit Argument dialog with
easy access to all embedded files as well as shortcuts for all file schemes.

+ Choose Commands to Run B | o Edit Argument ks
Fl u GUI Commands File schemne: embedded:/// ~
4 File C d
H File or’ﬂman.s X Choose an application file resource: embedded:///
[ Save Application —
5] Save Application As about_infermation.png cupmrn;n'.-"f.-"
=] Save Application on Server about_infermation_32.png " "
5! Save Application on Server As compute.png Hser
. temp/d/
Open File compute_32.png
+ SaveFile As cube.png Custom
[ %] Exi.tAppIication cube_32.png
b & Graphics Commands cube_large.png
I <@ Model Commands
error.png
Edit Node P Run Plot Set Value Show error_32.png
Show as Dialog Import File Enable Disable exit.png
"
Command lcon  Arguments oK Cancel
Save file as + |
R4

=

Edit Argument

The corresponding method code is as follows:

model.result().export("plot1").run();
fileSaveAs("temp:///lineplot.txt");

The Use of Temporary Files for File Export

Note that as a first step, in the example above, the file is written to a temporary
file, using the call to model.result().export("plot1").run(). This step is
done automatically by the application. In the second step, the method
fileSaveAs opens a file browser and lets the user of the application choose the file
location, for example, a folder on the computer’s local file system or to a network
folder. This extra step is needed in order for the application to function in a web
browser. Due to the security settings of a typical web browser, the application is
not permitted to automatically save a file to an arbitrary location. Instead, the
application is allowed to save to a few specific locations including the temp folder,
whose location is specified in the Preferences window settings. The other locations
are the user and common folders, also specified in the Preferences settings.

For more examples of file export, see the Application Programming Guide.

CREATING REPORTS USING LOW-LEVEL FUNCTIONALITY

This section describes creating reports using low-level functionality. For a more
direct method, see “File Export” on page 341.
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The example below shows an application where a report in the Microsoft® Word
format (.docx) can be saved by the user. The figure below shows a tab in the

ribbon of the application. In this tab, there is a Report button in the Documentation
section.

Hc:me
S5 = Fa

Reset Compute  Report Help

Input | Simulation | Documentation
The associated application tree node is shown in the figure below.

Application Bu
LR
- li_battery_designer.mph (root)
ﬁ Inputs
% Themes
- D Main Window
b [E File Menu
4 [+ Ribbon
4 ™ Home {home}
3 Input {input}
[ Simulation {simulation}
4 Documentation {documentation}
El Report {report}
[+ Help {help)
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The following figure shows how the syntax user:/// was used in the Filename
field in the Settings window of the Report node of the Model Builder.

R

uliaer

P ® Etv Eiw -
4 4 Ii_battery_designer.mph (root)
% Global Definitions
Py Parameters 1
4 Default Model Inputs
b Materials

I — Component 1 (comp )

b ~do Study 1

4 B Results

Datasets

Derived Values

b B Tables

I~ Probe Plot Group 1

~% Cell Potential and Load vs. Time

~¥ Positive Electrode Potentials vs, Time
~% Megative Electrode Potentials vs. Time

~% Temperature and Heat sources vs. Time

~¥ Parasitic Lithium Losses vs. Time

~% Electrolyte Potential Distribution

~¥ Electrode Phase Potential Distribution

~ Electrolyte Concentration Distribution

~ Electrolyte Conductivity Distribution

~ Integrated Lithium Loss Distribution

~ Electrode SOC Distribution

~¥ Intercalation Reaction Current Source Distribution

b~ SOCvs. Time

Export

4 [# Reports

4[5 Report 1

[=] 1D Lithium-lon Battery Model for Determinatic
Table of Contents 1

= 1. Software Information

. Input Data

. Results

-

7] Generate [Z| Preview Selected [5] Preview All # Write =

Label: Report 1 B
Template

~ Format

Output format: Microsoft Word -

Filenarne: user;///Li-lon_Battery Impedance.docx | F& Browse

[] Always ask for filename
Open finished report
[] Disable cross-reference hyperlinks

Microsoft Werd template: Default -
Start new page at section level:  Level 1 -
Enumerate sections to level: Level 3 -
¥ Images

Size: Large -
Type: PNG -
Color theme: Global theme -
Background: Transparent -
(® Generate images

() Suppress image regeneration

() Disable image generation

Link information for Word add-in: From preferences -
~ Number Format

Format: Default -

[] Right align numeric columns

In this application, the Open finished report checkbox is selected, which means that
the Word® document will open after the report has been created. The user of the
application can then save the report from the Word® file menu.

In this example, the file scheme common:/// could have been used in the same
way. The user and common file schemes are primarily useful when the same files
are used repeatedly by an application.
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The figure below shows the Settings window of the Report ribbon item.

Settings v RX
Name: report =

Text: Report

lcon: ¥ results_report_32.pn »  + =
Size: Large =

Tooltip: Create simulation report

Keyboard shortcut:  CTRL+W
State

Visible

Enabled

» (Choose Commands to Run B

b B Forms

I @ GUI Commands

I = Declarations

4 B Methods

E initializeApplication

changeMaterial
changeChargelnputMode
updateSolutionState
changeBatterySizeType
changeRowlnputMode
changeVsTimePlot
changeProfilePlot
compute
updateResults
createReport
resetToDefault

Edit Mode Run Plot Set Value Show
Show as Dialog Import File Enable Disable

L
Command lcon | Arguments
createReport @

b BE -

The method createReport includes the following call:
model.result().report("rpt1").run();

The file scheme syntax can also be used directly in methods. The code below is
from a method used to export an HTML report.
String answerh = request("Enter file name","File Name", "Untitled.html");
if(answerh != null){
model.result().report("rpt1").set("format","html");
model.result().report("rpt1").set("filename","user:///"+answerh);
model.result().report("rpt1").run(); }}
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Appendix D — Keyboard Shortcuts

The table below lists the keyboard shortcuts available in the Application Builder.
For a list of additional keyboard and mouse shortcuts, see the book Introduction
to COMSOL Multiphysics.

SHORTCUT ACTION APPLICATION ~ FORM METHOD
BUILDER EDITOR  EDITOR

Ctri+A Select all v ol ol

Ctrl+D Deselect all \

Ctr+C Copy \ \ \

Ctrl+V Paste \ \

Ctrl+X Cut v V Yl

Del Delete V \ \

Ctrl+N Create a new application \ \ \

Ctri+S Save an application \ \ \

Ctrl+F8 Test an application \ \ \

Alt+Click Edit certain form objects \

Pause Break or suspend a running method \
as soon as possible

Ctrl+Pause Stop a method \

Ctrl+Shift+F8 Apply changes \ \ \

Ctrl+R Record code \

FII Go to node \

Ctrl+K Create shortcut V \ \

FI Display help \ \ \

F2 Rename applicable nodes \

F3 Disable applicable nodes \

F4 Enable applicable nodes \

Ctrl+Up arrow Move applicable nodes up \

Ctrl+Down arrow Move applicable nodes down \

Ctri+Z Undo v ol ol

Ctri+Y Redo (Control+Shift+Z on Mac) v \ \

F5 Continue (in debugger) \

F6 Step (in debugger) \
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SHORTCUT

ACTION

APPLICATION
BUILDER

FORM
EDITOR

METHOD
EDITOR

F7
Shift+F7
F8

Fo
Ctri+F

Ctrl+Space, Ctrl+/,
or Ctrl+OEM2

Ctrl+U
Ctrl+Shift+U
Ctrl+B
Ctrl+M

Ctrl+Shift+M

Ctri++

Ctrl+-

Ctrl+0

Ctrl+Alt+0

Ctrl+Scroll wheel
up

Ctrl+Scroll wheel
down

Ctri+All arrow keys

All arrow keys

Step into (in debugger)
Step out of a method (in debugger)

Run a method or method call.
Create an executable or an add-in.

Check syntax
Find and replace text in methods

Autocomplete method code

Make selected code lowercase
Make selected code uppercase
Toggle breakpoint on selected line

Toggle between matching
parentheses, square brackets, or
curly braces

Select all characters between
matching parentheses, square
brackets, or curly braces

Ctrl key and plus key: Zoom in, in
form editors, method editors, and
the Main Window editing window.

Ctrl key and minus key: Zoom in, in
form editors, method editors, and
the Main Window editing window.

Reset zoom to 100% in form
editors, method editors, and the
Main Window editing window.

Zoom to fit the available space in
form editors and the Main Window
editing window.

Zoom in, in method code window

Zoom out, in method code window

Fine-tune position of selected form
objects

Fine-tune position of selected form
objects

\/
\/

< 2 =2 =2 < 2 2
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SHORTCUT ACTION APPLICATION  FORM  METHOD
BUILDER EDITOR  EDITOR

Ctrl+Shift+A Go to Application Builder window S \
Ctrl+Shift+M Go to Model Builder v \/
Ctri+Alt+Left-click  Create a local method or open a S

method associated with a form

object
Ctri+Alt+ Open a method from Method \
Double-click Editor code
Alt+F4 Close window v \/ l
Ctrl+F4 Close document S \
Ctrl+Shift+F4 Close all documents V l
Ctr+7 Toggle comment on and off \
Press Ctrl and Copy form object \
left-click. While

holding down the
key and button, drag
the mouse.
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Appendix E— Built-In Method Library

This appendix lists all of the built-in methods available in the Method Editor,
except for methods that operate on the model object and the application object.
For detailed information on using the built-in methods and for full information
on the syntax used, see the Application Programming Guide and the
Programming Reference Manual.

As an alternative method of learning the syntax of these methods, you can use
code completion by typing the name of the method and then use Ctrl+Space. A
window will open with information on the syntax and method signature.

@ Preview Dform‘l

I p1aysound

@ playSound(String name)
@ playSound(double hz, int milliseconds)

method] X

Plays a signal with given frequency and duration.

Parameters:
hz Frequency in Hz.
milliseconds Duration in milliseconds.

Model Utility Methods

The model utility methods make it possible to load the model object part of an
MPH-file into a method for further processing.

NAME DESCRIPTION

clearModel Clears the model object contents.

createModel Creates a new model with a given tag.

removeModel Removes a model. The embedded model cannot be removed.

modelTags Returns an array of model tags for all loaded models, including the
embedded model.

uniqueModeltag Returns a model tag that is not in use.

getModel Returns a model with a specified tag.

loadModel Loads a model with a specified tag from a file or, using a model
location URI, from a Model Manager database.

loadProtectedModel Loads a password protected model with a specified tag from a file.

loadRecoveryModel Loads a model from a recovery directory/folder structure.

saveModel Saves a model to a file. The filename can be a file scheme path or,
if allowed by security settings, a server file path.

getComsolVersion Returns the current software version as a string.
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File Methods

The file methods support, in addition to reading and writing to data files on the
file system, reading and writing of data files stored in a Model Manager database

by accepting a file location URI.

NAME DESCRIPTION
readFile Returns the contents in a given file as a string.
openFileStreamReader Returns a CsReader object that can be used to read

openBinaryFileStreamReader

readMatrixFromFile

readStringMatrixFromFile

readCSVFile

writeFile

openFileStreamWriter

openBinaryFileStreamWriter

writeCSVFile

exists

deleteFile

copyFile

line-by-line or character-by-character from a given file
name.

Returns a CsBinaryReader object that can be used to
read from a given file byte-by-byte.

Reads the contents of the given file into a double matrix.
The file has the same spreadsheet-type format as available
in the model tree Export node.

Reads the contents of the given file into a string matrix.
The file has the same spreadsheet-type format as available
in the model tree Export node.

Reads a file with comma-separated values (CSV file) into
a string matrix. By default, it expects the file to use the
RFC 4180 format for CSV. However, by providing an
additional input argument a user-defined delimiter can be
used.

Writes array data to a given file. If the spreadsheet
format is used, then the data can be read by
readMatrixFromFile or
readStringMatrixFromFile.

Returms a CsWriter object that can write to a given file.

Returns a CsBinaryWriter object that can be used to
write to a given file byte-by-byte.

Writes a given double or string array to a CSV file. The
RFC 4180 format is used for the CSV.

Tests whether a file with a given name exists.

Deletes a file with a given name if it exists. The file is
deleted on the server.

Copies a file on the server. Both the source and target
names can use file scheme paths.
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NAME

DESCRIPTION

importFile

writeExcelFile

readExcelFile

getFilePath

getClientFileName

getClientFilePath

Displays a file browser dialog and uploads the selected file
to the file declaration with the given name. Afternatively, it
uploads the selected file to the Filename text field in a
given model object entity.

Writes the given string array data starting from a
specified cell in a specified sheet of an Excel file.

Reads a specified sheet of an Excel file, starting from a
specified cell, into a 2D string array.

Returns the absolute server file path of the server proxy
file corresponding to a certain file scheme path, or null if
the server proxy file for the given path does not exist.

This method can be used to pass the path to, for
example, a file using the temp:/// scheme to extemal
code or an application.

Returns the original name of an uploaded file on the client
file system (or null if there is no uploaded file matching
the given file scheme path).

This method is only useful for providing user interface
feedback; for example, to get information on which
uploaded file is being used. There is no guarantee that the
original file would still exist on the client or even that the
current client would be the same as the original client.

Returns the original path of an uploaded file on the client
file system (or null if there is no uploaded file matching
the given file scheme path).

This method is only useful for providing user interface
feedback; for example, to get information on which
uploaded file is being used. There is no guarantee that the
original file would still exist on the client or even that the
current client would be the same as the original client.
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Operating System Methods

NAME DESCRIPTION

execute0SCommand Executes the OS command with a given command (full path) and
parameters. When applicable, the command is run server side.

fileOpen Opens a file with the associated program on the client. See also
the section “File Methods".

getUser Returns the usermame of the user that is running the application. If
the application is not run from COMSOL Server, then the value
of the preference setting General > Username > Name is
returned.

openURL Opens a URL in the default browser on the client.

playSound Plays a sounds on the client.

Email Methods

NAME DESCRIPTION

emailFromAddress Retums the email from address from the COMSOL Server or
preferences setting.

sendEmail Sends an email to the specified recipient(s) with the specified
subject, body text, and zero or more attachments created from
Report, Export, and Table nodes in the embedded model.

userEmailAddress Returns the user email address(es) corresponding to the currently

logged in user, or an empty string if the user has not configured an
email address.

Email Class Methods

The class EmailMessage can be used to create custom email messages.

NAME DESCRIPTION
EmailMessage Creates a new EmailMessage object.
EmailMessage.setServer Sets the email (SMTP) server host and port to

EmailMessage.setUser

use for this email message.

Sets the username and password to use for email
(SMTP) server authentication. This method must
be called after the setServer method.

EmailMessage.setSecurity Sets the connection security type for email

EmailMessage.setFrom

(SMTP) server communication.

Sets the from address.
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NAME DESCRIPTION

EmailMessage.setTo Sets the to addresses.

EmailMessage.setCc Sets the cc addresses.

EmailMessage.setBcc Sets the bcc addresses.

EmailMessage.setSubject Sets the email subject line. Note that newline
characters are not allowed.

EmailMessage.setBodyText Sets the email body as plain text. An email can
contain both a text and an HTML body.

EmailMessage.setBodyHtml Sets the email body as HTML text. An email can
contain both a text and an HTML body.

EmailMessage.attachFile Adds an attachment from a file. The attachment
MIME type is determined by the file name
extension.

EmailMessage.attachFile Adds an attachment from a file with a specified
MIME type.

EmailMessage.attachFromModel Adds an attachment created from a report,
export, or table feature in the model.

EmailMessage.attachText Adds a text attachment with a specified
sub-MIME type, such as plain or HTML.

EmailMessage.attachBinary Adds an attachment from a byte array with a
specified MIME type.

EmailMessage.send Sends the email to the email (SMTP) server. An

email object can only be sent once.
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EMAIL PREFERENCES

To set preferences for an outgoing email (SMTP) server, open the Email page of
the Preferences window, as shown in the figure below.

2@ Preferences x

BB Outgoing Server (SMTP)
b Application Builder Host:
Client-Server

servermyorganization.com

Port: 25

Computing

S

Email Connection security: | None -
Outgeing Server (SMTP)

Files

Geometry Password:

Graphics

Help

Libraries

User: paul@myorganization.com

LiveLink Connections
Mesh

Model Builder

Model Manager
Physics Builder
Results

Save
Security
Updates
User Interface

Factory Settings

Factory Settingsfor Al Import. Export. oK Cancel

COMSOL Server provides a similar set of email preferences.
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GUI-Related Methods

NAME

DESCRIPTION

Call a method directly

callMethod

useGraphics

openForm

closeForm

closeDialog

dialog

alert

alert

confirm

error

request

message
clearLog

clearMessagelog

Call a method from the Methods list by using its name; for
example, method1 (), method2()

Alternate way to call a method from the Methods list;
used internally and in cases of name collisions.

Plots a given entity (Plot Group, Geometry, Mesh, or
Explicit Selection) in the graphics form object given by a
name or name path in the second argument.

Shows the form with the given name in the current main
window. In a single window application, the form replaces
the current one. In an application with subwindows, the
form must exist in the main window layout. If not, it will
not be opened. Showing a form that is already open will
only activate the form.

Closes the form with the given name. Closing forms is
only possible in applications using subwindows. This
method is not applicable for single window applications.

Closes the form, shown as a dialog, with a given name.

Shows the form with a given name as a dialog. Equivalent
to the dialog method of a Form object; see below.

Stops execution and displays an alert message with a
given text.

Stops execution and displays an alert message with a
given text and title.

Stops execution and displays a confirmation dialog with a
given text and title. It also displays two or three buttons,
such as “Yes”, “No", and “Cancel".

Stops execution and opens an error dialog with a given
message.

Stops execution and displays a dialog with a text field,
requesting input from the user.

Sends a message to the message log.
Clears the log window.

Clears the message log window.
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NAME

DESCRIPTION

evaluateToResultsTable

evaluateToDoubleArray2D

evaluateToIntegerArray2D

evaluateToStringArray2D

useResultsTable

getChoicelist

setFormObjectEnabled

setFormObjectVisible

setFormObjectText

setFormObjectEditable

Evaluates a given entity, a Derived Value, in the table
object given by the name or name path in the second
argument, which will then be the default target for the
evaluations of the Derived Value. If the third argument is
true, the table is cleared before adding the new data.
Otherwise, the data is appended.

Evaluates the given entity, a Derived Value, and returns
the nonparameter column part of the real table that is
produced as a double matrix. All settings in the numerical
feature are respected but those in the current table
connected to the numerical feature are ignored.

Evaluates the given entity, a Derived Value, and returns
the nonparameter column part of the real table that is
produced as an integer matrix. All settings in the
numerical feature are respected, but those in the current
table connected to the numerical feature are ignored.

Evaluates the given entity, a Derived Value, and returns
the nonparameter column part of the potentially complex
valued table that is produced as a string matrix. All
settings in the numerical feature are respected, but those
in the current table connected to the numerical feature
are ignored.

Shows the values from the tableFeature in the
resultsTable form object.

Returns an object of the type Choicelist, representing
a choice list node under the declarations branch. The type
ChoicelList has associated methods that make it easy
to change values and display names, see the Application
Programming Guide.

Sets the enable state for the form object specified by the
name or name path.

Sets the visible state for the form object specified by the
name or name path.

Sets the text for the form object specified by the name or
name path in the second argument. This method throws
an error if it is impossible to set a text for the specified
form object.

Sets the editable state for the form object specified by the
name or name path. This functionality is only available for
text field objects.

360 |



NAME

DESCRIPTION

setMenuBarItemEnabled

setMainToolbarItemEnabled

setFileMenulItemEnabled

setRibbonItemEnabled

setToolbarItemEnabled

useView

resetView

getView

goToView

setWebPageSource

getScreenHeight

getScreenWidth

Sets the enable state for the menu bar item specified by
the name or name path (from the menu bar) in the first
argument.

Sets the enable state for the main toolbar item specified
by the name or name path (from the main toolbar) in the
first argument.

Sets the enable state for the file menu item specified by
the name or name path (from the file menu) in the first
argument.

Sets the enable state for the ribbon item specified by the
name or name path (from the main window) in the first
argument.

Sets the enable state for the toolbar form object item
specified by the name or name path in the first argument.

Applies a view to the graphics contents given by the name
or name path in the second argument.

Resets the view to its initial state in the graphics contents
given by the name or name path in the second argument.

Returns the view currently used by the graphics contents
given by the name or name path in the second argument.

TR TR TR TR TR TR}

Goes to one of the “xy”, "xz", "yx", “yz", "zx", or "zy"”
views in the main graphics window or in the graphics
window of a form object.

Sets the source for the form object specified by the name
or name path in the first argument.

Returns the height in pixels of the primary screen on the
client system, or of the browser window if Web Client is
used.

Returns the width in pixels of the primary screen on the
client system, or of the browser window if Web Client is
used.
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GUI Command Methods

NAME DESCRIPTION

clearAllMeshes Clears all meshes.

clearAllSolutions Clears all solutions.

clearSelection Clears the selection in the given graphics object.

environmentReflections
exit

fileOpen

fileSaveAs
printGraphics
rotateEnvironment
saveApplication
saveApplicationAs

saveApplicationCopyAs

Adds environment reflections to graphics
Exits the application.

Opens a file with the associated program on the client.

Downloads a file to the client. See also the section *File Methods”.

Prints the given graphics object.
Rotate the environment used for reflections

Saves the application.

Saves the application under a different name. (Or as an MPH-file.)

Saves a copy of the application.

scenelight Toggles scene light in the given graphics object.
selectAll Selects all objects in the given graphics object.
skyBox Shows skybox in graphics
transparency Toggles transparency in the given graphics object.
zoomExtents Makes the entire model visible in the given graphics object.
zoomToSelection Zooms to the current selection.
Debug Methods

NAME DESCRIPTION

clearDebuglLog Clears the Debug Log window.

debuglog Prints the value of an input argument to the Debug Log window.

The input argument can be a scalar, 1D array, or 2D array of the
types string, double, integer, or Boolean.

Methods for External C Libraries
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EXTERNAL METHOD

NAME DESCRIPTION

external Returns an interface to an external C (native) library given by the
name of the library feature. The External class uses the Java
Native Interface (JNI) framework. For more information, see the
Application Programming Guide.

METHODS RETURNED BY THE EXTERNAL METHOD

The external method returns an object of type External with the following
methods:

NAME DESCRIPTION

invoke Invokes a named native method in the library with the supplied
arguments.

invokeWideString Invokes the named native method in the library with the supplied
arguments.

close Releases the library and frees resources. If you do not call this

method, it is automatically invoked when the external library is no
longer needed.
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Progress Methods

NAME DESCRIPTION

setProgressInterval  Setsa progress interval to use for the top-level progress and
display message at that level.
Calling this method implicitly resets any manual progress
previously set by calls to setProgress().

setProgress Sets a value for the user-controlled progress level.

resetProgress Removes all progress levels and resets progress to 0 and the
message to an empty string.

showIndeterminatePr  Shows a progress dialog with an indeterminate progress bar, given

ogress message, and an optional cancel button.

showProgress Shows a progress dialog with an optional cancel button, optional
model progress, and one or two levels of progress information.

closeProgress Closes the currently shown progress dialog.

startProgress Resets the value of a given progress bar form object name to 0.

setProgressBar Sets the value of a given progress bar form object name in the

range 0 —100 and the associated progress message.

Date and Time Methods

NAME DESCRIPTION

currentDate Returns the current date as a string (formatted according to the
server's defaults) for the current date.

currentTime Returns the current time as a string (not including date and formatted
according to the server's defaults).

formattedDateTime Returns a formatted time given in milliseconds since the epoch to a
readable date and time.

formattedTime Returns a formatted time using the given format. The format can
either be a time unit or text describing a longer format.

sleep Sleep for a specified number of milliseconds.

timeStamp Current time in milliseconds since midnight, January I, 1970 UTC.

getExpectedComputatio
nTime

Returns a string describing the approximate computation time of the
application. The string can be altered by the method
setExpectedComputationTime.
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NAME

DESCRIPTION

setLastComputationTim
e

getLastComputationTim
e

Set the last computation time, overwriting the automatically
generated time.

You can use the timeStamp method to record time differences and
then set the measured time in ms (a long integer).

Returns the last computation time in the given format. The format can
either be a time unit or text describing a longer format. This format is
localized and the output is translated to the current language setting.
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License Methods

NAME

DESCRIPTION

checkoutLicense

checkoutLicenseForFil
e

checkoutLicenseForFil
eOnServer
getLicenseNumber

hasProduct

hasProductForFile

hasProductForFileOnSe
rver

Checks out one license for each specified product.

Checks out one license for each product required to open an
MPH-file.

Checks out one license for each product required to open an
MPH-file.

Returns a string with the license number for the current
session. Example: 1icensenumber=getLicenseNumber()

Returns true if the COMSOL installation contains the
software components required for running the specified
products.

Retumns true if the COMSOL installation contains the
software components required for running the specified
MPH-file.

Returns true if the COMSOL installation contains the
software components required for running the specified
MPH-file.

Conversion Methods

NAME DESCRIPTION

toBoolean Converts strings and string arrays to Booleans. (' true' retums true, all
other strings return false).

toDouble Converts floats, float arrays, strings, and string arrays to doubles.

toInt Converts strings and string arrays to integers.

toString Converts Booleans, integers, and doubles, including arrays, to strings.

Array Methods

NAME DESCRIPTION

getColumn Returns a string, double, integer, or Boolean array for a specified column
in a 2D array (matrix). This is, for example, useful when values have been
read from a file and only certain columns should be shown in a table.

getSubMatrix Returns a rectangular submatrix of an input matrix. Available for string,
double, integer, or Boolean 2D arrays.

insert Inserts one or more elements in an array and returns the expanded array.

Auvailable for string, double, integer, or Boolean arrays.
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NAME DESCRIPTION

append Adds one or more elements to the end of an array and returns the
expanded array. Available for string, double, integer, or Boolean arrays.

remove Removes one or more elements from an array and returns the shortened
array. Available for string, double, integer, or Boolean arrays.

insertRow Inserts one or more rows into a rectangular 2D array and returns the
expanded array. Available for string, double, integer, or Boolean arrays.

appendRow Adds one or more rows to the end of a rectangular 2D array and returns
the expanded array. Available for string, double, integer, or Boolean arrays.

removeRow Removes one or more rows from a 2D array and returns the reduced
array. Available for string, double, integer, or Boolean arrays.

replaceRow Replaces one or more rows in a rectangular 2D array and retums the
array. Available for string, double, integer, or Boolean arrays.

insertColumn Adds one or more columns into a rectangular 2D array and returns the
expanded array. Available for string, double, integer, or Boolean arrays.

appendColumn Adds one or more columns at the end of a rectangular 2D array and
retumns the expanded array. Available for string, double, integer, or
Boolean arrays.

removeColumn Removes one or more columns from a rectangular 2D array and returns
the smaller array. Available for string, double, integer, or Boolean arrays.

replaceColumn  Replaces one or more columns in a rectangular 2D array and returns the
array. Available for string, double, integer, or Boolean arrays.

matrixSize Returns the number of rows and columns of a matrix as an integer array
of length 2. Available for string, double, integer, or Boolean arrays.
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String Methods

NAME DESCRIPTION

concat Concatenates a given array or matrix of strings into a single string using
the given separators.

contains Returns true if a given string array contains a given string.

find Returns an array with the indices to all occurrences of a string in a string
array.

findIn Returns the index to the first occurrence of a string in a string array or the
first occurrence of a substring in a string.

length Returns the length of a string.

replace Returns a string where a string has been replaced with another string.

split Returns an array of strings by splitting the given string at a given separator.

substring Returns a substring with the given length starting at the given position.

unique Returns an array of strings with the unique values in the given array of

strings.

Collection Methods

NAME DESCRIPTION

copy Returns a copy of the given array or matrix. Available for string, double,
integer, or Boolean arrays.

equals Returns true if all elements in the given array are equal and they have the
same number of elements. Available for string, double, integer, or Boolean
arrays. For doubles, comparisons are made using a relative tolerance.

sort Sorts the given array. Note: The array is sorted in place. Available for
string, double, or integer arrays. If the array is two-dimensional (a matrix),
the columns are sorted by their row values from top to bottom.

merge Returns an array with all of the elements merged from the given arrays.

Available for string, double, or integer arrays.

With, Get, and

Set Methods

NAME DESCRIPTION

with Used to make code more compact.

endwith The ending of a with statement.

set Sets a Boolean, integer, double, or string property value. Allows

for a scalar, array, or matrix property.
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NAME

DESCRIPTION

setIndex

getIntArray
getIntMatrix
getBoolean
getBooleanArray
getBooleanMatrix
getDouble
getString
getDoubleArray
getDoubleMatrix
getStringArray
getStringMatrix
getDblStringArray
getint

get

descr

Sets a string, double, or integer property value for a matrix or
vector at a given index.

Gets an integer vector property.

Gets an integer matrix property.

Gets a Boolean property.

Gets a Boolean vector property.

Gets a Boolean matrix property.

Gets a double property.

Gets a string scalar, vector, or matrix property.
Gets a double vector property or parameter.
Gets a double matrix property or parameter.
Gets a string vector property or parameter.
Gets a string matrix property or parameter.
Returns the value as a matrix of strings.

Gets an integer property.

Returns a variable expression.

Returns a variable description.

Model Builder Methods for use in Add-Ins

For writing add-in method code that operates on the current component, current
mesh, current physics, and so on, use the methods in the table below.

NAME DESCRIPTION

getCurrentComponent Retumns an object of the type ModelNode for the current
component.

getCurrentPhysics Returns an object of the type Physics for the current physics
interface.

getCurrentMesh Returns an object of the type MeshSequence for the current
mesh.

getCurrentStudy Retumns an object of the type Study for the current
component.

getCurrentPlotGroup Returns an object of the type ResultFeature for the current

component.
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NAME DESCRIPTION

getCurrentNode Returns an object of the type ModelEntity for the current
component.
selectNode Select a particular model tree node.

These methods return the corresponding entity such that the method code in an
add-in can operate on it. When called from an application a method in this
category returns null. Also, null is returned if no entity of the corresponding type

exists such that nothing is current.
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Appendix F — Guidelines for Building Applications

General Tips

Include reports to files with input data and corresponding output data.
Make it intuitive. Provide help, hints, and documentation as necessary.
Make it foolproof: “Safe I/0”, “Reset to default data”; and so on.

Save a thumbnail image with the model.

Include a description text (It will be visible in the COMSOL Server library).
Test the application on the computer platforms for which it is intended.

Be minimalistic. From the developer’s point of view, it is much easier to
make sure logic works, organize, debug, maintain, and further develop the
app. From a user’s point of view, it is easier to use the application. The
minimalistic approach requires more care while developing but much less
maintenance later on and much higher adoption among users.

Embed libraries in the model if they are of manageable size.

Display the expected computation time and, after the computation, the
actual computation time.

When a computation is canceled, output data from the previous
computation should be cleared.

Password protect as needed. (Remember: No one can help you if you forget
the password.)

Naming Conventions

In the demo applications in the Application Libraries, all forms, events,
declarations, and methods use camelCase. You can adopt this convention also in
your own applications. Following this convention, a name should be composed of
a number of words joined without spaces, with each word’s initial letter in capitals
except the first letter that should be lowercase. Use a descriptive name and long
names are better than hard-to-understand short names.

Examples of names for forms:

main
inputParameters

geometryTab
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Examples of names for events:
+ updatePlot
» moveToVelocityTab

Examples of names for declarations:

o Strings — state, waveguideType

* Boolean — isError, didChange, hasBeenInitialized
¢ Integer — year, nextYear

* Double — speed, heatTransferCoefficient

Examples of names for methods:
e compute();

» computeStudyl();

» computeStudyAndPlot();

o getDataForPostProcessing();
 setPlotType();

Methods
* Do not create more methods than necessary.

Fewer methods give you a shorter list of methods to browse through when
looking for something. Fewer methods usually mean fewer lines of code to
worry about.

- If'several methods you wrote do essentially the same thing, consider merging
them into one method and dealing with the different cases by input
arguments.

- Do not create a method if it is only called from one place. Insert the code
right into that place instead.

» Create a local method if it is only used in a form, or triggered by a form
event or a form object event.

* Give methods descriptive names and name them so that similar methods are
grouped together when sorted alphabetically. You will have less to
remember and you will find what you are looking for casier. Long names are
better than hard-to-understand short names.

* The points above apply to method code as well: be minimalistic, use as few
lines of code and variables as possible, use descriptive names for variables,
use long names instead of hard-to-understand short names, and optimize
code to run efficiently.
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» The above points apply to declarations as well: use good names, don't use
more than necessary, and declare variables where they are used (in forms and
methods or in the model).

Forms

» Do not create more forms than necessary.

* Use the Form Wizard templates to get started with creating forms.
» Consider using subwindows instead of form collections.

* Give forms descriptive names. Same reasoning as for methods.

* Make good use of the many different types of form objects. Some are good
for some things, while some are good for others.

* Do notinsert more form objects than necessary. Too many options for input
data may make the application hard to use. Too much output data makes it
hard to find important information.

 Insert a text field for the user to leave comments to save with the user’s set
of input and output data when saving the application.

» Consider inserting a button with a method to reset to default data.

» Apply “Safe 1/0”:

- Forinput fields, alert the user about input data that is out of bounds. You can
do that cither by an alert triggered by an On Data Change event for an input
field, or by setting limits in the form objects settings window, which then sets
hard limits. In a method generating the alert, you may just warn the user and
then allow the input data if the user chooses to go ahead anyway.

- On output fields, give the precision that makes sense. If current results are
not based on current input data, show it. If the computation failed, show it.

* Include tooltips, help, documentation, hints, and comprehensive reports.

* Provide the user with information about how long it takes to run the
simulation with default input data on a typical computer. It could be
seconds, hours, or even days depending on the application, so that is
something the user would like to know before hitting the compute button.
Consider playing a sound to alert the user when the computation has
finished. The user may be doing something else while waiting for results.
(Sending an email message with a report to the user or some other place
when the computation is done may be a better alternative if the computation
is really long.)

* Spend some time on the layout of a form. A good-looking form makes it
easier and more fun to use the application.

Consider setting keyboard shortcuts for buttons and menu items.
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Appendix G — The Application Library Examples

In the Application Libraries, you can find example applications that showcase the
capabilities of the Application Builder. They are collected in folders with the name
Applications and are available for many of the add-on products. You can edit these
applications and use them as a starting point or inspiration for your own
application designs. Each application contains documentation (PDF) describing
the application and an option for generating a report.

Below is a partial list of the available application examples organized as they appear
in the Application Libraries tree. Note that some applications may require

additional products to run.

NAME

APPLICATION LIBRARY

Cluster Setup Validation
Curve Digitizer

Helical Static Mixer
Transmission Line Calculator
Tubular Reactor

Tuning Fork

B-H Curve Checker

Induction Heating of a Billet
Effective Nonlinear Magnetic Curves
Organ Pipe Design

Lithium Battery Designer
Lithium Battery Pack Designer
Lithium-lon Battery Impedance
Water Treatment Basin

Reaction Equilibrium - Gas Phase Conversion of
Ethylene to Ethanol

Cathodic Protection Designer

Cyclic Voltammetry

Electrochemical Impedance Spectroscopy
Concentric Tube Heat Exchanger

Equivalent Properties of Periodic Microstructures

Finned Pipe

COMSOL Multiphysics
COMSOL Multiphysics
COMSOL Muttiphysics
COMSOL Multiphysics
COMSOL Multiphysics
COMSOL Multiphysics
AC/DC Module
AC/DC Module
AC/DC Module

Acoustics Module, Pipe Flow Module

Battery Design Module
Battery Design Module
Battery Design Module
CFD Module

Chemical Reaction Engineering Module

Corrosion Module
Electrochemistry Module
Electrochemistry Module
Heat Transfer Module
Heat Transfer Module

Heat Transfer Module
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NAME

APPLICATION LIBRARY

Forced Air Cooling with Heat Sink
Inline Induction Heater
Thermoelectric Cooler

Mixer

Charge Exchange Cell Simulator

Truck Mounted Crane Analyzer
General Parameter Estimation

Heat Recovery for System for Geothermal Heat
Pump

Solar Dish Receiver Designer
Corrugated Circular Horn Antenna
Frequency Selective Surface Simulator

Slot-Coupled Microstrip Patch Antenna Array
Synthesizer

Rotor Bearing System Simulator
Si Solar Cell with Ray Optics

Beam Section Calculator (Using LiveLink™ for
Excel®)

Beam Section Calculator

Bike Frame Analyzer

Homogenized Material Properties of Periodic
Microstructures

Fiber Simulator
Plasmonic Wire Grating Analyzer

Polarizing Beam Splitter

Heat Transfer Module
Heat Transfer Module
Heat Transfer Module
Mixer Module

Molecular Flow Module, Particle Tracing
Module

Multibody Dynamics Module
Optimization Module
Pipe Flow Module

Ray Optics Module
RF Module
RF Module
RF Module

Rotordynamics Module
Semiconductor Module

Structural Mechanics Module, LiveLink™
for E><ce|®

Structural Mechanics Module

Structural Mechanics Module, LiveLink™
for SOLIDWORKS®

Structural Mechanics Module

Wave Optics Module
Wave Optics Module
Wave Optics Module

The following sections highlight some of the applications listed in the table above.

The highlighted applications exemplify a variety of important Application Builder
features, including the use of animations, email, optimization, parameter
estimation, tables, and the import of experimental data.

Helical Static Mixer
This app demonstrates the following:

* Geometry parts and parameterized geometries
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e Dark theme

* The use of subwindows

» Material appearance visualization with environment reflections

« Report generation for both Microsoft® Word and Microsoft® PowerPoint
» Options for setting different mesh sizes

* Improved graphics visualization when showing and hiding different
geometry objects

» Enabling and disabling ribbon items based on the solution state.

Helical static mixers are often used to mix monomers and initiators which then
react during a polymerization process. The concentration field is included in the
analysis in order to compute the extent of mixing between two streams injected
into the static mixer through semicircle-shaped inlets.

The app can be used to estimate the degree of mixing in a system including one
to five helical blades whose dimensions can also be varied. The monomers' liquid
properties and inlet velocity can also be varied.

This application does not require any add-on products.

e Untited.mph - Helical Statc Mixer - O X

Transmission Line Calculator
This app demonstrates the following;:

+ Creating apps for small screens such as smartphones

» User-interface navigation with a top menu typically used on websites
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e Dynamically hiding forms using card stacks to minimize the space required
by the app

+ Changing appearance by using different background colors.

Transmission line theory is a cornerstone in the teaching of RF and microwave
engineering. Transmission lines are used to guide waves of electromagnetic fields
at radio frequencies. They exist in a variety of forms, many of which are adapted
for easy fabrication and employment in printed circuit board (PCB) designs.
Often, they are used to carry information, with minimal loss and distortion, within
a device and between devices.

Electromagnetic fields propagate along transmission lines as transverse
electromagnetic (TEM) waves. The Transmission Line Parameter Calculator app
computes resistance (R), inductance (L), conductance (G), and capacitance (C) as
well as the characteristic impedance and propagation constant for some common
transmission lines types: coaxial line, twin lead, microstrip line, and coplanar
waveguide (CPW).

This application does not require any add-on products.

= Transmission Line Calcolator O *

Twin-lead Microstrip CPW
® =

Geometry Physics Simulation  Results/Help

Compute
Expected computation time: 4 seconds

Last computation time: 4s

&/

.f';“\. Coaxial Line simulation is solved.

Electric potential. Lines: Electric Field, Magnetic Flux Density
mm

About
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Tubular Reactor

This app demonstrates the following:

» Sending an email with a report when the computation is finished

» User-defined email server settings

» Playing a sound when the computation is completed

» Language localization

» Options to visualize plots tiled or tabbed.

The app exemplifies how students in chemical engineering can model nonideal
tubular reactors (radial and axial variations) and investigate the impact of different

operating conditions. It is also a great example of how teachers can build tailored
interfaces for problems that challenge the students’ imaginations.

The model describes a tubular reactor where propylene oxide (A) reacts with water
(B) to form propylene glycol (C):
A+B->C

Since water is the solvent and present in abundance, the reaction kinetics may be
described as first order with respect to propylene oxide

R=k*C_A
Alternatively, a second-order reaction can also be implemented according to
R=kt*C_A*C_B - kr*C_C

The reaction is exothermic and a cooling jacket is used to cool the reactor. The
reactor is modeled in 2D axisymmetry and the simulation results yield
composition and temperature variations in both the radial and axial directions.
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This application does not require any add-on products.

b Untitled.mph - Tubular Reactor - o X

Input  Simulation | Documentation
Input and Description Results

~ Input Temperature rsion | Temperature profiles  Conversion profiles
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wiim ) Temperature Surface
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~ Information
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Another version of this app demonstrates how the computational speed can be
increased with the use of a surrogate model, as opposed to a fully-fledged finite
element model. A surrogate model is a simpler, usually computationally cheaper
model, which is used to approximate the behavior of a more complex, and often
more computationally expensive, model. The faster model evaluation offered by
the surrogate model provides the user of the app a more interactive user
experience and makes it easier to spread the use of simulations in an organization.
This app is called Tubular Reactor Surrogate Model Application.

Tuning Fork

This app demonstrates the following:

» Playing a sound at a specific computed frequency
* Seclecting different materials from a combo box
 Visualizing material appearance, color, and texture

+ Choice of three different user interface layouts for computer, tablet, or
smartphone

+ Custom implementation of the secant method

e Custom window icon.

When a tuning fork is struck, it vibrates in a complex motion pattern that can be
described mathematically as the superposition of resonant modes, also known as
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eigenmodes. Each mode is associated with a particular eigenfrequency. The tuning
fork produces its characteristic sound from the specific timbre that is created by
the combination of all of the eigenfrequencies.

The app computes the fundamental resonant frequency of a tuning fork where you
can change the prong length. Alternatively, you can provide a user-defined target
frequency and the application will find the corresponding prong length using an
algorithm based on a secant method.

This application does not require any add-on products.

Tuning Fork - o x
File
A = 9 ) E4 o L
Geometry Compute  Plot Sound  Report Reset Help Home
Geometry & Material aa@- LrzkEn ¢ MEeERO @8
Find prong length o
Target frequency: 440 Hz
Frequency tolerance: 0.1 Hz
Prong length: L, 8213 mm
Radius ro2s mm
Material: Steel -
iy
P —
p————
J—T—— L

Sound
Play sound when computed
Sound duration: 1 B

Computed frequency: 440 Hz

B-H Curve Checker

This app demonstrates the following;:

« Importing measured data from a text file

+ Handling measured data using methods

» Exporting the results to a text file.

The app can be used to verify and optimize B-H curves using experimental data.
It also generates curve data in the over-fluxed region, where measurement are

difficult to perform. It removes the unphysical ripples of the slope of the B-H
curve that might cause numerical instability.

The original B-H curve is evaluated from two aspects. Firstly, to verify that the
extrapolation of the curve is reasonable from the physical point of view. Secondly,
to check if the slope of the curve is smooth. The optimization algorithms are
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mainly based on the simultaneous exponential extrapolation method and the
linear interpolation method, respectively.

The app requires the original curve data defined in a text input file. Once the curve
is imported, the application checks if optimization is required. By clicking the
Optimize Curve button, the user can generate the optimized curve data, which can
be exported to a text file.

This application does not require any add-on products.
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Induction Heating of a Steel Billet

This app demonstrates the following:

e Geometry parts and parameterized geometries

» Using tables for user input parameters

 Visualization on a 2D cross-section of a 3D geometry

» Improved visualization and user experience when a geometry object (the air
object) is hidden.

Induction heating is a method used to heat metals for forging and other
applications. Compared with more traditional heating methods, such as gas or
electric furnaces, induction heating delivers heating power directly to the piece in
a more controlled way and allows for a faster processing time.

The app is used to design a simple induction heating system for a steel billet,
consisting of one or more electromagnetic coils through which the billet is moved
at a constant velocity. The coils are energized with alternating currents and induce
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eddy currents in the metallic billet, generating heat due to Joule heating. The
billet cross section; the coil number, placement, and size; as well as the initial and
ambient temperature and the individual coil currents can all be specified as inputs
in the app.

This application requires the AC/DC Module.

g Untitled.mph - Induction Heating of a Steel Billet - o X
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Effective Nonlinear Magnetic Curves Calculator

This app demonstrates the following;:

» Importing measured data from a text file

* Handling measured data using methods

» Exporting the results to a text file

» Exporting the results as COMSOL Material Library file.

The app is a companion to the Effective Nonlinear Constitutive Relations
functionality. Magnetic-based interfaces in the AC/DC Module support the
Effective HB/BH Curve material model that can be used to approximate the
behavior of a nonlinear magnetic material in a frequency domain simulation
without the additional computational cost of a full transient simulation.

The Effective HB/BH Curve material model requires the effective Heff (B) or
Beff (H) relations defined as interpolation functions. This utility app can be used
to compute the interpolation data starting from the material’s H(B) or B(H)
relations.
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The interpolation data for the H(B) or B(H) relations can be imported from a text
file or entered in a table. The app then computes the interpolation data for the
Heff (B) or Beff (H) relations using two different energy methods. The resulting
effective material properties can be exported as a COMSOL Material Library file
and be further used in a model with the Magnetic Fields interface.

This application does not require any add-on products.

,,,,,,,,,,,,,,,,,,,

Organ Pipe Design
This app demonstrates the following;:

« Using a Java® utility class for combining several waveforms and for playing
sound

» Using tables for presenting results.

The app allows you to study the design of an organ pipe and then play the sound
and pitch of the changed design. The pipe sound includes the effects of different
harmonics with different amplitudes.

The organ pipe is modeled using the Pipe Acoustics, Frequency Domain interface.
The app allows you to analyze how the first fundamental resonance frequency
varies with the pipe radius and wall thickness, as well as with the ambient pressure
and temperature.

Using the app, you can find the full frequency response, including the
fundamental frequency and the harmonics. With a method written in Java®code,
the app detects the location and amplitude of all harmonics in the response, thus
extending the analysis beyond the built-in functionality of the COMSOL
Multiphysics user interface.
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This application requires the Acoustics Module.

Organ Pipe Design - o x
S| = =
S| = =] Eg
Reset | Compute | ResetWindow  Report Help
Tayout
oput | Simutstion | Layout | Documentation
nput ~ % Pipe Diameters Wall Thicknesses  Pipe Resonance Frequencies ~ 1 | Results -r
~ Organ pipe aaa-@UE@d ~ nformation
Length 1 o305 m Pipe Resonance Frequencies Expected computation ime: 40 seconds
Diamete (0 3 m /7 Lastcomputation time: 295
1s O,
Wallthickness 6w 2 = &
Young's modulus: 10 3 ~ Pipe Diameters, Amplitude Frequencies (Hz)
Poison'saic 04 10
w9
~ Notations s
, 105 w03
= a3
o JL a7
100
.
@ i |
2 o
,—‘ 3 ~ Wall Thicknesses, Amplitude Frequencies (Hz)
£ o 8
~ Ambient Conditons g 98
Temperat ) T < haict
emperature T e b
Presure: 101325 3 3
~ Pipe Diameters & Wall Thicknesses 80
Diameter @) Wallthickness 6w) e
2Aem] 03lmm] 7 ¥ Pipe Resonance, Six First Frequencies (Hz)
25lcm) e
3{em]. 2[mm] 2
35[em] 3{mm] o =
4em) 2
T =0 = - 3
Frequency Sweep B
Resoltion: 05 e
500 1000 1500 2000 2500 -
f(H2) ' =]

Lithium Battery Designer

This app can be used as a design tool to develop an optimized battery
configuration for a specific application. The application computes the capacity,
energy efficiency, heat generation, and capacity losses due to parasitic reactions of
a battery for a specific load cycle.

Various battery-design parameters consist of: geometrical dimensions of the
battery canister, the thicknesses of the different components (separator, current
collectors and electrodes), the positive electrode material, and the volume
fractions of the different phases of the porous materials can be changed. The load
cycle is a charge-discharge cycle using a constant current load, which may be
different for the charge and discharge stages.
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The app also computes the battery temperature (assuming an uniform internal
battery temperature), based on the generated heat and the thermal mass. Cooling
is defined using an ambient temperature parameter and a heat transfer coefficient.
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~ PackType

® Cylindrical 18650

Heigh

~ Active Material Volume Fraction

Relative el rollvolume i battery: 095

Lithium-lon Battery Designer

Graphics

Stote-of-Charge versus Charge/Discharge Time  Time Dependent Plots  Profile Plots
CellVoltage and Load -

eaqa-B UEM @ad

Cell Potential and Load vs. Time

sk \ .

Voltage(V)

—
— cellVoltage

Open-circuit cell voltage, coulombic

Crate (1)

o 2000 4000 6000
Time (s)

Li-lon Battery Pack Designer
This app demonstrates the following:

* Dynamic help system using card stacks

¢ Multiple components (1D and 3D) in a single app

8000 10000

» Toggle buttons in the ribbon for showing different input, hiding/showing
geometry selections, and for dynamic help

* Geometry parts and parameterized geometries

» Importing experimental data

« Options for creating different mesh sizes

» Resetting a portion of the input parameters or all

* Generating a results table during the app session

« Exporting results to a text file or to Microsoft® Excel if a license of
LiveLink™ for Excel® is available

 Sliders and buttons to control the time step to plot

| 385



* Visualizing results with animations

e Custom window icons.

It is a tool for investigating the dynamic voltage and thermal behavior of a battery
pack, using load cycle and SOC vs OCV dependence experimental data.

Parameter estimation of various parameters such as the ohmic overpotential, the
diffusion time constant, and the dimensionless exchange current can be performed
by the app. The app may then be used to compute a battery pack temperature
profile based on the thermal mass and generated heat associated with the voltage
losses of the battery.

Various battery pack design parameters (packing type, number of batteries,
configuration, geometry), battery material properties, and operating conditions
can be varied.

This application requires the Battery Design Module and the Optimization
Module.
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Li-lon Battery Impedance

The goal with this app is to explain experimental electrochemical impedance
spectroscopy (EIS) measurements and to show how you can use a simulation app,
along with measurements, to estimate the properties of lithium-ion batteries.
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The app takes measurements from an EIS experiment and uses them as inputs. It
then simulates these measurements and runs a parameter estimation based on the
experimental data.

The control parameters are: the exchange current density, the resistivity of the
solid electrolyte interface on the particles, the double-layer capacitance of NCA,
the double-layer capacitance of the carbon support in the positive electrode, and
the diftusivity of the lithium ion in the positive electrode. Fitting is done to the
measured impedance of the positive electrode at frequencies ranging from

10 mHz to 1 kHz.

The application requires the Optimization Module and the Battery Design
Module.
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Water Treatment Basin
This app demonstrates the following;:

* Parameterized geometry containing a geometry sequence with if-statements
to produce different types of designs

* Options to set the mesh size
+ Light Theme

» A graphical user interface that includes different windows that can be shown
or hidden.
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Water treatment basins are used in industrial-scale processes in order to remove
bacteria or other contaminants.

The app exemplifies modeling turbulent flow and material balances subject to
chemical reactions. You can specity the dimensions and orientation of the basin,
mixing baffles, and inlet and outlet channels. You can also set the inlet velocity,
species concentration, and reaction rate constant in the first-order reaction.

The app solves for the turbulent flow through the basin and presents the resulting
flow and concentration fields as well as the space-time, half-life, and pressure drop.

The application requires the CFD Module.
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Reaction Equilibrium—Gas Phase Conversion of Ethylene to Ethanol
This app demonstrates the following:
* How an app can be used as a teaching tool

* An 8 question multiple choice quiz where the answers can be sent to the
grader by email

This app calculates the equilibrium compositions in gas phase conversion of
ethylene to ethanol. It allows you to study how the initial conditions and the
operating conditions affect the ethanol production.

The app is designed to teach you how to compute quantitative results for the
equilibrium composition and provide an understanding for the dynamics of a
chemical equilibrium.
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The application requires the Chemical Reaction Engineering Module.
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The purpose of the app is to demonstrate and simulate the use of cyclic
voltammetry. You can vary the bulk concentration of both species, transport
properties, kinetic parameters, as well as the cycling voltage window and scan rate.

Cyclic voltammetry is a common analytical technique for investigating
clectrochemical systems. In this method, the potential difference between a
working electrode and a reference electrode is swept linearly in time from a start
potential to a vertex potential, and back again. The current-voltage waveform,
called a voltammogram, provides information about the reactivity and mass
transport properties of an electrolyte.
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The application requires one of the Battery Design Module, Electrochemistry
Module, Electrodeposition Module, Corrosion Module, or Fuel Cell &
Electrolyzer Module.
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Electrochemical Impedance Spectroscopy
The purpose of this app is to understand EIS, Nyquist, and Bode plots. The app
lets you vary the bulk concentration, diffusion coefficient, exchange current
density, double layer capacitance, and the maximum and minimum frequency.

Electrochemical impedance spectroscopy (EIS) is a common technique in

electroanalysis used to study the harmonic response of an electrochemical system.
A small, sinusoidal variation is applied to the potential at the working electrode,
and the resulting current is analyzed in the frequency domain.

The real and imaginary components of the impedance give information about the
kinetic and mass transport properties of the cell, as well as the surface properties
through the double layer capacitance.
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The application requires one of the Battery Design Module, Electrochemistry
Module, Electrodeposition Module, Corrosion Module, or Fuel Cell &
Electrolyzer Module.

Untitled.mph - Electrochemical Impedance Spectroscopy - o x

input | 5
Input and Information Results TEENESE. @
~ nput Nyquist Plot _ Bode Plot _ Bode Plot, Phase Angle

Qaq@a- WeED @s
mi/s Nyquist plot: Impedance with respect to ground
m/s 0.0075

mol/m* 0.007
0.0065
0.006
0.0055
0.005

0.0045
0.004
~ Simulation Information 0.0035

B 0.003

0.0025 - .
0.002

0.0015
0.001

oooos |

o

Imaginary impedance (@*m?)

/7 Last computation time: 25

U

0.0005

3 0.002 0.004 0.006 0.008 0.01
Real impedance (Q*m?)

Concentric Tube Heat Exchanger

This app demonstrates the following:

o Sclecting predefined or user-defined materials

» User option to switch between laminar flow or turbulent flow

» Changing boundary conditions using methods

 Visualizing temperature dependent material properties as graph plots

» User option to set the solver tolerance.

Finding the right dimensions for a heat exchanger is imperative to ensure its
effectiveness. Other properties must also be considered in order to design a heat

exchanger that is both of the right size and provides heated or cooled fluid of the
right temperature.

The app computes these quantities for a heat exchanger made of two concentric
tubes. The fluids can flow either in parallel or in counter current flow.

The fluid properties, heat transfer characteristics, and dimensions of the heat
exchanger can all be varied. The Nonisothermal Flow multiphysics interface is
used to model the heat transfer.
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This application requires the Heat Transfer Module.
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Equivalent Properties of Periodic Microstructures
This app demonstrates the following;:

* Visualization of a periodic structure from a unit cell
» Resetting some or all input parameters

« Export the resulting material properties as an MPH-file or an XML file that
can be imported to a COMSOL Multiphysics session.

Periodic microstructures are frequently found in composite materials, such as
carbon fibers and honeycomb structures. They can be represented by a unit cell
repeated along three directions of propagation.

To reduce computational costs, simulations may replace all of the microscopic
details of a composite material with a homogeneous domain with equivalent
properties. This app computes the equivalent properties for a geometrical
configuration and the material properties of a unit cell to be used in a macroscopic
model that uses these composite materials.

Nine different microstructures are given, with dimensional characteristics that are
modifiable by the user, as well as thirteen predefined materials. The app calculates
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the equivalent density, heat capacity, and thermal conductivity or diffusivity of the
composite materials.

This application does not require any add-on products.
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Finned Pipe
This app demonstrates the following:
* Geometry parts and parameterized geometry

A results table form object containing outputs.

Finned pipes are used for coolers, heaters, or heat exchangers to increase heat
transfer. They come in different sizes and designs depending on the application
and requirements.

When the fins are placed outside the pipe, they increase the heat exchange surface
of the pipe so that a cooling or heating external fluid can exchange heat more
efficiently. When placed inside the pipe, it is the inner fluid that benefits from an
increased heat exchange surface. Instead of fins, grooves can also increase the heat
exchange surface, particularly inside the pipe where space is limited.

With this app, you can customize a long cylindrical pipe with predefined inner and
outer fins or grooves to observe and evaluate their cooling effects. The app
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calculates the thermal performance of a pipe that is filled with water and then
cooled or heated by surrounding air with forced convection.

Various geometric configurations are available for the outer structure
(disk-stacked blades, circular grooves, helical blades, helical grooves, or none) and
for the inner structure (straight grooves or none).

The app computes the dissipated power and the pressure drop as functions of the
geometry and air velocity.

This application requires the Heat Transfer Module
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Forced Air Cooling with Heat Sink

This app demonstrates the following;:

* Geometry parts and parameterized geometries

+ Sending an email with a report when the computation is finished

» User-defined email server settings which is useful when running compiled
standalone applications

« Options for setting different mesh sizes
» Error control of input parameters using methods.
Heat sinks are usually benchmarked with respect to their ability to dissipate heat

for a given fan curve. One possible way to carry out this type of experiment is to
place the heat sink in a rectangular channel with insulated walls.
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The temperature and pressure at the channel’s inlet and outlet, as well as the
power required to keep the heat sink base at a given temperature, is then
measured. Under these conditions, it is possible to estimate the amount of heat
dissipated by the heat sink and the pressure loss over the channel.

The purpose of the app is to carry out investigations of such benchmarking
experiments. You can vary the type of heat sink as well as the number of fins or
pins and their dimensions to find the optimal design for a given pressure loss over
the channel.

Air velocities and heat source rates can be varied and the app solves for
nonisothermal flow, assuming turbulence as described by the algebraic yPlus
model.

This application requires the Heat Transfer Module.
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Inline Induction Heater

This app demonstrates the following;:

* A model using symmetry while the results are visualized in full 3D
» Provides info if the results are above or below certain critical values

* Seclecting predefined or user-defined materials
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* Error control of geometry parameters using methods and presentation of
possible errors using card stacks

+ Sliders and buttons to control the position of the slice when visualizing the
results with a slice plot.

The app computes the efficiency of a magnetic induction apparatus for the heating
of liquid food flowing in a set of ferritic stainless steel pipes.

Ferritic stainless steels become more and more used in food processing due to their
relatively low and stable price, and their magnetic properties that allow using new
heating techniques.

A circular electromagnetic coil is wound around a set of pipes in which a fluid
flows. The alternating current passing through the coil generates an alternating
magnetic field that penetrates the pipes, generates eddy currents inside them, and
heats them up. Then heat is transferred to the fluid essentially by conduction.

Various configurations are available for the set of pipes (number, length, thickness,
material) and for the coil (number of turns, wire radius, current density, and
excitation frequency) to optimize the heat exchange with the fluid, while ensuring
homogeneous temperatures within it for a given flow rate.

This application requires the Heat Transfer Module and the AC/DC Module.
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Thermoelectric Cooler
This app demonstrates the following:
* Visualizing material appearance, color, and texture

* Showing info below the graphics about geometry parameters, results, and
performance depending on the selected plot action

Thermoelectric coolers are widely used for electronics cooling in various
application areas, ranging from consumer products to spacecraft design. A
thermoelectric module is a common type of component used in thermoelectricity
applications. A typical module consists of several thermoelectric legs sandwiched
between two thermally conductive plates, one cold and one hot. The device that
needs to be cooled down must be attached to the cold face.

Due to the variety of applications, there can be many different thermoelectric
cooler configurations. This app covers the basic design of a single-stage
thermoelectric cooler of different sizes with different thermocouple sizes and
distributions. It also serves as a starting point for more detailed calculations with
additional input options and can be extended to multistage thermoelectric
coolers.

This application requires the Heat Transter Module, AC/DC Module, and
Optimization Module. Instead of the AC/DC Module you could alternatively use
the MEMS Module or the Plasma Module.
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Mixer

This app demonstrates the following:

* Multiple tabs in the ribbon

* Geometry parts and parameterized geometries

 Parts and cumulative selections can be used to automatically set domain and
boundary settings in the embedded model

+ Adding or removing geometry parts with different geometrical
configuration

» Options for creating different mesh sizes

* Sending an email with a report when the computation is finished

» User-defined email server settings which is useful when running compiled
standalone applications

« Sliders to control the visualization of a slice plot.

The app provides a user-friendly interface where scientists and process engineers
can investigate the influence that vessels, impellers, baffles, and operating
conditions have on the mixing efficiency and on the power that is required to drive
the impellers. You can use this application to understand and optimize the design
and operation of a mixer for a given fluid.

You can specify the dimensions of the vessel from a list of three types and the
dimensions and configuration of the impellers from a list of eleven types. The
vessels can also be equipped with baffles. You can further specify the impeller
speed and the properties of the fluid that is being mixed.
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The application requires either the CFD Module or the Polymer Flow Module.

Unttedmph - Miser o ox

Charge Exchange Cell Simulator

A charge exchange cell consists of a region of gas at an elevated pressure within a
vacuum chamber. When an ion beam interacts with the higher-density gas, the
ions undergo charge exchange reactions with the gas which then create energetic
neutral particles. It is likely that only a fraction of the beam ions will undergo
charge exchange reactions. Therefore, in order to neutralize the beam, a pair of
charged deflecting plates are positioned outside the cell. In this way, an energetic
neutral source can be produced.

This app simulates the interaction of a proton beam with a charge exchange cell

containing neutral argon. User input includes several geometric parameters for the
gas cell and vacuum chamber, beam properties, and the properties of the charged
plates that are used to deflect the remaining ions.

The simulation app computes the efficiency of the charge exchange cell, measured
as the fraction of ions that are neutralized, and records statistics about the different
types of collisions that occur.
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This application requires the Particle Tracing Module and the Molecular Flow
Module.
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Truck Mounted Crane Analyzer

This app demonstrates the following;:

+ Using the knob form object

» Updating the geometry by rotating a knob

e Provides info if the results are above or below certain critical values

Many trucks are equipped with cranes for handling loads and such cranes have a
number of hydraulic cylinders that control the motion of the crane. These
cylinders and other components that make up the crane are subjected to large
forces when handling heavy loads. In order to determine the load-carrying
capacity of the crane, these forces must be computed.

In the app, a rigid-body analysis of a crane is performed in order to find the
payload capacity for the specified orientation and extension of the crane.

Inputs include the angle between the booms, the total extension length, the
capacity of the inner and outer boom cylinders, and the capacity extension
cylinders. Results from the app include the payload capacity and hydraulic cylinder
usage.
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The application requires the Multibody Dynamics Module.
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General Parameter Estimation
This app demonstrates the following;:

* Importing measured data from a text file or use built-in functionality for
data generation

» Automatically change solver options based on the input
* Dynamically update the equation display.
The app can be used to estimate parameters in models without any physics. Data

can be imported from a file or the built-in functionality for data generation can be
utilized.

The models include linear, quadratic, sigmoid, sloped Gaussian, and a custom
model with up to 5 parameters.

The Levenberg—Marquardt solver computes confidence intervals for the estimated
parameters, while the other solvers (MMA, SNOPT, and BOBYQA) allow for
specification of parameter bounds. MMA and BOBYQA allow for minimization
of the maximum square instead of the sum.
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The application requires the Optimization Module.
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Geothermal Heat Pump
This app demonstrates the following;:

» Changing the design by using a combo box with predefined options

» Options for creating different mesh sizes

« Editing and plotting monthly data input

o Setting the end time and the time steps size of a time dependent simulation

* Visualizing the initial values for a time dependent simulation

* Includes a simple control system to manage the temperature.

Geothermal heating is an environmentally friendly and energy-efficient method to
supply modern and well insulated houses with heat. Heat exchangers placed at a
sufficient depth in the ground below the house utilize subsurface heat, where
temperatures are almost constant throughout the year.

The app studies different pipe configurations of a ground heat exchanger. It
provides information on the performance of ground-coupled heat exchangers for
different specifications (depth, pattern, pipes configuration, and heating
conditions), temperature conditions, soil thermal conductivity, and temperature

gradient.
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The heater can also be turned off if the daily heat demand is achieved, and then
turned on again after 24 hours. The temperature at the pipe’s outlet can be
controlled and compared to the minimum temperature required in the heat
exchanger specifications.

This application requires the Pipe Flow Module.
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Solar Dish Receiver Designer

Solar concentrator/cavity receiver systems can be used to focus incident solar
radiation into a small region, generating intense heat which can then be converted
to electrical or chemical energy. A common figure of merit in solar thermal power
systems is the concentration ratio, or the ratio of the solar flux on the surface of
the receiver or in the focal plane to the ambient solar flux.

This app is an application based on the Solar Dish Receiver tutorial model. In this
app, incident solar radiation is reflected by a parabolic dish, while the concentrated
solar radiation is collected in a small cavity. A total of six different parameterized
cavity geometries are available for investigation: Cylindrical, Dome,
Heteroconical, Elliptical, Spherical, and Conical. It is also possible to take several
different types of perturbation into account, including solar limb darkening and
surface roughness. For each cavity geometry, built-in plots show the flux
distribution and concentration ratio in the focal plane as well as the incident flux
on the interior surfaces of the cavity.
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You can learn more about this example in a related blog post: “Efficiently
Optimizing Solar Dish Receiver Designs”:
https: / /www.comsol.com/blogs/efficiently-optimizing-solar-dish-receiver-designs.

This application requires the Ray Optics Module.
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Corrugated Circular Horn Antenna

This app demonstrates the following:

+ A toolbar with large buttons for the navigation instead of a ribbon

+ Subforms used as sections and the sections' headings include an image

+ Provides info if the results are within a certain range

* Visualizes a 2D axisymmetric model in full 3D

The excited TE mode from a circular waveguide passes along the corrugated inner
surface of a circular horn antenna where a TM mode is also generated. When
combined, these two modes give lower cross-polarization at the antenna aperture.
By using this app, the antenna radiation characteristics, as well as aperture

cross-polarization ratio can be improved by modifying the geometry of the
antenna.
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This application requires the RF Module.

Cormgat Creio Hom Botenna - o x

Frequency Selective Surface Simulator

This app demonstrates the following:

* Designing an app for small screens such as smartphones

» User-interface navigation with a top menu typically used on websites
* Geometry parts and parameterized geometries

* Visualizing periodicity of a geometry with material rendering

» Warning messages on icons when properties are not updated

* Sending an email with a report attached when the computation is finished

Frequency selective surfaces (ESS) are periodic structures that generate a bandpass
or a bandstop frequency response. They are used to filter or block RF, microwave,
or, in fact, any electromagnetic wave frequency. For example, you see these
selective surfaces on the doors of microwave ovens, which allow you to view the
food being heated without being heated yourself in the process.

The app simulates a user-specified periodic structure chosen from the built-in unit
cell types. It provides five unit cell types popularly used in FSS simulations along
with two predefined polarizations in one fixed direction of propagation that has
normal incidence on the FSS. The analysis includes the reflection and transmission
spectra, the electric field norm on the top surface of the unit cell, and the
dB-scaled electric field norm shown on a vertical cut plane in the unit cell domain.
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You can change the polarization, center frequency, bandwidth, number of
frequencies, substrate thickness and its material properties, and unit cell type
(circle, ring, split ring, and so on) as well as their geometry parameters, including
periodicity (cell size).

This application requires the RF Module.

FequeneySlctiveSuraceSvistor - o x
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Microstrip Patch Antenna Array Synthesizer

This app demonstrates the following:

o Parameterized geometries

 Visualizing material appearance, color, and texture

* Multiple plots in the same window to visualize the results

+ Options to visualize the results with different views using checkboxes
Microstrip patch antenna arrays are used in a number of industries as transceivers

of radar and RF signals. This is a prime candidate for the 5G mobile network
system.

The app simulates a single slot-coupled microstrip patch antenna, fabricated on a
multilayered low-temperature cofired ceramic (LTCC) substrate. When using this
app, you will be able to simulate the far-field radiation pattern of the antenna array
and its directivity. The far-field radiation pattern is approximated by multiplying
the array factor and the single antenna radiation pattern to perform an efficient
far-field analysis without simulating a complicated full-array model.
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You can also evaluate phased antenna array prototypes for 5G mobile networks
with a default input frequency of 30 GHz. You can do this by varying antenna
properties such as the geometric dimension and substrate material.

This application requires the RF Module.
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Rotor Bearing System Simulator
This app demonstrates the following;:

» Navigation system using toggle buttons in the ribbon and Back/Forward
buttons in the settings window

* Seclecting predefined or user-defined materials
» Using a table for input of geometry objects
The app simulates a rotor bearing system consisting of disks and bearings mounted

on a rotating shaft. An eigenfrequency analysis is performed for a range of angular
speeds, to identify critical speeds of the system.

An app of this kind is useful at an early design stage where design modifications
can be made to move critical speeds away from the operating speed of the system.

Results include whirl modes, a Campbell plot, and a list of critical speeds.
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This application requires the Structural Mechanics Module and the
Rotordynamics Module.
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Si Solar Cell with Ray Optics

This app demonstrates the following:

e Multiple components (1D and 3D) in a single app

» Using the same choice list in the app as in the model using Data Access
functionality

¢ Output numerical results for a specific time step using a combo box

The app combines the Ray Optics Module and the Semiconductor Module to
illustrate the operation of a silicon solar cell at a location specified by the user. The
Ray Optics Module computes the average illumination over a day of the year. The
Semiconductor Module computes the normalized output characteristics of a solar
cell with design parameters specified by the user. The normalized output
characteristics is then multiplied by the computed average illumination to obtain
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the output characteristics of the cell at the specified date and location, assuming
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This app demonstrates the following:

« Reading and importing data from an Microsoft® Excel file

« Exporting data to an Microsoft® Excel file

The app computes the beam section properties and true stress distribution in a
designated steel beam section. A broad range of American and European beam

data in Excel® worksheets.

standards are available. It uses LiveLink™ for Excel® to read and store the beam
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This %Dplication requires the Structural Mechanics Module and LiveLink™ for
Excel®. A version of this app is also provided without Microsoft® Excel
functionality.
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Bike Frame Analyzer

This app demonstrates the following:

» Connecting an app to a SOLIDWORKS® session

e Setting a maximum allowed value which the solution is compared to

* Selecting predefined or user-defined materials

» Changing boundary conditions with a combo box using methods

The app computes the stress distribution and the deformation of a bike frame
based on user configurable loads and constraints. It leverages LiveLink™ for

SOLIDWORKS® to load the geometry, and to update the frame dimensions for
studying their effect on the results.
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This application requires the Structural Mechanics Module and LiveLink™ for
SOLIDWORKS®.

° Bike Frame Analyzer - o X

Fil

T e e A= R .2

jpdate  Update  Mesh Compute  Help Sketch

Home

Reset
fom CAD from App
nput Geometsy Simulstion | Documentation
~ Design Geometry Mesh ~Effective stress  Displacement Maximurm stress  Maximum stress range
Use geometryfrom: | Specifed document v | | Cronkangle: | 0ldeg] -
e mountainbike_hardtailSLOPRT | Display options: (1] Loads [] Maximum value [1] Mesh [] Deformation
Configuration: 7 Qaa@ar@ Ly hEkn C [E-X=)
Display state <Default> Display State von Mises stress (MPa) - Crank angle = 0° o
Lstupdated:  Oct 20,2021 120000 AM
 Definitions.
50
Dimensions  Material | Loads & Constrints
Headangle 7 .
gle (A): as
Seatangle ns .
Top tube length (O (588 m
88 drop (D): 6 mm 40
Chainstay ©: @ m
Wheelbase (F): 1032 mm 35
Stack (G): 618 mm
Weight: 16 kg 30
~ Computation
25
Usesymmetr: | Off >
Mesh sze: Finer Coarser
20
Mesh scale factor: 1
 Verification 15
Maximum allowable stress factor: 0.5
The resuling masimurn effectiv tress 0

below the allowable value.

~ Information

s e
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Fiber Simulator

For almost all commercial optical fiber types, the design consists of a concentric
layer structure with the inner layer(s) forming the core and the outer layer(s)
forming the cladding. Since the core has a higher refractive index than the
cladding, guided modes can propagate along the fiber.

This application performs mode analyses on concentric circular dielectric layer
structures. Each layer is described by an outer diameter and the real and imaginary
parts of the refractive index. The refractive index expressions can include a
dependence on both wavelength and radial distance. Thus, the simulator can be
used for analyzing both step-index fibers and graded-index fibers. These fibers can
have an arbitrary number of concentric circular layers. Computed results include
group delay and dispersion coefficient.

This application requires the Wave Optics Module.

I Unitied mph - Fiber Simulator =X
N o

(&) Standard Telecom Single-Mode Fiber —_ willa - W =

e g = X v ogh k£ W 0 B

- Show  Mesh Compute Mode ModeField Group Dispersion Attenuation Refractive  Report Help
(8 Graded-Index Multi-Mode Fiber  Geometry = Field Diometer Delay Index

nput Design Simulation Results Documentstion
' Fiber Design Table Wavelength: ~ 1200 v KM Mode: 6 Effective modeindexis 14511 v suTENSes: B
" Label Dismeter (um) | ' aaq- €L~ @8
Core £2um] 00052 mat3.fi.. | 063 206°0.14). Surface: Electric field norm (V/m) Arrow Surface: Electric field Contour: Electric field, z-component (V/m)
Cladding 125{um) matifiida0".|(063+2.06°0.14),
60
s0
BHee t L+ 5%
~ Available Materials 40
» Name g 30
5102 (Siicon dioide, iics, Quartz) (Maltson 1965:F... | mat3
6602 (Germanium dioxide, Germanis) (Flerming 1964 matd 20
5102 (Siicon dioxide, Siica, Quartz) (Gao et al 2013: T.. | mat5
5102 (Siicon dioxide, Siica, Quartz) (Ghosh 1998 3-Q... | mat5 10
5102 (Siicon dioxide, Siica, Quartz) (Ghosh 1998 3-Q... | mat? _
5102 (Slcon dioside, Slca, Quarts) (Kichkat et a. 20.. | matd £
=
Help
10
~ Simulation Parameters
Minimur wavelength 12 um 20
Masimum vavelength 15 um
Number of wavelengths: 11 =0
Number of modes 6
<0
~ Information
50
Expected computation time with default setings: 60 seconds
(7Y Lost computation time: 345
©) 0

20 40 60 km
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Plasmonic Wire Grating
This app demonstrates the following:

» Choice of different user interface layouts for computer/tablet or
smartphone

+ Custom background image and color
» Graphics appearance with custom top color and bottom color

» Custom position of the graphics toolbar

This application computes diffraction efficiencies for the transmitted and reflected
waves (m = 0) and the first and second diffraction orders (m = +1 and +2) as
functions of the angle of incidence for a wire grating on a dielectric substrate. The
incident angle of a plane wave is swept from normal incidence to grazing
incidence. The application also shows the electric field norm plot for multiple
grating periods for a selected angle of incidence.

This application requires the Wave Optics Module.

n Plasmonic Wire Grating Analyzer - o X
S A = X & 0 ®© o
Reset. Geometry. Compute  Electric Field  Diffraction Report. s ne

< Geometry Parameters
Periodicity:

g &
3

Wire radius:

i Material Properties
Substrate efractive index: 12

) Wave Properties

Wavelength in vacuum: M1 nm

© Out-of-plane polarization

O In-plane polarization

Incident wave

02 ¥ Mo &1 02

About

Polarizing Beam Splitter

A Gaussian beam is incident on a 45-degree thin-film stack embedded in glass
material prisms. The thin-film stack is designed from alternating high and low
refractive index materials. The wave will be refracted at the Brewster angle at each
internal interface. Thus, mainly p-polarized waves (polarization in the plane of
incidence) will be transmitted, whereas mainly s-polarized waves (polarization
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orthogonal to the plane of incidence) will be reflected. Changing the spot radius
for the Gaussian beam modifies the polarization discrimination.

The reflectance and transmittance spectra are calculated for different Gaussian
beam spot radii.

The app automatically calculates the phase expressions necessary for the
Electromagnetic Waves, Beam Envelopes interface, when the user changes the
design parameters.

This application requires the Wave Optics Module.

s Untited.mph - Polarizing Bearm Spiter - o x
= ®) B
O | A =} ® N~ B
Reset  Geomety Mesh Compute  Electic Reflectanceand Refractive | Report Help
S Field  Tranamitance  Index
Input | Design | Simulation Visualzation Documentstion
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i 45
1673
High-index materia efractive index (nHigh) 0
18
m User defined B 35
23 30
Lovwindex materi!refractive index (nLov) 16
25
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20
3 14
Number of syers i stack 15
N 7 B o
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~ Simulation Parameters 5
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Center wavelength (wl0) -
gth (w0} 5
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Bandwidth (W) 10 o8
a1 500 om 1s
Number o wavelengths: e
I [ 2 -
Spot radius (w0); 25
wo 200 m
0 0.4
Polarzaion: sandp B
35
~ iformation 02
<0
Ecpected simulstion tme: 2 mintes
(7 Lostcomputation time: 475 s o
)
%0  s0 40 30 20 10 3 10 20 30 40 50 60 4m
X (um)
Wavelength: 530 nm B Plottype: | Total electricfield norm Polarzstion: | 5 v
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ID array 166
2D array 167
3D coordinates 298

About dialog 43
About to shutdown event 150
action 64, 68, 149
activation condition 170, 252, 259
active card selector 286
Add New Choice List 170
Add New Form Choice List 170
add-in 14, 132, 224, 225, 324
selections 94
Add-in Libraries 229
add-on products 10, 374
alert 217, 359
aligning form objects 114, 123
animation 79, 86, 89
appearance
button object 78
forms 53, 55
graphics object 80
input field object 102
multiple form objects 62
table 3/2
text 61
append unit from unit set 176
append unit to number 99, 317
application
saving 330
Application Argument /3, 133
Application Builder 2/
desktop environment /2, 20
window 12, 15, 18
Application Builder Reference Manual

I'1, 232

application example

beam section calculator 409
B-H curve checker 380
concentric tube heat exchanger 391
equivalent properties of periodic mi-
crostructures 392
fiber simulator 412
frequency selective surface simulator
405
helical static mixer 375
induction heating of a steel billet 38/
li-ion battery impedance 386
li-ion battery pack designer 385
lithium battery designer 384
microstrip patch antenna array syn-
thesizer 406
mixer 398
organ pipe designer 383
plasmonic wire grating 413
Si solar cell with ray optics 408
transmission line calculator 376
truck mounted crane analyzer 400
tubular reactor 378
tuning fork 379
water treatment basin 387
Application Gallery 29
Application Libraries 10, 28, 29, 46, 374
Application Library
COMSOL Server 33
application object 184
Application Programming Guide I/,
184,213
application tree 12, 15, 17, 18
applications
publishing 44
applications folder 10, 29, 374
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apply changes 24
arguments
input and output 209
arranging form objects | 14
array 166
ID 166
2D 167
2D, interactively defining 168
syntax |67
array input object 155, 158, 297
auto complete 204

Automatic Notation 279

background color 55
background image 55
Blank form template 56
BMP file 233
Boolean variable 163, 165, 166, 237
conversion 366
Boundary Point Probe 95, 183
Break 211
breakpoint 21
browser
web 32, 135
built-in method library 353
button 66, 79, 112, 207
command sequence 68
icon 66
keyboard shortcut 67
on click event 66, 68
size 66, 116
style 66
text 116
tooltip 67

C libraries

external 362
CAD-file import 290, 332, 334
Call Stack window 21 |

cancel shutdown 150

card 285
card stack object 112, 163, 164, 285,
294
cell margins 122, 129
cells
merging 121
splitting /121
Chatbot window 213
check box object 112, 155, 158 165,
188, 207, 237
check syntax 197
choice list 65, 159, 169, 170, 245, 249,
254, 262, 263, 301, 302, 309, 310,
360
clear selection
graphics 83
click-through agreement 4/
clipboard 267, 279, 326
close application icon 150
Close brackets automatically 203
code completion 204
tooltip 205
code folding 203
color
material 83
selection 83
column settings 120, 128
combo box object 112, 155, 163, 169,
173,243
command line 133
command sequence 18, 50, 51, 68, 71,
72,79, 88, 142, 149, 153, 155, 184,
208, 209, 234, 315, 323
comments
toggle on and off 202
common, file scheme 332, 348
compatible with physical quantity, unit
dimension check 99

compatible with unit expression, unit



dimension check 99
Compiler
button 38
node 39
compiler 10, 24, 27, 38
complex numbers 279
component syntax 203
computation time 297
expected 105, 294, 296
last 105, 296, 365
COMSOL Client 10, 26, 27, 32, 35
file handing 328
running applications in 35, 328
COMSOL Compiler 10, 24, 27, 38
COMSOL Desktop environment |2,
20
COMSOL Multiphysics 10, 24, 25, 30,
31,35, 130, 184, 213, 269, 275, 277
COMSOL Runtime 39
COMSOL Server 10, 24, 26, 27, 29, 31,
32, 35,36, 332
manual 38
COMSOL Software License Agree-
ment 44
confirm 217, 359
Continue 21/
Convert to Form Method 18, 73, 184,
208
Convert to Local Method 19, 73, 184,
208
Convertto Method 18,72, 74, 184, 186,
208, 337
Coordinate 181, 182
Copy Table and Headers to Clipboard
279
copying
forms and form objects 130, 326
objects 59

rows or columns /21

Create Local Method 207
Create Local Variable 206
Create New Declaration and Use It as
Source 98
Create New Form Declaration and Use
It as Source 98
creating
forms 16, 46
methods /8
CSV file 163,280, 315, 316
curly brackets 203
custom file type 171
custom ribbon tab 225

custom settings window 131/

DAT file 163, 280, 315, 316
Data Access 109, 192, 196
data change 64, 155, 209, 239, 240, 373
data display object 102, 104, 112
information node 296
tooltip 107
data file 163, 280, 315
Data picking 182
data picking 95, 182
data validation 99, 176
Data Viewer window 21|
date 364
dbfile, file scheme 332
Debug Log 2/2
debug log window 212, 362
debugging 210, 362
Decimal Notation 279
Declaration and Use it as Source 6/
Declarations 14, 159, 161
form 98, 159, 160
global 98
local 98
declarations node 237
delete button 59, 71, 292
deleting an object 59
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Depth Along Line 183
derived values 105, 278
description text
Boolean variable 239
derived value 103
desktop icon 25, 40, 135
desktop shortcut 25, 135
Developertab 18, 107, 132, 194, 220
dialog 359
digital twin 14, 154
Disable All 21
disable form object 360
display name, for choice list 169, 173,
246, 302, 309, 360
displayed text 6/
Domain Point Probe 183
domain point probe 95
double variable 163, 165, 166
conversion 366
double, data validation 100
download
option for compiling 39
drag and drop, form objects 59
duplicating
rows or columns /2]

duplicating an object 59

edit local method 209
edit node 69, 190, 191
Editor Tools 190
editor tools 64, 193, 248, 249
window 18
editor tree 65, 68, 82, 190, 329, 331
element size |||
change 260
email 321
class 356
methods 356
email attachment

export 356

report 356
table 356
embed
option for compiling 39
embedded, file scheme 232, 235, 332,
340
Enable code folding 203
enable form object 360
enabled state, for form objects 78
Engineering Notation 279
equation object 264
error message, data validation 99, 101
Evaluation 2D 183
Evaluation 3D 183
evaluation tables 183
event 64, 149, 155, 207, 209, 251
About to shutdown 150
button on click 68
for multiple form objects 62, 157
form 155
form object 155
global 13,112, 149
keyboard shortcut 67
knob 320
local 149
node 150
on close 157
on data change 64, 155, 209, 239,
240, 373
on load 64, 157
on startup 150
slider 318
Events 13
example application
bike frame analyzer 410
charge exchange cell simulator 399
corrugated circular horn antenna 404
effective nonlinear magnetic curves

calculator 382



finned pipe 393 File menu editor 17

forced air cooling with heat sink 394 file open
general parameter estimation 40/ system method 356
geothermal heat pump 402 file scheme
inline induction heater 395 common 332, 348
polarizing beam splitter 413 dbfile 332
rotor bearing system simulator 407 embedded 232, 235, 332, 340
solar dish receiver designer 403 syntax 232
thermoelectric cooler 397 temp 332
Excel® file 163, 280, 315 upload 171, 332, 338, 341
executable 10, 24, 38 user 332, 348
explicit selection 90, 93 File Type 159
exponent, number format /05 file type
export declaration /71
emalil attachment 356 filename 291, 335, 355
export button, results table 279 files library 235
export node 328 341 Find 198

Export Selected Image File 233 fit, row and column setting 1 16, 120

exporting fixed, row and column setting 116, 120

results 328, 341
external C libraries 362

extracting subform 116

File 159

file
commands 329
declaration /71
destination 291, 335
download 34, 330
import 69, 155, 158,171, 232
menu 143
methods 354
opening 329
saving 330
types 292
upload 34, 330

file browser 346

file custom 171

file import object 155, 158, 171, 232,

290, 328, 334

for statement 215
form 15, 54
Declarations 159
local 57
form collection 112, 138, 282
Form Editor 2/
desktop location |2
overview 5
preferences 20, 58
using 54
form event 155
form method 18, 149, 155, 184
form object 15, 58, 64, 236
event /55
with associated methods 188
form reference 282
Form tab, in ribbon 15
form toolbar 323
form window 15

Form wizard 64, 65, 103
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Forms I3
Full Precision 279

function 17

gauge object 272
parameter 273
scalar variable 273
variable 273
geometry 31, 49, 68, 79, 85, 94, 304,
326, 336, 338, 359
import 290, 332, 334
operations 269, 275, 277
Geometry Entity Level 183
geometry node 68
get 369
GIF file 233
global evaluation 105, 285
global event 13, 149
global method 18, 155, 184
global parameter 216
go to method 18,72, 186
graphics 73
clearing contents 85
commands 82
hardware acceleration 44
hardware limitations 84
object 48, 49, 79, 155, 359
plot group 85
Source for Initial Graphics Content

181

source for initial graphics content 79

tab, New Form wizard 49
toolbar 85, 112
using multiple objects 84
view 82, 88, 361
graphics data 95, 159, 181
grid layout mode 34, 55, 104, 13

grid lines, sketch layout mode [ /4

grow, row and column setting /16, 120

growth rules 116

H Home tab, in ribbon 46

HTML

code 266

report 266, 349
HTTP and HTTPS protocols 321
hyperlink object 320

icon 233,323
button 66
close application /50
command 69
desktop 25, 40, 135
graphics 80
help 101
main window |37
menu item /42
method 188
ribbon item 142
toolbar 323
if statement 215
ignore license errors 26
image
background 55
formats 233
object 267
Preview 233
scaling 267
thumbnail 29
Images library 233
Immediately
Store changes 77
import
file 69, 155,158 171,232, 291, 335
Indent and Format 202
Indent and format automatically 203
information card stack object |12, 294
information node 296
inherit columns /28
initial size, of main window 39

initial values, of array 166



initialize
parameter 74
variable 74
Initializing Installer progress window 4/
input arguments |33, 209
input field object 96, 112, 155, 158, 163,
176
adding 96
information node 296
text object 103
tooltip 98
unit object 103
Inputs 13, 133
inputs tab, outputs tab, New Form wiz-
ard 48
inserting
form objects 62, 64
rows and columns |16, 119
rows or columns |2/
integer
data validation 100
variable 163, 165, 166
variable conversion 366
interactive editing
menus and ribbon items 145
tem
menu 142, 207
ribbon /44
toolbar 322

ava Shell window 213

J

Java utility class 232

Java® programming language 184, 213
J

PG file 30, 233

keyboard shortcut 20, 64, 149, 191, 204,
206, 211, 350
event 67, 142, 323
knob object 318

parameter 3/9

L

scalar variable 319

variable 319

Language 140
language elements window 18, 189, 213
language localization /40
LaTeX 103, 106, 264
layout mode 55, 113
layout options, form collection 282
layout template 16, 47, 58
Libraries 14
libraries node 232, 267
license agreement 44
license errors
ignoring 26
Line Entry Method 183
line object 265
list box object 12, 155, 158, 163, 169,
173,306
LiveLink™ for Excel® 163, 280, 315
LiveLink™ products 35
local event 149
local form 57
local method 18, 64, 73, 149, 155, 158,
184, 188, 207, 209, 239, 246, 326
local variable 206
Localization 140
log object 275
logo image 80

low-resolution displays 34

Main Form 138

Main Window 13, 16, 138, 269
node 137, 146

Main Window Editor 21, 145
desktop location /2
overview |6

Main window type 138

margins

cell 122,129
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material 252 Model Builder

material color and texture 83 method 204, 217
math functions 215 model commands 33/
menu [42, 144 model data access /12, 152, 326
bar 138 141 Model Expressions |99
item 79, 112, 142, 207 model expressions window |8
toggle item 142, 241 model object 184, 213, 353
Menu editor |7 model tree node, controlling if active
menu toggle item |12 218
merging cells [ 16, 121 model utility methods 353
mesh 49, 79, 85, 11| move down
change element size 260 command sequence 7|
size 11 move up
meshing 269, 275, 277 command sequence 7/
message log object 276, 359 MP4 file 268
method 14, 17,62,72,79, 159, 184, 353 MPH-file 14, 24, 25, 27, 31, 46, 52, 232,
event 150, 155 331, 362
form 18, 149, 155, 184 multiline text 104
form object 188 multiple form objects
global 18, 155, 184 selecting 62, 157
local 18, 64, 73, 149, 155, 158, 184, N name
188,207, 239, 246, 326 button 66
Model Builder 217 check box 239
window 18 choice list 169
Method Call 218, 225 form 54

Method Editor 2/, 353
desktop location |2

form object 62

graphics object 79
overview |7

menu /42
Preferences 203 method 202
using 184 shortcut 178
Method Errors and Warnings window .
variable 162

197
Method tab, in ribbon 18
method, called from the Model Builder
217
Methods 14
Microsoft® Word® format 347
minimum size

form objects 122

named selection 90

new element value 166

new form 16

New Form wizard 63, 103
graphics tab 49
inputs and outputs tabs 48
ribbon buttons tab 50

new method /8
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notation
data display number format 105
unit 105

number format 102, 105

number of rows and columns [ /6

numerical validation 100, 176

OGYV file 268

on click event, button 66

on close event |57

on data change event 64, 155, 209, 239,
240, 373

on load event 64, 157

On request

Store changes 77

on startup event /50

open file 329

OpenGL graphics hardware accelera-
tion 44

operating system command line 133

operators 2[4

optimization 387

orthographic projection 82

OS commands 356

output arguments 209

Output directory

for compiled applications 39

panes 282
parameter 17, 49,73, 97,99, 163, 216,
326, 369
combo box object 243
declarations 14, 159
events 3, 149
input field object 96
method 196, 215
slider object 317
text label object 103
parentheses 203

password protected application 31/

pasting
form objects 59
forms and form objects 130
image 267
rows or columns /2]
pixels 61, 113
play sound 34, 234, 356
plot 49, 50, 68, 69, 79, 85, 165, 238, 247,
310, 337, 345, 359
plot geometry command 69
plot group 73, 165
PNG file 30, 233
Point Being Modified 183
Polar Complex Numbers 279
position and size 61, 113, 115
multiple form objects 62
positioning form objects 58
precedence, of operators 2/4
precision 279
precision, number format 105
preferences 20, 58, 203, 332, 333
for compiled applications 44
security 3/
Preview
image 233
preview form 24
printing
graphics 83, 362
Probe 183
procedure |7
Programming Reference Manual |/
progress 269, 364
progress bar |38
progress bar object 269, 364
progress bar, built in 269
progress dialog 271, 364
publishing applications 44

Q Quick Access Toolbar 24

Find 198
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radio button object 112, 155, 169, 173,
300
Record Code 194
recording code 94
Rectangular Complex Numbers 279
recursion 210
regular expression /01
Remove All 21|
removing
password protection 3/
rows and columns /16, 119
rows or columns /2]
report 371, 374
creating 328, 341, 347, 348
creating automatically 218
email attachment 356
embedding 266
HTML 266, 349
image 30
node 328, 341, 348
request 217, 359
reset current view 82, 89
Reset Window Layout 5/
resizable graphics 34
resizing form objects 59
Results Evaluation /81, 182
results table object 278, 360
ribbon /38, 143
item 112, 144
section 144
tab 144
toggle item 112, 144, 241
Ribbon button 67
ribbon buttons tab, New Form wizard
50
ribbon tab
custom 225
Ribbon tab editor 17

row settings |19

run application 24, 26
running applications
compiled 38
in a web browser 32, 328
in the COMSOL Client 35

runtime 39

save
application 52
running application 27
save application command 330
save as 362
save file 330
Scalar 163
scalar variable 163, 245, 285, 317
scene light 82, 362
Scientific Notation 279
security settings 3/
select all
graphics 83
selection 49, 79, 85
explicit 93
selection colors 83
selection input object 93, 303
selections 90
add-in 94
selectNode method 218

separator
menu /42
ribbon 144

toolbar 142, 322
separators

CSV, DAT, and TXT files 316
set value command /[ |
Settings Form 132, 218, 225
Settings Forms /31
settings window

customized 131/

Form editor 12, 15

Method editor 18



shortcut
desktop 25, 135
shortcuts 159, 178
use 200
Show as Dialog command 74
Show Dialog 132
Show Errors 130
show form command 75
Show in Model Builder /31
shutdown
cancel 150
Single form template 56
Single window 138
sketch grid |14
sketch layout mode 55, 104, 113
slider object 112, 156, 316
smartphones
running applications on 34
software rendering 44
solving 269, 275, 277
sound
play 234
Sounds library 233
Source for Initial Graphics Content /81,
182
spacer object 325
special characters 135
splash screen 40
splitting cells 116, 121
state
enabled, for form objects 78
visible, for form objects 78
Status bar 138
status bar 269
Step 211
Step Into 211
Step Out 2/ |
Stop 211
Stop Recording 196

stopping a method 21/ |
Store changes 77
Stretch image 267
string variable 13,74, 149, 151, 163, 166,
244, 246, 254, 283, 295, 306
conversion 366
methods 368
subroutine 17
Subwindow editor |7
subwindow layout 16
Subwindows 138
subwindows 146
Switch to Model Builder and Activate
Data Access 98
syntax errors |97
syntax highlighting 202, 204
system methods 356
OS commands 356

table
email attachment 356
table object 156, 166, 311, 360
add to table 312
source 312
tables, model tree 278
tablets
running applications on 34
Target for Data Picking 95, 182
temp, file scheme 332
template 16, 47, 58
templates 146
temporary file 346
test application 24, 26
test in web browser 24
text 142
text color 55
text file 163, 279, 315
text label object 96, 103, 105
text object 112, 155, 158, 306

information node 296
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Theme 204
Themes I3
Themes node 53
thumbnail image 29, 30
time 364
time parameter
combo box object 249
Timer events 13, 154
timestamps 277
title
form 54
main window |37
menu 42

toggle button 112, 241

size |16
text 116
toggle item

menu |12, 142, 241
ribbon 112, 144, 241
toolbar 322
toolbar 141, 279, 322
button, table object 315
graphics 85, 112
item 112,322
separator 42, 322
tooltip
button 67
data display object 107
input field object 98
knob object 319
method editor 205
slider object 274, 317
toolbar button 323
unit mismatch 100
transparency 82, 362
TXT file 163,279, 315,316

Unicode 103, 106

unit

changing using unit set /73

data display 105
dimension check 99, 100, 176
expression 99
groups 173
lists 173
object 96, 103
Unit Groups 173
Unit Lists 173
Unit Set 173
unit set 101, 159, 263, 302, 310
Untitled.mph 27
upload
file scheme 171, 332, 338, 341
URL 135, 266, 321
use as source
array input object 299
card stack object 286
check box object 239
combo box object 245
data display object 105
declaration /61
explicit selection 93, 303
gauge object 273
graphics object 79
information card stack object 295
input field object 96
knob object 319
list box object 308
radio button object 30/
results table object 279
selection input object 93, 303
slider object 317
text object 306
Use component syntax 203
use shortcuts 200
user
file scheme 332, 348
user interface layout /5

username 356



V  Value 169, 173 with statements 203

variable 14, 159, 196 with() command 310
accessing from method 215 wrap text
activation condition 170 text label object 104

Boolean 165, 166, 237
declaration 14, 159

Z zoom extents 79, 82, 310, 337, 362

derived values 105
double 165, 166
events 3, 149, 151
input field object 96
integer 165, 166
name completion 204
scalar 245, 285, 317
slider object 317
string 163, 166, 244, 246, 283, 295,
306
text label object 103
video
controls 269
player 269
video object 268
view
go to default 3D 88
graphics 82, 88, 361
reset current 82, 89
View all code 203
visible state, for form objects 78

volume maximum 105

W WAV file 233
web browser 10, 27, 32, 135
file handling 328
web page
hyperlink 321
web page object 266
WebGL 32
WebM file 268
while statement 215
Window Layout 51, 138, 147
with statement 203, 215, 368
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